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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help
You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed Help
If you’re setting up an on-premise PeopleSoft environment, and your organization has firewall restrictions
that prevent you from using the hosted PeopleSoft Online Help, you can install the online help locally.
See Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files
You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation
Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

• Application Fundamentals

• Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.
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In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions
PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions
The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign 
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

. . . (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
 Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
 an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.

⇒ This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes
PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.
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ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY_CD_TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY_TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers
Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

• Asia Pacific

• Europe

• Latin America

• North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

• USF (U.S. Federal)

• E&G (Education and Government)

Translations and Embedded Help
PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We
are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.
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Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

• Using the PeopleSoft Online Help.

• Managing hosted Online Help.

• Managing locally installed PeopleSoft Online Help.

PeopleTools Related Links

PeopleTools 8.60 Home Page

PeopleSoft Search and Kibana Analytics Home Page

"PeopleTools Product/Feature PeopleBook Index" (Getting Started with PeopleTools)

PeopleSoft Online Help

PeopleSoft Information Portal

PeopleSoft Spotlight Series

PeopleSoft Training and Certification | Oracle University

My Oracle Support

Oracle Help Center

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.

Follow Us

Icon Link

YouTube
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Icon Link

Twitter@PeopleSoft_Info.

PeopleSoft Blogs

LinkedIn
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Chapter 1

Getting Started with PeopleSoft Change
Assistant

PeopleSoft Change Assistant Overview

Oracle's PeopleSoft Change Assistant is a standalone Java program that orchestrates the process of
updating or upgrading your PeopleSoft system. Environment Management Framework is used for non-
PUM enabled updates and for deploying files with Update Manager.

Change Assistant provides these main benefits:

• Automates many of the steps in an upgrade or update process.

• Provides a clear step-by-step definition of the process for applying maintenance or performing an
upgrade. Whether the process is automated or manual, as long as you complete each step, you will
successfully apply the application maintenance or perform the upgrade.

• Provides in-line documentation for each of the steps in the process.

• Is integrated with the PUM application and uses the change package definitions created in the
PeopleSoft Update Image.

The Environment Management Framework performs these key tasks:

• Crawls local drives and directory paths to discover and validate the components associated with a
given PeopleSoft environment.

• Deploys files to various components in the PeopleSoft environment.

Related Links
Environment Management Framework

Change Assistant Actions
Change Assistant supports the following actions:

Term Definition

Apply Updates Any systems that are not Update Manager enabled will use the
Apply Updates to apply updates downloaded from My Oracle
Support.
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Term Definition

Update Manager Update Manager contains 4 sets of tasks:

• Update Manager Tasks

Update Manager is used for application patching and
updates for PeopleSoft PUM-enabled applications(all 9.2
applications and Interaction Hub 9.1). This option allows
you to select the updates from the PeopleSoft Update
Image and create a custom change package that includes
only the updates and any calculated requisites you want to
apply to your application.

• Application Upgrade Tasks

Application Upgrade is used to perform an upgrade to 9.2
application release.

• PeopleTools Tasks

PeopleTools tasks include applying the database changes
required with PeopleTools patches, PeopleTools upgrades
and PeopleTools delta packages.

• Other tasks

Other tasks include exporting and importing Change
Assistant settings.

View PUM Automated Merge Sessions If Object Merge is enabled, this action can be used to display
the merge session and review how the code was automatically
merged based on the merge rules.

Create or Modify Templates Change Assistant templates are composites of all the possible
steps that apply to an update or upgrade. The templates are
delivered as part of the change package or upgrade. Once you
select a change package or upgrade, the template is loaded
into the Change Assistant internal storage. You can edit the
template or add additional chapters, tasks and steps, if needed.

Installation

Prior to using Change Assistant the following items must be in place:

Step Reference

Install PeopleTools, database client software and any database
client connect information.

PeopleTools Installation for your platform

Install your PeopleSoft application Your PeopleSoft application installation guide
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Step Reference

Install Change Assistant PeopleTools Installation for your platform : Installing
PeopleSoft Change Assistant

Note: PUM DPK will install and configure Change Assistant
for the PUM source.

Quick Start

The following items provide a quick start reference for the main steps and concepts related to the
implementation and use of Change Assistant. This list is designed to help get you up and running with
Change Assistant as well as to help you to understand the main functions for which Change Assistant was
designed.

PeopleSoft Update Manager (PUM) Enabled Updates
The steps appear in the logical order that you would perform them, and the links point to the location
where the information for a specific task is provided. PUM enabled applications include all 9.2
applications and Interaction Hub 9.1
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This diagram illustrates the PUM environment which includes the PeopleSoft Update Image, the target
environment and the windows client.

Note: If the target environment is Oracle database on a lower PeopleTools release than the PeopleSoft
Update Image, the configuration will be the same as the target on a non-Oracle database.

Step Reference

1. Use My Oracle Support (MOS) to find the current
PeopleSoft Update Image and download it.

See PeopleSoft Update Manager Home Page [ID 1641843.2]

2. Install the PeopleSoft Update Image.

Note: The PeopleSoft Update Image may be at a different
release/patch level than your target environments.

See PeopleSoft Deployment Packages for Update Images
Installation (PeopleSoft PeopleTools 8.5x).

3. (Optional) Configure and start the PSEMAgent on every
server within your PeopleSoft target environment.

Note: EMF is only run on the target environments not on the
PeopleSoft Update Image.
EM Hub is only used for file deploy in PUM-enabled
applications.

See Configuring an Environment Management Agent.
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Step Reference

4. Map your Windows client to the PeopleSoft Update Image
shared drives. Mapping can be done using the PeopleSoft
Update Image IP address.

Note: The IP address can be identified using the ifconfig Linux
command on the VirtualBox.

See Configuring the Microsoft Windows Client Running
Change Assistant

5. Configure Microsoft Windows client running Change
Assistant.

See Configuring the Microsoft Windows Client Running
Change Assistant

6. Install Change Assistant on Windows client at the same
release/patch level as the PeopleSoft Update Image.

See Installing Change Assistant

7. Start Change Assistant. Click Next on Welcome page, then
select Update Manager action.

See Selecting Update Manager Action

8. In Change Assistant, select Update Manager > Define
Change Package.

The Change Assistant Wizard will lead you through the setup
pages.

See Defining Change Package

9. Use PeopleSoft Update Manager PIA application in the
PeopleSoft Update Image environment to search for updates
you need, review the update impact, and define your update
change package.

Note: Update change packages can also be created in Change
Assistant using standard search criteria.

See Defining Update Change Packages

10. Use Change Assistant to create the change package from
your custom change package definition created with PeopleSoft
Update Manager PIA application, analyze the change impact,
 and apply the updates.

See Packaging Updates.

11. Use Change Assistant to apply the change package. See Applying Change Package

Note: Use the PeopleSoft Update Image Home Pages tab from the PeopleSoft Update Manager Home
Page [ID 1641843.2] to access the PeopleSoft Update Image for your application. The Update Image
Home page for your application will contain links to all the relevant information for the PeopleSoft
Update Image you are downloading. The Installation Documentation section on the page contains a link
to the installation guide for the Image.
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Applying Individual PeopleSoft Release Patchset (PRP) to PeopleSoft
Update Image

The steps appear in the logical order that you would perform them, and the links point to the location
where the information for a specific item exists within this PeopleBook.

Step Reference

1. Search MOS for the PRP. See PeopleSoft Update Manager Home Page [ID 1641843.2]

2. Download the PRP to a local directory. See Applying Downloaded PeopleSoft Release Patchset to
PeopleSoft Image

3. Apply the PRP to the PeopleSoft Update Image using
Update Manager action Apply Downloaded Individual Posting
to PeopleSoft Update Image.

See Applying Downloaded PeopleSoft Release Patchset to
PeopleSoft Image

4. Use the Update Manager process to search for and apply the
new individual fix to your target databases.

See PeopleSoft Update Manager (PUM) Enabled Updates

Traditional (Non-PUM Enabled) Updates
The steps appear in the logical order that you would perform them, and the links point to the location
where the information for a specific item exists within this PeopleBook.

Step Reference

1. Configure and start the PSEMHUB within your PeopleSoft
environment.

See Configuring the Environment Management Hub.

2. Configure and start the PSEMAgent on every server within
your PeopleSoft environment.

See Configuring an Environment Management Agent.

3. Install and configure Change Assistant, specifying the proper
directories for file download and storage, and ensuring it can
connect to the PSEMHUB.

See Installing Change Assistant.

4. Use My Oracle Support (MOS) to identify the bundles and
updates that need to be applied to your specific environment.

See Discovering Updates Using My Oracle Support.

5. Download the required bundles and updates. See Downloading Updates From My Oracle Support.

6. Use Change Assistant to apply the bundles and updates. See Applying Updates To A Target Environment.
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Application Upgrade
Application Upgrade is only used to upgrade from a previous application release to application release
9.2. The steps appear in the logical order that you would perform them, and the links point to the location
where the information for a specific item exists within this PeopleBook.

Step Reference

1. Install new PeopleTools release, if necessary. See PeopleSoft PeopleTools 8.5x Deployment Packages
Installation

2. Use My Oracle Support (MOS) to find the current
PeopleSoft Upgrade Source Image and download it.

Note: Or install the Demo database for the Upgrade Certified
new release from the media pack or CD, available on Oracle
Software Delivery Cloud (classic method).

See  PeopleSoft Upgrade Source Image Home Page (ID:
1552580.1).

3. Install the PeopleSoft Upgrade Source Image.

Note: The PeopleSoft Upgrade Source Image may be at a
different release/patch level than your target environments.

See PeopleSoft Deployment Packages Installation (PeopleSoft
PeopleTools 8.5x).

4. Use My Oracle Support (MOS) to find the current
PeopleSoft Update Image and download it.

See PeopleSoft Update Manager Home Page [ID 1641843.2]

5. Install the PeopleSoft Update Image.

Note: The PeopleSoft Update Image may be at a different
release/patch level than your target environments.

See PeopleSoft Deployment Packages for Update Images
Installation (PeopleSoft PeopleTools 8.5x).

6. Create an upgrade change package. See Defining an Upgrade Package

7. Upgrade to new application release. See Upgrading Application

Other Sources of Information

This section provides information to consider before you begin to use PeopleSoft Change Assistant. In
addition to implementation considerations presented in this section, take advantage of all PeopleSoft
sources of information, including the installation guides, release notes, PeopleBooks, and training courses
and your PeopleSoft application upgrade documentation.

Related Links
Application Designer Developer’s Guide
Lifecycle Management Guide
Change Impact Analyzer
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Chapter 2

Understanding The Environment
Management Framework and PeopleSoft
Change Assistant

Environment Management Framework

Environment Management Framework (EMF) is a collection of software elements that gathers and
publishes PeopleSoft installation, configuration, and update information. It enables you to identify and
view data about PeopleSoft environments. You can use EMF to obtain a snapshot of configuration and
setup information about the file servers, the web servers, the application servers, the individual hosts,
and the PeopleSoft Process Scheduler servers that comprise your PeopleSoft system. EMF also provides
a vehicle to carry out commands remotely on different machines on the network, directed by Change
Assistant, which uses EMF to apply updates to PeopleSoft installations and configurations.

EMF is used with Change Assistant to deploy files contained in an upgrade package. For traditional
updates (non-PUM enabled applications), EMF is required to identify PeopleSoft environments, for all
other Change Assistant actions configuring and running EMF is optional.

EMF consists of the following core elements:

• The Environment Management hub (PSEMHUB)

• Environment Management Agent (PSEMAgent)

• The Environment Management viewer

Environment Management Hub
The Environment Management hub is a web application that is installed with the PeopleSoft Internet
Architecture and portal. It is started along with the rest of the web applications when the user boots the
web server. The hub is the broker for all communication between peers.

The Environment Management hub handles:

• Peer registration.

The hub registers all of the information that is published by the agents. It also assigns a unique peer
ID for every peer that engages in a dialogue with the hub.

• Maintenance of configuration information.

The hub handles updates to configuration information, the correlation of information, and the
grouping into environments based on the information that is published by the agents.

• Agent health monitoring.
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The hub keeps track of the state or "health" information of the managed components. It shows
whether a peer is still running remotely or not.

• Message brokering.

The hub services message service requests and responses from peers. The messages can be delivered
to the respective peers even if the peers are not currently running. They are picked up the next time
the peers “call in” to the hub. Typical messages include requests to deploy files to managed servers.
It's recommended that the managed server agents be left up and running at all times to listen for
messages from the hub. This is critical when applying software updates.

The Environment Management hub is installed as part of the standard PeopleSoft Internet Architecture
installation. It supports both single-server and multi-server installations. The Environment Management
hub is deployed in the J2EE containers as web application modules. They can be managed like any of the
standard web application modules.

Environment Management hub directories are created on the J2EE container for the hub. For Oracle
WebLogic, the directory is PIA_HOME\webserv\domain\applications\peoplesoft\PSEMHUB

The required JAR files for the Environment Management hub are installed in the WEB-INF\lib
subdirectory.

Agents
An Environment Management agent is a Java executable installed on the servers in a PeopleSoft
environment, such as application servers, Process Scheduler servers, web servers, and so on. The
Environment Management agent initiates communication with the hub and is assigned a unique peer ID.
This ID persists and is reused for later connections by the agent.

The primary function of the agent is crawling the managed servers to identify manageable components.
The metadata of the search results of the crawling are saved to the local hard disk. On startup, if the agent
detects missing metadata, it recrawls the hard disk for manageable components. You can configure the
drives and directory paths used for crawling.

The agent also publishes managed server information to the hub. After detecting a manageable
component, the agent reads the non-sensitive information from configuration files of the component.
Some relevant information that is related to environment and patch levels is also fetched from the
database with which the application server or Process Scheduler communicates. The agent publishes this
information to the hub upon initial connection and upon a recrawl or revalidate.

The agent also determines heartbeat and command execution. On every heartbeat, the agent pings the
server to determine whether it has any pending messages. If there are pending messages for the agent, the
messages are retrieved from the hub and carried out locally on the agent machine.

Note: The Environment Management agent is installed in the PSEMAgent directory in PS_HOME when
you deploy PeopleTools.

Note: Multiple EM Agents can be run, but they must be run using a different agentport.

See PeopleTools installation documentation for your database platform.
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Viewer
The Environment Management viewer is a command-line tool enabling you to view data stored on the
Environment Management hub. This data is saved in an XML file that contains data that is specific to
individual customer sites—such as, information about environments, software updates, hosts, file servers,
application servers, PeopleSoft Process Scheduler servers, and web servers. Users can view this static data
in HTML.

The Environment Management viewer may only be executed on PeopleSoft web servers, from its
installed location in PS_HOME\PSEMViewer. You don't have to carry out any additional installation steps
to install the viewer.

EMF Terminology
The following terms relate to Environment Management:

Term Definition

Manageable component A component that can be individually managed from the
Environment Management hub. A manageable component
for PeopleSoft is typically a file server, an application server,
 a web server, individual hosts, or a PeopleSoft Process
Scheduler server.

Peer A manageable component that is involved in a transaction with
one or more peers in the Environment Management by using
the hub as the intermediary. A peer may also be responsible
for delegation of management responsibility to a collection
of manageable components. Examples of peers are agents,
 Change Assistant, and the Environment Management viewer.

Heartbeat “I am alive messages” sent by every peer to the hub. The
default interval is configurable. On every heartbeat, the peer
pings the server to see if it has any pending messages. If it
does, the messages are taken and carried out.

Environment All of the manageable components in the enterprise that share
the same globally unique identifier (GUID) in the database.
 There can be more than one instances of a type of managed
component in an environment. For example, development
environments can contain several application servers, Process
Schedulers, and web servers.

GUID Uniquely identifies a particular PeopleSoft system. PeopleSoft
assigns a unique value, referred to as a GUID, to each
PeopleSoft application installation. This value can't be
customized. When an Environment Management agent notifies
the hub that it has found a manageable component belonging
to an environment, if the GUID of the environment is not
recognized, the hub creates a new environment representation.
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Term Definition

Crawling The process of scanning the hard disk for known PeopleSoft
patterns for manageable components. The hub has a set of
configurable parameters by which the recrawl intervals can be
altered. Based on this, the hub can issue a recrawl command
to the agents to discover information about newly installed or
changed configurations.

Note: During crawling, the Environment Management
Framework uses the psserver property in the peopletools.
properties file within each PS_HOME installation to determine
the type of server(s) installed. For example, APP is application
server, BATCH is Process Scheduler, DB is database server,
 WEB is web server, and FILE is file server.

Note: Recrawling includes revalidating.

Revalidate The process of checking whether the last set of managed
components that have been discovered is still valid. The
agent iterates through the list of components that have been
discovered from the last recrawl. It then checks whether
the current set of configuration parameters for the managed
components have changed the management scope for the
component. If so, the information is updated. If the new set
of configuration options has made the component not usable,
 it is removed from the list of managed components. This
information is updated in the hub the next time the agent
communicates with the hub.

Change Assistant

Change Assistant is a standalone application that enables you to assemble and organize the steps
necessary to apply updates and fixes for PeopleSoft application maintenance updates as well as
performing upgrades. Change Assistant automates many of the steps, but will prompt you and guide you
through any manual steps with embedded documentation.

You use Change Assistant for these situations:

• Selecting and applying updates related to PeopleSoft application maintenance. Change packages are
automatically created based on the customers selection of the updates to apply.

• Performing upgrades, which includes PeopleTools-only upgrades and PeopleSoft application-only
upgrades.

• Applying database changes for PeopleTools patches.

Note: You use Change Assistant to apply updates that have a .ZIP extension. You do not use Change
Assistant to apply updates that have an .EXE extension.

You can use PeopleSoft Update Manager for select applications releases to search for updates you may
need for your environment and to review the potential impact of the selected changes. PeopleSoft Update
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Manager will automatically include requisite updates based on the items you select; it will show you what
has already been applied to your target environment; and, it will let you review the changes included
with each update before selecting it. You can then create a custom change package definition with your
selected updates.

Important! The change package definition created only guarantees the requisites for the specific target
selected. If the same change package is applied to a different target, you may encounter errors or warnings
if the environment is not at the same level as the target specified when the package definition was created.

Understanding Change Assistant Versions
You can use a newer version of Change Assistant than the version of PeopleTools you are using.
However, the environment management agents and hub should be at the same release level as Change
Assistant.

For PUM , your PeopleTools version for target database could be at 8.54.03, but you can run Change
Assistant at the 8.57.03 level, in this case the environment management hub and agents would run on
8.54.03.

For non-PUM enabled environments, the environment management agents and hub must be at the same
release/patch level as Change Assistant, in order to apply updates. For example, your PeopleTools version
could be at 8.53.09, but you can run Change Assistant at the 8.53.14 level as long as the agents and hub
are also at the 8.53.14 level.

Maintaining Change Assistant for PUM Enabled Updates
When you install a new PUM Source, you will need to install the new Change Assistant version for that
PUM image. Change Assistant is installed from the tools_client directory using SetupPTClient.bat.

See Configuring the Microsoft Windows Client Running Change Assistant

Maintaining Change Assistant for Non-PUM Enabled Updates
Periodically, Oracle provides patches for PeopleTools that supply fixes to critical defects. With each
PeopleTools patch version, Oracle provides the following updates in executable format:

Executable Description

version.exe

For example, 85014.exe

Contains all current fixes to the entire PeopleTools product,
 including those fixes to the software update technology, which
includes Change Assistant and all environment management
elements (agents, hub, and so on).
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Executable Description

version-PSCA.exe

For example, 85014-PSCA.exe

Contains only the current fixes for Change Assistant and all
environment management elements (agents, hub, and so on).

The software update technology runs independently from the
rest of PeopleTools.

Important! This only applies to non–PUM enabled
applications.

Note: If you install a complete PeopleTools patch, you do not need to apply the -PSCA patch individually.
Apply the -PSCA patch individually only if you are running non- PUM enabled applications and
interested in just the fixes for the software update tools and not the fixes for the entire PeopleTools
product.

The -PSCA patch enables you to apply only the latest fixes to Change Assistant and the environment
management framework without applying the latest full PeopleTools patch. By doing so, you can avoid
the regression testing that typically occurs after applying a full PeopleTools patch.

PeopleSoft Update Manager

PeopleSoft Update Manager (PUM) is a tool which runs on the PeopleSoft Update Image database. 

PeopleSoft Update Images (PI) are fully functioning instances of the PeopleSoft environment. There
is one PeopleSoft Update Image per product family (database instance) and they will be released
periodically according to the image schedule posted on the PeopleSoft Update Manager Home Page. The
PeopleSoft Update Image is the master source environment from which you will pull the updated objects,
create a custom change package, and apply updates to your environment. The PeopleSoft Update Image
for your application is cumulative so you will download the most current PeopleSoft Update Image and
get all of the updates that you need.

There are two types of downloads for your PeopleSoft Update Image:

• VirtualBox: Use this download to deploy the PeopleSoft Update Image using a VirtualBox Virtual
Machine. This is similar to the installation process used with images using PeopleTools 8.53 and 8.54.

• NativeOS: This download is for Linux and Windows customers. This download allows you to apply
your PeopleSoft Update Image directly to your OS or a virtualization platform without having to use
VirtualBox.

The PeopleSoft Update Manager PIA Application and the PeopleSoft Update Image work together; the
PeopleSoft Update Image contains the updates and the PeopleSoft Update Manager PIA Application
is the searching tool and custom change package definition generator. PeopleSoft Change Assistant
orchestrates the entire process flow. Change Assistant is the tool used to analyze and compare changes,
to apply the changed objects to your environment, to add in your customizations, and to generate custom
change packages.
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Software Update Process

The software update process refers to applying updates to your PeopleSoft application. The procedure for
applying updates depends on whether the PeopleSoft application is PUM enabled.

PUM Enabled PeopleSoft Systems
All PeopleSoft updates for a product family are made available on a PeopleSoft Update Image. The
PeopleSoft Update Image contains the very latest PeopleSoft working database, applications, managed
objects, codeline, and the data and metadata required to use the PeopleSoft Update Manager. The
PeopleSoft Update Image is posted and downloaded from My Oracle Support (MOS). The schedule for
images will be posted in advance on MOS for each PeopleSoft application database instance.

Software update tools include:

• Environment Management Framework

Used to collect environment information.

See Running the Environment Management Hub

• Change Assistant

Used to upload target database information to the PeopleSoft Update Image, create change packages
from the change package definitions created using PeopleSoft Update Manager, and to the apply
change packages to target databases.

See Applying Updates To A Target Environment

• PeopleSoft Update Manager PIA Application

The Update Manager Dashboard provides a central location for all update tasks including:

• PUM Analytics

• Defining Change Packages

Wizards are used to search for updates and create custom change package definitions.

• Integrating with CFO Tool

• Change Package Utilities

• Maintaining Test Repository

See Update Manager Dashboard Overview

• Change Packager

Creates the change package in Change Assistant based on the change package definition created in
PUM.
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This diagram illustrates the Software Update process steps for the initial pass.

Steps Used in Software Update Process

This table lists the steps used to search for and apply updates to your development or target database.

Step Description

1 Download and install the latest PeopleSoft Update Image from MOS.

2 Configure your windows client to access the PeopleSoft Update Image (PI) database.

3 ( Optional )Install and configure EMF on the target environment.
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Step Description

4 Install Change Assistant on the windows client.

5 (Optional) Start EMF Agent.

6 Start Change Assistant and configure for Update Manager. This includes defining the PUM Source.

Note: Update Manager action.

7 In Change Assistant, Select Tools, Upload Target Database Information to PUM Source.

8 In Change Assistant, Select Tools, Define Change Package to create a change package. From this
option, you can either:

• Sign on to the PeopleSoft Update Image and use PUM PIA application to search for desired
updates, review potential update impacts and changes, and generate your update change package
definition.

• Create a change package in Change Assistant based on available search criteria.

9 In Change Assistant, Select Tools, Create Change Package to create the change package based on the
change package definition defined in step 8.

10 In Change Assistant, Select Tools, Apply Change Packages to create the change package and apply it
to your target database.

Use the Initial Pass option to identify your customizations and adjust the project accordingly. Reapply
any customizations as necessary.

11 As part of the initial pass process, Change Assistant will create a new change package with all of your
customizations that can be applied to your other environments, using the Subsequent Pass or Move to
Production Pass option.

Non-PUM Enabled PeopleSoft Systems
This software update process is only used for PeopleSoft systems that are not PeopleSoft Update Manager
enabled. For PUM enabled systems refer to the previous section.

This software update process refers to applying change packages, bundles, and maintenance packs to
your non-PUM enabled PeopleSoft application. For example, PeopleSoft application development teams
periodically post change packages containing fixes to various application elements, such as pages and
PeopleCode programs, that you can download and apply to your PeopleSoft system. You use Change
Assistant to apply software updates.
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Step Description

1 Install and configure Change Assistant and the Environment
Management components.

2 Use My Oracle Support (MOS) to search for updates.

3 Download the Change Packages from MOS.

4 After you have downloaded the change packages, you can then
apply them in a batch or individually. If prerequisites or post-
requisites are required, they will be included in the list as well.

Software Upgrade Process

Selective adoption process for application maintenance was introduced with PeopleSoft 9.2. The last
application upgrade needed for your database will be to upgrade the application to 9.2. The software
upgrade process involves installing a new version of PeopleTools and a new version of an existing
PeopleSoft application.

This process uses Change Assistant, and the Environment Management Framework when running remote
upgrade processes. If you are upgrading to PeopleSoft 9.2 consult your specific application's install and
upgrade documentation.

Source and Target Databases

In various places within this PeopleBook, as well as any PeopleSoft documentation related to upgrades or
database compares, the terms source and target are used. Knowing the meanings of these terms helps you
to understand the context of a description or step.

During a PeopleSoft update or upgrade, in most cases, you copy application definitions (such as pages
and records) from a source database to a target database. The definitions of these terms are:

Term Definition

Source database The source database is the database from which the new
changes are coming.

Target database The target database is the database to which you are moving
the new changes.

Note: Depending on whether you are performing an upgrade or update, and the stage within the process
you are, these terms are relative and can refer to different databases.
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Change Assistant Databases and Terminology
The database definition will include:

• Database name

• Database type

• User Ids and passwords

• SQL query executable

• SQR Settings

• Products

Change Assistant will query the database for the products.

• Languages

Change Assistant will query the database for the languages.

• Paths to the current home directories.

• PS_HOME

• PS_APP_HOME

• PS_CUST_HOME

• For upgrades, the database will also include paths to the new home directories.

Paths to Home Directories

The order by which the PeopleTools runtime will pick up objects from the file system is as follows:

1. PS_CUST_HOME

2. PS_APP_HOME

3. PS_HOME

Change Assistant will loop through the paths in order of precedence until it finds the first instance of the
file object at which time it will execute the step.

Databases Used for Each Action

Action Databases and Paths Used

Apply Update Target database with path for current environment.
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Action Databases and Paths Used

Update Manager Target database with path for current environment.

Source database (PeopleSoft Update Image ) with path for
current environment.

Application Upgrade PeopleSoft Update Image with path for current environment.

Certified Upgrade Source Image with path for current
environment.

Copy of Production with path for current environment and
new PS homes.

Production database with path for current environment and
new PS homes.

Upgrade PeopleTools Target database with path for current environment and a path
for the new PeopleTools home.
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Management Components

Configuring the Environment Management Hub

Before you can run the Environment Management hub, you must ensure that it's properly configured.

The hub issues automatic recrawl and revalidate commands to the agents, and it can be configured to
accept automatic updates from Change Assistant. You configure the hub by setting appropriate parameters
in its configuration file, which is located in PIA_HOME\webserv\domain\applications\peoplesoft
\PSEMHUB\envmetadata\config\configuration.properties.

The following table describes the primary configuration.properties parameters for the hub:

Configuration Parameter Description Default Value

recrawlinterval The interval, in hours, between two
successive recrawl commands that have
been issued to a peer. The server issues
recrawl commands only to agents that
are connected to the hub and have no
pending messages in the queue. This
configuration parameter is ignored by the
agent.

24 hours

Note: A 0 value means that it will not
recrawl.
Recrawling includes a revalidating.

revalidateinterval The maximum time, in hours, between
two successive automatic revalidates that
the hub issues.

6 hours

Note: A 0 value means that it will not
revalidate.

Hub Security Considerations

Environment Management framework does not support HTTPS connections. The agent and hub
communicate using standard HTTP only.

For a single server configuration on WebLogic, PSEMHUB is a web application running within PIA. If
PIA is configured to be accessed using HTTPS, you need to configure a separate server instance for the
hub to enable the HTTP connections between agents and hub.

Configuring Hub Logging

The Environment Management hub logs are located in PIA_HOME\webserv\domain\applications
\peoplesoft\PSEMHUB\envmetadata\logs.
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Edit the .....\PSEMHUB\envmetadata\config\Logconfig.properties to configure logging for the hub. The
following two Logconfig.properties parameters, which determine the maximum size of each log file, and
the amount of log files rolled over, can be changed:

• log4j.appender.R.MaxFileSize=1024KB

• log4j.appender.R.MaxBackupIndex=1"

Running the Environment Management Hub

Before you run the Environment Management agent, you must first ensure that it's properly configured in
the hub's configuration.properties file.

Running the Hub on a Single Server
On a single server, the PSEMHUB starts within PIA, so use the command you use for your web server to
start PIA.

Running the Hub on Multiple Servers
Environment Management also supports multi-server installs. However, the Environment Management
hub does not support clustering. The Environment Management hub persists metadata into the file system
on the J2EE container. This is not replicated in a clustered environment. You experience erroneous
behavior when you attempt to run the Environment Management hub in a clustered environment.

The Environment Management hub deals with large binary files that Change Assistant sends to the agents
by using the hub as the intermediary dispatcher. This can create significant overhead to a production
system that is running on a multi-server clustered environment. Therefore, PSEMHUB must always run
on separate servers dedicated to the Environment Management hub requests.

Starting PSEMHUB on Multiple Servers on WebLogic

In a multiple server configuration, the PSEMHUB server listens on port 8081, by default.

Use the following steps to start the WebLogic hub:

1. Configure the Environment Management hub to run on a server that is different from the PeopleSoft
Internet Architecture servers.

2. Configure the reverse proxy to redirect any network traffic with a uniform resource identifier (URI) of
PSEMHUB to the server running the Environment Management hub.

On the machine from which the RPS application runs, access the HttpProxyServlet folder.

Select PSEMHUBHttpProxyServlet and click the Init Params tab. Replace WebLogicHost ,
WebLogicPort with the host and port from which your PSEMHUB server listens.

Note: Save your new configuration.

40  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 3 Configuring and Running Environment Management Components

Use the following commands in sequence to start the Environment Management hub in a multi-server
installation:

...\StartWebLogicAdmin.cmd (start the admin server)

...\StartManagedWebLogic.cmd RPS

...\StartManagedWebLogic.cmd PSEMHUB

Then use the following URL to access PSEMHUB: http://RPS host:RPS port/PSEMHUB/hub.

Note: For a single server install using a reverse proxy, this additional step needs to be performed
in order for the Environment Management hub to be able to process the PSEMHUB requests. You
need to edit: PIA_HOME\webserv\domain\applications\HttpProxyServlet\WEB-INF\web.xml. In the
PSEMHUBHttpProxyServlet section, change the default port from 8001 to 80.

The following is a sample configuration:

- <servlet>
  <servlet-name>PSEMHUBHttpProxyServlet</servlet-name>
  <servlet-class>weblogic.servlet.proxy.HttpProxyServlet</servlet-class>
- <init-param>
  <param-name>WebLogicHost</param-name>
  <param-value>localhost</param-value>
  </init-param>
- <init-param>
  <param-name>WebLogicPort</param-name>
  <param-value>80</param-value>
  </init-param>
 </servlet>

Stopping the PSEMHUB on Multiple Servers on WebLogic

In a multiple server environment, target the server which is dedicated to PSEMHUB then execute
PIA_HOME\webserv\domain\stopWebLogic.cmd PSEMHUB on Windows and PS_HOME/
webserv/domain/stopWebLogic.sh PSEMHUB on UNIX. This will only stop the server servicing
PSEMHUB requests. The other servers will still be up processing PIA requests.

The following is a sample XML configuration file for the WebLogic multi-server installation:

1.1 Sample XML configuration file for WebLogic Multiserver installation
<UriGroup Name="default_host_server1_st-lnx06_Cluster_URIs">
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid" Name="/*" />
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid"
Name="/PSIGW/*" />
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid"
Name="/PSINTERLINKS/*" />
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid"
Name="/PSOL/*" />
</UriGroup>
- <UriGroup Name="default_host_server1_pt-lnx03_Cluster_URIs">
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid" Name="/*" />
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid"
Name="/PSIGW/*" />
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid"
Name="/PSINTERLINKS/*" />
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid"
Name="/PSOL/*" />
</UriGroup>
- <UriGroup Name="default_host_server1_pt-ibm15_Cluster_URIs">
  <Uri AffinityCookie="JSESSIONID" AffinityURLIdentifier="jsessionid"
Name="/PSEMHUB/*" />
</UriGroup>
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Configuring an Environment Management Agent

Before you can run an environment management agent, you must ensure that it's properly configured. You
configure the agent by making appropriate entries in its configuration.properties file, which is located
under:

PS_HOME\PSEMAgent\envmetadata\config

The following table describes the configuration.properties parameters for the Environment Management
agent:

Configuration Parameter Description Default Value

hubURL The URL that contains the host name
and the port number of the machine on
which the Environment Management hub
is running (inside a J2EE container).

http://hostname:port/PSEMHUB/hub.

agentport A port that the agent uses for internal life
cycle management.

5283.

pinginterval The interval, in milliseconds, between
two successive attempts that the peer
makes to contact the hub. All peers that
access this configuration file have the
same ping interval.

10000 (in milliseconds for the heartbeat).

Note: The minimum required
pinginterval value is 1000.

windowsdrivestocrawl On Microsoft Windows, the set of local
drives or directory paths where PS_
HOME, PS_CFG_HOME, PS_APP_
HOME , and PIA_HOME are located.
 Separate the drive letters or directory
paths with spaces and a pipe symbol ( | ).

c: | d:

Note: Do not leave a trailing '/' or '\'
character at the end of the path.

unixdrivestocrawl On UNIX, the set of local drives or
directory paths where PS_HOME, PS
_CFG_HOME, and PIA_HOME are
located.

Note: The environment variable for
PS_APP_HOME should be set in
the application server/batch server
configuration.

$HOME

Note: Do not leave a trailing '/' or '\'
character at the end of the path.

chunksize Only applicable to large files, which may
be chunked when sent. The chunksize
represents the maximum size in bytes of
each chunk.

1048576 (1 MB) (used for large file
transfers).
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Configuring Agent Logging

The Environment Management agent's logs are located under PS_HOME\PSEMAgent\envmetadata\logs.

Edit PS_HOME\PSEMAgent\envmetadata\config\Logconfig.properties to configure the logging for the
agent.

The following parameters determine the maximum size of each log file and the amount of log files rolled
over. You can change the values of these parameters.

• log4j.appender.R.MaxFileSize=1024KB

• log4j.appender.R.MaxBackupIndex=1"

Configuring PS Agent Home

If the environment variable PS_AGENT_HOME is not set, EMF writes to PS_HOME, which restricts
the ability to run multiple agents specific to each application simultaneously on a shared PS_HOME.
This also poses a security concern as users under which the EM Agent runs must have write access to
PS_HOME.

Set the environment variable PS_AGENT_HOME to the directory where you want to write the
environment management metadata. When you launch PSEMAgent, the system will check for the
PS_AGENT_HOME location and copy the necessary files to the PS_AGENT_HOME directory and log
all activity in that directory.

Note: If you are using a Portable PS_HOME, you must set the PS_AGENT_HOME variable to your
Portable PS Home location.

Configuring Agents With a Secure PS_HOME

Change Assistant deploys the updates to the PS_HOME using the agents running on the managed servers.
Therefore, the agent running on a server should have write access to the PS_HOME and its subdirectories.

Note: While specifying the crawl path in configuration.properties, make sure that the decoupled
configuration home (PS_CFG_HOME) is also included.

Related Links
"Working with the Default PS_CFG_HOME" (System and Server Administration)
"Securing PS_HOME on UNIX" (System and Server Administration)
"Securing PS_HOME on Windows" (System and Server Administration)

Running an Environment Management Agent

This section discusses how to:

• Run an agent.
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• Start an agent automatically in Windows.

Running an Agent
Before you run an Environment Management agent, you must ensure that it's properly configured in the
agent's configuration.properties file.

Starting the Agent

At a command prompt, navigate to PS_HOME\PSEMAgent.

Use one of these scripts to start the Environment Management agent:

• On Microsoft Windows, run PS_HOME\PSEMAgent\StartAgent.bat.

Note: If you want the agent to start automatically when the machine starts, use the Microsoft
Windows service that's delivered as part of PeopleTools. Or, you can add the script to the startup
applications.

• On UNIX, run PS_HOME/PSEMAgent/StartAgent.sh.

Note: If you want the Environment Management agent to start automatically on UNIX when the
machine starts, add StartAgent.sh to the login/boot scripts.

The first time an agent starts, it crawls the machine to locate PeopleSoft elements on that machine.
The results of searching the hard disk are saved in the PS_AGENT_HOME\envmetadata\data\search-
results.xml file.

Note: When starting an agent manually from the command prompt or from a script, the command prompt
will continue to stay open, and it is normal to see the output of the periodic heartbeat events ("sending
pulse") in the command prompt as the agent communicates with the hub. By default these "pulses" are
every 10 seconds, except when environment information is being uploaded to the hub. You can configure
the agent to run in the background using the provided Windows service, and on UNIX by using the
nohup command.

See Starting an Agent in the Background on UNIX.

See Starting an Agent With PSEMAgent Windows Service.

Note: Only one Environment Management agent can be started per machine. If an agent is already
started, you may receive error messages indicating that the agent cannot be started because there is
already one running on the machine.

Starting the Agent on a Secure PS_HOME

On Microsoft Windows:

1. Create a new shortcut from the desktop (right-click, New, Shortcut).

2. In the Type the location of the item enter:

<PS_HOME>\PSEMAgent\StartAgent.bat -u :<domainname>\<username>
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For example:

c:\ptinstalls\pt851\PSEMAgent\StartAgent.bat -u :example.com\user

Where the user specified has write access to PS_HOME.

Note: When you run <PS_HOME>\PSEMAgent\StartAgent.bat -u :<domainname>\<username>, the
%TEMP% directory is used. Both the user that runs the command and the "runas" user need write/
execute access to the %TEMP% directory.

3. Click Next, and enter a name for the shortcut.

4. Use this shortcut to start the agent.

On UNIX:

1. Log in as the user who has write access to the PS_HOME.

2. PS_HOME/PSEMAgent/StartAgent.sh.

See "Securing PS_HOME on UNIX" (System and Server Administration).

Stopping the Agent

Use one of these scripts to stop the Environment Management agent:

• On Microsoft Windows, run PS_HOME\PSEMAgent\StopAgent.bat.

• On UNIX, run PS_HOME/PSEMAgent/StopAgent.sh.

Recrawl

If you install new software components, the running Environment Management agent doesn't
automatically detect them. This is because, to improve performance, the agent doesn't crawl every time it
starts up. Instead it crawls only if the search-results.xml file does not exist.

You can force a recrawl and make the new components manageable by reissuing the StartAgent command
with the recrawl option:

1. Open a new command line window.

2. Change directories to PS_HOME\PSEMAgent.

3. Issue the following command:

StartAgent recrawl

This forces a recrawl and creates a new search-results.xml file. If an agent is already running, it
publishes the results to the hub.

If the running Environment Management agent is connected to the hub constantly, the recrawl interval
occurs every 24 hours by default. If the agent has not been connected to the hub for a few days, the hub
requests the agent to recrawl when the agent contacts the hub the next time.

Note: Recrawling includes revalidating.
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Note: The recrawl process assumes the Environment Management agent is running. If it is not running,
you may see error messages in the output. It is recommended that before running a recrawl, you make
sure the agent is running.

Revalidate

If the Environment Management agent does not recognize any of the installed components, the search-
results.xml file may not exist or may contain only an entry for Host. The problem may be that the agent
needs to have permission to read directories as well as execute programs. Grant these permission for the
agent. Also check whether the agent has permission to create a file on the local file system. Finally, check
whether the disk is full. The agent might have no disk space to create a search-results.xml file.

If the hub is not running, you may receive the following error messages in the agent log or console:

• Broken connection - attempting to reconnect.

• RemoteException while connecting to server - retrying attempt 1.

• RemoteException while connecting to server - retrying attempt 2.

• RemoteException while connecting to server - retrying attempt 3.

Once the Environment Management hub is back up, the agent will successfully connect. There's no
need to stop and restart the agent.

Note: If you are performing a recrawl, you don't need to separately revalidate.

Command-Line Arguments for the Agent

You can run these command-line arguments with the startAgent.bat (or startAgent.sh) script.

Argument Description Sample Output

version Returns the version of the agent. Version:8.45 Build Number: 109

shutdown Shuts down a previous instance of the
agent if it is running.

If the agent does not exist:

Shutting down Agent....
Unable to detect a
running agent...
Instance does not exist

If the agent exists:

Shutting down Agent....
Shut down normally

url Prints the URL of the hub with which the
agent is configured to communicate.

http://192.0.2.1:80/PSEMHUB/hub
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Argument Description Sample Output

validate Validates the current set of managed
components that have been discovered
from the last crawling by the agent.

Not applicable (NA)

recrawl Recrawls the hard disk to detect new
configurations. Recrawls the detected
database environments to update
database information. The current
search-results.xml file is backed up.

Note: Recrawling includes revalidating.

NA

isrunning Returns true if an agent is already
running and false if an agent is not
already running.

NA

remove Removes the peer and all its registered
components from the hub.

Removal Completed- PeerID 2 has been
removed.

Removal Failed- PeerID 2 could not be
removed from the hub.

Starting an Agent in the Background on UNIX
Use the UNIX nohup command with the StartAgent.sh script to start an agent automatically and run
in the background. This enables you to avoid having a command prompt open at all times showing the
constant heartbeat of the agent. You can specify an output file to store heartbeat information.

For example,

nohup ./StartAgent.sh > agent_output.log &

Starting an Agent With PSEMAgent Windows Service
You can set an Environment Management agent to start automatically when your Environment
Management machine boots and run in the background. This enables you to avoid having a command
prompt open at all times showing the constant heartbeat of the agent.

For this option, use the PSEMAgent Windows service that's delivered as part of PeopleTools.

Installing the PSEMAgent Service

You install the PSEMAgent service from a command prompt. Copies of the install program are located in
two places:

PS_HOME\bin\client\winx86
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PS_HOME\bin\server\winx86

To install the PSEMAgent service:

1. At a command prompt, change to either location of the install program.

2. Enter the following command:

PSEMAgentService /install PS_HOME\PSEMAgent

Where PS_HOME is the PeopleTools installed location.

The PSEMAgent service is now installed, but not started. It's configured by default to start
automatically when the system boots, and to log on using the local system account. You can start it
manually, or wait for the next reboot.

Note: The PSEMAgent service is configured to start as an automatic service, by default. However,
the Hub must be running prior to the PSEMAgent service attempting to start, or the PSEMAgent
service will not start successfully. It is recommended to set the PSEMAgent service to manual start
in the Windows Services interface. Then, to start the PSEMAgent service, start it manually from the
Services interface.

Starting the PSEMAgent Service

You can start the PSEMAgent service from a command prompt, or from the Windows Services control
panel. The name of the service follows this convention: PeopleSoft Environment Management Agent-
<release>.

• To start the PSEMAgent service from a command prompt, use the NET START command. For
example:

NET START "PeopleSoft Environment Management Agent-8.50"

• To start the PSEMAgent service from the Windows Services control panel:

1. Open the Windows Control Panel, then double-click Administrative Tools, then Services.

2. In the Services control panel, right-click the PeopleSoft Environment Management Agent entry
and select Start.

Stopping the PSEMAgent Service

You can stop the PSEMAgent service from a command prompt, or from the Windows Services control
panel.

• To stop the PSEMAgent service from a command prompt, use the NET STOP command. For
example:

NET STOP "PeopleSoft Environment Management Agent-8.50"

• To stop the PSEMAgent service from the Windows Services control panel:

1. Open the Windows control panel, then double-click Administrative Tools, then Services.
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2. In the Services control panel, right-click the PeopleSoft Environment Management Agent entry
and select Stop.

Uninstalling the PSEMAgent Service

You uninstall the PSEMAgent service from a command prompt.

To uninstall the PSEMAgent service:

1. At a command prompt, change to either location of the uninstall program.

Copies of the uninstall program are located in two places:

PS_HOME\bin\client\winx86

PS_HOME\bin\server\winx86

2. Enter the following command:

PSEMAgentService /uninstall

PSEMAgentService determines if the service is currently started, and automatically stops it before
completing the uninstall operation. You'll see messages reporting on the status of the operation.

Note: If the service is currently stopped, you'll see an error message indicating that it can't be stopped.
Regardless of this, the uninstall operation completes normally.

Running the Viewer

To view data from the Environment Management hub:

1. Run a Java program to connect to the hub and retrieve the information in XML format.

Run the appropriate script for your environment in from PS_HOME\PSEMViewer. You will be
prompted for the web server's listening port.

• UNIX: ./GetEnvInfo.sh

• Windows: GetEnvInfo.bat

Note: For security reasons, the Java program connects only to the local host.

2. Open PS_HOME\PSEMViewer\envmetadata\data\viewer.html to view the information in the
generated XML file.
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Configuring and Starting an Environment Management Agent on
z/OS

To run an agent on z/OS, you must have installed JRE delivered with PeopleTools on the z/OS machine.

To configure and start the agent on z/OS:

1. Edit the configuration.properties file (PS_HOME/PSEMAgent/envmetadata/config).

2. Edit hubURL and define the hub machine name and hub port.

3. Edit unixdrivestocrawl and set it to the set of directories that need to be crawled.

4. Edit StartAgent.sh.

On the first line, replace PS_HOME with your PS_HOME location.

Edit the last line to point to your JRE location.

5. Edit StopAgent.sh.

On the first line, replace PS_HOME with your PS_HOME location.

Edit the last line to point to your JRE location.

The default charset on z/OS is EBCDIC. If you wish to view the content of PS_HOME/PSEMAgent/
envmetadata/data/search-results.xml, you need to run the following commands:

cd PS_HOME/PSEMAgent/envmetatda/data
. PS_HOME/psconfig.sh
PS_HOME/bin/psuniconv utf-8 search-results.xml ccsid1047 result.txt

Note: To change the newline characters, use one of transformations - NewLine LF, NewLine CR, or
NewLine CRLF at the end of the command. This utility is available to use in the bin directory.

This comment is also true for PS_HOME/PSEMAgent/envmetadata/data/matchers.xml.

You can find a viewable version of the results in result.txt. You can also FTP (binary) these files to a
different machine running a different operating system and view them in any editor.
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Configuring Change Assistant

Installing Change Assistant

Change Assistant runs on supported Microsoft Windows workstations and limited use on Linux.

Complete installation instructions for Change Assistant appear in your PeopleSoft 9.2 Application
Installation guide.

See PeopleSoft 9.2 Application Installation for your database platform: Installing PeopleSoft Change
Assistant

For hardware and software requirements, consult My Oracle Support, Certifications.

Microsoft Windows

Change Assistant can be installed from:

• PeopleSoft Update Image DPK

See Installing Change Assistant from PeopleSoft Update Image DPK

• PeopleTools Client DPK

See Installing Change Assistant from PeopleTools Client DPK

• PeopleTools Client DPKs in Update Manager Mode

See Installing Change Assistant for PUM

• Setup.bat

See Installing Change Assistant Using Setup.bat

Note: A new version of Change Assistant is delivered with each PeopleTools patch.

PeopleSoft Change Assistant installation includes the following features:

• You can install multiple instances of PeopleSoft Change Assistant (PeopleTools 8.55 and above) on
one physical machine.

Note: Multiple Instances of Change Assistant can run in parallel starting with PeopleTools 8.56,
however you can not run multiple instances against the same target database. See Running Multiple
Instances of Change Assistant

• You must install each PeopleSoft Change Assistant instance in a separate installation location.

• You can remove or upgrade each PeopleSoft Change Assistant instance separately.
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• When you remove an installation instance, you have the option to save the existing configuration
information in a group of files gathered in a zip archive. You can configure Change Assistant at a later
time by importing the zip file.

Linux

When you install the PeopleTools DPK for Linux, you can select to install Change Assistant.

Linux only supports a command line version of Change Assistant for Update Manager mode.

Linux is not supported for target databases that are below PeopleTools 8.57.17.

Installing Change Assistant from PeopleSoft Update Image DPK
Starting with PeopleTools 8.59, when you deploy the PeopleSoft Update Image from the DPK, Change
Assistant will be installed and configured for the PUM Source. The installation will create folders for
staging, output, and download directories. The Image and REST credentials are also updated in the PUM
database.

Note: This Change Assistant installation is for the exclusive use of PUM Automated Updates and should
not be used for any other purpose.

See PeopleSoft Deployment Packages for Update Images Installation PeopleTools  for the current
PeopleSoft PeopleTools release.

See Setting Credentials for Automation.

Installing Change Assistant from PeopleTools Client DPK
PeopleTools Client deployment is documented in PeopleSoft PeopleTools 8.5x Deployment Packages
Installation, Task 2-5: Deploying the PeopleTools Client DPK. The directions here only refer to the
Change Assistant portion.

When you deploy PeopleTools Client in standalone mode using (SetupPTClient.bat -t), you will
be prompted whether or not to install Change Assistant.

Do you want to install Change Assistant? [Y/N]:

If you answer y (yes), specify the installation directory, or accept the default, C:\ProgramFiles
\PeopleSoftChange Assistant:

Please specify the directory to install Change Assistant [C:\Program Files\PeopleSo⇒

ft\Change Assistant]:

If you enter a directory where a previous version of Change Assistant is installed, it will upgrade that
version to the new PeopleTools release/patch. If you enter a new directory, a new instance of Change
Assistant will be installed.
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Installing Change Assistant for PUM
Windows Client Installation is documented in PeopleSoft Deployment Packages for Update Images
Installation (PeopleSoft PeopleTools 8.5x), Task 2-6: Deploying the PeopleTools Client DPKs in Update
Manager Mode.

When you deploy PeopleTools Client in Update Manager Mode from the tools_client directory using
(SetupPTClient.bat), Change Assistant is always installed for PeopleTools release of the PUM
Source.

Installing Change Assistant Using Setup.bat
Setup.bat is located in the PS_HOME\setup\PsCA directory.

You can use Setup.bat to create a new instance of Change Assistant, update an existing instance or delete
an existing instance.

Installing a New Instance of Change Assistant using Setup.bat

To install a new instance of Change Assistant:

1. From the PS_HOME\setup\PsCA directory, run Setup.bat.

Note: If you have existing instances of Change Assistant and select to install a new instance the same
wizard is used.

2. Enter 1 on the PeopleSoft Change Assistant menu.

3. Accept the default Destination Folder or enter the path for Change Assistant. The default destination
folder is C:\PS\Change Assistant.

--------------------------------
PeopleSoft Change Assistant
--------------------------------
  1) New Installation
  2) Maintain or Update
  q) Quit
Command to execute (1-2, q):1

PeopleSoft will install Change Assistant to the following directory .
Destination Folder [C:\PS\Change Assistant] :

If the installer detects an existing installation in the destination folder that you specified, you see a
message telling you to uninstall the instance.

Change Assistant already installed in this path. Please uninstall it before ne⇒

w installation Exiting installer after deteciting old installation

4. When the copy is complete, a shortcut to the new Change Assistant will appear on your desktop.

Uninstalling PeopleSoft Change Assistant Instances in the Current Release

To uninstall an instance of Change Assistant:

1. From the PS_HOME\setup\PsCA directory, run Setup.bat.
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2. Enter 2 on the PeopleSoft Change Assistant menu.

--------------------------------
PeopleSoft Change Assistant
--------------------------------
  1) New Installation
  2) Maintain or Update
  q) Quit
Command to execute (1-2, q):2

3. Select the installed instance you want to uninstall.

Please select the instance of Change Assistant :
1) Change Assistant  2 PT856.07 C:\Program Files\PeopleSoft\Change Assistant
2) Change Assistant  3 PT857.01 C:\CA

q)Quit
Command to execute (1-2, q):1

4. Enter 2 to uninstall the selected instance.

Please select the activity :
1) Upgrade Selected Instance
2) Uninstall Selected Instance
q)Quit
Command to execute (1-3, q):2

5. When you uninstall an instance of Change Assistant, you have the option of retaining the existing
configuration. If you select 2, you will see a message that gives the name of the backupconfiguration
file, such as changeassistantcfgbak.zip, and the installation location where you can find it, for
example C:\Program Files\PeopleSoft\Change Assistant.

Please select the activity :
1)Without Retaining existing configuration
2)Retaining existing configuration
q)Quit
Command to execute (1-3, q):1

Updating Existing Instance of Change Assistant

To update an existing instance of Change Assistant:

1. From the PS_HOME\setup\PsCA directory, run Setup.bat.

2. Enter 2 on the PeopleSoft Change Assistant menu.

--------------------------------
PeopleSoft Change Assistant
--------------------------------
  1) New Installation
  2) Maintain or Update
  q) Quit
Command to execute (1-2, q):2

3. Select the installed instance you want to update.

Please select the instance of Change Assistant :
1) Change Assistant  1 PT856.07 C:\ca856
2) Change Assistant  4 PT857.01 C:\PS\Change Assistant

q)Quit
Command to execute (1-2, q):1
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4. Select to upgrade the selected instance.

Please select the activity :
1) Upgrade Selected Instance
2) Uninstall Selected Instance
q)Quit
Command to execute (1-3, q):1

5. Select if you want to retain the existing configuration.

Please select the activity :
1)Without Retaining existing configuration
2)Retaining existing configuration
q)Quit
Command to execute (1-3, q):2

If you retain the existing configuration, the configuration will be automatically imported when you
open the Change Assistant instance.

Define Environment Identification
In the browser, navigate to the PeopleTools Options page (PeopleTools, Utilities, Administration,
PeopleTools Options) and make sure that the Environment Long Name and Environment Short Name
are specified correctly.

The Environment Management Framework and Change Assistant use these values, along with the GUID,
to identify an environment and associate environment information with a particular named environment.
Likewise, it enables you to search for updates for a specific environment.

Related Links
Cloned Databases Not Being Unique

Opening Change Assistant the First Time

The first time you open Change Assistant after installing it, you will be presented with the Welcome
menu. You can select not to display this page again.

Click Next to view the Change Assistant Options.
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This example illustrates the fields and controls on the Change Assistant Wizard – Select Action page. You
can find definitions for the fields and controls later on this page.

Depending on the action you select, the Change Assistant Wizard will guide you through the steps. Each
of these actions has a topic that will provide details.

Field or Control Description

Apply Updates Any systems that are not PUM enabled, will use the Apply
Updates option to apply updates downloaded from My Oracle
Support.

Apply Updates can be used with any non-PUM change
packages.

See Applying Updates To A Target Environment

This option is also used for Required For Install fixes in PUM
releases.

Update Manager Update Manager is used to create and apply PUM Change
Packages and PUM PeopleSoft Release Patches (PRP).
 PeopleSoft Update Images (PI) are fully functioning instances
of the PeopleSoft environment that contain the updates for a
PeopleSoft application. The PeopleSoft Update Manager PIA
application is used in the PeopleSoft Update Image to search
for updates, review potential change impact, and create a
custom change package definition that is based on the updates
you selected for your environment.

Update Manager action is also used to apply PeopleTools
patches and upgrade PeopleTools release.

Note: Update Manager is only available for PUM enabled
applications patching.

See Update Manager Action Overview
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Field or Control Description

Create or Modify Templates Change Assistant templates are composites of all the possible
steps that apply to an update or upgrade. The templates are
delivered as part of the change package. Once you select
a change package, the template is loaded into the Change
Assistant internal storage. You can edit the template or add
additional chapters, tasks and steps, if needed.

Note: In order to modify a template, you need to import
the template from the change package. After making any
modifications, you need to export the template into the same
change package as the import in order for the template to be
usable in a job.

Merge Select Object Types Select this option to review the merge session details that were
created as part of the change package apply.

Specifying Change Assistant Options
When you first start Change Assistant, you will need to define options necessary for the selected action.
Only the options related to the Change Assistant Action you selected will be displayed. Many of the
options apply to all actions. If you are using the Change Assistant Wizard, after you select an action and
click Next, the General Options page will be displayed.

Option Description

General The General Options define the Change Assistant PS Homes
and directory paths used with associated action.

Depending on the action selected, only the paths relating to
that action are displayed.

PUM Source Options The PUM Source is only used with Update Manager, to define
the PeopleSoft Update Image that will be used for applying
application and PeopleTools updates.

For all other actions, PUM Source Options are skipped.

EM Hub Options For Update Manager, the Environment Management Hub is
used to deploy files. If you are deploying files manually, leave
the Define EM Hub check box deselected.

EM Hub is only required for traditional updates (Apply
Update action).

Additional Options Additional options include email notifications and proxy
information. These options are optional and available with all
actions.
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Note: Once the environment has been configured, you can use Tools > Options to make any changes to
the environment options.

Defining Databases

Each source or target database that is used with Change Assistant needs to be defined. When you create
the database definition, the system will query the database for details including:

• If the database is Unicode

• Products

• Product Line

• Industry

• Languages

• Base Language

• PeopleTools Version

To create a new database:

1. Access the Database Wizard using one of the following methods:

• Directly from the Change Assistant menu, select File, New Database.

• From another Wizard or PeopleTools Options page that includes the Create button for the
database. Click Create.

2. On the Define Database page, enter the information for the database you are defining. Depending on
the action you selected and the database type, complete the fields necessary.

3. Click Next.

Change Assistant will query the database and gather additional database information.

Note: Change Assistant will verify the connection to the database, including User ID/password,
Access ID/password, and Connect ID/password. You will need to correct any errors before continuing
to define the database.

4. The information is then displayed on the Additional Database Details page.

5. Click Next and the Confirm Settings page is displayed.

6. Click Finish.
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This example illustrates the fields and controls on the Database Wizard - Define Database page. You can
find definitions for the fields and controls later on this page.

The Database Configuration Wizard provides a separate configuration page for each database type,
containing these settings:

Field or Control Description

Database Type Select a database platform from the list. Based on signon
requirements for the database platform that you select in this
field, other fields will be disabled or become available for
entry.

Database Name Enter a name of up to 8 characters for the database.

If EMF is configured and running, you can select a database
from Hub.
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Field or Control Description

Database Server Name Only applies to Informix, Microsoft SQL Server and Sybase.

If applicable, enter a name of up to 256 characters for the
database server name.

Owner ID (Used for DB2 z/OS only). Enter the owner ID used for the
tables.

User ID and Password Enter the PeopleSoft user ID and password for the database
that will be used to perform the upgrade. Examples of user IDs
are VP1 and PS.

Access ID and Password The access ID has full access to all objects in the database.

Your access ID is not a PeopleSoft user ID, such as VP1 or PS.
Examples of access IDs are sa or sysadm.

Note: For Microsoft SQL Server the access ID must also have
System Administrator privileges.

Note: The IDs and passwords are case-sensitive.

Note: The access ID is often the database owner. It is not
normally the same value as the connect ID, which has limited
access to the database.

See "Access IDs" (Security Administration).

Connect ID and Password Enter the connect ID and password for the target database. The
default connect ID is people.

Set DB Owner Credentials If this check box is select, then the DB Owner ID and DB
Owner Password Fields are required fields.

The DB Owner is only used with the step type SQLScript-
DBO. When the SQLScript-DBO step executes, the Set DB
Owner Credentials option is checked prior to issuing the
commandline. If the attribute is disabled, the job will exit
with an error stating the credentials are not set, rather than
attempting to execute the command and failing.

DB Owner ID and Password Enter the Database Owner ID and password for the target
database.
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Field or Control Description

SQL Client Tool Select the correct executable for the database platform. Valid
SQL query executables for each platform are:

• DB2: db2cmd.exe

• Microsoft SQL Server: sqlcmd.exe

• Oracle: sqlplus.exe

Note: Change Assistant uses the command line version of the .
exe, not the GUI version. For example, sqlplus.exe is used for
an Oracle database, rather than sqlplusw.exe.

Important! Oracle Database Customers: For systems running
on the Oracle database, by default, Change Assistant copies
the generated SQL script files to the location specified as the
TEMP User variable on the Environment Variables dialog box.
 So, on Oracle, the generated SQL script files will actually
exist in two locations: the specified Change Assistant output
directory, and the TEMP directory. This behavior is in place
because some versions of Oracle SQL Plus do not support path
names longer than 79 characters. It is recommended that you
ensure that the value specified for the TEMP User variable
is set to a path short enough so that the string comprising the
path and generated SQL file will not exceed 79 characters.

Current HomesPS Home Enter the location of your current PS_HOME.

Note: Oracle recommends using a mapped drive.

Current Homes PS App Home Enter the location of your current PS_APP_HOME.

Note: Oracle recommends using a mapped drive. Do not enter
your PS_HOME directory.

Current Homes PS Cust Home Enter the location of your current PS_CUST_HOME.

Note: Oracle recommends using a mapped drive. Do not enter
your PS_HOME directory.

SQR SettingsSQR Executables (SQRBIN) The SQRBIN value is read only and derived from the PS
Home and platform setting.

SQR Settings SQR Flags (PSSQRFLAGS) By default , the -ZIF parameter is to set the full path and name
of the SQR initialization file, SQR.INI. Make any necessary
changes or add additional SQL parameters if needed.

Copyright © 1988, 2022, Oracle and/or its affiliates. 61



Configuring Change Assistant Chapter 4

Field or Control Description

SQR Setting PSSQR Path This field is read-only and will contain the path that is used in
Change Assistant:

1. StagingDirectory\SQR

2. PS_CUST_HOME\SQR

3. PS_APP_HOME\SQR

4. PS_HOME\SQR

Each path is separated by a “;” (semi-colon).

The static display is: “<StagingDir>\SQR;<Cust_Home>
\SQR;<App_Home>\SQR;PS_Home>\

Configure New Homes for Upgrade Select this option to define new PeopleSoft Homes for a
PeopleTools upgrade.

See Using Change Assistant to Upgrade PeopleTools,

Enable Process Scheduler Select this option to define up to two Process Scheduler
servers to run ProcessScheduler steps during the upgrade job
run.

This option only applies in an application upgrade.

See Specifying Database Process Scheduler Settings

Enable PeopleSoft Test Framework Select this option if the upgrade contains PTF steps or if you
want to incorporate PTF scripts into your template.

See Specifying PeopleSoft Test Framework Settings

Configuring New Homes for Upgrade
If you have selected the Configure New Homes for Upgrade check box for an applicable database
definition, you must enter the required information for the new homes.
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This example illustrates the fields and controls on the Database Wizard – New Homes page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Retrieve Database Details using New PS Home When performing a PeopleTools upgrade, initially you will
connect to your target database using your current PS Home.
 Once the target database is updated to the new release, the
rest of the steps will require you to connect using the New PS
Home.

Select this checkbox if you need to edit the database after the
database has been upgraded to the new PeopleTools release.

PS Home Enter the location of new PS_HOME.

Note: Oracle recommends using a mapped drive.

PS App Home Enter the location of your new PS_APP_HOME.

Note: Oracle recommends using a mapped drive. Do not enter
your PS_HOME directory.

PS Cust Home Enter the location of your new PS_CUST_HOME.

Note: Oracle recommends using a mapped drive. Do not enter
your PS_HOME directory.

SQR Executables (SQRBIN) The SQRBIN value is read only and derived from the PS
Home and platform setting.

SQR Flags (PSSQRFLAGS) By default , the -ZIF parameter is to set the full path and name
of the SQR initialization file, SQR.INI. Make any necessary
changes or add additional SQL parameters if needed.
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Field or Control Description

PSSQR Path This field is read-only and will contain the path that is used in
Change Assistant:

1. StagingDirectory\SQR

2. PS_CUST_HOME\SQR

3. PS_APP_HOME\SQR

4. PS_HOME\SQR

Each path is separated by a “;” (semi-colon).

The static display is: “<StagingDir>\SQR;<Cust_Home>
\SQR;<App_Home>\SQR;PS_Home>\.

Specifying Database Process Scheduler Settings
If you have selected the Enable Process Scheduler check box for an applicable database definition, you
must enter the required information for the host machine and the Process Scheduler server definitions
associated with that database that will be running the ProcessScheduler steps.

This example illustrates the fields and controls on the Database Wizard – Process Scheduler Settings
page. You can find definitions for the fields and controls later on this page.

Field or Control Description

Machine name or IP Enter the host name or the IP address of the application server
where the appropriate Process Scheduler server domain is
running (PSPRCSRV.EXE and so on).

JSL Port Enter the domain's JSL port (listener port).
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Field or Control Description

Domain Connection Password Enter the domain connection password for the application
server.

Server Name Enter the name of the Process Scheduler server definition,
 such as PSUNIX.

Method of retrieving Process Scheduler logs You can download and view the Process Scheduler logs from
within Change Assistant so that you don't need to monitor
the processes separately using Process Scheduler monitoring
and logging. Similar to other Change Assistant log files,
 the downloaded Process Scheduler log files are saved to the
Change Assistant output directory.

• None: Disables the ability to view Process Scheduler log
information from within Change Assistant.

• File Copy: Select if Process Scheduler is running on a
Windows or Linux server.

Users needs to map a Windows or Samba share path as a
network drive.

To copy log files when using Process Scheduler on Linux
server:

1. Install Samba on Linux.

2. Set up Samba share for Log/output directory.

3. Map the shared folder on your Windows machine as a
network drive.

Note: If the network drive is protected, Windows prompts
for user ID and password before mapping.

4. Add this mapped folder path as Log/output Directory
while adding database to Change Assistant in Process
Scheduler settings.

Otherwise, you can directly download log files from Process
Monitor on the PIA page.

You can use NFS share instead of Samba. This will require an
NFS client software to be installed on Windows to access a
native NFS share.

If running Change Assistant on Linux, user must mount the
NFS share to a local path and configure the same in Change
Assistant database definition.

Note: If you have configured multiple Process Scheduler
servers within your upgrade environment, and they each
run processes within the job, as needed, note that the log
information will reside in two locations, with each location
containing the log information associated with the processes
run on that server.
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Field or Control Description

Log/output Directory Applies to File Copy. Enter the path to where the Process
Scheduler logs are located on the server. This is the (mapped)
path on the Change Assistant workstation.

Specifying PeopleSoft Test Framework Settings
If you selected the Enable PeopleSoft Test Framework option, you will need to supply PTF connection
settings.

Field or Control Description

Server:Port Enter the server name and port for the environment. Contact
your Integration Broker administrator or system administrator
for the correct values.

The format for the Server:Port field is:

<machine_name>:<https_port>

For example:

rtdc79614.example.com:443

If the https port is the default 443 the port is optional.

You can also enter a complete https URL in this format:

https://<machine_name>:<https_port>/PSIG⇒

W/HttpListeningConnector

For example:

https://rtdc79614.example.com:443/PSIGW/⇒

HttpListeningConnector

Node ID This field is required if more than one database is connected to
the server. Enter the name of the PeopleSoft node with which
the integration gateway is to communicate.

Contact your Integration Broker administrator or system
administrator for the correct values.

Execution Options Specify the name of the Execution Options configuration to
use.

Path to PTF Client Specify the path to the PTF client executable.

The default location is C:\Program Files
\PeopleSoft\PeopleSoft Test Framework.
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Field or Control Description

Use Proxy Options Select this option to enter details for the proxy server. When
you select this option, the proxy information fields are
enabled.

Proxy Information Enter the following information for the proxy server:

• Server: Enter the server name.

• Port: Enter the server port.

• User: Enter the user ID for the proxy server.

If you use network authentication, use the DOMAIN
\USER format.

• Password: Enter the password.
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Working With Change Assistant

Understanding The Change Assistant Interface

Change Assistant enables you to run, view, and modify Change Assistant templates. You open Change
Assistant on a Windows workstation by selecting Start, Programs, PeopleSoft Change Assistant 8.5x.xx,
Change Assistant.

Change Assistant enables you to:

• View, modify, and create Change Assistant templates or jobs.

• Run PeopleSoft update and upgrade jobs.

Select and configure the action and task to perform. A Change Assistant job is created from the change
package selected.

Note: Before starting and running Change Assistant, application servers, Process Scheduler servers, and
web servers should be running. If you are planning to use EM Hub for file deploy or using the Apply
Updates (non-PUM) action, then ensure all agents running on the servers are running and sending pulses.

This example illustrates the fields and controls on the Change Assistant interface. You can find definitions
for the fields and controls later on this page.

When you have a Change Assistant template or job open, you use these areas in the project workspace:
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Interface Area Description

Template tree The template tree section displays distinct nodes for the
chapters, tasks, and steps within a template.

• Chapters are section dividers that group and display the
tasks.

• Tasks are section levels that contain one or more steps.

• Steps are the actual update actions that complete the
processing of your update job.

Note: Properties are assigned at the step level in the template,
 not the task or chapter level.

Properties box Depending on what is selected in the template tree, the
properties box displays the properties associated with that
node.

For the Create or Modify Templates action, the properties
box displays the properties assigned to the step when it was
defined.

For a job, the properties box displays information related
to the progress of a step, such as start time, end time, total
duration, and so on.

Documentation box Each template contains its own built-in documentation
to provide guidance for a chapter, task, or step. The
documentation exists in separate HTML files, but it appears in
this box for each selected node on the template tree.

Activity box The Activity box displays the processing and status messages
associated with a step, when a job is running in Change
Assistant. This is similar to the Output window in the
Application Designer workspace.

Working With Change Assistant Menu Options

This section describes the menu options available when using Change Assistant.

Note: Some menu options are enabled only during a specific Change Assistant action, which is
determined in the Change Assistant Actions dialog box.

File Menu

The File menu contains some generic Windows options, plus these specific Change Assistant options:
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Menu Option Description

New Template Creates a new Change Assistant template.

Open Template Opens a template from the Change Assistant storage (internal
database).

Save Template Saves the template into the Change Assistant storage (internal
database).

Save Template As Saves the new template with the name you specify.

New Job Creates a new Change Assistant job.

Open Job Opens a job from the Change Assistant storage (internal
database).

Save Job Saves the job into the Change Assistant storage (internal
database).

Save Job As Saves the job with the name you specify.

Close Closes the current template or job.

Import Template Imports an existing template into Change Assistant.

Note: Any modifications to the current template will not affect
the original template that you imported. If you want others to
obtain a copy of your modified template, you need to export it
out of Change Assistant.

Delete Template Removes the template from Change Assistant. When you
delete a template, you also delete all the jobs associated with
the template.

Note: Press and hold the CTRL key to select multiple
templates for deletion.

Export Template Exports a copy of the template out of Change Assistant so
others can use it.
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Menu Option Description

Export Job Exports a copy of the job out of Change Assistant so others
can use it.

Delete Job Removes a job associated with the current template.

New Database Launches the Database wizard for creating a new database.

Change Assistant uses these settings to locate PS_HOME
directories, connect to the Target database, and so on.

Open Database Opens a defined database.

Import Database Imports an existing database.

Delete Database Deletes an existing database.

Exit Exits Change Assistant.

Note: This option is disabled when a Change Assistant step is
running. To exit Change Assistant while a process is running,
 you must first kill the process (select Run, Kill). When you
relaunch Change Assistant you can resume at the point where
you killed the process.

Edit Menu

The Edit menu contains some generic Windows options, plus these specific Change Assistant options:

Menu Option Description

Insert Chapter Inserts a new chapter. A chapter serves as a section head for
multiple tasks.

Insert Task Inserts a new task within a chapter. A task serves as a section
head for one or more steps.

Insert Step Inserts a new step within a task.

Step Properties When a step is selected, launches the Step Properties dialog.
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Menu Option Description

Rename Renames an existing chapter, task, or step.

Run Runs the selected step.

Stop Stops the selected step.

Restart Restarts certain types of steps that you have stopped or have
failed. Restart is supported for these step types:

• Application Engine

• SQL

Application Engine programs can keep track of the state of
a program run, and when restarted, they can pick up where a
previous run stopped.

When restarting SQL steps, Change Assistant generates
a separate log file and numbers them incrementally, as in
logfile_2, logfile 3, and so on.

Complete Marks the selected step as complete. Often used when setting
a manual step to complete, indicating that the manual work is
done.

View Log Opens the current job processing log.

View Script Opens the script associated with the selected step.

Job Properties Enables you to set properties for the job.

Set Documentation Directory Specifies the directory into which your upgrade documentation
is saved. Change Assistant loads the documentation for
viewing when you open a template or job.

Edit Documentation Enables you to modify the documentation associated with the
selected chapter, task, or step.

Finalize Documentation Generates the HTML files.

View Menu

The View menu contains these specific Change Assistant options:
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Menu Option Description

Step Details Displays the step properties box in the Change Assistant
workspace.

Documentation Displays the documentation box in the Change Assistant
workspace.

Activity Displays the Activity box in the Change Assistant workspace.

Expand All Expands all chapters, tasks, and steps.

Collapse All Collapses all chapters, tasks, and steps.

Steps Not Yet Completed Filters steps to show steps not yet completed.

Steps Completed by System Filters to show steps completed by the system.

Deselect this option if you want to hide all the steps that have
been completed.

Steps Completed Manually Filters to show the steps that were manually completed.

Deselect this option if you want to hide all the steps that have
been manually completed.

Steps Filtered By Filter Query Filters to show the steps that were filtered using a query filter.

Deselect this option if you want to hide all the steps that have
been filtered by a filter query.

Steps Filtered at the Job Level Filters to show the steps that were filtered at the job level.

Deselect this option if you want to hide all the steps that have
been filtered at the job level.

Run Menu

The Run menu contains these specific Change Assistant options:

Menu Option Description

Run Begins the execution of a Change Assistant job.
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Menu Option Description

Cancel Stops the processing of a Change Assistant job after the
currently running process completes.

Kill Stops the processing of a Change Assistant job completely and
immediately, including the step that's currently running.

Tools Menu

The Tools menu contains these specific Change Assistant options:

Note: If the menu option does not apply to the action selected, it will be grayed out.

Menu Option Description

Upload Target Database Information to Image Enabled when action type is Update Manager.

Uploads the target database information to the PUM source.

Define Change Package Enabled when action type is Update Manager.

Allows user to define a new change package in either Update
Manager Dashboard or Change Assistant using standard
searches.

See Defining Change Package

Create Change Package Enabled when action type is Update Manager.

Opens Change Assistant Wizard to select your database
information and leads you through the process to create a
change package.

Apply Change Package Enabled when action type is Update Manager.

Opens Change Assistant Wizard to lead you through the
process to apply a change package.

See Applying Change Package

Apply Tools Delta Package Enabled when action type is Update Manager.

Opens Change Assistant Wizard to lead you through the
process to apply a delta change package.

See Creating and Applying Tools Delta Package
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Menu Option Description

Apply Translation Delta Package Enabled when action type is Update Manager.

Opens Change Assistant Wizard to lead you through the
process to apply a translation delta change package.

See Applying Translations Delta Package

Apply PeopleSoft Release Patchset Enabled when action type is Update Manager.

Opens Change Assistant Wizard to guide you through applying
PeopleSoft release patchset to the PeopleSoft Update Image.

See Applying Downloaded PeopleSoft Release Patchset to
PeopleSoft Image

Apply PeopleTools Patch Enabled when action type is Update Manager.

Open Change Assistant wizard to guide you through applying
a PeopleTools patch.

See Using Change Assistant to Apply PeopleTools Patch

Apply Required for Upgrade Package Enabled when action type is Update Manager.

See Defining an Upgrade Package

Upgrade PeopleTools Enabled when action type is Update Manager.

Open Change Assistant wizard to guide you through upgrading
your database for the new PeopleTools release.

See Using Change Assistant to Upgrade PeopleTools

Upgrade Application Enabled when action type is Update Manager.

Open Change Assistant wizard to guide you through upgrading
your application for the new application release.

See Upgrading Application

Validate Validates the Change Assistant settings for EM Hub to ensure
that the required elements are up and running, and that Change
Assistant can connect to them.
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Menu Option Description

Export/ Import Settings Allows you to export Change Assistant settings to a file and
import Change Assistant settings either from another Change
Assistant directory or from a backup configuration.

See Exporting and Importing Change Assistant Settings

Migrate PUM Data Enabled when action type is Update Manager.

Allows you to migrate user metadata (PUM customization
Information, test information and package definition
information from one PUM Image to a new PUM Image.

See Migrating PUM Data

Merge PeopleCode/SQL/XSLT Enabled when action type is View PUM Automated Merge
Sessions.

Allows you to delete the merge session data and the
corresponding merged objects.

For more details, refer to Retaining Object Merge Data and
Session

Scan Configuration Enabled when action type is Apply Updates.

Searches the Change Assistant workstation for tools and
utilities required to perform updates and upgrades. For
example, this process locates the local SQL tool, Data Mover,
 Application Designer, and so on.

Change Actions Opens Change Assistant Wizard Select Action page.

See Opening Change Assistant the First Time

Options Opens the Change Assistant Options dialog box, enabling you
to select Change Assistant configuration options.

Exporting and Importing Change Assistant Settings

Change Assistant settings can be exported and imported using one of the following processes:

• Exporting Configuration

1. Change Assistant Installer exports configuration when Retain existing configuration is selected
during the install.
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See Installing Change Assistant Using Setup.bat

2. User exports configuration manually in Change Assistant GUI.

See Exporting Change Assistant Setting in Change Assistant

3. User exports configurations using Change Assistant command line.

See Constructing Command Lines for Configuring Change Assistant.

• Importing Configuration

1. Change Assistant Installer imports configuration when an existing Change Assistant instance is
upgraded and Retain existing configuration is selected.

See Installing Change Assistant Using Setup.bat

2. User imports configuration using Change Assistant GUI through menu item.

See Importing Change Assistant Setting in Change Assistant

3. User imports configuration to Change Assistant using command line.

See PeopleTools Installation for your database platform: Installing PeopleSoft Change Assistant,
Installing PeopleSoft Change Assistant in Silent Mode

Change Assistant settings are exported to configuration backup files. A configuration backup is a zip file.
It consists of the following XML files:

• Configuration backup property file (cfgbak_prop.xml)

• Options file (settings.xml)

• Database definitions backup file (cfgbak_dblist)

Configuration Backup Property File

Configuration backup property file (cfgbak_prop.xml) contains the following content:

• ToolsVersionCA

The value is the Tools version of Change Assistant which is used to generated this backup file.

• Creator

The value is Installer or CA.

• ImportType

The value is Auto, Confirm, or Manual.

• OptionsIncluded

The value is true or false.
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• DBDefnNum

The value is the number of database definitions included in the export file.

• DB definition list

The database list will be used as a pre-check to determine if the database definition already exists in
Change Assistant when user imports the configuration.

Exporting Change Assistant Setting in Change Assistant
Use the Export/Import Change Assistant Setting option to export or import settings.

Navigation:

In Change Assistant, select Tools, Export/Import Change Assistant Settings

or

In Change Assistant, select Tools, Change Actions, Update Manager, Export/Import Change Assistant
Settings

This example illustrates the fields and controls on the Export&Import Settings Wizard – Export/Import
page to export settings.

Exporting Change Assistant Settings

To export Change Assistant Settings:
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1. In Change Assistant, select Tools, Export/Import Change Assistant Settings.

2. Select the Export radio button.

3. Enter the destination directory and file name.

4. Click Next.

5. On the Select Details page, select if you want to export the settings, as well as the databases.

This example illustrates the fields and controls on the Export&Import Settings Wizard – Select Details
page. You can find definitions for the fields and controls later on this page.

Field or Control Description

Export existing settings(option, layout, merge color and
font, etc)

Select this option to export CA settings.

Database Definitions Select this option to export database definitions. When this
option is selected, the databases defined in CA will be listed
and you can choose which databases to export.

6. Click Next. The status is displayed with the path to the configuration backup file.

This example illustrates the fields and controls on the Export&Import Settings Wizard – Export/
Import Status page. You can find definitions for the fields and controls later on this page.
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7. Click Finish.

Importing Change Assistant Setting in Change Assistant
Use the Export/Import Change Assistant Setting option to export or import settings.

Navigation:

In Change Assistant, select Tools, Export/Import Change Assistant Settings

or

In Change Assistant, select Tools, Change Actions, Update Manager, Export/Import Change Assistant
Settings

This example illustrates the fields and controls on the Export&Import Settings Wizard – Export/Import
page. You can find definitions for the fields and controls later on this page.

Importing Change Assistant Settings

You can import Change Assistant Settings from either another instance of Change Assistant or from a
configuration backup file.

To import Change Assistant settings:

1. In Change Assistant, select Tools, Export/Import Change Assistant Settings.

2. Select the Import radio button.
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3. Select the import option to use:

• Import from other Change Assistant Installation

Select the Change Assistant directory for the instance.

This example illustrates the fields and controls on the Import from other Change Assistant
Installation option.

• Import from configuration backup

Select the directory and file.
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This example illustrates the fields and controls on the Import from configuration backup option.

4. Click Next. A progress bar is displayed as Change Assistant retrieves the information.

• If Import from other Change Assistant installation is selected, Change Assistant will check the
Tools version of the selected Change Assistant instance. If the Tools version is available, it will
call the selected Change Assistant instance to export the configuration to a temporary folder. The
configuration is then retrieved from the temporary configuration backup file.

• If Import from configuration backup is checked, Change Assistant will retrieve the configuration
from the selected configuration backup file.

• If there is a problem with retrieving the configuration, a warning message is displayed.

5. Click Next. On the Select Details page, select if you want to import the options and which databases
you want to import.

• If settings have already been configured on this instance of Change Assistant, the Overwrite
existing settings check box will be cleared.
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• If this instance of Change Assistant has not been configured, the Overwrite existing settings check
box is selected.

• If a database definition already exists in Change Assistant, the check box for the database is
cleared.

• If a database definition does not exists in Change Assistant, the check box for the database is
selected.

• If a database definition is being used in a job, the check box for the database is cleared.

This example illustrates the fields and controls on the Export&Import Settings Wizard- Select Details
page where the new instance of Change Assistant does not contain any settings.

6. Click Next. Change Assistant will validate the settings and display the status.

This example illustrates the fields and controls on the Export&Import Settings Wizard- Status page
where the new instance of Change Assistant does not contain any settings.

7. Click Finish.
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If the validation showed any issues with the options settings, Change Assistant will launch the
Options window automatically when you click Finish, in order to make the corrections.

Migrating PUM Data

Change Assistant provides the ability to migrate metadata from the current PUM Source to the new PUM
Source. The following data types can be migrated:

• PUM Customization Information

See Using Customization Repository

• Test Information

See Using the Test Repository

• Package Definition Information

Package definition information refers to all of the metadata for Change Packages that were created on
the PUM Source. Only Created change packages are migrated.

Importing the Change Package definitions into the new PUM Source provides change package
history. The change package definitions can be viewed in the new PUM Source, but can not be used to
directly create a change package.

• Merge Repository and PUM Automated Updates

Exporting PUM Data from Current PUM Source

To export PUM data on the current PUM source:

1. From the Change Assistant menu, select Tools, Options, PUM Source.

Alternatively, select Tools, Change Actions, Update Manager, PUM Source .

2. Click Manage for Migrate Customer Data.

3. Select Export PUM(User) Metadata From Existing PUM Source.

4. Select the current PUM database.

5. Select the metadata to export.

See Using PUM Data Migration Page

6. Select the export directory in the Export To field.

The export file is a data mover DAT file. By default the name is customerdata.DAT.

7. Deselect Import PUM(User) Metadata to New PUM Source.

8. Click Import/Export.
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Change Assistant will check that the database is a PUM Source, if it is not, you will receive an error
message.

9. A message is displayed that the export was successful.

Importing PUM Data into New PUM Source

To import PUM Data from a DAT file into a new PUM Source:

1. Install a new Change Assistant instance for the new Update Image.

2. In the new Change Assistant instance, select Tools, Options, PUM Source.

3. Click Manage for Migrate Customer Data.

4. Deselect Export PUM(User) Metadata From Existing PUM Source.

5. Select Import PUM(User) Metadata to New PUM Source.

6. Either select the new PUM Source database or click the Create button to open the Define Database
Wizard and define the database.

7. Select the metadata to export.

See Using PUM Data Migration Page

8. Select whether to overwrite existing data or ignore duplicates.

9. Select Specify.

10. In the Import From field select the path and file for the DAT file exported from the old PUM Source.

11. Click Import/Export.

Migrating PUM Data

If both your old PUM source and new PUM source are available, you can export and import at the same
time.

To migrate PUM data:

1. Download and deploy new Update Image.

2. Install Change Assistant from the PS Home that matches the new PUM Source.

Note: Change Assistant Settings can be retained from the existing instance of Change Assistant. See
Installing Change Assistant

3. In Change Assistant, configure database definitions for the old PUM source database and the new
PUM source database.

4. Select the task Migrate Customer Data from the Tools menu.

5. Select the metadata to import and export.

See Using PUM Data Migration Page
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6. Click Import/Export.

7. Change Assistant performs a compatibility check.

8. If the compatibility check passes, a Migration Summary report is displayed.

9. Click Finish.

Using PUM Data Migration Page
In Change Assistant, select Tools, Options, PUM Source tab, then click Manage for Migrate Customer
Data.

This example illustrates the fields and controls on the PUM Data Migration page. You can find definitions
for the fields and controls later on this page.
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Field or Control Description

Export PUM(User) Metadata From Existing PUM Source Select to enable the export.

Database Select the old PUM source database.

If the database has not been defined in this instance of Change
Assistant, use the Create button to launch the Define Database
wizard.

Customization Repository Select to export the customization repository.

Test Repository Select to export the test repository.

Package Definitions Select to export change package definitions.

Merge Repository Select to export Merge Repository.

You can also export merge session history tables to maintain
different versions of customization object in the merge
repository. Refer to Retaining Object Merge Data and Session

PUM Automated Updates Select to export PUM Automated Update settings and jobs.

Note: Only applies to PUM Images on PeopleTools 8.59 and
above.

Export To Enter the path and file name for the export.

Import PUM(User) Metadata to New PUM Source Select to enable import.

Database Select the new PUM source database.

If the database has not been defined in this instance of Change
Assistant, use the Create button to launch the Define Database
wizard.

Customization Repository Select to import customization repository.

Test Repository Select to import test repository.

Package Definition Select to import change package definitions.

Merge Repository Select to import Merge Repository.

You can also import merge session history table to maintain
different versions of customization object in the merge
repository. Refer to Retaining Object Merge Data and Session
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Field or Control Description

PUM Automated Updates Select to import PUM automated update settings and jobs.

Overwrite if exists Select to overwrite data if the data already exists.

Ignore duplicate Select to ignore duplicate data.

Same as Export The file specified in the Export To field is used.

Specify Select if you have an existing file to import.

Import From Enter the path and file name for the import.

Working with Change Assistant Templates and Jobs

Whether you are performing an update or an upgrade, you work with Change Assistant templates and
jobs. The templates are composites of all possible steps that apply to an update or upgrade, whether they
apply to your environment or not.

The source of the template is dependant on the action you are performing in Change Assistant. This table
lists the template source for each Change Assistant action.

Change Assistant Action Template

Apply Update Change Assistant template comes in the change package
downloaded from MOS.

For change packages created in Application Designer,
 the template is generated when you select Generate New
Template.

Update Manager Change Assistant template is either generated from the change
package when you select to apply the change package or
delivered from PeopleSoft if you are applying a PeopleSoft
Release Patchset (PRP).

For PeopleTools patches, the change package is located in
PSHOME\PTP directory for the new PeopleTools patch.

For PeopleTools upgrades, the change package is located in
the PSHOME\PTU directory for the new PeopleTools release.

For Upgrade to a New Application Release, the change
package is generated in the PUM Image.

After you specify the required settings in Change Assistant regarding your environment, you use Change
Assistant to build a job tailored to your environment. When building the job, Change Assistant filters the
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steps so that the job contains only the steps applicable to your implementation. For example, the resulting
Change Assistant job will have only steps that apply to your database type, your installed products, your
languages, and so on.

When you apply updates or run an upgrade, Change Assistant automatically loads the template into
the Change Assistant internal storage system. You can add additional chapters, tasks, and steps to the
template, if needed. In the job, you can not modify steps that have been filtered, however you can modify
non-filtered steps, delete or add new steps.

Templates can also be modified from the Create or Modify Templates mode, specified on the Change
Assistant Options dialog box. If you modify templates using this option, you must import the template
from the change package zip file, open and modify the template, then export the template back to the
change package zip file.

Examples of custom steps that might be added include, dropping indexes, adding indexes, backing up a
database, adding PTF steps, and so on.

Note: In most cases, it is not necessary (or recommended) to modify a delivered template. Any changes
that you make to the imported template won't affect the original template that you downloaded. Any
changes made to the template in the initial pass or subsequent pass are exported and added to the updated
change package at the end of the apply process and will be used in future applies. However, if you choose
to edit a template, keep a backup of the original.

Creating New Template Elements
You can add chapters, tasks and steps to an existing template.

To insert a template element:

1. Highlight the location where you want to add the element.

If you want to add a chapter above the existing first chapter in the template, highlight the template
root node (template name) at the top of the template tree.

2. From the Edit menu (or toolbar) select the appropriate option: Insert Chapter, Insert Task, Insert
Step.

3. Enter a unique name for your new element.

Note: Each chapter in the update template must have a unique name, each task within a chapter must
have a unique name, and each step within a task must have a unique name.

4. Click OK.

When creating new steps, Change Assistant displays the Step Properties dialog box for specifying step
options.

Deleting Template Elements
To delete a chapter, task, or step:

1. Highlight the chapter, task, or step that you want to delete.
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Note: Press and hold the CTRL key to select multiple steps for deletion.

Warning! If you delete a chapter, Change Assistant deletes all the tasks and steps within the chapter.
If you delete a task, Change Assistant deletes all the steps within the task.

2. Select from the following:

a. If you want to delete a chapter, select Edit, Delete Chapter.

b. If you want to delete a task, select Edit, Delete Task.

c. If you want to delete a step, select Edit, Delete Step.

3. Change Assistant deletes the chapter, task, or step and updates the template.

4. Save the template.

Exporting Templates
In order for others to use the template that you create or modify, you need to export it from Change
Assistant. If you want to overwrite an existing template file, enter the name of the original template.

To export a template:

1. Open the template in Change Assistant by selecting File, Open Template.

2. Select File, Export Template.

The Export Template dialog box appears.

3. Navigate to the folder in which you want to save the template.

4. Enter the name of the template.

Note: If you want to overwrite the original template that you downloaded, enter the original name of
the template.

5. Click Save.

Exporting Jobs to XML, HTML, or Microsoft Excel Format
Change Assistant allows you to export jobs to XML, HTML, or Microsoft Excel file formats.

To export a job:

1. Select File, Export Job.

2. Enter the desired exported filename and the select the desired file type format.

You can use this option to enable other implementation team members, who do not have access to the
machine on which Change Assistant is running, to view the job. Exporting the job to Microsoft Excel
enables you to view the timings in a spreadsheet format.
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Note: You can not export a Change Assistant job and either import it or open it on another machine with
Change Assistant installed and then run or modify the job on that other machine.

Working with Steps

This section discusses how to:

• Set step properties.

• Set filter queries.

• View step status.

Setting Step Properties
PeopleSoft delivers update templates with default settings and steps to perform updates. If needed, you
can modify the steps, or create new steps, based on the conditions that apply when you run the update
process.

To modify the step properties, highlight the step for which you want to modify the step properties, then
double-click on the step or select Edit >Step Properties. After making any changes to step properties,
click OK, and save your template.

Note: Depending on what mode you are in, some of the fields may be disabled.

Note: Under normal circumstances, it is recommended that you do not modify or edit the step properties
in your delivered template.

This section describes fields and options on the Step Properties dialog box. You can modify step
properties for a step when adding or editing steps in the template.
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This example illustrates the fields and controls on the Step Properties dialog box. You can find definitions
for the fields and controls later on this page.

Term Definition

Step Description This field displays the current step.

Script/Procedure Enter the name of the script, procedure, project, or program
name to which you want to assign the properties of the step.
For example, enter SYSAUDIT.

This field is required for all step types except manual stop.

Type Select a step type. This selection defines the type of action to
be performed by the step. For example, if you are running the
SYSAUDIT SQR report, select SQRReport.

Detailed information related to each step type appears
elsewhere in this PeopleBook.

See Step Types
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Term Definition

Parameters Enter additional parameters that you may need to run the step.
 For example, for SQL commands, you enter the actual SQL
command in this field. In other cases, you use this edit box to
override various environment settings or other parameters so
that the step completes successfully.

Detailed information related to the parameter options for each
step type appears elsewhere in this PeopleBook.

See Step Parameters

From Tools Release Specify the PeopleTools releases to which a step applies.
 Use the associated operator from the drop-down list box to
indicate ranges of releases. The default values are All with the
= operator.

The operator drop-down list box enables you to express
greater than, less than, equal to, and 'in' relationships.

The in operator enables you to specify more specific ranges,
 such as 'in' 8.48 and 8.49, as opposed to 'greater than' 8.48.
 When adding multiple release numbers, separate the values
with a comma (,). For example:

8.48,8.49

Note: If you enter more than one From Tools Release value,
 the system assumes the 'in' operator.

Change Assistant uses these values to filter the steps when
creating the upgrade job so that only the steps necessary for a
particular environment remain.

Run Location For Application updates and PeopleTools-only upgrades, steps
run locally.

Orientation Specify which database the step needs to be run against.
 Options will vary based on the action selected, but may
include:

• Source

• Target

• Copy of Current Demo

• Production

• Not Applicable

Step type and type of upgrade determine valid orientation
settings.

See Source and Target Databases.
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Term Definition

Products Click the Products icon. Change Assistant displays the Select
Products dialog box, which enables you to select the product
line, the industry, and the products to which your step should
be run against (for example, FIN/SCM, Commercial, Asset
Management).

Note: You must select at least one product.

Apply Type Specify the type of upgrade to which this step applies:

• Initial Pass: refers to the initial application of a change
package a target database.

• Subsequent Pass refers to any passes to additional target
databases before moving to production.

• Move to Production: refers to the application of a change
package to your production database.

Note: When the job is created, the system filters the template
steps to be executed by the apply type specified. For example,
 if Move to Production is specified as the apply type, only
steps in the template specified as Move to Production will be
included in the job.

Allow for Errors Indicates how the system should react to any errors that may
arise during a step run. If set to Yes, if the step encounters
errors the system does not perform any error handling and
continues on to the next step.

Default is set to No.
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Term Definition

Run Concurrently Enables you to set multiple steps (programs, processes, and so
on) to run simultaneously.

If you select this option for two or more consecutive steps,
 Change Assistant starts those processes concurrently, until the
job reaches:

• a step with Run Concurrently set to No.

• a step type of Manual Stop.

• the Maximum Concurrent Processes value, as set on the
Change Assistant Options dialog box.

By setting Run Concurrently to Yes, you are indicating to
Change Assistant that this step can run concurrently with
the following step. The total number of processes that can
run concurrently is determined by the Maximum Concurrent
Processes setting on the Change Assistant Options dialog box.

Some examples are shown here, these examples use 3 AE
steps and CA concurrency set to 2:

• Example 1

Steps:

• AE1 Concurrent=Yes

• AE2 Concurrent=Yes

• AE3 Concurrent=No

• Manual Stop

In this example, AE1 and AE2 will run in parallel.
 When both finish, AE3 will then run. Job will stop when
ManualStop is encountered.

• Example 2:

Steps:

• AE1 Concurrent=Yes

• AE2 Concurrent=Yes

• AE3 Concurrent=Yes

• Manual Stop

In this example, AE1 and AE2 will run in parallel, when
either AE1 or AE2 finish, AE3 will run. Job will stop
when ManualStop is encountered.

• Example 3

Steps:

• AE1 Concurrent=Yes
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Term Definition

• AE2 Concurrent=Yes

• Manual Stop

• AE3 Concurrent=No

In this example, AE1 and AE2 will run in parallel, the job
will stop when ManualStop is encountered. AE3 will run
after the user completes the ManualStop.

• Example 3

Steps:

• AE1 Concurrent=Yes

• AE2 Concurrent=No

• AE3 Concurrent=Yes

• Manual Stop

In this example, AE1 will run, when AE1 finishes, AE2
will run, when AE2 finishes AE3 will run. Job will stop
when ManualStop is encountered.

Running steps concurrently is a strategy reserved for
application upgrades to save time when running the following
step types on Process Scheduler:

• Application Engine

• SQL

• Data Mover

Concurrent processing is not enabled in any circumstances for
these step types:

• DBTSFIX

• Load Base Data

• Upgrade PeopleTools

• Manual Stop

Note: If a step is dependent on a previous step, it is not
recommended to set it to run concurrently with that step.

Note: Steps set to run concurrently can span across multiple
consecutive tasks or chapters, and can be of different step
types.

Note: In an application upgrade, do not run the "Update
PeopleTools System Tables" step concurrently, and, unless
specifically instructed to do so, do not run any of the steps in
the "Apply PeopleTools Changes" chapter concurrently.
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Term Definition

See the upgrade documentation for your specific upgrade for
recommendations on specific steps within that upgrade that
can be run concurrently.

Setting Filter Queries
Filter queries provide the ability to add ad-hoc step filtering criteria to a template to further improve
applicability of job to the customer and where possible remove unnecessary manual steps.

See Adding Filter Queries

Viewing Step Status
When working with templates and jobs, you see these status icons to the left of steps:

Term Definition

 Run Indicates that Change Assistant runs this step or process
automatically without manual intervention.

 Stop Indicates that Change Assistant stops on this process. It
also indicates that there may be manual steps to perform
for this step. Review the documentation window for further
instructions. After completing the work described in a manual
step, you must set the status to Complete.

 Restart
Indicates a restart process. If a step failed and you corrected
the problem, you can set the step to restart from the point of
failure.

Processing
Indicates that the process is running.

 Failure
Indicates a failure has occurred that needs immediate attention.
 This appears if a Data Mover script, SQL script , or project
copy step fails. Resolve the error before continuing with
processing.

Warning
Indicates a warning for this step which does not need
immediate attention. The job continues processing with no
adverse affects. After the job completes, review the steps in a
warning state and evaluate for further action.

 Complete Indicates that the step was completed by the system.

 Manually Complete
Indicates this step was completed manually.
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Term Definition

 Filter
Indicates this step is filtered at the job level.

Steps filtered at the job level will not execute and are
equivalent to Complete. To hide these steps, select View, and
deselect Steps Filtered at the Job Level.

Filter Query
Indicates this step is filtered by a filter query.

Steps filtered by filter query will not execute and are
equivalent to Complete. To hide these steps, select View, and
deselect Steps Filtered by Filter Query.

Running Multiple Instances of Change Assistant
Beginning with PeopleTools 8.56 multiple instances of Change Assistant can run in parallel, however
you can not run multiple instances against the same target database. This CA functionality is available
independent of the Tools Release of the Target Databases, however, some calls on some older Tools
Releases do not support parallel processing and therefore locking will occur. If locking occurs, a message
will be displayed in Change Assistant showing the lock.

This is an example of a Change Assistant lock message.

Adding Filter Queries

Filter queries provide the user with the ability to add ad-hoc step filtering criteria to a template in order to
improve the applicability of a job to the customer and where possible remove unnecessary manual steps.
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Creating Filter Query Step Type
A template can have 0–n Filter Query steps defined and they can be defined at any position in the
template. The location of the filter query step will determine when the filter queries associated to that step
will be executed.

This example illustrates the fields and controls on the Step Properties for Type FilterQuery. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Script/Procedure The Script/Procedure is defaulted to Filter<n+1> where n is
set to 0 for a new template and incremented by 1 each time a
Filter Query step type is added and saved.

The first Filter Query step created in a template will be named
Filter0001, the second will be named Filter0002, and so on.

These values must be unique, deletion of a filter query step,
will not change the n value. When a filter query step is deleted,
 the value is never reused within the current template.
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Field or Control Description

Define Filter Query Use this button to access the Define Filter Queries dialog box.

The following step attributes can be set for Filter Query step type:

• From Tools release

• Orientation

• Products

• Platforms

• Languages

• Apply Type

Setting Step Properties

The following step attributes cannot be changed and will be greyed out.

• Parameters — not required for Query Filter step type

• Run Location (Default = Local)

• Allow for Errors (Default = No)

• Run Concurrently (Default = No)

Note: A filter query step cannot be filtered by it’s own query. A filter query step can not be filtered by a
filter query defined in another step.

Defining Filter Queries
The Define Filter Queries page is used to define the actual filter queries. The grid is displayed in read-
only mode and always contains a minimum of one row in the view.

• To add a new filter query, right-click and select Add New Filter Query.

• To delete an existing filter query, right-click on the row and select Delete Selected Filter Query.

• To update an existing filter query either:

• Right-click on the row and select Edit Selected Filter Query.

• Double click on the row.

Defining Filter

Use the Filter Definition dialog box to define the filter.
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This example illustrates the fields and controls on the Filter Definition dialog box. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Filter ID The Filter ID must be unique within the Filter Query step. The
Filter ID value in conjunction with the Script/Procedure name
is used to ensure uniqueness within the template. For example:
Filter1–AP Check.

Description Enter a description for the filter query.
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Field or Control Description

System Query Select this radio button to use a system queries. System
queries include:

• Source Platform = Target Platform

• Source Platform != Target Platform

• Database EM Hub Enabled = Yes

• Database EM Hub Enabled = No

• Unicode Database = Yes

• Unicode Database = No

• Last Job in Jobset = Yes

• Last Job in Jobset = No

• Scripts File Exists

• Scripts File Does not Exist

• SQR File Exists

• SQR files Does not Exist

• MO Project Exists

• MO Project Does not Exist

• ADS Project Exists

• ADS Project Does not Exist

User Defined Select this radio button to type your own query definition.

Query Definition Enter the SQL statement for the query.

Special filter queries are also available as described in the next
section.

Note: The SQL statement must be a select statement, however
the select statement is not validated.
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Field or Control Description

Filter if True Value The Filter if True Value can be a numeric or a string. Valid
operator are:

• Numeric

=, <, >, >=, <=, <>

• String

Contains, Does Not Contain

For a single filter query, when the Filter if True Value is True
then the associated step will be filtered.

Assigning Filter Query to a Step
To use a filter query, the filter query must be assigned to a step. The following rules apply:

• The drop down list of filter queries will be restricted to filter queries that are defined in the template at
a position ahead or above the step being updated.

• Steps can only be associated to Filter Queries that would execute prior to the step being executed.

• Steps cannot be associated to the same Filter Query twice.

Adding a Filter Query to a Step

To add a filter query to a step:

1. Double-click on the step to open the Step properties.

2. Select the Filter Queries tab.

104  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 5 Working With Change Assistant

This example illustrates the fields and controls on the Filter Queries dialog box. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Step will be filtered if: Select when filtering will be done.

• All Filter Queries listed Return True Values

AND condition

• One Filter Query listed returns True value

OR condition

Filter Name Select the Filter name from the drop down list.

To add additional filter queries, right-click and select Insert
Query.

Filter Identifier Select the Filter Identifier from the drop down list.

Note: The drop down list will contain all of the Filter IDs for
the selected Filter Name. This field will be grayed out if a
Filter name has not been specified.

To add additional Filter Queries, right-click on a row and select Insert Query.
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Deleting a Filter Query from a Step

To delete a filter query:

1. Double-click on the step to open the Step properties.

2. Select the Filter Queries tab.

3. Right-click on the row with the filter and select Delete Query.

4. Click OK.

Cutting and Pasting Filter Queries
Once Filter Query Step types have been defined and used as filters for additional steps, you must take care
in deleting or moving the steps in the template. Keep in mind the following points:

• Deleting a Filter Query Step

If you delete a Filter Query step from the template, you will receive a warning that the deletion will
result in all references to all filters defined in that step will be deleted. If you choose to continue, the
process will remove all step references to the deleted Script/Procedure + Filter ID values.

• Cutting and pasting a Filter Query Step to another location in the template

• Pasting to a position above or ahead of the original position has no impact.

• Pasting to a position below the original position will result in a warning message indicating that
moving step will result in removal of references to the current filter query step above it’s new
position if any exist.

If you choose to continue, the process will remove all step references to the moved Script/
Procedure + Filter ID values in steps that precede it in the revised template.

• Cutting and pasting a non-filter query step

• Pasting to a position below the original position has no impact.

• Pasting to a position above the original position will result in a warning message indicating that
moving the step will result in removal of references to filter queries below it’s new position if any
exist.

If you choose to continue, the process will remove all step references to the impacted Script/
Procedure + Filter ID values within the relocated step.

Creating and Executing Jobs that Include Filter Queries
This section discusses how filter queries affect:

• Job Creation

• Job Execution
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Job Creation

At the time of job creation, Filter Query steps can be filtered by any of the standard attributes (such as
Platforms) as is the case for any other Step type. The filtering of a Filter Query step in this manner does
not invalidate or cause steps that reference the filter query to filtered.

At job creation all Filter Queries defined within the template will be set to a default value of Null or No
Value. No Step will be filtered by an Ad-Hoc Filter Query at job creation, because no Filter queries have
been run at that time. The earliest these Filter Queries can be executed is in the first step of the template/
job.

Job Execution

On Filter Query step execution, results are retrieved for all filter query ID’s defined within that specific
Filter Query step. These results are written to the Change Assistant database.

• The execution accounts for the orientation of the Filter Query step.

• The return values for each Filter Query are noted in the CA log listing the Filter Identifier, Filter ID,
the Hide if True Condition, the return value and whether the Hide if True Condition was met.

• In the event of a SQL error, an error message is written to the CA log and the step is marked as
Failed.

• In the event that the SQL returns a value of the wrong type (numeric as string) ,an error message is
written to the CA log and the step is marked as Failed.

Upon completion of this execution, the template is refreshed and as part of this action filtering of steps
will occur. Filtering of steps by filter query can only occur where all associated Filter Identifier’s have
been resolved and are not in the Null or no value state. This is true even when only a single FALSE is
required to filter a step. All the filter query results are also written to a log file. Each filter step generates a
log file with results named to match the filter value for example filter0001_out.log.

When a Job is opened or refreshed – the filter query filtering will execute to ensure that all required
filtering has occurred. All steps filtered by Filter query are listed in the job.log file.

Working with Embedded Documentation

Each delivered Change Assistant template comes with embedded documentation to help guide you
through an update or upgrade job, especially for manual steps. Typically, full upgrades have significantly
more documentation than updates.

The documentation for any chapter, task, or step resides in a separate HTM file with the same name as the
template element. For upgrade templates a master HTML file stores the compilation of the separate HTM
files displayed in an order matching the template.

When working with Change Assistant documentation, you:

• Set the documentation directory.

• View documentation.

• Create and edit documentation.
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• Finalize documentation.

Setting the Documentation Directory
You set the documentation directory before an upgrade and prior to customizing documentation. The
documentation directory contains the documentation HTM files.

To set the documentation directory:

1. Select Edit, Set Documentation Directory.

2. Navigate to the directory where you want to store the documentation.

3. Click Open.

Viewing the Documentation
To view the embedded documentation associated with a particular template element:

1. Select the template node.

2. View the documentation in the documentation box.

To view the compiled documentation:

1. Navigate to the documentation directory.

2. Open the template_name.HTM file.

Creating and Editing Documentation
To create or edit documentation:

1. Select the desired element node.

2. Select Edit > Edit Documentation.

3. In the edit box on the Edit Documentation dialog box, insert your cursor, and add new content or
modify existing content.

Click Attach to incorporate additional files, such as graphics or additional text files. Attaching
files moves that file into the documentation directory and inserts a link to that file in the embedded
documentation.

4. Click OK.

Finalizing Documentation
After modifying any documentation for individual template elements, select Edit > Finalize
Documentation to compile the individual documentation changes into the master HTM file.
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Maintaining Change Assistant Directories

After you download and apply change packages, it's not uncommon for there to be a number of files left
in the local Change Assistant directories. This section describes when it's safe to remove the files and
what to consider if you want to remove any of the files.

Directory Maintenance Consideration

Download Location where the system stores your downloaded bundles
and change packages. After the updates have been applied
to all environments, you may delete the updates from this
directory.

This can be advantageous when applying change packages
by keeping the list of change packages on the Select Change
Packages page of the Apply Change Packages wizard at a
manageable length.

However, keep in mind that if you delete the updates, and then
you need to recreate another environment, you will need to
download the update again.

Staging A temporary holding place for files needed during the
application of a change package. It is safe to delete files in this
directory after a change package has been successfully applied
to all target databases.

Output Contains all the logs related to the processing of a change
package. The files in this directory should be kept as long as it
is feasible in case problems are detected later. The logs contain
valuable information for troubleshooting.

PeopleSoft Update Manager Directory This is a network share that maps to the PI_HOME share of
the image. Do not delete these files.

Note: The PI_HOME directory requires read and write access
to apply PeopleSoft Release Patchsets (PRPs).

PS_HOME\Maint Contains script files and other files that are only required
during the application of the change package. It is safe to
delete files in this directory after a change package has been
successfully applied.
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Running Change Assistant from Command
Line

Running Change Assistant Job from the Command Line

Change Assistant jobs can be run from the command line to automate applying updates to multiple
environments. There are 2 modes available AU and UM.

• Update Manager Mode (UM)

• Traditional Apply Updates Mode (AU)

To get command line help:

• Enter Changeassistant.bat ? to get a list of the actions.

• To get help on a specific action enter Changeassistant.bat -MODE UM -ACTION
<action> for example  Changeassistant.bat -MODE UM -ACTION CPAPPLY.

Update Manager Mode
Update Manager mode supports the following actions:

• ENVIMP = Import Environment

• ENVCREATE = Create Environment

• ENVUPDATE = Update Environment

• EMFVAL = Validate EMF Settings

• OPTIONS = Set General Options

• UPLDTGT = Upload Target database to PUM Source

• CPAPPLY = Apply Previously Created (non-PRP) Change Package

• CPDEFINE = Define a New Change Package

• PRPAPPLY = Apply PRP

• PTPAPPLY = Apply a patch to your Current PeopleTools Release

• PTUAPPLY = Upgrade to a New Release of PeopleTools

• UPGAPPLY = Apply Application Upgrade

• DLTAPPLY = Apply Tools Delta Package
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• TDPAPPLY = Apply Translation Delta Package

• RFUAPPLY = Apply Required for Upgrade Package

• CPCREATE = Create Change Package

• EXPCFG = Export configuration

• IMPCFG = Import configuration

• IMPCUSTDATA = Import customer data from the data file to the new PUM source

• EXPCUSTDATA= Export customer data from existing PUM source and save it as a data file

• UPLDCUSTDATA = Upload customer metadata and test data

• LANGINSTALL = Install language(s) on PUM Source

Constructing Command Lines for Configuring Change Assistant

Configuring Change Assistant includes the following:

• ENVIMP = Import Environment

• ENVCREATE = Create Environment

• ENVUPDATE = Update Environment

• EMFVAL = Validate EMF Settings

• OPTIONS = Set General Options

• EXPCFG = Export configuration

• IMPCFG = Import configuration

• UPLDTGT = Upload Target Database

Command Line for Uploading Change Assistant Environments that were
Previously Exported

The action ENVIMP is used to import an environment that was previously exported.

Command line format:

changeassistant.bat -MODE UM -ACTION ENVIMP -FILEPATH <location of xml file> -FILE ⇒

<xml file name> -REPLACE <Y or N>

or

changeassistant.bat -MODE UM -ACTION ENVIMP -INI <path to ini file>
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Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

ENVIMP = Import Environment

-FILEPATH Location of xml file to be uploaded. (Required)

Example: -FILEPATH C:\pt8.53

-FILE Name of xml file to be uploaded. (Required)]

Example: -FILE PT903R1.xml

-REPLACE Replace existing data if it exists (Optional)

• Y = Replace existing values if they exist. (default)

• N = Do not replace values if they exist.

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Creating Environment
The action ENVCREATE is used to create an environment using the command line.

Command line format:

changeassistant.bat -MODE UM -ACTION ENVCREATE -TGTENV <target database> -OUT <log ⇒

path> -REPLACE <Y or N> -EXONERR <Y or N> -CKYN <Y or N> -CT <database type> -CS <d⇒

atabase server name> -OID <owner ID> -UNI <unicode> -CA <access id> -CAP <access id⇒

 password> -CO <user id> -CP <user password> -CI <connect id> -CW <connect id passw⇒

ord> -CZYN <Y or N> -CZ <DB owner> -CZP <DB owner password> -SQH <path to SQL Query⇒

 tool> -INP <products> -PL <product line> -IND <industry> -INL <languages> -INBL <B⇒

ASE LANGUAGE> -PSH <path to PS Home> -PAH <path to PS App Home> -PCH <path to PS Cu⇒

st Home> -SQRF <SQR flags> -NPYN <Y or N> -NPSH <path to new PS Home> -NPAH <path t⇒

o new PS App Home> -NPCH <path to new PS Cust Home> -NSQRF <new SQR Flags>

or

changeassistant.bat -MODE UM -ACTION ENVCREATE -INI <path to ini file>
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The parameters for ENVCREATE action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

ENVCREATE = Create Environment

-TGTENV Name of target database. (Required)

-OUT Path of log file (Optional)

If the log directory is not specified it uses the default defined
under General Options.

-REPLACE Replace existing data if it exists (Optional)

• Y = Replace existing values if they exist. (default)

• N = Do not replace values if they exist.

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-CKYN Validate database connection and retrieve information from
database (Optional)

• Y = Validate (by default)

• N = Do not validate

-CT Database Type (Required)

Database type is a number:

1 – DB2 zOS

2 – Oracle

3 – Informix

4 – DB2 LUW

6 – Sybase

7 – Microsoft SQL Server
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Parameter Description

-CS Database Server Name (Optional)

-OID Owner ID (Optional)

-UDI Unicode (Required)

• Y = Yes

• N = No

-CO User ID (Required)

-CP User Password (Required)

-CA Access ID (Required)

-CAP Access Password (Required)

-CI Connect ID (Required)

-CW Connect Password (Required)

-CZYN Set DB Owner Credentials (Optional)

• Y = Yes

• N = No (default)

-CZ DBOwner ID (Required if –CZYN is Y)

-CZP DBOwner Password (Required if –CZYN is Y)

-SQH SQL Query Tool (Required)

-INP Installed Products (Required)

Specify either all , a single or multiple products.

For example:

• -INP all

• -INP FMA

• -INP FMA.REA,SMA
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Parameter Description

-PL Product Line (Optional)

-IND Industry (Required)

Specify either all , or a specific industry.

For example:

• -IND all

• -IND Commercial

-INL Languages (Required)

Specify either all , or a specific languages.

For example:

• -INL all

• -INL ENG,FRA

-INBL Base language (Required)

-PSH PS Home (Required)

-PAH PS App Home (Required)

-PCH PS Cust Home (Required)

-SQRF SQR Flags (Optional)

-NPYN Enable new PS Home (Optional)

• Y = Yes

• N = No (default)

-NPSH New PS Home (Required if –NPSH is Y)

-NPAH New PS App Home (Required if –NPSH is Y)

-NPCH New PS Cust Home (Required if –NPSH is Y)

-NSQRF New SQR Flags (Optional)
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Parameter Description

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Updating Environment
The action ENVUPDATE is used to set options using the command line.

The command line for updating the environment uses the same parameters as creating an environment
(ENVCREATE), except -REPLACE is not included.

Command Line for Setting Options
The action OPTIONS is used to set options using the command line.

Command line options are available for the General Options, EM Hub Options, and PUM Source
Options. Additional options are not supported via command line.

Command line format:

changeassistant.bat -MODE UM -ACTION OPTIONS -OUT <path to output log> -REPLACE <Y ⇒

or N> -EXONERR <Y or N> -SWP <True or False> -MCP <maximum concurrect processes> -P⇒

SH <path to PS Home> -STG <staging directory> -OD <output directory> -DL <download ⇒

directory> -SQH <path to SQL Query tool> -EMYN <Y or N) -EMH <server host name> -EM⇒

P <server host port> -EMC <chunck size> -EMPING <ping interval> -EMDRV <drives to c⇒

rawl> -SRCYN <Y or N> -SRCENV <PUMsource database name> -PUH <PUM PS Home> -PIA <PU⇒

M PIA URL>

or

changeassistant.bat -MODE UM -ACTION OPTIONS -INI <path to ini file>

The parameters for OPTIONS action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

OPTIONS = Set General Options
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Parameter Description

-OUT Path of log file (Optional)

If the log directory is not specified it uses the default defined
under General Options.

-REPLACE Replace existing data if it exists (Optional)

• Y = Replace existing values if they exist. (default)

• N = Do not replace values if they exist.

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-SWP Show Welcome Menu (Optional)

• True = Show welcome page

• False = Do not show welcome page

-MCP Maximum Concurrent Processes (Optional)

-PCH PS Home (Optional)

-PAF PS App Home (Optional)

-PCH PS Cust Home (Optional)

-STG Staging Directory (Optional)

-OD Output Directory (Optional)

-DL Download Directory (Optional)

-PUH PeopleSoft Update Directory (Optional)

-SQH SQL Query Tools (Optional)

-EMYN Configure EM Hub for file deploy (Optional)

• Y = Yes

• N = No (default)
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Parameter Description

-EMH Server Host Name (Required if –EMYN is Y)

-EMP Server Host Port (Required if –EMYN is Y)

-EMC Chunk Size (Required if –EMYN is Y)

-EMPING Ping Interval (Required if –EMYN is Y)

-EMDRV Drives to Crawl (Required if –EMYN is Y)

-SRCYN Configure PUM Source (Optional)

• Y = Yes

• N = No (default)

-SRCENV PUM Source Database Name (Required if –SRCYN is Y)

-PUH PUM PS Home Directory (Required if –SRCYN is Y)

-PIA PUM Source PIA URL (Required if –SRCYN is Y)

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line to Validate EMF Settings
The action EMFVAL is used to validate EMF using the command line.

Note: In Linux/UNIX, the user running validating EMF settings should have write permission to
PS_APP_HOME.

Command line format:

changeassistant.bat -MODE UM -ACTION EMFVAL -OUT <path to log file>  -EXONERR <Y or⇒

 N>

or

changeassistant.bat -MODE UM -ACTION EMFVAL -INI <path to ini file>

The parameters for EMFVAL action are:
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Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

EMFVAL = Validate environment

-OUT Path to log file. (Optional)

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-INI Path to INI file.

See Using a Configuration File with Changeassistant.bat

Command Line to Upload Target Database
The action UPLDTGT is used to a target database using the command line.

Command line format:

changeassistant.bat -MODE UM -ACTION UPLDTGT -OUT <path to log file>  -EXONERR <Y o⇒

r N>

or

changeassistant.bat -MODE UM -ACTION UPLDTGT -INI <path to ini file>

The parameters for UPLDTGT action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

UPLDTGT = Upload target database

-TGTENV Target database (Required)
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Parameter Description

-OUT Path to log file. (Optional)

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Constructing Command Line to Install Languages

Use the LANGINSTALL action to install languages in the PUM Source. The following command formats
are available:

• Command line format to install languages that exist on a selected target environment.

Changeassistant.bat -MODE UM -ACTION LANGINSTALL -TGTENV <Target Env>

• Command line format to install selected languages.

Changeassistant.bat -MODE UM -ACTION LANGINSTALL -LANG <Language codes comma s⇒

eparated>

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

LANGINSTALL = Install language

-TGTENV Target environment

-LANG Language code

For multiple languages, use commas to separate the codes.

For example: –LANG ESP,FRA
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Constructing Command Lines for Migrating and Uploading
Customer Data

Commands for migrating and uploading customer data include:

• IMPCUSTDATA = Import customer data from the data file to the new PUM source

• EXPCUSTDATA= Export customer data from existing PUM source and save it as a data file

• UPLDCUSTDATA = Upload customer metadata and test data.

This command includes ability to enable or disable object merge.

In order to migrate customer data, you will need to:

1. Export the customer data from the old PUM source database and save it as a data file.

2. Import the customer data from the selected data file to the new PUM source database.

Command Line to Export Customer Data
The action EXPCUSTDATA is used to export the customer data from the old PUM source Database and
save it as a data file.

Command line format:

Changeassistant.bat -MODE UM -ACTION EXPCUSTDATA –SRCENV <old PUM DB> -DATATYPE <ty⇒

pe> -DATATYPE <type> -FILEPATH <file path> -FILE <file name>

or

Changeassistant.bat -MODE UM -ACTION EXPCUSTDATA -INI <path to ini file>

The parameters for EXPCUSTDATA action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

EXPCUSTDATA = Export the customer data

- SRCENV Name of the old PUM source Database. (Required)
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Parameter Description

-DATATYPE The definition type to export. There are 5 type definitions:
Package Definitions, Customization Repository, Test
Repository, Merge Repository, and PUM Automated Updates.
 (Optional)

• ALL = Select all the types. (default)

• PKGDEFN = Export package definitions.

• CUSTRPST = Export customization repository

• TESTRPST = Export test repository

• MERGERPST = Export merge repository.

• PAU = Export PUM automated updates.

You can specify multiple data type by separating
them by semicolon. For instance -DATATYPE
PKGDEFN;CUSTRPST;TESTRPST

- FILEPATH Specify the configuration backup file location. (optional)

If the file path is not specified, the Output Directory is used.

- FILE Specify the configuration backup file name. (Optional)

If the backup file name is not specified, customerdata.DAT is
used.

-INI Path to ini file.

See Using Change Assistant to Upgrade PeopleTools

Command Line to Import Customer Data
The action IMPCUSTDATA is used to import the customer data from the selected data file to the new
PUM source Database.

Command line format:

Changeassistant.bat -MODE UM -ACTION IMPCUSTDATA –NEWSRCENV <new PUM DB> -DATATYPE ⇒

<type> -FILEPATH <file path> -FILE <file name> -OVERWRITE <Y|N>

or

Changeassistant.bat -MODE UM -ACTION IMPCUSTDATA -INI <path to ini file>

The parameters for IMPCUSTDATA action are:
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Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

IMPCUSTDATA = Import Customer data from the selected
data file to the New PUM Source

-NEWSRCENV Name of the new PUM source Database. (Required)

-DATATYPE The definition type to export. There are 5 type definitions:
Package Definitions, Customization Repository, Test
Repository, Merge Repository, and PUM Automated Updates.
 (Optional)

• ALL = Select all the types. (default)

• PKGDEFN = Export package definitions.

• CUSTRPST = Export customization repository

• TESTRPST = Export test repository

• MERGERPST = Export merge repository.

• PAU = Export PUM automated updates.

You can specify multiple data type by separating
them by semicolon. For instance -DATATYPE
PKGDEFN;CUSTRPST;TESTRPST

- FILEPATH Specify the configuration backup file location. (optional)

If the file path is not specified, the Output Directory is used.

- FILE Specify the configuration backup file name. (Optional)

If the backup file name is not specified, customerdata.DAT is
used.

- OVERWRITE Overwrite the Change Package definition if it exists. 
(Optional)

• Y = Overwrite if exists.

• N = Ignore duplicate. (default)

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat
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Command Line to Upload Customer Data
The action UPLDCUSTDATA is used to upload customer data to the PUM source Database. This action
is also used to enable or disable Object Merge.

Command line format:

Changeassistant.bat -MODE UM -ACTION UPLDCUSTDATA -RPSTTYPE <CUST|TEST> -PRJTYPE <M⇒

O|ADS> -PRJFROMDB <DB:project> -MRGOPT <Y|N> -PRJFROMFILE <file name> -NEWPRJ <DB:p⇒

roject> -REPLACE <Y|N> -ERRORCONTINUE <Y|N>

or

Changeassistant.bat -MODE UM -ACTION UPLDCUSTDATA -INI <path to ini file>

Example command line to upload customization project from H9257P08 database project TEST_AE_PC.

Changeassistant.bat -MODE UM -ACTION UPLDCUSTDATA -RPSTTYPE CUST -PRJTYPE MO -PRJFR⇒

OMDB H9257P08:TEST_AE_PC -REPLACE Y

Example command line to upload customization project from H9257P08 database project TEST_AE_PC
and enable object merge.

Changeassistant.bat -MODE UM -ACTION UPLDCUSTDATA -RPSTTYPE CUST -PRJTYPE MO -PRJFR⇒

OMDB H9257P08:TEST_AE_PC -REPLACE Y -MRGOPT Y

Note: This command first updates the merge option in PUM Source database and then uploads the
project.

Example command line to enable object merge.

Changeassistant.bat -MODE UM -ACTION UPLDCUSTDATA -MRGOPT Y

Example command line to disable object merge.

Changeassistant.bat -MODE UM -ACTION UPLDCUSTDATA -MRGOPT N

The parameters for UPLDCUSTDATA action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

UPLDCUSTDATA = Upload customer metadata and test data.
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Parameter Description

-RPSTTYPE Target Repository Type (Required)

• CUST

• TEST

-PRJTYPE Select the customer metadata type (Required)

• MO = Managed Object Project

• ADS = ADS Project

Note: If the repository type is TEST, MO is the only valid
option.

-PRJFROMDB Select Existing Database Project(s)

Example: -PRJFROMDB DB1:custprj1;DB2:custprj2

Note: Use this option if the project exists in the database.

-MRGOPT Enable Object Merge (Optional)

• Y = Enable object merge.

• N = Disable object merge.

-PRJFROMFILE Select Existing Project File(s)

Example: -PRJFROMFILE c:/temp/custprj1;c:/temp/custprj2.

Note: Use this option if the project has been copied to file.
This option can’t be used with -MRGOPT.

-NEWPRJ Create new database project

Example: -NEWPRJ DB1:custprj1

-REPLACE Replace existing data if it exists (Optional)

• Y = Replace Existing Values if they Exist (default)

• N = Do Not Replace Values if they Exist

-ERRORCONTINUE Proceed with Uploading Customer Data even if errors are
found (Optional)

• Y = Proceed with Apply even if Errors found (default)

• N= Stop apply when Errors encountered
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Parameter Description

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Constructing Command Lines to Create and Apply Change
Packages

Apply commands include:

• CPDEFINE = Define a New Change Package

• CPAPPLY = Apply Previously Created (non-PRP) Change Package

• PRPAPPLY = Apply PRP

• PTPAPPLY = Apply a patch to your Current PeopleTools Release

• PTUAPPLY = Upgrade to a New Release of PeopleTools

• UPGAPPLY = Application Upgrade

• DLTAPPLY = Apply Tools Delta Package

• TDPAPPLY = Apply Translation Delta Package

• RFUAPPLY = Apply Required for Upgrade Package

When you run the command line, the error codes are as follows:

• 0 = Success

• 1 = Failure

• 2 = Manual Stop encountered

• 3 = Failed to get lock

• 4 = Job completed with warnings

The RESUMEJOB parameter has the following limitations:

• COMPLETECONTINUE cannot be used for a failed Filter Query step

If the pending job is stopped by a failed Filter Query step, -RESUMEJOB can only have the value of
RESTARTCONTINUE or READYTORUNCONTINUE. If the value is COMPLETECONTINUE ,
an error message is reported.

• RESTARTCONTINUE| READYTORUNCONTINUE cannot be used for a manual stop step.
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If the pending job is stopped by a manual stop step, -RESUMEJOB can only have the value of
COMPLETECONTINUE. If the value is RESTARTCONTINUE or READYTORUNCONTINUE, an
error message is reported.

• The job must exist in Change Assistant Database in order to use RESUMEJOB.

If there is no job set in progress when the CA apply command line is run with the parameter -
RESUMEJOB, a warning message is reported.

• RESUMEJOB cannot be used when the parameter RESETJOB is Y.

If there is a job in progress and the -RESETJOB parameters is set as Y or not set (the default value is
Y) a warning message is reported as The resuming job can’t be reset.

• All other parameters need to be consist with the parameters of existing job

If there is a job in progress but the job parameters are not consistent with the ones in CA apply
command line; a warning message is reported as The pending job can’t be resumed by the inconsistent
parameter values.

Note: From 8.60, you can create and apply change packages from separate jobs. Earlier defining,
creating, and applying change package was executed consecutively in change assistant command line
mode in a single job.

Command Line for Defining a Change Package
You can use the command line to define a change package using a standard system search or a customer
saved search.

Command line format:

changeassistant.bat -MODE UM -ACTION CPDEFINE -TGTENV<TARGET ENVIRONMENT> -UPD <cha⇒

nge package> -SEARCHNAME <SYSTEM SEARCH NAME OR CUSTOMER SEARCH NAME> -PKGDESC <PAC⇒

KAGE DESCRIPTION> -EXONERR <Y or N>

or

changeassistant.bat -MODE UM -ACTION CPDEFINE -INI <path to ini file>

The parameters for CPCREATE action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

CPDEFINE =Define Change Package
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Parameter Description

-TGTENV Target environment (Required)

Example: -TGTENV H92CD540

-UPD Update ID of change package. (Required)]

Example: -UPD 11111

-SEARCHNAME Specify the System search name or customer search name. 
(Required)

Available system search names:

• MMC = All Updates Not Applied

• PO = All Critical Updates Not Applied

• IP = All Unapplied Updates for Installed Products

• POI= All Critical Unapplied Updates for Installed
Products

• TAX = All Tax Updates Not Applied

• TR= All True Requisites Not Applied

-PKGDESC Specify a Change Package description. (Optional)

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Creating Change Package
The action CPCREATE is used to upgrade to a new PeopleTools release using the command line.

Command line format:

changeassistant.bat -MODE UM -ACTION CPCREATE  -UPD <change package> -OUT <path to ⇒

log file>  -EXONERR <Y or N>

or

changeassistant.bat -MODE UM -ACTION CPCREATE -INI <path to ini file>
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The parameters for CPCREATE action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

CPCREATE =Create Change Package

-UPD Update ID of change package. (Required)]

Example: -UPD PTU854

-OUT Path to log file. (Optional)

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Applying PUM Updates
The action CPAPPLY is used to apply a change package that was created using PUM.

Command line format:

Changeassistant.bat -MODE UM -ACTION CPAPPLY -TGTENV <target database> -UPD <change⇒

 package> -TYPE <initial pass or move to production> -SYNCTYPE <y OR n> -OUT <log f⇒

ile directory> -WARNINGSOK <Yor N> -RESETJOB <Y or N> -EXONERR <launch GUI Y or N> ⇒

-RESUMEJOB [COMPLETECONTINUE|RESTARTCONTINUE| READYTORUNCONTINUE]

or

Changeassistant.bat -MODE UM -ACTION CPAPPLY -INI <path to ini file>

Example command line:

Changeassistant.bat -MODE UM -ACTION CPAPPLY  -TGTENV HC920001 – UPD PKG1

In this example the target database is named HC920001and the change package to apply is PKG1. All of
the other parameters will use the default.
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Parameter Description

-MODE Change Assistant mode (Required)

UM

-ACTION Change Assistant action (Required)

CPAPPLY = Apply Previously Created (non-PRP) Change
Package

-TGTENV Target database

-UPD The Change Package to apply. (Required)

Specify either all , a single or multiple Change Packages to
apply to the specified environment.

For example:

• -UPD all

• -UPD PKG1

• -UPD PKG1,PKG2

-TYPE Apply Type. (Optional)

• IP = Initial Pass (All steps) (default)

• MTP = Move to production

• IPSRC = Source only initial pass

• IPTGT = Target only initial pass

-SYNCTYPE Synchronize target metadata. (Optional)

• Y = Yes (default if type is IP)

• N = No (default if type is not IP)

-OUT Path of log file (Optional)

If the log directory is not specified it uses the default defined
under General Options.

-WARNINGSOK Proceed with apply even if warnings are found. (Optional)

• Y = Proceed with apply even if warnings are found. 
(default)

• N = Stop apply when warnings are encountered.
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Parameter Description

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-RESETJOB Specify whether or not to reset the job if the job fails the first
time it is run.

• Y = Delete existing job and create a new job

• N = Do NOT delete existing job and continue running the
existing job. (default)

-RESUMEJOB Specify the parameter value:

• COMPLETECONTINUE

To mark the first failed step or manual stop step to status
COMPLETED MANUALLY and continue the job.

• RESTARTCONTINUE

To mark the first failed step or manual stop step to status
RE-START and continue the job.

• READYTORUNCONTINUE

To mark the first failed step or manual stop step to status
READYTORUN and continue the job.

• WARNINGSREVIEWED

To retrieve and review the job which stopped with
warnings, and then set to status COMPLETED
MANUALLY.

This is similar to COMPLETECONTINUE resume
option.

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Applying Downloaded PRP to PeopleSoft Update Image
The action PRPAPPLY is used to apply a previously downloaded PRP to the PeopleSoft Update Image.

In order to apply a PRP from the command line, you must run 2 commands, first identify the PUM source
using the Options action and then apply the PRP.

1. This is an example of the command line to set the PUM environment.

Changeassistant.bat -MODE UM -ACTION OPTIONS -SRCYN Y -SRCENV HR92U016 -PUH D:⇒
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\psft\pt\pi_home\ -PIA http://machine.example.com:8000/ps/signon.html -OUT d:\⇒

temp\PRP.LOG -EXONERR Y

In this example, Configure PUM Source (SRCYN) is set to Y, the PUM Source database (-SRCENV)
is HR92U016 , the PI home directory (-PUH) is set to D:\psft\pt\pi_home\, the PIA URL (-PIA) is set
to http://edddr32p1.example.com:8000/ps/signon.html.

See the section on Command Line for Setting Options for additional details on setting General
Options.

2. This is an example for applying the PRP.

changeassistant.bat  -MODE UM -ACTION PRPAPPLY -UPD PRJ22534037

In this example the change package to apply is PRJ22534037 (name of the downloaded PRP change
package). All of the other parameters will use the default.

Command line format:

Changeassistant.bat -MODE UM -ACTION PRPAPPLY  –UPD <change package> -OUT <log file⇒

 directory> -WARNINGSOK <Y or N> -REPLACE <Y or N> -EXONERR <launch GUI Y or N> -RE⇒

SETJOB <Y or N>

or

Changeassistant.bat -MODE UM -ACTION PRPAPPLY -INI <path to ini file>

Parameter Description

-MODE Change Assistant mode (Required)

UM = Update Manager

-ACTION Action name (Required)

PRPAPPLY = Apply PRP

-UPD Update ID of Change Package to apply. (Required)

-OUT Path of log file (Optional)

If the log directory is not specified it uses the default defined
under General Options.

-WARNINGSOK Proceed with apply even if warnings are found. (Optional)

• Y = Proceed with apply even if warnings are found. 
(default)

• N = Stop apply when warnings are encountered.
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Parameter Description

-REPLACE Replace existing data if it exists (Optional)

• Y = Replace existing values if they exist. (default)

• N = Do not replace values if they exist

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-RESETJOB Specify whether or not to reset the job if the job fails the first
time it is run.

• Y = Delete existing job and create a new job

• N = Do NOT delete existing job and continue running the
existing job. (default)

-RESUMEJOB Specify the parameter value:

• COMPLETECONTINUE

To mark the first failed step or manual stop step to status
COMPLETE and continue the job.

• RESTARTCONTINUE

To mark the first failed step or manual stop step to status
RE-START and continue the job

• READYTORUNCONTINUE

To mark the first failed step or manual stop step to status
READYTORUN and continue the job

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Applying PeopleTools Patch
The action PTPAPPLY is used to apply a PeopleTools Patch using the command line.

Command line format:

Changeassistant.bat -MODE UM -ACTION PTPAPPLY -TGTENV <target database> -UPD <chang⇒

e package>
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or

Changeassistant.bat -MODE UM -ACTION PTPAPPLY -INI <path to ini file>

The parameters for applying a PeopleTools patch are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

PTPAPPLY =Apply PTP

-TGTENV Target environment (Required)

-UPD Update ID of change package. (Required)]

Example: -UPD PTP85401

-OUT Path to log file. (Optional)

-WARNINGSOK Proceed with apply even if warnings are found. (Optional)

• Y = Proceed with apply even if warnings are found. 
(default)

• N = Stop apply when warnings are encountered.

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-RESUMEJOB Specify the parameter value:

• COMPLETECONTINUE

To mark the first failed step or manual stop step to status
COMPLETE and continue the job.

• RESTARTCONTINUE

To mark the first failed step or manual stop step to status
RE-START and continue the job

• READYTORUNCONTINUE

To mark the first failed step or manual stop step to status
READYTORUN and continue the job
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Parameter Description

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Applying PeopleTools Upgrade
The action PTUAPPLY is used to upgrade to a new PeopleTools release using the command line.

Command line format:

changeassistant.bat -MODE UM -ACTION PTUAPPLY -TGTENV <target database> -UPD <chang⇒

e package> -OUT <path to log file> -WARNINGOK <Y or N> -EXONERR <Y or N>

or

changeassistant.bat -MODE UM -ACTION PTUAPPLY -INI <path to ini file>

The parameters for PTUAPPLY action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager

-ACTION Action name (Required)

PTUAPPLY=Apply PTU

-TGTENV Target environment (Required)

-UPD Update ID of change package. (Required)]

Example: -UPD PTU854

-OUT Path to log file. (Optional)

-WARNINGSOK Proceed with apply even if warnings are found. (Optional)

• Y = Proceed with apply even if warnings are found. 
(default)

• N = Stop apply when warnings are encountered.
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Parameter Description

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-RESUMEJOB Specify the parameter value:

• COMPLETECONTINUE

To mark the first failed step or manual stop step to status
COMPLETE and continue the job.

• RESTARTCONTINUE

To mark the first failed step or manual stop step to status
RE-START and continue the job

• READYTORUNCONTINUE

To mark the first failed step or manual stop step to status
READYTORUN and continue the job

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Applying Application Upgrade
The action UPGAPPLY is used to upgrade to 9.2 application release using the command line.

Command line format:

changeassistant.bat -MODE UM -ACTION UPGAPPLY -TGTENV <target database> -UPD <chang⇒

e package> -OUT <path to log file> -WARNINGOK <Y or N> -EXONERR <Y or N>

or

changeassistant.bat -MODE UM -ACTION UPGAPPLY -INI <path to ini file>

The parameters for PTUAPPLY action are:

Parameter Description

-MODE Change Assistant Action (Required)

UM = Update Manager
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Parameter Description

-ACTION Action name (Required)

UPGAPPLY=Apply PTU

-TGTENV Target environment (Required)

-UPGSRC Upgrade source environment (Required)

-UPD Update ID of change package. (Required)]

Example: -UPD HCM91TO92UPG

-RFU Required for upgrade change package (Optional)

• Y Yes (apply)

• N No(not apply)

-PTU PeopleTools upgrade change package (Optional)

Example: -PTU PTU856

-TYPE Apply Type. (Optional)

• IP = Initial Pass (All steps) (default)

• MTP = Move to production

• SP= Subsequent Pass

-SYNCTYPE Synchronize Target Metadata (Optional)

• Y Yes (default if type is IP)

• N No(default if type is not IP)

-OUT Path to log file. (Optional)

-WARNINGSOK Proceed with apply even if warnings are found. (Optional)

• Y = Proceed with apply even if warnings are found. 
(default)

• N = Stop apply when warnings are encountered.

-RESETJOB Reset Job Set before applying (Optional)

• RESETJOB Y = Reset Job Set before applying (default)

• RESETJOB N = Do Not Reset Job Set before applying
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Parameter Description

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-RESUMEJOB Specify the parameter value:

• COMPLETECONTINUE

To mark the first failed step or manual stop step to status
COMPLETE and continue the job.

• RESTARTCONTINUE

To mark the first failed step or manual stop step to status
RE-START and continue the job

• READYTORUNCONTINUE

To mark the first failed step or manual stop step to status
READYTORUN and continue the job

-FS Specify either the file servers or ini path.

File servers hostname#configPath (Optional)

• -FS all (default)

• -FS <hostname>#c:\pt8.53-102-r1

• -FS <hostname>#c:\pt8.53-102-r1; <hostname>#c:\pt8.
53-103-r1

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Applying Tools Delta Package
The action DLTAPPLY is used to apply a Tools Delta change package that was created using PUM.

Command line format:

Changeassistant.bat -MODE UM -ACTION DLTAPPLY -TGTENV <target database> -UPD <chang⇒

e package> -TYPE <initial pass or move to production> -SYNCTYPE <y OR n> -OUT <log ⇒

file directory> -WARNINGSOK <Yor N> -RESETJOB <Y or N> -EXONERR <launch GUI Y or N>⇒

 -RESUMEJOB [COMPLETECONTINUE|RESTARTCONTINUE| READYTORUNCONTINUE]
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or

Changeassistant.bat -MODE UM -ACTION DLTAPPLY -INI <path to ini file>

Example command line:

Changeassistant.bat -MODE UM -ACTION DLTAPPLY  -TGTENV HC920001 – UPD PKG1

In this example the target database is named HC920001and the change package to apply is PKG1. All of
the other parameters will use the default.

Parameter Description

-MODE Change Assistant mode (Required)

UM

-ACTION Change Assistant action (Required)

DLTAPPLY = Apply Tools Delta Change Package

-TGTENV Target database (Required)

Optional if TYPE is IPSRC

-UPD The Change Package to apply. (Required)

Specify either all , a single or multiple Change Packages to
apply to the specified environment.

For example:

• -UPD all

• -UPD PKG1

• -UPD PKG1,PKG2

-TYPE Apply Type. (Optional)

• IP = Initial Pass (All steps) (default)

• MTP = Move to production

• IPSRC = Source only initial pass

• IPTGT = Target only initial pass

-SYNCTYPE Synchronize target metadata. (Optional)

• Y = Yes (default if type is IP)

• N = No (default if type is not IP)
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Parameter Description

-OUT Path of log file (Optional)

If the log directory is not specified it uses the default defined
under General Options.

-WARNINGSOK Proceed with apply even if warnings are found. (Optional)

• Y = Proceed with apply even if warnings are found. 
(default)

• N = Stop apply when warnings are encountered.

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-RESETJOB Specify whether or not to reset the job if the job fails the first
time it is run.

• Y = Delete existing job and create a new job

• N = Do NOT delete existing job and continue running the
existing job. (default)

-RESUMEJOB Specify the parameter value:

• COMPLETECONTINUE

To mark the first failed step or manual stop step to status
COMPLETE and continue the job.

• RESTARTCONTINUE

To mark the first failed step or manual stop step to status
RE-START and continue the job

• READYTORUNCONTINUE

To mark the first failed step or manual stop step to status
READYTORUN and continue the job

-FS Specify either the file servers or ini path.

File servers hostname#configPath (Optional)

• -FS all (default)

• -FS slc06ejv#c:\pt8.53-102-r1

• -FS slc06ejv#c:\pt8.53-102-r1;slc08eyu#c:\pt8.53-103-r1
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Parameter Description

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Applying Translation Delta Package
The action DLTAPPLY is used to apply a Tools Delta change package that was created using PUM.

Command line format:

Changeassistant.bat -MODE UM -ACTION TDPAPPLY -TGTENV <target database> -UPD <chang⇒

e package> -TYPE <initial pass or move to production> -SYNCTYPE <y OR n> -OUT <log ⇒

file directory> -WARNINGSOK <Yor N> -RESETJOB <Y or N> -EXONERR <launch GUI Y or N>⇒

 -RESUMEJOB [COMPLETECONTINUE|RESTARTCONTINUE| READYTORUNCONTINUE]

or

Changeassistant.bat -MODE UM -ACTION TDPAPPLY -INI <path to ini file>

Example command line:

Changeassistant.bat -MODE UM -ACTION TDPAPPLY  -TGTENV HC920001 – UPD PKG1

In this example the target database is named HC920001and the change package to apply is PKG1. All of
the other parameters will use the default.

Parameter Description

-MODE Change Assistant mode (Required)

UM

-ACTION Change Assistant action (Required)

TDPAPPLY = Apply Translation Delta Change Package

-TGTENV Target database (Required)

Optional if TYPE is IPSRC
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Parameter Description

-UPD The Change Package to apply. (Required)

Specify either all , a single or multiple Change Packages to
apply to the specified environment.

For example:

• -UPD all

• -UPD PKG1

• -UPD PKG1,PKG2

-TYPE Apply Type. (Optional)

• IP = Initial Pass (All steps) (default)

• MTP = Move to production

• IPSRC = Source only initial pass

• IPTGT = Target only initial pass

-SYNCTYPE Synchronize target metadata. (Optional)

• Y = Yes (default if type is IP)

• N = No (default if type is not IP)

-OUT Path of log file (Optional)

If the log directory is not specified it uses the default defined
under General Options.

-WARNINGSOK Proceed with apply even if warnings are found. (Optional)

• Y = Proceed with apply even if warnings are found. 
(default)

• N = Stop apply when warnings are encountered.

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)
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Parameter Description

-RESETJOB Specify whether or not to reset the job if the job fails the first
time it is run.

• Y = Delete existing job and create a new job

• N = Do NOT delete existing job and continue running the
existing job. (default)

-RESUMEJOB Specify the parameter value:

• COMPLETECONTINUE

To mark the first failed step or manual stop step to status
COMPLETE and continue the job.

• RESTARTCONTINUE

To mark the first failed step or manual stop step to status
RE-START and continue the job

• READYTORUNCONTINUE

To mark the first failed step or manual stop step to status
READYTORUN and continue the job

-FS Specify either the file servers or ini path.

File servers hostname#configPath (Optional)

• -FS all (default)

• -FS slc06ejv#c:\pt8.53-102-r1

• -FS slc06ejv#c:\pt8.53-102-r1;slc08eyu#c:\pt8.53-103-r1

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Command Line for Applying Required for Upgrade Package
The action RFUAPPLY is used to apply a Tools Delta change package that was created using PUM.

Command line format:

Changeassistant.bat -MODE UM -ACTION RFUAPPLY -TGTENV <target database> -UPD <chang⇒

e package> -TYPE <initial pass or move to production> -SYNCTYPE <y OR n> -OUT <log ⇒

file directory> -WARNINGSOK <Yor N> -RESETJOB <Y or N> -EXONERR <launch GUI Y or N>⇒

 -RESUMEJOB [COMPLETECONTINUE|RESTARTCONTINUE| READYTORUNCONTINUE]
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or

Changeassistant.bat -MODE UM -ACTION RFUAPPLY -INI <path to ini file>

Example command line:

Changeassistant.bat -MODE UM -ACTION RFUAPPLY  -TGTENV HC920001 – UPD PKG1

In this example the target database is named HC920001and the change package to apply is PKG1. All of
the other parameters will use the default.

Parameter Description

-MODE Change Assistant mode (Required)

UM

-ACTION Change Assistant action (Required)

RFUAPPLY = Apply Required for Upgrade Change Package

-TGTENV Target database (Required)

Optional if TYPE is IPSRC

-UPD The Change Package to apply. (Required)

Specify either all , a single or multiple Change Packages to
apply to the specified environment.

For example:

• -UPD all

• -UPD PKG1

• -UPD PKG1,PKG2

-TYPE Apply Type. (Optional)

• IP = Initial Pass (All steps) (default)

• MTP = Move to production

• IPSRC = Source only initial pass

• IPTGT = Target only initial pass

-SYNCTYPE Synchronize target metadata. (Optional)

• Y = Yes (default if type is IP)

• N = No (default if type is not IP)
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Parameter Description

-OUT Path of log file (Optional)

If the log directory is not specified it uses the default defined
under General Options.

-WARNINGSOK Proceed with apply even if warnings are found. (Optional)

• Y = Proceed with apply even if warnings are found. 
(default)

• N = Stop apply when warnings are encountered.

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-RESETJOB Specify whether or not to reset the job if the job fails the first
time it is run.

• Y = Delete existing job and create a new job

• N = Do NOT delete existing job and continue running the
existing job. (default)

-RESUMEJOB Specify the parameter value:

• COMPLETECONTINUE

To mark the first failed step or manual stop step to status
COMPLETE and continue the job.

• RESTARTCONTINUE

To mark the first failed step or manual stop step to status
RE-START and continue the job

• READYTORUNCONTINUE

To mark the first failed step or manual stop step to status
READYTORUN and continue the job

-FS Specify either the file servers or ini path.

File servers hostname#configPath (Optional)

• -FS all (default)

• -FS slc06ejv#c:\pt8.53-102-r1

• -FS slc06ejv#c:\pt8.53-102-r1;slc08eyu#c:\pt8.53-103-r1

146  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 6 Running Change Assistant from Command Line

Parameter Description

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Constructing Command Line to Apply Traditional Updates (non-
PUM-enabled)

CPAPPLY (Apply Change Package) is the only action available for the mode AU (Apply Updates).

Command Line for Non-PUM Enabled Environments
For Non-PUM enabled environments (PeopleSoft Update Image is not available), use the following
command line format:

Changeassistant.bat -MODE AU -ACTION CPAPPLY -ENV <target database>  – UPD <change ⇒

package> -FS <file server> -CA <access id> -CAP <access password> -CO <user id> -CP⇒

 <user password> -DL <download directory> -BLD <manual or auto> -OUT <log file dire⇒

ctory> -EXONERR <launch GUI Y or N>

or

Changeassistant.bat -MODE AU -ACTION CPAPPLY -INI <path to ini file>

Note: EMF Agent must be running.

The parameters for CPAPPLY action are:

Parameter Description

-MODE Change Assistant Action (Required)

AU = Apply Updates

-ACTION Action name (Required)

CPAPPLY = Apply Change Package

-ENV Target database. (Required)
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Parameter Description

-UPD The Change Package to apply. (Required)

Specify either all , a single or multiple Change Packages to
apply to the specified environment.

For example:

• -UPD all

• -UPD PKG1

• -UPD PKG1,upd222222

-FS File Server path to apply the Change Package to the specific
environment. (Required)

Select either all or list a specific file server configuration path
in order.

For example:

• -FS all

• -FS c:\pt8.53

-FS c:\pt8.53,c:\pt8.53–903

-CA Access id for the environment. (Required)

-CAP Access password for the environment. (Required)

-CO User id for the environment. (Required)

-CP User password for the environment. (Required)

-DL Download directory for the environment. (Optional)

If the directory is not specified it uses the default defined
under General Options.

-BLD Specify whether to create the Build scripts and execute them
automatically or have the DBA run the scripts automatically. 
(Optional)

• 0 = Manual

• 1 = Automatically (default)

-OUT Path of log file (Optional)
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Parameter Description

-EXONERR Specify whether or not to launch GUI if an error or manual
stop is encountered. (Optional)

• Y = Do not Launch

• N= Launch (default)

-INI Path to ini file.

See Using a Configuration File with Changeassistant.bat

Constructing Command Line to View and Delete Merge Sessions

You can view active merge session details and delete the specified merge session along with the written
back version of objects.

This section discusses how to:

• View merge sessions.

• Delete merge sessions.

View Merge Sessions
You can list or view merge sessions of a configured PUM source database or a specific database
environment.

View Merge Sessions of Configured PUM Source

The GETMRGSESSN action lets you to list or view the merge sessions of all the configured PUM source
databases.

Command line format:

-MODE UM -ACTION GETMRGSESSN

Example command line:

Changeassistant.bat -MODE UM -ACTION GETMRGSESSN

Parameter Description

-MODE Change Assistant mode (Required)

UM
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Parameter Description

-ACTION Change Assistant action (Required)

GETMRGSESSN = Get Merge Session

View Merge Sessions of Specified Database Environment

When you provide database name along with the GETMRGSESSN action in the command line, Change
Assistant lists all the merge sessions of the specified database.

Command line format:

MODE UM -ACTION GETMRGSESSN –ENV <DATABASE_NAME>

Example command line:

Changeassistant.bat -MODE UM -ACTION GETMRGSESSN -ENV H92143SR

Parameter Description

-MODE Change Assistant mode (Required)

UM

-ACTION Change Assistant action (Required)

GETMRGSESSN = Get Merge Session

-ENV Specify the database.

Delete Merge Session
You can delete merge sessions from configured PUM source and any specific database.

Delete Merge Session from Configured PUM Source

The DELMRGSESSN action lets you to delete merge sessions of the configured PUM source database.

Command line format:

-MODE UM -ACTION DELMRGSESSN -SESSION <SESSION_NAME>

Example command line:

Changeassistant.bat -MODE UM -ACTION DELMRGSESSN -SESSION MRGOBJSQL

Change Assistant queries with the session name and deletes the merge session.
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Parameter Description

-MODE Change Assistant mode (Required)

UM

-ACTION Change Assistant action (Required)

DELMRGSESSN = Delete Merge Session

-SESSION Merge session name.

Delete Merge Session from Specified Environment

You can delete merge session from a specific database. When you provide session name and database
name, Change Assistant queries for the session in the specified database environment and deletes the
session.

Command line format:

-MODE UM -ACTION DELMRGSESSN -ENV <DATABASE_NAME> -SESSION <SESSION_NAME>

Example command line:

Changeassistant.bat -MODE UM -ACTION DELMRGSESSN -ENV H92143SR -SESSION MRGOBJSQL

Parameter Description

-MODE Change Assistant mode (Required)

UM

-ACTION Change Assistant action (Required)

DELMRGSESSN = Delete Merge Session

-ENV Specify the database.

-SESSION Merge session name.

Note that DELMRGSESSN and GETMRGSESSN throws error code 1, if:

• no PUM source is configured.

• the specified merge session does not exists.

• the specified database is a lower version than PeopleTools 8.60.
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Using a Configuration File with Changeassistant.bat

You can create a configuration file that contains the parameters and then run the command line using –INI
parameter which contains the path to the ini file. For example, if you created an ini file named config.ini
in the C:\temp folder, you would run the following command.

changeassistant.bat -INI C:\temp\config.ini

Note: For security reasons, the ini file is deleted immediately after CA has loaded the parameters.

The ini file needs to contain the General parameters and the parameters specific to the action.

Example ini File for Creating an Environment
[GENERAL]
MODE=UM
ACTION=ENVCREATE
OUT=d:\aaa.log
EXONERR=Y

[ENVCREATE]
TGTENV=T2D85501
CT=2
UNI=Y
CA=emdbo
CAP=password
CO=PTTRN
CP=password
CI=people
CW=password
CZYN=N
SQH=D:\psft\db\oracle-server\12.1.0.2\BIN\sqlplus.exe
INP=All
PL=PEOPLETOOLS
IND=ALL
INL=All
INBL=ENG
PSH=D:\PT8.55.04_Client_ORA
PAH=D:\PT8.55.04_Client_ORA
PCH=D:\PT8.55.04_Client_ORA
REPLACE=N

Example ini File for Creating a Change Package
[GENERAL]
MODE=UM
ACTION=CPCREATE
OUT=d:\CREATEPKG4.log
EXONERR=N

[CPCREATE]
UPD=PKG4
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Understanding Update Manager Action

Update Manager Action Overview

This section provides an overview of the Update Manager action.

Understanding Update Tools
This section describes the tools used in applying updates with the PeopleSoft Update Manager (PUM). In
a typical update process, you will use these tools to:

1. Locate, download, and install the PeopleSoft Update Image for your PeopleSoft application. This is
the PUM Source environment.

2. Set up a Microsoft Windows client with Change Assistant, PeopleTools client and database client
utilities for your environment.

3. Enable the Environment Management Framework on the target environment.

4. Configure Change Assistant with information about the source and target environments, and define a
new change package.

5. Use the PeopleSoft Update Manager PIA Application to search for updates and create a custom
change package.

See Quick Start for a list of steps and links.

PeopleSoft Update Image

PeopleSoft Update Images (PI) are fully functioning instances of the PeopleSoft environment made up of
PeopleSoft deployment packages (DPKs). The DPK downloads are available in the following versions:

• VirtualBox

This download to deploy the PeopleSoft Update Image using a VirtualBox Virtual Machine.

• NativeOS

This download is for Linux and Windows customers. This download allows you to apply your
PeopleSoft Update Image directly to your OS or a virtualization platform without having to use
VirtualBox.

Oracle delivers a complete and current PeopleSoft Update Image on a regular schedule for each
PeopleSoft application database instance, for example: FSCM, HCM. The delivery schedules and the PI
will be posted on My Oracle Support (MOS). Customers must download the image and deploy the image
locally before they can run Update Manager or create a custom change package.
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The most current PeopleSoft Update Image will be delivered on the most current PeopleTools release. It
is not necessary to upgrade PeopleTools on your target environment in order to use the current Image. The
PeopleSoft Update Image supports multiple releases.

Note: It is recommended that customers download PeopleSoft Update Images when they are available,
this will avoid the need to do a large download when a current image is needed to resolve a critical
production issue.

The PeopleSoft Update Manager Home Page(My Oracle Support, Document 1641843.2) is the central
location for all things related to PeopleSoft Update Manager (PUM) and PeopleSoft Update Images (PIs).

• Hardware and Software Requirements are available from the left-hand side of the PeopleSoft Update
Manager Home Page.

• The PeopleSoft Update Image Home Pages tab provides links for you to locate the PeopleSoft Image
and additional information for your application.

The Update Image Homepage for your application will contain links to all the relevant information for
the PI you are downloading. The Installation Documentation section on the page contains a link to the
installation documentation for the Image.

• The Best Practices provides information to help you plan for and determine the maintenance strategy
and best practices your organization.

See Installing PeopleSoft Update Image and Configuring the Microsoft Windows Client Running Change
Assistant.

Change Assistant

Install Change Assistant on the Microsoft Windows client machine. The Update Manager action in
Change Assistant is used to:

• Upload Target Database information to the PeopleSoft Update Image, including products and
maintenance logs. Once the database information is uploaded, the database will be available in
PeopleSoft Update Manager as a target database.

• Define a change package using standard search criteria or previously defined searches.

• Create a custom change package based on the change package definition created in PUM. Since
Change Assistant has all of the target database information, this custom change package is
automatically filtered for database platform and installed products.

• Apply updates to the target database.

• Create the reconciled or modified change package that can then be applied without compare into all
other customized environments, assuming these customized environments are at the same release/
patch level.

• Deploy updates to additional target environments using the reconciled change package.

• Update PeopleSoft Update Image with PeopleSoft Release Patchsets (PRP).

• Apply change package for PeopleTools patch.

• Apply change package for new PeopleTools release.
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• Apply application upgrade.

See Opening Change Assistant the First Time

Environment Management Framework (Optional)

Environment Management Framework (EMF) gathers and publishes configuration and setup information
about the file servers, the web servers, the application servers, the individual hosts, and the PeopleSoft
Process Scheduler servers that comprise your PeopleSoft system. Change Assistant uses the information
gathered by EMF to identify the available target databases when applying updates.

Configuring and running EMF is optional, EMF is only required to automate the file deploy process. If
EMF is not configured and running, you will need to deploy files manually when you apply an application
update.

See Configuring the Environment Management Hub

PeopleSoft Update Manager PIA Application

The PeopleSoft Update Manager PIA application runs on the PeopleSoft Update Image (PI) virtual
machine. The Update Manager Dashboard provides pivot grids to determine the current status of your
target databases and also provides folders with links to the Update Manger pages. The Define Change
Package folder contains links to wizards that will lead you through the process of selecting updates and
defining custom change packages for your environment. It provides a wide array of search options for
selecting the updates to apply to your environment. It lets you review the details of the changes for each
update before creating the change package definition, shows you what has already been applied to your
environment, and automatically includes requisite updates based on what you selected and what is already
applied to your environment.

Once the Target information has been uploaded to the PI, you can directly signon to the PI at any time to
search for updates and create change package definitions without using Change Assistant. However, when
you access Update Manager PIA application directly, the maintenance log details of that target will not be
updated. Target database details are updated when:

• The task Upload Target Database Information to PUM Source is run.

• The step SyncDatabaseInfoToPUMSource in the change package template is executed.

Note: This step is included in the change package if the option Synchronize Target Metadata
(Requires Source) is selected on the Change Package Settings page when applying the update.

Change Assistant is updated when:

• The database is defined.

• The step SyncDatabaseInfoToCA in the change package template is executed.

When you are ready to create and apply the change package, the change package definition will be
available from Change Assistant.

Understanding Update Manager Action
Update Manager Action includes the following actions:

Copyright © 1988, 2022, Oracle and/or its affiliates. 155



Understanding Update Manager Action Chapter 7

Validate Change Assistant EMF Settings

EMF is used with the Update Manager action to identify the file servers for your target environment. If
you configured the EM Hub option for your environment, use this to validate the EMF settings.

Upload Target Database Information to PUM Source

The Upload Target Database Information to PUM Source is used to upload the target database information
to the PeopleSoft Update Image, including products and maintenance logs. Once the database information
is uploaded, the database will be available in PeopleSoft Update Manager as a target database.

Note: In previous releases of Change Assistant, the target information was uploaded to the
PUM source when you were creating a new change package in Change Assistant or when the
PUMMaintenanceLogSync step was executed in Change Assistant. The PUMMaintenanceLogSync step
has been replaced by the steps SyncDatabaseInfoToPUMSource and SyncDatabaseInfoToCA.

Define Change Package

The Define Change Package option provides 2 options for defining a Change Package.

1. Use the link provided to open a browser session to the PeopleSoft Update Image database (PUM
source). Define change package definition using PeopleSoft Update Manager PIA application on the
PeopleSoft Update Image.

2. Use a standard or saved search to create the change package in Change Assistant.

See Defining Change Package

Create Change Package

The Create Change Package option is used to:

• Create the change package in Change Assistant.

• Apply the change package to the target database.

See Creating Change Package

Apply Change Package

The Apply Change Package option is used to:

• Apply the custom change package to a target environment.

• Apply custom change package to additional target environments.

See Applying Change Package

Apply Translation Delta Package

The Apply Translation Delta Package option is used to:

• Apply translation delta package to a target environment.
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• Apply translation delta package to additional target environments.

See Applying Translations Delta Package

Apply Downloaded PeopleSoft Release Patchset to PeopleSoft Image

The Apply Downloaded PeopleSoft Release Patchset to PeopleSoft Update Image is used to apply
PeopleSoft Release Patches (PRP) to the PeopleSoft Update Image.

See Applying Downloaded PeopleSoft Release Patchset to PeopleSoft Image

Upgrade to New Application Release

The Upgrade to New Application Release is used to upgrade to application 9.2.

Apply a Patch to Your Current PeopleTools Release

PeopleTools patches deliver fixes between PeopleTools minor releases. PeopleTools patches are posted to
My Oracle Support, as they become available. PeopleTools patches are cumulative. They include all fixes
from all previous patches for the specified release.

A PeopleTools patch contains the PeopleTools binaries and database changes. The database changes
are delivered in a change package located in the PS_HOME\PTP directory. The Apply a Patch to Your
Current PeopleTools Release option is used to apply this change package.

Upgrade to a New Release of PeopleTools

A PeopleTools upgrade consists of the new PeopleTools release and PeopleTools upgrade change package
that contains all the database changes. After installing the new release and downloading the upgrade
change package, this option is used to apply the upgrade change package.

Apply Tools Delta Package

The Apply Tools Delta Package option is used to:

• Apply the tools delta package to a target environment.

• Apply the tools delta package to additional target environments.

See Creating and Applying Tools Delta Package
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Setting Up the Client, Source, and Target
Environments

Installing PeopleSoft Update Image

To prepare your environment, you must install the PeopleSoft Update Image and configure the client
machine that runs PeopleSoft Change Assistant to communicate with the PI.

To install the PeopleSoft Update Image see PeopleSoft Deployment Packages for Update Images
Installation (PeopleSoft PeopleTools 8.5x)

Configuring the Microsoft Windows Client Running Change
Assistant

Change Assistant needs to be run from a Microsoft Windows client. It is highly recommended that you
dedicate a Microsoft Windows client machine that is not used for other PeopleSoft purposes for each
PeopleSoft Update Image (PI). It is necessary to configure this Microsoft Windows client machine
to access your target environment, as well as the PI. This setup is necessary for Change Assistant to
communicate with the PI and target databases in 2-tier mode in order to correctly install updates.

In setting up the Microsoft Windows client, be sure to review the software versions listed on the My
Oracle Support home page for the PI you are using, as these will impact your setup.

Note: This documentation uses "release/patch" to refer to the PeopleSoft PeopleTools release, for
example, 8.54, and patch number, for example 06. This release/patch example is written as 8.54.06.

The Microsoft Windows client needs to include:

• Oracle Database Client at a version level that is certified for the PeopleSoft PeopleTools release
included on the PI.

See My Oracle Support, Certifications

• Database Client for target database platform (if the target RDBMS is not Oracle).

• For a target database that is not Oracle, you must always install the database client for your
database platform.

• For a target database that is Oracle, it may be necessary to install a second Oracle Database Client
if the target database is not at the same PeopleTools release level as the PI.

For example, PeopleTools 8.53 uses a 32–bit client and PeopleTools 8.54 requires a 64–bit client.
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• PeopleTools Client for Oracle database platform at the same version level of the PI.

Note: The PeopleTools client will work with all your target databases that are on the same
PeopleTools release as the PI in carrying out PUM-enabled maintenance as long as the PeopleTools
client is installed from the tools_client shared drive. If your target database is on a different
PeopleTools release, you will need to install a second PeopleTools Client for that PeopleTools release.

• PeopleTools Client for target database platform at a version level supported by the PI.

Note: The supported PeopleTools client installer is available in the tools_client share. It is not
necessary to upgrade the target database to the supported PeopleTools release patch level. The target
database will work with the PeopleTools client.

• Change Assistant installed from the PS_HOME directory for the PeopleSoft Update Image on
the Microsoft Windows client. However if the target database is at a higher release level than the
PeopleSoft Image, then the latest tools version must be used to install Change Assistant. For example,
the customer upgrades the target database to 8.56 and the latest PeopleSoft Image is still on 8.55, the
customer must use Change Assistant 8.56 to apply updates.

Note: This use of PS_HOME refers to the location created by the client installation. You may need
more than one client PS_HOME location, when you configure the Microsoft Windows Client. This
documentation also uses "PS Home" in some cases to match the syntax on the Change Assistant UI.

After you install and initialize the PI, you access a shared drive which makes the folders from the image
accessible to the host (Microsoft Window OS).

From Windows Explorer access the virtual appliance file system from your Microsoft Windows host by
selecting Start, Run, and entering the Microsoft Windows UNC path containing your virtual machine IP
address.

This example illustrates the fields and controls on the Microsoft Windows Run dialog box with IP
address.

The shared drive includes 3 folders:

The <product>_pi_home folder contains all files needed for patching.

The <product>_app_home folder contains the application home for the PUM source.

The tools-client folder includes the following:
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• client-858

The client-858 folder includes a Readme file, a manifest with version information, archives, and
scripts for deployment of the PeopleSoft PeopleTools 8.58 client home folder.

• client-859

The client-859 folder includes a Readme file, a manifest with version information, archives, and
scripts for deployment of the PeopleSoft PeopleTools 8.59 client home folder.

• client-860

The client-860 folder includes a Readme file, a manifest with version information, archives, and
scripts for deployment of the PeopleSoft PeopleTools 8.60 client home folder.

• oracle-client

The oracle-client folder includes a Readme file, a manifest with version information, archives, and
scripts for deployment of the Oracle 19c database client home folder.

• SetupPTClient.bat — Interactive script that installs the PeopleSoft PeopleTools components such as
Application Designer and Change Assistant.

You supply information such as the PeopleSoft PeopleTools release and the RDBMS platform.

• source.properties — A text file that includes information required for the setup. Do not edit this file.
The information is supplied by the setup scripts.

• tnsnames.ora — Oracle database connectivity file. The file includes the information for the source
(PI) database.

Configuring the Microsoft Windows Client Configuration
You will use the SetupPTClient.bat file to configure the client. When you run the setup script, you will be
prompted for information about your environment.

For detailed information on the setting up the client see the PeopleSoft PeopleTools Deployment
Packages installation guide on the PeopleSoft PeopleTools Patches Home Page, My Oracle Support, Doc
ID 2062712.2.

The script uses the information you supplied and carries out the following validations and deployments:

• Oracle 19c database client for the Update Image source database (PI). The setup process determines
whether a 64-bit Oracle 19c database client is present on the Microsoft Windows client machine for
connectivity to the source database. If not, the setup process installs it.

• PeopleSoft PeopleTool 8.59 and 8.60 require 64-bit Oracle 19c. PeopleSoft PeopleTools 8.58, 8.57,
8.56, 8.55, and 8.54 require a 64-bit Oracle 12c Database Client installation. PeopleSoft PeopleTools
8.53 requires the 32-bit Oracle 12c database client.

• PeopleSoft PeopleTools Client for the source (PI). The source client tools are installed in C:
\Peoplesoft\PSHOME\Client<release_number>, where <release_number> refers to the PeopleSoft
PeopleTools release and patch, such as 8.58.03.
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• PeopleSoft PeopleTools Client for the target. The target client tools are installed in C:\Peoplesoft
\PSHOME\Client<release_number>, .where <release_number> refers to the PeopleSoft PeopleTools
release and patch, such as 8.57.14.

• Change Assistant installation Change Assistant is installed in C:\Program Files\Peoplesoft\Change
Assistant. If there is an earlier Change Assistant installation on the machine, the setup script removes
it.

Understanding the Microsoft Windows Client Configuration
After running the SetupPTClient, you will need to update the tnsnames.ora file located in your
oracle_home directory with the tnsnames entry from the tools_client folder. If your target database is also
Oracle, you will also need to add the target databases tnsnames entry. To update the tnsnames.ora file:

1. Open the tnsnames.ora file in the tools_client directory.

2. Copy the entry in the tnsnames.ora file to the tnsnames.ora file located in your oracle_home directory.

Depending on your installation, the location of the tnsnames.ora file in the oracle_home directory
will vary. If you installed the oracle client using SetupPTClient, the tnsnames.ora file is located in
oracle_home\network\admin\tnsnames.ora; for example:  C:\oracle\product\12.1.0\client_1\network
\admin\tnsnames.ora:

3. If your target database is on Oracle, copy the tnsnames entry for your target database into the
tnsnames.ora file.

The location of the tnsnames.ora file will vary depending on the Windows client installation. If
SetupPTClient detects an existing Oracle DB Client 12c with 64-bit installation, it will use that
version of Oracle Database, if SetupPTClient needs to install the DB Client 12c , the default location
is: C:\oracle\product\12.1.0\client_1.

The tnsnames entry for your target databases must use the SERVICE_NAME in order for your
PeopleTools or Change Assistant clients to connect to the PUM source database within the 12c
database server. This is an example of the entry:

PT855GA1 =
  (DESCRIPTION =
     (ADDRESS = (PROTOCOL = TCP)(HOST = hostname.domain)(PORT = 1521))
     (CONNECT_DATA =
      (SERVER = DEDICATED)
      (SERVICE_NAME = PT855GA1)
    )
  )

4. Save the file.

Microsoft Windows Client Configuration
This table describes the Microsoft Windows client installs and when it needs to be installed.

Microsoft Windows Client machine install When you need this install

Oracle database 64-bit client Always install for PUM source.
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Microsoft Windows Client machine install When you need this install

Enter the tnsnames entry into the tnsnames.ora file Always enter tnsnames entry for PUM source database.

If target database is on Oracle enter the tnsnames entry for the
target database.

PeopleTools 8.60 client Always install for PUM source.

PeopleTools 8.53 through 8.58 Install the PeopleTools client that matches the target
environment.

Note: If your target database is on a different release than the
PUM source, you will have 2 PS homes.

Oracle database 32-bit client Required if target environment is on PeopleTools 8.53.

Target database client environment

Set up database connectivity.

Required if target environment is not on Oracle.
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This diagram illustrates the relationship between the Microsoft Windows client running Change Assistant
and the PI when your target database is not Oracle.

When the target environment is not on Oracle database, you will always have 2 PS Homes and 2 database
clients (one for Oracle and one for the target database platform). The PS Home for the PUM Source
database will be on PeopleTools 8.60 and the Target PS Home will be on the same release as the target
database.

164  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 9

Using Update Manager Action

Selecting Update Manager Action

The Update Manager action is used to selectively apply updates (bug fixes, patches, enhancements or new
features) to your system. Before you can select this action, the following prerequisites must be configured
and installed.

1. Download the latest PeopleSoft Update Image (PI) from My Oracle Support and install it locally.

See PeopleSoft Update Manager Home Page [ID 1641843.2]

2. Configure the Microsoft Windows Client running Change Assistant.

See Installing PeopleSoft Update Image and Configuring the Microsoft Windows Client Running
Change Assistant

Setting Up Target Environment
To set up the target environment:

• Configure the Environment Management Framework (EMF) for your environment. (Optional)

EMF is required for the file deploy feature. This feature will automatically deploy files in change
packages to different servers.

Note: If Environment Management Framework is not configured, the file deploy steps will be
excluded from the change package and any files included in the change package will require manual
deployment.

Change Assistant 8.58 and later is compatible with EMF on all releases.

See Configuring an Environment Management Agent

• Start the EMF Agent on the target environment.

To verify that the EMF Agent is running, enter the hubURL into a browser. You should see a window
with a message similar to this: "Sending pulse from 'com.peoplsoft.emf.peer: id 1'"

See Running an Environment Management Agent

• Set user ID access.

In Change Assistant, the user ID for the target database needs to have Full data admin access
defined for Build/Data Admin on the Tools Permissions page for PeopleTools on one of the assigned
permission lists. With the Full data admin access permission assigned, Change Assistant has access to
all the build and copy options. Application Data Set (ADS) objects represent another security issue,
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because they contain actual rows of application data and there may be instances where this data is not
suitable for compare or copy. In order to compare and copy ADS definitions, the user ID must have
Full Access to compare and copy defined on the Copy Compare Permissions page for Data Migration
on one of the assigned permission lists.

See "Setting PeopleTools Permissions" (Security Administration) and "Setting Data Migration
Permissions" (Lifecycle Management Guide).

Starting Change Assistant
To start Change Assistant:

1. Select Start, Programs, PeopleSoft Change Assistant 8.6x.xx, where x.xx refers to the release/patch
number or use the Shortcut on the desktop.

2. Depending on your preferences, you may or may not see a Welcome dialog box. If the Welcome
dialog box is displayed, click Next.

The Select Action page is displayed.

This example illustrates the fields and controls on the Change Assistant Wizard - Select Action page.

3. Select Update Manager and click Next.

Note: You must select Update Manager for PUM-enabled maintenance.

Configuring Change Assistant for Update Manager
If this is the first time you are selecting Update Manager, the Wizard will guide you through the
environment setup. As you click Next you will complete the following pages:

Note: The Change Assistant instance installed from the PUM DPK will already be configured. See
Installing Change Assistant from PeopleSoft Update Image DPK

1. General Options

2. PUM Source Options
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3. EM Hub Options

4. Additional Options

5. Select Task

Note: After the environment has been configured, you can use Tools > Options to make any changes to
the environment options.
Change Assistant settings can be exported and imported, therefore the options only need to be set once.
See Exporting and Importing Change Assistant Settings.

Setting General Options
If Change Assistant was installed from the PeopleSoft Update Image DPK, this page will be populated
with the folders created as part of the install.

See Creating and Applying Change Packages

This example illustrates the fields and controls on the General Options page. You can find definitions for
the fields and controls later on this page.
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Field or Control Description

Maximum Concurrent Processes Specifies the maximum number of processes that can be
executed concurrently on the local machine. The default is 1.

PS Home Server TCP Port Range Specify the port range for PS Home server.

Change Assistant uses this port number to communicate with
Change Assistant PS Home servers. The default starting port
number is 6151. If you enter a port number that is already
in use, you see an error message. You must change to a port
number that is not in use, and then restart Change Assistant for
the change to take effect.

PS Home Server Maximum Instances Enter a number between 1 and 10 for the maximum number of
PS Home servers.

Use this value for environments with more than one PS_
HOME. For each server instance, Change Assistant increments
the PS Home Server Starting Port number by 1 up to the
maximum number of instances. For example, with a PS Home
Server Starting Port value of 6151 and a PS Home Server
Maximum Instances value of five, the port numbers would be
6151, 6152, 6153, 6154, and 6155. The default is 5.

If you change this value, you must restart Change Assistant for
the change to take effect.

Time Out for Locking(Seconds,Max=99999) Specify the time out for locking.

• Max value is 99999 = 27.8 hours

• Default value is 300 = 5 minutes

See Running Multiple Instances of Change Assistant

Data Mover Consolidation Maximum Script Limit The valid Limit range is [0, 15000].

0 and 1 mean there is no consolidation for data mover steps.

The default is 1000.

See Consolidating Data Mover Scripts

PS Home Enter the full path in which you installed PeopleTools client on
the Windows Client machine.

Note: Specify the PS_HOME location you used to install
Change Assistant.

Staging Directory Enter the directory in which you would like to stage all the
Change Assistant update files. This is the location that Change
Assistant will store files to be used during the apply update
process.
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Field or Control Description

Output Directory Enter the directory in which you want the log files generated
by the update process to reside.

Download Directory Enter the full path of the location to which you want to
download your change packages.

SQL Query Tool Select the correct executable for the database platform that
matches the PS_HOME defined for CA.

Note: The SQL Query tool must align with the installed
Change Assistant version.

This value is used as the default when creating databases. Each
database contains separate settings and therefore, you can
change this executable for a specific database.

Valid SQL query executables for each platform are:

• DB2: db2cmd.exe

• Microsoft SQL Server: sqlcmd.exe

• Oracle: sqlplus.exe

Note: Change Assistant uses the command line version of the .
exe, not the GUI version. For example, sqlplus.exe is used for
an Oracle database, rather than sqlplusw.exe.

Important! Oracle Database Customers: For systems running
on the Oracle database, by default, Change Assistant copies
the generated SQL script files to the location specified as the
TEMP User variable on the Environment Variables dialog box.
 So, on Oracle, the generated SQL script files will actually
exist in two locations: the specified Change Assistant output
directory, and the TEMP directory. This behavior is in place
because some versions of Oracle SQL Plus do not support
pathnames longer than 79 characters. It is recommended that
you ensure that the value specified for the TEMP User variable
is set to a path short enough so that the string comprising the
path and generated SQL file will not exceed 79 characters.

Setting PUM Source Options
The PUM Source Options page is used to define the PUM source as well as managing the Customization
Repository, Test Repository and Migrating Customer Data.

Note: When Change Assistant is installed as a part of the PeopleSoft Update Image DPK, the PUM
Source database is defined in Change Assistant.
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This example illustrates the fields and controls on the PUM Source Options page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Define PUM Source Select this checkbox to define the PUM Source.

Note: Not all Change Assistant actions require a PUM Source.

PUM Source Database If the database has already been defined, it will be available
from the drop-down list. After you select a database that has
already been configured, the database information on the
remainder of the page will be displayed in read-only mode.

If the database has not been defined yet, click Create which
will launch the Database Wizard.

See Defining Databases
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Field or Control Description

PUM(PI_HOME) Directory Enter the path to the pi_home share on the PI. The pi_home
share contains all files needed for patching.

Note: The drive is a path mapped to the pi_home share folder.

PUM Source PIA URL Enter the URL to sign on to the PUM Source.

PUM Source Additional Settings Select Install to install additional languages on the PUM
Source.

See Installing Additional Languages

Customization Repository This section is used to manage the Customization Repository.

See Creating Customization Repository.

Test Repository Select Manage to enable the Test Repository and upload tests
to the PUM source.

See Creating Test Repository.

Metadata Management Select Manage to migrate metadata from a previous PUM
Source.

See Migrating PUM Data.

When you click OK, Change Assistant will validate the connection to the PUM Source database.

Installing Additional Languages
To install additional languages on the PUM source, select the Install button.
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This example illustrates the fields and controls on the PUM Source Language Installation page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Select language to install based on existing database definition Select this radio button if you have defined a target database
that includes additional languages.

When you select the target environment, the installed
languages will be displayed.

Select languages manually Select this radio button to manually select the languages to
install.
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Setting EM Hub Options

EM Hub Options

Use this page to configure the EM Hub options for the target database.

This example illustrates the fields and controls on the Change Assistant - EM Hub Options page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Configure EMHub For Deploy File Select this checkbox if you want to use EMHub for file deploy.

Note: In order to use this option EMF must be configured and
running.

Server Host Name The hostname of the server in which the Environment
Management HUB resides.

Server Host Port Indicates the port in which to connect to the Environment
Management hub.
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Field or Control Description

Chunk Size Used for deploying files during a software update. Default is
1024 * 1024 bytes. Typically this does not need to be changed
unless there are a significant number of files greater that
1024KB in a software update.

Ping Interval Ping interval is in milliseconds for Change Assistant to contact
the hub for new messages.

Ping Click to verify a valid server URL. If you see Service is off to
the right of this button, then you must correct the server URL
and ping again until you see Service is on.

View Click to display the list of all PeopleSoft components
discovered and registered in the Environment Management
Hub.

Environment Management Hub Summary

When you click the View button, the Environment Manager Hub Summary page is displayed.
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This example illustrates the fields and controls on the Environment Management Hub Summary page.
You can find definitions for the fields and controls later on this page.

Field or Control Description

Environment(s) defined in Change Assistant If the database has been defined in Change Assistant, the grid
will display the Server, Host, App Home, PS Home, Cfg Home
and Release for each database that is discovered by EMF and
defined in Change Assistant.

Environment(s) not defined in Change Assistant If EM Hub is running and it discovers databases , that have not
yet been defined in Change Assistant, they will be listed.

File Server Summary Lists the file servers discovered by EM Hub.
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Setting Additional Options
This example illustrates the fields and controls on the Change Assistant - Additional Options page. You
can find definitions for the fields and controls later on this page.

Notification Settings Section

Field or Control Description

Send Email Notifications Select this check box to receive email notifications if there are
errors in the update process. Change Assistant also sends you
a completion message when it encounters a Stop in the update
process.

SMTP Server Enter the SMTP mail server from which you receive the error
or completion messages.

Port Enter the port from which you want to access the email.
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Field or Control Description

Send To Enter the address to which you want the email sent.

Return Address Enter the email address of the sender. Use this to identify who
sent the notification.

Test Validates that email is sent to the designated recipients and is
working correctly.

Note: Ensure that your SMTP server is installed and
configured correctly.

Proxy Section

Field or Control Description

Host (Optional) Enter the name of the proxy server if you want to
run Change Assistant behind the firewall using a proxy server.

Port (Optional) Enter the port number for the proxy server.

Anonymous Proxy Indicates that you are using a proxy server that does not
require authenticated connections.

Microsoft Proxy Server Indicates that you are using a proxy server with Windows
authentication.

Windows Domain The network domain in which the system runs.

Other Proxy Servers Indicates you are using non-Microsoft proxy servers.
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Select Task
This example illustrates the fields and controls on the Change Assistant Wizard - Select Task page. You
can find definitions for the fields and controls later on this page.

Depending on the options configured, some tasks may be not be enabled. For example if EM Hub is not
defined, Validate Change Assistant EM Settings will be grayed out.

Field or Control Description

Validate Change Assistant EMF Settings Select to validate the settings. Change Assistant validates
settings by:

• Locating valid SQL query tools required to run SQL
scripts.

• Testing the Environment hub and ensuring Change
Assistant can communicate with it.

See Validating Change Assistant EMF Settings

178  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 9 Using Update Manager Action

Field or Control Description

Upload Target Database Information to PUM Source Select to upload the target database information to the PUM
source database.

Once the database information is uploaded, the database
will be available in PeopleSoft Update Manager as a target
database.

See Uploading Target Database Information

Define Change Package Select to open the Wizard that will guide you through the
process of defining a change package. Change packages can
be defined using Update Manager Dashboard or Change
Assistant.

See Defining Change Package

Create Change Package Select to open the Wizard that will guide you through the
process of creating a change package based on defined change
package.

See Creating Change Package

Apply Change Package Select after the custom change package has been created to
apply the change package to your target database.

See Applying Change Package

Apply Downloaded PeopleSoft Release Patchset to PeopleSoft
Image

Select to apply a PRP to the PeopleSoft Update Image.

See Applying Downloaded PeopleSoft Release Patchset to
PeopleSoft Image

Upgrade to New Application Release Select to upgrade your target database to a new application
release.

See Upgrading Application

Apply a Patch to Your Current PeopleTools Release Select to apply a PeopleTools patch change package.

See Using Change Assistant to Apply PeopleTools Patch

Upgrade to a New Release of PeopleTools Select to apply a new release of PeopleTools change package.

See Using Change Assistant to Upgrade PeopleTools

Export/Import Change Assistant Settings Select to export or import Change Assistant Settings.

See Exporting and Importing Change Assistant Settings

From this page, you also have the ability to go directly to other pages by selecting the radio button on the
left:
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Field or Control Description

Welcome Page Select to go to the Welcome page.

Select Action Select to go to the Select Actions page.

General Select to go to the General Options page.

PUM Source Select to go to the PUM Source Options page.

EM Hub Options Select to go to the EM Hub Options page.

Additional Select to go to the Additional Options page.

Select Task This radio button is selected by default to lead you through the
wizard for the option selected on the right.

Validating Change Assistant EMF Settings
After you have set up and configured Change Assistant and the Environment Management components,
you should validate your Change Assistant and environment settings. To validate your environment:

1. Select the Validate Settings radio button.

2. Click Finish.

3. Click Start Validation.

When the validation is complete, a completion message appears. To view the log, click the View Log
button. The log will contain information about any steps that were not successful.

This example illustrates the fields and controls on the Validating Change Assistant Settings in Your
Environment dialog box
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Defining Target Database

The Define Database page is used to define all databases. See Defining Databases.

When defining the target database to use with PUM, make sure that the various PS homes are properly
configured based on your database platform and release.

Important! You only need to define the database once. When you install a new instance of Change
Assistant the existing settings can be maintained. See Exporting and Importing Change Assistant Settings.

PS Home
PS Home needs to be set to the PeopleTools release/patch for your target database.

When you set up your windows environment, you may have installed 2 PS Homes. One for Oracle on the
PUM image release/patch, which is used for the PUM Source PS Home and one for your target database
platform at the supported release/patch level for your target environment. Make sure you select the PS
Home for your target environment.

PS App Home
PS App Home is the location where you installed your PeopleSoft application files for your target
environment. If you needed to install a new PS Home to use with the PUM image, it will not contain your
application files. Make sure you select the path where your application files reside.

PS Cust Home
If you are using PS_CUST_HOME (PeopleSoft Customization Home) to identify and store your site's
customized files, you need to specify the path PS Cust Home.

Uploading Target Database Information

In order to use the Update Manager actions, the PUM Source must contain all of the information about
your target database. The upload may take several minutes. This information includes:

• Database name

• Database user defined in Change Assistant for this database.

Note: Change Packages are associated with both database and user ID. The user ID on the target
database must match the user ID used to signon to the PUM source in PIA when you create a define a
change package.

• Products

• Languages
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Note: If you have multiple target databases with different languages, you will need to install separate
PeopleSoft Update Images for each language combination.

To upload the target database information:

1. In Change Assistant, select Tools, Change Actions.

2. Select Update Manager and click Next.

3. Select Upload Target Database Information to PUM Source and click Finish.

Note: The PUM Source must be defined before this option is available to select.

4. Select or Create the target database to upload.

This example illustrates the fields and controls on the Upload Target Database Information to PUM
Source page. You can find definitions for the fields and controls later on this page.

Field or Control Description

Target Database Select an existing target database or create a new target
database using the Create button.

See Defining Databases

Upload Target Database Information to PUM source This check box is always selected and read only. This option
upload the target database information to the PUM Source.

Update Target Database Information in Change Assistant
Environment

This check box is always selected and read only. This option
updates Change Assistant with the target database information.

Proceed to Define New Change Package Wizard after Target
Information Upload

Select this check box to open the Define a New Change
Package Wizard after target information is uploaded.
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Note: After upgrading the target database tools release, it is necessary to update the target database in
Change Assistant and upload the upgraded target database information to the PeopleSoft Update Image
database. In Change Assistant, select File, Open Database and update the target database. After updating
the target database, select Tools, Upload Target Database Information to PUM Source.

Defining Change Package

In order to define a new change package, the following steps must be completed:

• PUM Source Database defined.

• Target Database defined.

• Target Database uploaded to the PUM Source.

See Selecting Update Manager Action

Use the Define Change Package action to create the change package definition. Change packages can be
created using Update Manager Dashboard or Change Assistant.

To define a new change package:

1. In Change Assistant, select the Update Manager action.

The Update Manager action is available from:

• The menu by selecting Tools, Change Actions.

• Clicking Next on the Welcome page.

2. Select Define Change Package and click Finish.
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This example illustrates the fields and controls on the Define Change Package. You can find definitions
for the fields and controls later on this page.

Select the method to use for creating the Change package.

Defining a New Change Package in Update Manager Dashboard
Select the Click Here to Open Browser and Connect to PUM Source Database button to define the change
package in PIA.

Use the PeopleSoft PIA application to create the change package definition. See Defining Update Change
Packages

Defining a New Change Package in Change Assistant
Standard search options are available for common use cases. Customers also have the option to create
their own commonly used search criteria.
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This example illustrates the fields and controls on the Define a New Change Package in Change Assistant
page. You can find definitions for the fields and controls later on this page.

Field or Control Description

Target Database Select the target database.

Package Name Enter a package name.

Package Description Enter a package description. (Optional)

Search Definition Option Select the type of search definition.

• Standard System Search Criteria

When you click Next, the standard system searches will
be displayed.

• Previously Defined Search Criteria

When you click Next, your previously defined searches
will be displayed.

Standard Search Options

The same standard system search options available from the Update Manager Dashboard are available in
Change Assistant. These include:

• All Unapplied Updates for Installed Products

• All Critical Unapplied Updates for Installed Products
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• All Critical Updates Not Applied

• All Tax Updates Not Applied

• All True Requisites Not Applied

• All Updates Not Applied

Previously Defined Search Criteria

If you select Previously Defined Search Criteria and click Next, the list will include all Change Package
definitions with a status of Complete in the PUM source database.

This example illustrates the fields and controls on the Previously Defined Search Criteria page.

Select the checkbox if you want to proceed to create the change package when the package is defined.
Click either Finish or Next (if you selected to proceed to create change package) to define the change
package.

Creating Change Package

Use the Create Change Package action to create the change package in Change Assistant. The Change
Package definition must have a status of complete in order for it to be available in Change Assistant.

To create a change package:

1. In Change Assistant, select the Update Manager action.
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The Update Manager action is available from:

• The menu by selecting Tools, Change Actions.

• Clicking Next on the Welcome page.

2. Select Create Change Package and click Finish.

3. Select the change package to create and click Finish.

The Change Package Wizard will generate the change package. When the package is created you will
receive a message indicating the change package was successfully created.

This example illustrates the fields and controls on the Create a New Change Package page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Download Directory Select the download directory to use for this change package.
 The default is the download directory defined on the Options
page.

Change Package Select the change package from the drop down of available
change package definitions.

Proceed to Apply Change Package Wizard after Package
Creation

Select this check box to proceed to the Apply Change Package
Wizard when the package is created.

From PeopleTools 8.60, Change Assistant exports minimal Managed Object (MO) project that is
sufficient for the change package create process.

The entire MO project is exported during the change package apply process as the source apply step.
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This is applicable to the package types RFU, PUM, DLT, TDP, and UPG available in the Update Manager
mode.
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Using PUM Automated Updates

Understanding PUM Automated Updates

Customers can configure Update Manager to automatically download Application Update Image DPKs,
PRPs, apply the PRPs, define and create change packages, as well as apply the source only steps.

See Installing Change Assistant from PeopleSoft Update Image DPK and PeopleSoft Deployment
Packages for Update Images Installation (PeopleSoft PeopleTools 8.60).

The Update Manager Homepage provides the tiles to set up automations and schedule updates.

This example illustrates the fields and controls on the Update Manager Homepage. You can find
definitions for the fields and controls later on this page.

Term Definition

Update Settings Select this tile to view or modify MOS credentials,
 notifications and settings.

See Setting Credentials for Automation.

Update Scheduler Select this tile to define and schedule jobs.

See Scheduling Update Jobs.
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Term Definition

Download Repository Select this to view downloads.

See Viewing Download Repository

Customization Repository Select this tile to manage customizations when selecting
updates in the PUM Search.

Administer Metadata Select this tile to define and manage databases using Update
Manager.

Usage Repository Select this tile to fetch usage monitor data from different
databases.

Setting Credentials for Automation

The Update Settings component contains 3 pages:

• Settings

• Notifications

• Subscription

Setting Credentials
Automation requires the proper credentials. MOS credentials are necessary to download the PRPs
from My Oracle Support (MOS) and must be entered by the customer. The Image and REST services
credentials are auto-updated during DPK installation, these credentials can be added or modified as
necessary. The REST credentials will be used by the Download Manager to communicate the status of
PRPs downloads.

Note that PAU uses OAuth 2.0 for authentication.

Use the Settings page to review and enter credentials.

This example illustrates the fields and controls on the Settings page for MOS Credentials. You can find
definitions for the fields and controls later on this page.
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These MOS credentials are used to connect to MOS, while downloading PRPs from MOS. When the page
is saved, the system will validate connectivity to MOS using the credentials, encrypt the credentials and
save to the database.

Field or Control Description

User ID Enter the user ID for your My Oracle Support account.

Password Enter the password for your My Oracle Support account.

This example illustrates the fields and controls on the Image Credentials section. You can find definitions
for the fields and controls later on this page.

Initially these credentials are provided from the DPK when the PUM environment is deployed, then
through the Automated Configuration Manager (ACM).

These credentials need to be updated if they are changed in the PUM source. All credentials are encrypted
before storing in the database.

Field or Control Description

DB User ID Database User ID.

DB Password Database password.

Connect ID Connect Id for the database.

Connect Password Connect ID password.

Access ID Access Id for the database.

Access Password Access ID password

DB Admin ID Database Administrator ID.
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Field or Control Description

DB Admin Password Database Administrator ID password.

This example illustrates the fields and controls on the REST Service Credentials. You can find definitions
for the fields and controls later on this page.

Initially these credentials are provided from the DPK when the PUM environment is deployed, then
through the Automated Configuration Manager (ACM).

These credentials need to be updated if the REST Service credentials are changed in the PUM source.

REST Services are used by the Download Manager that downloads PRPs to communicate status of
downloads. The user ID must have permission list PTPT4300.

Viewing Notifications
Use the Notifications page to set up preferences for notifications.

This example illustrates the fields and controls on the Navigations page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Distribution ID Type Select User or Role.

Distribution ID Enter the User ID or role name.

On Initiation Select Yes to be notified when an automated update job is
initiated.

192  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 10 Using PUM Automated Updates

Field or Control Description

On Success Select Yes to be notified when an automated update job runs to
success.

On Failure Select Yes to be notified when an automated update job fails.

Email Notification Select to send email notifications.

Note: For details, see Email Details

If Email Notification is selected, enter the SMTP details:

This example illustrates the fields and controls on the Email details section. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Server Name Enter the SMTP mail server from which you receive the error
or completion messages.

Port Number Enter the port from which you want to access the email.

Connection Security Select the connection security.

SSL/TLS type connection

User Name Enter the user name to log in to the SMTP server.

Password Enter password for SMTP user name.

Email To Enter the email address.

Email CC Enter the email address.
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Field or Control Description

On Initiation Select Yes to send an email when an automated update job is
initiated.

On Success Select Yes to send an email when an automated update job
runs to success.

ON Failure Select Yes to send an email when an automated update job
fails.

Email Details

The email notification for tasks, such as, Download PRPs from MOS or Apply PRPs to PUM Source,
contains all relevant details.

Task Details

Download PRPs from MOS or Apply PRP to PUM Source Displays the:

• PRP name, description and download time.

• Link to the Job Monitor page.

• Link to the PRP Details page that has details of all PRPs
downloaded or applied.

When user runs Download and Apply PRP in one PAU job,
 it sends two emails with list of PRPs downloaded and PRPs
applied.

Define Change Package/ Create Package Displays the:

• Change Package name, database name, search scope, and
search name.

• Link to the Job Monitor page.

Apply Change Package Displays the success or failure status and link to the Job
Monitor page.
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This example illustrates the fields and controls on the PRP Details page.

Viewing Subscriptions
The subscriptions page displays the default channel information corresponding to the deployed
PeopleSoft Image.

This example illustrates the fields and controls on the Subscriptions page.

Scheduling Update Jobs

From the Update Manager Homepage, select the Update Scheduler tile.

The first time you access the Manage jobs page no jobs will be defined. Use the Define Job button to
define jobs. See Defining Jobs.

This example illustrates the fields and controls on the Manage Jobs when no jobs have been defined.

After job have been defined and scheduled or run, the Manage Jobs page will display the Job Status.
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This example illustrates the fields and controls on the Manage Jobs page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Actions Actions include:

• Delete

Select to delete a job.

• Run

Select to run a job.

• Resume

Select to resume a failed job or after a manual stop.

• History

Select to review the job history.

> Use the > icon to view the Job Monitor.

The Job Monitor can also be accessed by clicking the row.

For details, refer Viewing Job Monitor

Defining Jobs
Select the Define Job button on the Manage Jobs page to define a new PAU job.
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This example illustrates the fields and controls on the Define Job page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Name Enter a job name.

Type Select the job type:

• Ad hoc

The job can be triggered from the Define Job page or the
Manage Jobs page.

• Scheduled

The job will run at the scheduled time. You can set a
recurrence schedule.

Note: Scheduled Jobs cannot be run on an ad hoc basis
through the Managed Jobs page. In case of failure or
manual stop, the job can be resumed but not run on an ad
hoc basis.

Download Application Update Image Select Yes to download Application Update Image DPKs.

Starting with PeopleTools 8.60, customers can download an
Application Update Image DPKs from the Update Manager 
(Define Job) page.

Customer will be able to download Application Update Image
DPK based on the application pillar environment in use. For
example, you can schedule or download HCM Application
Update Image DPKs from an HCM PUM source.

Note: You can continue to download Application Update
Image DPKs manually from My Oracle Support or Oracle
Software Delivery Cloud as in previous releases.

For more details, refer Downloading Application Update
Image DPKs
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Field or Control Description

Download PRPs from MOS Select Yes to download PRPs from MOS.

Note: The Download Manager validates each PRP before
downloading and ignore PRPs that are incompatible with the
currently installed PeopleSoft Image.

Apply PRPs to PUM Source Select Yes to Apply PRPs to PUM Source.

Define Change Package Select Yes to Define Change package using Previously
Defined or Standard System search criteria.

See Defining Change Package.

Create Package Select Yes to create the defined change package.

Apply CP (IP: Source Only Steps) Select Yes to apply the source only steps.

The Source Steps Only option runs the initial pass on the PUM
source and creates all files that are contained in the change
package. Once the initial pass has completed, a modified
change package is created that contains all the files. The
modified update change package can then applied to the target
database using the Target Only option.

Scheduling Jobs
On the Define Job page, select Type: Scheduled.

This example illustrates the fields and controls on the Defining Scheduled Job. You can find definitions
for the fields and controls later on this page.
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Field or Control Description

Type Scheduled

Run Date Select the date and time to run the job.

Recurrence Use this option to set up the job on a recurring schedule. Select
the recurrence name from the drop down list.

To add a new recurrence definition see "Defining Recurrence
Definitions" (Process Scheduler)

Downloading Application Update Image DPKs
On the Define Job page, select Download Application Update Image.

You can run a job for this Download Application Update Image task on an ad hoc or scheduled basis.

Note: The Download Application Update Image task cannot be combined with other tasks, such as,
Create Package. It requires a separate job to run.

This example illustrates the fields and controls to download Application Update Image DPK.

Field Description

Image for Virtual box, Image for Windows, Image for Linux The three types of Application DPKs or Update Image patch
sets that is available for download.
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Field Description

File Directory Specify the directory to download the DPK. It can be any
relevant path in Process Scheduler to which PAU has access.

It can be a local path or network path (Windows or Linux
machine).

This directory is validated to check if sufficient space is
available on file system for the current download job.

Note that when any PAU job runs, the other PAU jobs, such as download or apply PRP and create or
define Change Package, are in queue.

Defining Change Package
When you select to Define a Change Package, you will need to enter additional information.

After you Save the job, you can run the job directly from this page using the Run button.

This example illustrates the fields and controls on the Define Job page for defining a change package
PAU job.

Field or Control Description

Package Name Enter a name for the change package.

Package Suffix Select a suffix, choices are:

• Date(yyyymmdd)

• Date(yymmdd)

Package Description Optionally add a description.
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Field or Control Description

Target DB Select the target database from the drop down list.

Select the Search Scope Search Scope choices are:

• Previously Defined

• Standard System

Search Name Select the search name from the drop down list.

Creating and Applying Change Packages
You can define a change package and create the change package in different PAU jobs. These two jobs are
completely independent.

Prior to PeopleTools 8.60, you had to define and create change packages in a single job.

Use the Create Package task in PAU job to create change packages that are either defined in the Define
Change Package wizard in the Update Manager tile or in the PAU job.

This example illustrates the fields and controls to search for the change packages defined in Update
Manager tile or in the PAU job.

Select the Apply CP (Source Only Steps) option, to apply the change package created. This option applies
only the source only steps.

Viewing Job History
Select the History action from the Manage Jobs page to view the job history.
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This example illustrates the fields and controls on the Job History page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Status There are two status fields.

Job level status- Displays the current status of the job. The
status can be COMPLETED only when the all the activities
within the job has a COMPLETED status.

Activity level status- Displays the status of an activity in the
job.

Select to view the job template detail.

This template appears only for Apply Change Package and
Apply PRP tasks.

Select to view the job log for the activity.

Download Logs Select to download the logs.

Viewing Job Monitor
Use the Job Monitor to monitor the status of job activities, logs, and download logs.

To view the Job Monitor, from the on the Manage Jobs page either click the row for the job or use the >
icon.
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This example illustrates the fields and controls on the Job Monitor page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Select to view the job template.

Select to view the job log.

Download Logs Select to download a zip file which includes all the logs for the
job.

This example illustrates the fields and controls on the Job Detail Template. You can find definitions for
the fields and controls later on this page.

The list of chapters, tasks and steps are listed on the left hand side of the page. Select the chapter, task or
step to view.
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Resuming a Job
Select the Resume button on the Job Monitor page to resume a job.

You can resume a job:

• If the job encounters a manual stop.

• If a PRP fails with 'Applied with Warnings' status.

If the job encounters a manual stop, the user must mark the step as complete and continue to run the job.

If the job fails for on a step in the template, the user can select to either Mark the step as manually
complete and continue to run the job or Mark the step to restart and continue to run the job.

This example illustrates the fields and controls on the Resume Job. You can find definitions for the fields
and controls later on this page.

Sometimes a PRP fails when a job stops with the 'Applied with warnings' status. Review the warnings to
fix the issue and resume to apply the PRP from the Job Monitor page.

Viewing Download Repository

From the Upgrade Manager Homepage, select the Download Repository tile to view the downloaded
PRPs.
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This example illustrates the fields and controls on the Download Repository page.

Click on a row or use the > icon to view the PRP details. Details will list the bugs and patch files included
in the PRP.

This example illustrates the fields and controls on the PRP Details page.
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Using Update Manager Dashboard

Update Manager Dashboard Overview

The Update Manager Dashboard provides a central location for all update tasks. The dashboard provides
analytics for PUM (PeopleSoft Update Manager) that assist in determining your current level of
maintenance. The various pivot grids provided on the dashboard, provide access into the maintenance
logs and bug information for each database uploaded to the PeopleSoft Update Image. After drilling down
onto a specific pivot grid, you can select bugs to include in a change package.

This example illustrates the fields and controls on the Update Manager Dashboard. You can find
definitions for the fields and controls later on this page.

See Using PeopleSoft Update Manager (PUM) Analytics

The left navigation pane of the Update Manager Dashboard provides links to Update Manager features
and pages. When you select a link from the left navigation pane, the corresponding page appears in the
target content area. The following folders make up the Update Manager Dashboard.
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Folders Description

Select Target Database This folder contains a list of all the target database that have
been uploaded to the PUM Source. When you select a database
Push Notifications is used to refresh the Pivot Grid tiles in the
dashboard.

See Using PeopleSoft Update Manager (PUM) Analytics

Define Change Package This folder contains links to the various types of change
packages.

See Defining Change Package

Integrate With CFO Tool This folder contains the steps to integrate with the CFO tool.

See Integrating with Cumulative Feature Overview (CFO)
Tool

Change Package Utilities This folder contains links to Change Package utilities.

See Using Change Package Utilities

Test Repository This folder contains links to the tasks necessary for managing
test repository.

See Understanding Test Repository

About PeopleSoft Image Use the About PeopleSoft Image page to display information
about the PeopleSoft Image.

Information for working with and customizing Dashboards is provided elsewhere in PeopleTools product
documentation. See the product documentation for PeopleTools 8.59: Using PeopleSoft Applications

About PeopleSoft Image
Use the About PeopleSoft Image page to display information about the PeopleSoft Image.

Navigation:

Select PeopleTools >Lifecycle Tools >Update Manager > About This PeopleSoft Image
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This example illustrates the fields and controls on the About PeopleSoft Image page.

Using PeopleSoft Update Manager (PUM) Analytics

The Update Manager Dashboard provides analytics for PUM (PeopleSoft Update Manager) that assist
in determining your current level of maintenance. The Update Manager Dashboard is available on the
PeopleSoft Update Image. The various pivot grids provided on the dashboard, provide access into the
maintenance logs and bug information for each database uploaded to the PeopleSoft Update Image.

By default the Update Manager Dashboard has twelve tiles with the following pivot grids:

1. Database Bug Status

2. Bug Percent by Tag

3. Bug Percent by Image

4. Bugs by Product

5. Enhancements by Image

6. Enhancements by Prod

7. Enhcmnt by Min Tools

8. Applied Bugs by Image

9. Bugs by Language

10. Bugs by Image From

11. Bugs by Dependency
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12. Customization Impacts

Bugs are categorized by into four distinct groups:

• Applied Bug Fixes for installed products

All bug fixes that have been applied to the target database for installed products.

• Applied Bug Fixes for non-installed products

All bug fixes that have been applied to the target database for non-installed products.

• Unapplied Bug Fixes for installed products

Use the unapplied bug fixes for installed products to determine how far behind the target database is
compared to the current PeopleSoft Update Image. If there are no unapplied bug fixes for installed
products, the target database is current.

• Unapplied Bug Fixes for non-installed products

Unapplied bug fixes for non-installed products will not have any effect on target database.

Reviewing Bugs and Enhancements Using the Pivot Grid

Displaying Analytics

To display analytics for a specific target database and pivot grid:

1. Expand the Select Target Database folder and click the link for the database to display.

2. Click on one of the pivot grid tiles to open Pivot Grid Viewer.

3. Use the Show Filters icon to display the available filters on the left-hand side of the pivot grid.

4. The grid showing the bugs that match the filter criteria is displayed.

Applying Filters

Use the Show Filters icon to display the available filters on the left-hand side of the pivot grid. Once you
select a filter, the pivot grid will be refreshed with the current filters. The following filters are available
for the pivot grids:

• Bug Status

Applied or Unapplied

• Image

• Bug Severity

• Product

• Product Installed

• Component
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• Sub Component

Reviewing the Grid

Once you open a pivot grid and apply the filters, all of the bugs meeting the specified criteria are
displayed with the following columns:

• Action check box

• Database

• Bugs

• Image Number

• Subject

• Bug Severity

• Bug Status

• Product Name

• Product Installed

• Bug Type

• Component

• Sub Component

• Posted date

Certain pivot grids have additional columns:

• Database Bugs by Tags includes columns for Tag Name and Tag Value.

• Enhancements by Minimum Tools includes a column for Minimum Tools.

• Applied Bugs by Image Lag includes a column for Image Lag.

This example illustrates the fields and controls on the grid. You can find definitions for the fields and
controls later on this page.
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Field or Control Description

Actions After selecting bugs, by checking the Actions column in the
grid, use the Actions drop down to select Add to Change
Package.

Select All Click this button to select all bugs.

Clear All Click this button to clear all bugs.

Creating a Change Package From the Pivot Grid
To use the pivot grid to select bugs for your change package:

1. Double-click the pivot grid.

2. Set the filters to use.

You may want to include the filter for Unapplied.

3. Review the bugs listed in the grid and select the Action check box for the bugs you want to include in
your Change Package.

This example illustrates bugs selected to add to a change package.

4. Click the Actions drop down and select Add to Change Package.

5. The Enter Change Package Name page is displayed.
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This example illustrates the fields and controls on the Enter Change Package Name. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Action By default the action is Create. If you want to add the bugs
to an existing Change Package that has not been applied,
 select Edit.

Name Enter a name for the change package. If the action is Edit,
 select an existing package.

Description Enter a description.

6. Click Next.

7. The change package wizard will open on Step 6 of 6.

See Define Update Package Wizard Step 6 of 6.

Database Bug Status
This pivot grid displays the status of all installed products. Use the filters to determine what bugs need to
be applied.
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This example illustrates the fields and controls on the Database Bug Status pivot grid. This example
displays the pivot grid filtered by Installed products and Complete Loss of Service.

Bugs by Product
This pivot grid displays the status of all installed products. Use the filters to determine what bugs need to
be applied.
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This example illustrates the fields and controls on the Bugs by Product. In this example the filter was
changed to show unapplied bugs.

Database Bugs by Tags
This pivot grid displays bug status by tag. Tag types will vary depending on the application. Use the
filters to narrow down the search.
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This example illustrates the fields and controls on the Database Bugs by Tags. This example id filtered by
unapplied..

Bugs by Image
This pivot grid displays the bug status by Image, which can be used to track your maintenance strategy.

This example illustrates the fields and controls on the Bugs by Image. This example shows a database that
is current through image 31.

Note: When filtering the Bug Status by Image pivot grid, select only one Product Status at a time.
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Enhancements by Image
This pivot grid displays the enhancements (and no bugs) by Image, which can be used to determine which
enhancements have been applied and which enhancements you would like to apply.

This example illustrates the fields and controls on the Enhancements by Image pivot grid filtered by
product and installed..

Enhancements by Product
This pivot grid displays the enhancements (and no bugs) by product, which can be used to determine
which enhancements for a product have been applied and which enhancements you would like to apply.
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This example illustrates the fields and controls on the Enhancements by Product.

Enhancements by Minimum Tools
This pivot grid displays the enhancements (and no bugs) that are available based on PeopleTools release
for the target environment.. Use this pivot grid to determine which enhancements you can apply to your
current target database, as well as what enhancements are available when you upgrade to a newer version
of PeopleTools.

This example illustrates the fields and controls on the Enhancements by Minimum Tools for a target
database that is on 8.56.09.
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Applied Bugs by Lag Image
This pivot grid describes the relative time to apply fixes in the system. This analytic shows the difference
between when the change is delivered versus when the change is applied. If a bug is delivered in PI 15
and the customer applies the bug in PI 15, then it is 0. If the customer does not apply the bug until PI 16,
it will show as -1.

Note: If you upgrade your 9.1 application to an image point, for example PI 20, no data for lag time will
be available because there will not be any applied packages defined in the database.

This example illustrates the fields and controls on the Applied Bugs by Lag Image. In this example, the
current PI is 21 (0). For the bugs you have applied using PI 21, you can see the PI when the bug was
available, image 20 (-1,) image 19 (-2), image 18 (-3), and image 17 (-4).

Bugs by Language
This pivot grid displays the multi-lingual fixes available for installed languages on the target. If the target
database is English no data will appear in the pivot.
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This example illustrates the fields and controls on the Bugs by Language pivot grid.

Bugs By Image Applied From
This pivot grid displays all bugs and enhancements based on the image they were applied from.

This example illustrates the fields and controls on the Bugs By Image Applied From. You can find
definitions for the fields and controls later on this page.

Bugs By Dependency
This pivot grid displays the number of dependencies each bug that has not been applied on the target
database. You can view information on bugs, enhancements or both using the filter option. By default
both are displayed.

The x axis for this analytic contains number ranges rather than the actual number of dependencies. This
limits the number of vertical bars in the grid to provide better usability, given the actual dependency data
could have 1000’s of possible values.
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This example illustrates the fields and controls on the Bugs by Dependency pivot grid.

Customization Impacts By Bug
This pivot grid displays the number of bugs that have not been applied on the target database that have a
customization impact.

Data is only displayed on this pivot grid if:

1. Customer data on customizations has been uploaded to the PUM Source.

2. The Customization Calculation has been run on the PUM Source.

Defining Change Packages

There are 4 types of change packages that can be created:

1. Update Package

The Update Package component is a wizard that will lead you through the process of selecting
updates and defining a custom change package for your environment. It provides a wide array of
search options for selecting the updates to apply to your environment. It lets you review the details
of the changes for each update before creating the change package definition, shows you what has
already been applied to your environment, and automatically includes requisite updates based on what
you selected and what is already applied to your environment.

Note: Required for Upgrade (RFU) bugs are included in the Upgrade package.

See Defining Update Change Packages

2. Upgrade Package

The Upgrade Package component is a wizard that will create an upgrade package based on the
upgrade path specified. When you select this option 2 change package definitions are created the
upgrade package (UPG) and the Required for Upgrade package (RFU).

See Defining an Upgrade Package

3. Tools Delta Package
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The Tools Delta Package component is a wizard that is used after a PeopleTools upgrade to create
a Tools delta change package that contains attributes or objects that were stripped away when the
updates were applied in the old release.

See Creating and Applying Tools Delta Package

4. Translation Delta Package

The Translations Delta Package component is a wizard that will lead you through the process of
selecting the languages and translation fixes and create a translation delta package.

See Defining Translations Delta Package

Integrating with Cumulative Feature Overview (CFO) Tool

Understanding CFO Tool
Cumulative Feature Overview (CFO) tools provides concise descriptions of new and enhanced solutions
and functionality delivered with each PeopleSoft image. This tool provides the ability to upload an
Applied Bug report which is used to determine which features you have and have not applied to your
target database, as well as a link to the original CFO tool. Cumulative Feature Overview

This example illustrates the fields and controls on the Cumulative Feature Overview page.
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Field or Control Description

Upload an applied bug report Click this button to upload an applied bug report.

Applied bug reports are created in PeopleSoft Update Manager
for your target database.

The uploaded report is used to produce a report listing the
features that have been applied, as well as the features that
have not been applied.

Note: The Upload an applied bug report is only used generate
the Features report, it is not stored or retained. Once you close
the CFO tool, the report is no longer available.

Generate a CFO report Click this button to use the CFO tool to identify new features
for your products based on the current release and target
release.

This example illustrates the page from where we produce a CFO report showing all new features for
Benefits Administration product where the current release is PeopleSoft 9.2 Image 26 and the target
release is PeopleSoft 9.2 Image 42.

The CFO report generation tool provides the ability to select one or more products, your current release
(Current) and the release you plan to upgrade to (Target) to generate a report listing all the new features
available.
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The generated report will list the features, as well as links to the documentation and any videos available
for the feature.

This example illustrates a report produced for Benefits Administration features where the current release
is PeopleSoft 9.2 Image 40 and the target release is PeopleSoft 9.2 Image 42.

Integrating with CFO Tool
The Integrate with CFO Tool page provides steps and links necessary to create the Applied Bug Report,
upload the report to the CFO Tool, generate and modify the features report, and then use that report to
define a new change package.

To define a change package based on bugs in the CFO export file:

1. Select your target database under Select Target Database.

2. Select Integrate With CFO Tool, Integrate with CFO Tool.

3. Click the Export Applied Bug Report button.

In this step, you will create the export file.

See Exporting Applied Bug Report.

4. Click the Launch CFO Tool button.

In this step, you will upload the Applied Bug report to the CFO tool, produce and modify the Feature
report to contain the features you want to apply to your target database and then export the file.

See Launching CFO Tool

5. Click the Attach CFO Export File button and enter the required information.
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This step will create the Change Package definition based on your selection in the CFO Tool.

See Attaching CFO Export File and Defining the Change Package

Navigation:

Select PeopleTools >Lifecycle Tools >Update Manager >Update Manager Dashboard >Integrate
With CFO Tool >Integrate With CFO Tool

This example illustrates the fields and controls on the Integrate With CFO Tool page. You can find
definitions for the fields and controls later on this page.

Exporting Applied Bug Report
This step will generate the Applied Bug file that you will upload in step 2. You will be prompted to save
the file and enter a file name.

Remember to save the file in .csv format.

Manually edit the CSV file to delete column C, which is labeled as PTIASPRPTSUBJECT.

Important! Deleting column C ensures that you do not encounter a gateway timeout when uploading a
large applied bug report.
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Launching CFO Tool
Step 2 – Launch CFO Tool involves several tasks:

1. Upload an applied bug report.

2. Review and filter the report to select the features you want to apply to your target database.

3. Export the feature report to a csv file.

Launching CFO Tool and Uploading Applied Bug Report

Click the Launch CFO Tool button, to open the CFO Tool. On the CFO Tools, select Upload an Applied
Bug Report.

Note: The report is not stored in the CFO tool, it is only used to generate the report.

This example illustrates the fields and controls on the Upload an Applied Bug Report. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Select a product family Select the product family.

Select an Applied Bug report file Select the report created in Step 1.

Upload the selected file Click to upload the file.

Reviewing and Filtering the Report

Once you upload the Applied Bug report, the CFO Report with Applied Bugs is displayed. This report
will show all applied and unapplied features, use the filters on the left to restrict your search.

226  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 11 Using Update Manager Dashboard

This example illustrates a CFO Report with Applied Bugs where the filter has been set to limit the
products and only show unapplied features.

There are 2 ways to create the feature report:

1. When you have the desired selection displayed in the Feature Applied Status Report section, click the
Export to Excel link to create the CFO Export file.

You will be prompted for a file name. The report will be in .csv format.

2. Select the bugs in the select column and click Next.

This will bring up the Feature Report page.

This example illustrates the fields and controls on the Feature Request page.

Click Download report to CSV. You will be prompted to enter the file name and location. The report
must be in csv format.
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Attaching CFO Export File and Defining the Change Package
In this step, you will create a new change package definition based on the CFO Export file.

This example illustrates Step 3 for Defining the change package.

Field or Control Description

Attach CFO Export File Click this link to attach the CFO export file created in step 2.

Action Select the action.

Package Name Enter the package name.

Package Description Enter the package description.

Launch the Define Change Package Wizard Click this button to launch the Define Change Package
Wizard.

Define Change Package Wizard will open on step 5 of 6 and
display all of the bugs included in the change package.

Using Change Package Utilities

Update Manager Utilities include:

• Review Change Package

• Delete Change Package
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• Merge Change Package

• Analyze Applied PRP(s)

Reviewing Change Package
Navigation:

Select My Update Manager Dashboard >Change Package Utilities >Review Change Package

Select the Change Package.

You can also select the Review Package Definition link on the Define Change Package Step 6 of 6 page.

This example illustrates the fields and controls on the Review Change Package (top of page). You can
find definitions for the fields and controls later on this page.
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This example illustrates the fields and controls on the Review Change Package – Included Bug Fixes and
Excluded Bug Fixes. You can find definitions for the fields and controls later on this page.

This example illustrates the fields and controls on the Review Change Package – Included Managed
Objects and Included ADS Managed Objects. You can find definitions for the fields and controls later on
this page.

This example illustrates the fields and controls on the Review Change Package – Customizations Impact
and Existing Tests. You can find definitions for the fields and controls later on this page.

The Review Change Package page is displayed only to provide information on the change package.

Incomplete packages will not display all of the fields.
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Field or Control Description

Package Status Indicates the current status of the package.

• Incomplete- the change package definition has not been
completed in the Update Manager UI.

• Complete - the change package definition has been
completed in the Update Manager UI.

• Package Created - the change package has been created in
Change Assistant.

Search Scope Indicates the scope used to create the change package.

Depending on the scope selected, additional information is
displayed.

Dependency Calculation Indicates which type of dependency calculation used to create
the change package (Standard or PostReq's Included).

Summary of Metadata for this Package For each metadata type, if there is metadata, a link Available is
displayed. Use this link to go to that section of the page.

If the metadata type is not contained in the package, the
metadata type will indicate Not Applicable.

Bugs delivered through a PRP will have no data on
components to test, therefore Components to Test will indicate
No Data.

Template For change packages that are complete, use this link to view
the steps in the change package template.

Included Bugs For change packages that are complete, you see a grid
displaying the bug in the change package, with a flag
indicating the selected bugs. Use the detail icon to view bug
details.

Excluded Bugs For change packages that are complete, you see a grid
displaying the list of excluded bugs in the change package.

The Is Used field indicates interaction of objects, which are
part of excluded bugs, with Usage Repository data. It can have
Yes or No value.
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Field or Control Description

Included Managed Objects For change packages that are complete, you see a grid listing
the Managed Objects included in this package.

The Is Used field indicates whether the object is referenced in
Usage Repository. The values are:

• Yes- If the managed object is referenced in the bug and
the Usage Repository after usage calculation.

• No- If the managed object is not referenced in the bug and
the Usage Repository after usage calculation.

• Not In Use- The managed objects are not uploaded in the
Usage Repository.

The Is Customized field is used to show if the object is part
of the customization or not. This field can have the following
values:

• Yes- Object belongs to the Customization repository and
is customized.

• No- Though the object is part of Customization
repository, it is a non-customized object.

• Blank- Object does not belongs to the Customization
repository.

Included ADS Managed Objects For change packages that are complete, you see a grid listing
the ADS Managed Objects included in this package.

Customization Impact Lists the impacted customization names.

Existing Tests Lists the existing test names that cover objects delivered in this
package.

Components To Test Lists the components to test for this package.

Bug Details

Click the Details button on the Included Bug Fixes and Excluded Bug Fixes grid to access the Bug Details
page.
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The Bug Details page details the bug-specific Change Package information.

Template

Click Template link on the Review Change Packages page to open the Change Package Template window
listing the chapters, tasks, steps, and step scripts in the change package template.

Copyright © 1988, 2022, Oracle and/or its affiliates. 233



Using Update Manager Dashboard Chapter 11

This example illustrates the fields and controls on the Change Package Template page.

Deleting Change Packages
Navigation:

Select My Update Manager Dashboard >Change Package Utilities >Delete Change Packages

This example illustrates the fields and controls on the Delete Change Packages page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Package Name Search by package name.

Database Name Search by database name.

Package Status Search by package status. Package statuses are:

• Complete

• Imported

• Incomplete

• Package Created

Package Type Search by package type. Package types are:

• Application Upgrade

• Tools Delta Package

• Required for Upgrade

• Translations Delta Package

• Updates

The Select Package Definitions to Delete grid will list all the change packages that meet the selection
criteria. Select the change packages to delete and click the Delete Selected button.

Merging Change Packages
The following restrictions apply to merging change packages.

• Change Packages must have same target database.

• Change Package definition must have a status of complete or incomplete,

• Change Package type is Update(PUM).

• Change Package is defined, but not created in Change Assistant.

To merge change packages:

1. From the Update Manager Dashboard select the target database.

2. Expand Update Manager Utilities and select Merge Change Packages.

3. On Step 2 of 6, Create is selected by default and is the only option available. Enter the package name
and description.

4. Click Next.

5. On Step 3 of 6, select the packages to merge.
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6. Click Next.

Note: Step 4 of 6 is skipped.

7. On Step 5 of 6 review the bugs.

8. Click Next. You will receive a message that there are overlapping packages, click OK.

9. Step 6 of 6 indicates the change package was successfully created.

Navigation:

Select PeopleTools >Lifecycle Tools >Update Manager Dashboard >Update Manager
Utilities >Merge Change Packages

This example illustrates the fields and controls on the Merge Change Packages Step 2 of 6 page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Action Create is the only available option.

Package Name Enter a name for your merged change package.

Analyzing Applied PRP(s)
If you have existing defined or created Change Package definitions that have not been applied to your
target database, conflicts may exist after applying PRPs to the PUM source that will impact the existing
Change Package. The PRP may contain post requisite updates, which would result in a partial and
undocumented apply. To prevent this scenario, conflicts will be detected when the PRP is applied
to the PUM source and displayed on the Analyze Applied PRP(s) page. The Recalculate Selected
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Package Definitions button on the Analyze Applied PRP(s) page will run the application engine program
PTIARECALCCP to recalculate the package and remove the conflicting bugs.

Navigation:

Select My Update Manager Dashboard >Change Package Utilities >Analyze Applied PRP(s)

This example illustrates the fields and controls on the Analyze Applied PRP(s) page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Filter Options Set the filter to show all or conflicts only.

Package Name Name of the unapplied Change Package definition.
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Field or Control Description

Type Change Package type:

• Update

• Required for Upgrade

• Tools Delta

Note: PRPs do not deliver changes to translations, therefore
Translation packages (TDP) are not affected.

Conflict Resolved Indicates whether or not the conflict has been resolved.

Initial Bug Count Indicates the initial number of bugs in the change package.

Resolved Bug Count Indicates the number of bugs after the conflict has been
resolved. If Conflict Resolved is No, the resolved bug count
will be Pending.

Updated On Date the change package was last updated.

Select All Click to select all packages.

Deselect All Click to deselect all packages.

Recalculate Selected Package Definitions Click to recalculate the selected packages.

This will launch the PTIARECALCCP application program
in Process Scheduler. Depending on the size of the Change
Package, the job may take a while to complete. This program
will set the Conflict Resolved Status to Y (Yes) if successful or
E (Error) if a failure occurs.
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Managing Customization Repository

Understanding Customization Repository

The customization repository provides a way to assist customers in managing customizations when
selecting updates in the PUM Search. The customization repository includes:

• Customization repository in the PUM Source Image.

• Visualization of customization impact in the PUM Search.

• Ability to take action based on identified customization impacts, including PUM automatic merge for
PeopleCode, SQL, and XSLT.

• Customization Repository persistence mechanism.

See Migrating PUM Data

Creating Customization Repository

The customization repository resides on the PUM Source. In order to create the repository, you must
first identify all of the customizations that you want to track in the target databases and then upload
the customization projects to the PUM Source. The customization projects apply across all your target
databases. There are 2 types of customization projects, Managed Objects projects and ADS Managed
Objects projects.

Managed Object Customization Project

To create a managed object project:

1. Create a project on the customer database that includes your customizations.

Note: You can create as many customization projects as required.

The following methods are available to create the customization projects:

• In Application Designer create a project by manually adding the managed objects you have
identified as customizations.

You can use the UPGCUST project from your last upgrade.

• Create the project using PJRCUST, using one of theses options:

• In Change Assistant use the step Create Customization Project to create the project.
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See Step Types

• Create the project using the command line PJRCUST.

See "Creating Customization Project Using the Command Line" (Lifecycle Management
Guide)

Important! Your target database must be on PeopleTools 8.55 or above to use PJRCUST.

• Create the customization project in Change Assistant using the Create New Database Project
option in Upload Customer Data to Image.

2. (Optional) Copy the customization project to file.

Note: PUM Automatic Merge only supports the project from database.

3. Use Change Assistant to upload the customer data to PUM Source.

4. Review the upload on the PUM Source.

5. Run the Customization Calculation on the PUM Source.

See Run Customization Calculation

ADS Managed Objects Project

To create an ADS project:

1. Sign on to the browser for the database where your ADS managed objects reside.

2. Select PeopleTools >Lifecycle Tools >Migrate Data >Data Migration Workbench.

3. Create the ADS project and save it.

See "Defining ADS Project" (Lifecycle Management Guide)

4. Optionally copy the project to file.

Note: If the data set is encrypted, you will not be able to upload the file in Change Assistant.

5. Use Change Assistant to upload the customer data to PUM Source.

6. Review the upload on the PUM Source.

7. Run the Customization Calculation on the PUM Source.

See Run Customization Calculation

Uploading Customer Data to Image
The PUM Source Options page contains a section to setup the customization repository.
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This example illustrates the fields and controls on the PUM Source Options — Customization Repository.
You can find definitions for the fields and controls later on this page.

Field or Control Description

Object Merge Select Enabled to enable object merge.

Customization Repository The Customization Repository will display Disabled until
you upload some customizations. Select Manage to upload
customizations.

Default Merge Rules The Edit button is available to set default merge rules after
customizations have been uploaded.

Navigation:

From the Change Assistant menu select Tools, Options, PUM Source Options. Select Manage button for
the Customization Repository.
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This example illustrates the fields and controls on the Upload Customer Data to Image page. You can find
definitions for the fields and controls later on this page.

There are 3 options for uploading customization data:

• Select Existing Project File(s)

Note: This option is grayed out if object merge is enabled.

• Select Existing Database Project(s)

• Create New Database Project

After selecting the projects, click the Load button to upload the customizations to the PUM Source
Customization Repository.
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Select Existing Project File(s)

This example illustrates the fields and controls on the Select Existing Project File(s) page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Target Repository Customization is selected and read only.
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Field or Control Description

Project Type For Customizations, the project types are:

• Managed Objects

• ADS Managed Objects

Note: If the ADS Managed Object project is encrypted, it will
not be available to upload from project file.

Object Merge Disabled for Existing Project Files.

Folder Select the folder where the project file is stored.

Search Enter value to search for and press the Enter key.

All projects matching the entered value will be returned.

Project Grid Select the projects that you want to upload from the project
grid.

Add Selected Click the Add Selected button to return to the Upload
Customer Data to Image page.
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Select Existing Database Project(s)

This example illustrates the fields and controls on the Select Existing Database Project(s) page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Target Repository Customization is selected and read only.

Project Type For Customizations, the project types are:

• Managed Objects

• ADS Managed Objects

Object Merge Indicates if object merge is enabled or disabled.

Database Select the target database that contains the project.

Search Enter value to search for and press the Enter key.

All projects matching the entered value will be returned.

Project Grid Select the projects that you want to upload from the project
grid.

Add Selected Click the Add Select to return to the Upload Customer Data to
Image page.
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This example illustrates the fields and controls on the Select Existing Database Project(s) for ADS
Managed Objects.

Create New Database Project

This example illustrates the fields and controls on the Create New Database Project. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Database Select the database that contains the customizations.

Project Name Enter the Project Name.

Object Merge Indicates if object merge is enabled or disabled.
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Field or Control Description

All Customized Managed Objects This feature will go through the specified objects in a database
and compare the object user id with ‘PPLSOFT’ and insert
the object into the customization project if the user ID is not
‘PPLSOFT’.

Using Customization Repository

The Customization Repository provides the following components to manage the customizations:

1. Manage Customizations

2. Manage Repository Objects

3. Run Customization Calculation

Managing Customizations
The Customization Repository is used to identify the relationships to customized objects before the
change package is created. The Customization Repository is delivered empty on the PUM Source and
must be populated using Change Assistant to upload the customer data.

To access the Customization Repository page, select the Customization Repository tile from the Update
Manager Homepage.

The Manage Customizations Search page is displayed.

This example illustrates the fields and controls on the Manage Customizations Search page. You can find
definitions for the fields and controls later on this page.

Copyright © 1988, 2022, Oracle and/or its affiliates. 247



Managing Customization Repository Chapter 12

Field or Control Description

Customization Name The Customization Name is the name used to group
customizations.

By default, this the name of the customization project that was
uploaded to the PUM Source using Change Assistant. You can
have 0–n customizations defined. Each defined customization
must have a unique customization name.

You can add additional Customization names using the Add
Customization button to regroup the uploaded objects as
needed.

Description You can add a description on the Manage Customization page
to assist in searching for customized objects.

Owner You can add an owner on the Manage Customization to assist
in searching for customized objects

This example illustrates the fields and controls on the Manage Customizations page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Description Use this field to provide a more detailed description of the
customization.
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Field or Control Description

Owner Specify the owner for the Customization.

Added to Repository Read only field with the date the project was uploaded.

Last Updated Oprid Read only field displaying the User ID that uploaded the
customization.

Additional Details Add any additional details to describe the customization
objects in this group.

Do you want to make this Customization Active Specify whether the customized objects in this Customization
group are active.

• No

The customized objects are excluded from the calculation
analysis.

When you define a change package that contains a bug fix
which impacts the customized object, the Custom Impact
column will display Excluded.

• Yes (default)

The customized objects are included in the calculation
analysis.

When you define a change package that contains a bug fix
which impacts the specified customization, the Custom
Impact column will display Included.

Do you want to Include these Customized objects in Package Specify whether bug fixes which impact the customized object
should be, by default, included or excluded from change
package creation.

• No – exclude from package creation

The customization objects are excluded from the
calculation analysis.

When you define a change package that contains a bug fix
which impacts the customized object, the Custom Impact
column will display Excluded. This is a visual indicator,
 however you must manually deselect the bug or it will be
included in the package.

• Yes (default) – include in package creation

The customized objects are included in the calculation
analysis.

When you define a change package that contains a bug fix
which impacts the specified customization, the Custom
Impact column will display Included.
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Field or Control Description

Add Attachment Add documents pertaining to the customization from your
local.

You can upload documents of type TXT, Microsoft Excel,
 Microsoft Word, and PDF.

Customized Objects The customized objects grid lists the object type, object values,
 if it is a customization, and if 3 way merge is enabled.

Adding Customizations

To manually add customizations:

1. Select Customization Repository from the Update Manager homepage.

2. Select Add Customization

3. Enter the Customization name and click Add.

4. Enter the details and preferences.

5. Initially, no objects will be associated with the Customization.

6. Select either Managed Objects or Manage Application DataSets.

7. Use the Add Object to Customization button to add the objects.

8. From the Add Managed Objects page or Add Application DataSets page, search for and select the
objects to add.

Note: All objects that have been uploaded to the Customization Repository are available to add.

9. Use the Add icon (+) to add additional objects to the customization.

Note: Objects must be added one at a time.

10. Save the Customization.

11. Run the Customization Calculation.
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This example illustrates the fields and controls on the Manage Customizations page for a new
customization.

This example illustrates the fields and controls on the Example Add Managed Objects page. You can find
definitions for the fields and controls later on this page.

Deleting Customizations

To delete an object from the Customization:

1. Select Customization Repository from the Update Manager homepage.

2. Open the Customization Name.

3. Select the – (delete row) action in the customized object grid.

4. You will be prompted that the row will be deleted when the customization is saved.

If a customization is deleted, the customization calculation must be re-run to ensure that the correct
metadata exists in the database.
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Manage Repository Objects
The Manage Customized Objects page contains a list of the customized objects. The same object may
exist in more than one customization.

To access the Customization Repository page, select the Customization Repository tile from the Update
Manager Homepage.

Select Manage Repository Objects.

This example illustrates the fields and controls on the Manage Repository Objects page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Object Type Use the Object Type editbox to display customizations by
object type.

Object Name Use the Object Name editbox to display customizations for a
specific object names.

Object Type Specifies the managed object type.

Object Value 1–4 These 4 columns are the same 4 key columns used to identify a
managed object in PUM and managed object projects.

> Click to open the Add/Delete Customization References page.
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This example illustrates the fields and controls on the Manage Application Datasets page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

ADS Type Select the ADS Type to display..

Object Name Use the Object Name editbox to display customizations for
specific object names.

Data Set Name Name of the Data Set.

Object Value 1–8 These are the key columns used to identify an ADS managed
object in PUM and ADS managed object projects

Customizations Displays the customization count. Click the count link to open
the Add/Delete Customization References page.

Adding and Deleting Customization References

To add or delete customization references, click Data Set Name or the > icon. This will open the Manage
Object Customization Reference page. The list of customizations to add to an object is limited to the list
of customizations defined in the Customization Repository.

This example illustrates the fields and controls on the Manage Object Customization References page.
You can find definitions for the fields and controls later on this page.
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To add a reference:

1. Click the Add a row icon (+).

2. Select an existing Customization Name using the Lookup icon.

Note: Customization Names are defined in the Customization Repository.

3. Click Save.

Note: If a customization reference is added, the Customization Calculation must be rerun.

To delete a reference:

1. Click the Delete a row icon (+).

2. Click OK to delete the row.

3. Click Save.

Note: If a customization reference is deleted, the Customization Calculation must be rerun.

Run Customization Calculation
In order to manage and display the customization impact in the PUM Search UI, a customization
calculation must be generated for each bug fix in the Image. The Run Customization Calculation page is
used to run the calculation for the customizations identified in the Customization Repository.

Both the Manage Customizations page and the Manage Object Customization References have a button
to Run Customization Calculation. You can also access this page by selecting the Run Customization
Calculation from the left hand menu on the Customization Repository.

This example illustrates the fields and controls on the Run Customization Calculation page.

Click the Run Customization Calculation button to update the bug calculations.

Bug fixes containing customizations will be flagged in the Custom Impact column when you define a
change package. The status is dependant on which option you selected on the Manage Customizations
page. Included indicates you want to include the definition in the change package and Excluded indicates
you want to exclude it.

Note: If no data exists in the Customization Repository, then there is no customization impact and the
Run Customization Calculation button will be grayed.
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Defining and Managing Databases Using Update Manager

This topic discusses how to define and manage databases using Update Manager.

Defining Databases with Update Manager
Use the Define Database page to retrieve data from customer-maintained databases to PUM source
database by invoking the provider API from the PUM source.

Customer-maintained database can be:

• The target database.

• An old PUM source containing the customization repository, which is on an older PUM Image.

See Migrating PUM Data.

You can fetch data from customer-maintained databases without having to configure its PeopleSoft client
information in Change Assistant.

Important! Integration objects created as part of provider REST service will be delivered for customer-
maintained databases environments on PeopleTools releases prior to 8.60.

Only minimal information, such as, hostname and credentials, are fetched from the target database.

Prior to PeopleTools 8.60, target databases needed to be defined in Change Assistant. In PeopleTools 8.60
and higher, you can define the database in Update Manager.

For instructions on defining databases in Change Assistant, refer Defining Databases

Navigation

Update Manager >Administer Metadata >Manage Database >Define DB
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This example illustrates the fields and controls on the Define Database page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Database Name Enter the database name.

Description Use this field to provide a more detailed description of the new
database.

Hostname Enter the hostname of the webserver for the target database.

Port Number Enter the port number of the webserver for the target database.

This is the port used to create the REST Base URL.

Node Name Enter the default local node name of the target database.

This is the node used to create the REST Base URL.

Fetch DB Information Click this button to invoke REST API for the environment
specified as the hostname.

If the connection is successful, the REST API returns basic
database information, such as, PeopleTools version of the
target database, languages installed, and base language.

This information is stored in the PUM source database.

Name: Based on the information returned after the connection
is successful, you can define a role or orientation for the
PeopleSoft PUM source database.

For details, refer Database Orientation.

Orientation

Status- Use this field to set the orientation Active or Inactive.
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Once you define the database, it appears on the Manage Database page.

Database Orientation

You can assign a role or orientation for the defined database.

Based on the orientation, you can retrieve different metadata from the customer maintained database. To
retrieve different metadata,

If customer needs to retrieve only merge repository data, can assign the orientation as Customer Instance.

The database role or orientation options are:

Orientation Description

Customer Instance With this orientation, you can set the defined database (remote
database) as a customer instance.

On the Define Activity page, you can run the Sync Merge
Repository Objects activity on this database to retrieve the
latest merge repository data.

Source-Old Sets the defined database (remote database) as old PUM
source, which contains maintenance bug metadata that is
required to analyze and create Change Packages.

When the next PeopleSoft Image releases, customer can use
this metadata and proceed with the PUM activities.

Run the Retrieve Old PUM Metadata activity from the
Defined Activity page on this database to retrieve customer
metadata such as, package definitions of the old PUM source,
 customization repository data, test repository data, PUM
automated updates from the old PUM source.

Target Sets the defined database (remote database) as the target
database and retrieves target information. Target database,
 which is on an older release, contains information, such as
maintenance log.

You can use the target database information, to create a change
package for applying upgrade or update maintenance.

Usage Monitor Sets the remote database as the Usage Monitor database.

Customers can use the usage data to analyze and then add
objects to the Change Package.

For details, refer to Handling Usage Monitor Data

Based on the orientation, different database activities appear for the remote database.
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There can be multiple orientation for a remote database.

For details on the database activities, refer Defining and Managing Database Activities.

Managing Databases
The Managing DBs page lists all the defined databases and the current PUM source database.

Initially the page displays a single row with the current PUM source database, which has only the Source-
Current orientation. The current PUM source details will be read-only.

Databases defined in Change Assistant or Update Manager are listed.

This example illustrates the fields and controls on the Define Database page. You can find definitions for
the fields and controls later on this page.

The Actions options on the database activities appear for each database based on the database orientations
defined for this database. The database can have multiple orientations.

For example, the H92TD906 database has four database activities based on the orientations selected. In
this example, the Retrieve Old PUM Metadata appears only because one of the orientation is Source-
Old. Suppose, you select one of the activity, such as, Sync Usage Monitor Data. The Define Activity page
opens with the pre-defined parameters. In this case, the Sync Usage Monitor Data activity opens with the
pre-defined preferences. You can either update and run this activity or choose any one of the other three
database activities.

For more information on database activities, refer Defining Database Activities.

Defining and Managing Database Activities

This topic discusses how to define and manage database activities.

Defining Database Activities
You can run database activities on customer-maintained databases on a scheduled or ad hoc basis to fetch
different metadata and perform various PUM activities.

The different activity options for a database are available based on the orientation assigned while defining
the database.
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This example illustrates the fields and controls on the Define Activity page. You can find definitions for
the fields and controls later on this page.

Not all activities can be scheduled. Some of the activities run only on ad hoc basis.

After defining the activity, you can run or save it to run later from the Manage Activity page.

Activity Description

BackUp PUM Metadata Run this activity to take a backup of the PUM user metadata
from the current source to a file present in the App Server file
directory. The file directory is created while provisioning the
DPK.

The App Server file directory is <PS_CFG_HOME>/
<appserver_domain_name>/files

Preferences: Select any of these metadata to back up in form
of a file from the existing PUM source:

• Cust Repository

• Merge Repository

• Test Repository

• Package Definition

• PUM Automatic Updates

If PeopleTools version for the existing source is lower than
8.59, then Merge Repository and PUM Automated Updates
options will be disabled.

You can schedule or run this activity on ad hoc basis.
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Activity Description

Load Languages Run this activity to load languages to the current PUM source.

This activity runs only on ad hoc basis.

Select language based on Target- Select this option and then
choose the database. Only databases defined as Target will
be available for selection. Languages associated with this
database will be displayed.

Select language manually- Select this option to manually
select languages which are not already installed on existing
PUM source. Language list differs from application pillar to
pillar.

For example, if HCM supports Spanish, it will appear in the
language list if the source is a HCM database.

Restore PUM Metadata To restore the PUM user metadata from the backup file created
using the BackUp PUM Metadata activity.

This activity runs only on ad hoc basis.

Preferences: Select the different metadata that need to be
restored from the file:

• Cust Repository

• Merge Repository

• Test Repository

• Package Definition

• PUM Automatic Updates
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Activity Description

Retrieve Old PUM Metadata Run this activity to fetch PUM user metadata from a database
that acts as the old PUM source.

Database Options: Only databases with orientation 'Source-
Old' will be available for selection.

Preferences: Select the different metadata that need to be
retrieved from the selected old PUM Source:

• Cust Repository

• Merge Repository

• Test Repository

• Package Definition

• PUM Automatic Updates

If the PeopleTools version of the selected database is lower
than 8.59, then Merge Repository and PUM Automated
Updates options will be disabled.

You can schedule or run this activity on ad-hoc basis.

Retrieve Target DB Information Run this activity to fetch maintenance log, which lists the bugs
and features that are already applied, and installed product
information from the selected Target database.

Database Options: Only databases with orientation 'Target'
will be available for selection.

You can schedule or run this activity on ad-hoc basis.

Sync Merge Repository Objects Run this activity to synchronize and update the latest version
of objects in customer’s database based on the existing
metadata rows in the PUM source database's merge repository.

Database Options: Only databases defined as 'Customer
Instance' will be available for selection.

Preferences: You can select these objects that need to be
synchronized based on the metadata information in the merge
repository:

• SQLs

• XSLT Definitions

• PeopleCode

If you select PeopleCode object, a set of PeopleCode
definitions, such as Application Package, Component Record,
 Page, and so on will be displayed to choose from.

Copyright © 1988, 2022, Oracle and/or its affiliates. 261



Using Administer Metadata Chapter 13

Activity Description

Sync Usage Monitor Data Run this activity to fetch information from the database that is
defined as Usage Monitor database.

Database Options: Only databases with orientation 'Usage
Monitor' will be available for selection.

The Load Languages, BackUp PUM Metadata, and Restore PUM Metadata are source-only activities as
these affect only the PUM source database.

The remaining activities can be referred as integration activities as these triggers metadata exchange or
synchronization between the source and customer maintained databases.

Managing Database Activities
The Manage Activity page displays the status and details of the activities defined and scheduled or run on
the Define Activity page.

This example illustrates the fields and controls on the Manage Activity page. You can find definitions for
the fields and controls later on this page.

The activities that were saved and not run on the Define Activity page will not show any status on this
page.

Actions Description

Update Select to edit the activity.

Delete Select to delete the activity. You can delete scheduled and ad
hoc activities.

Run Select to run the activity that was defined and saved.

History Select to view the run history and logs of the activity.

Alternatively, you can click on the row or the chevron (>) icon
to view the history and logs.
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Viewing Activity History

Select the History action from the Manage Activity page to view the activity history.

This example illustrates the fields and controls on the Activity History page. You can find definitions for
the fields and controls later on this page.

Open the Activity History page of an activity to view the number of activity runs.

History is logged in order of the activity run with the date and status.

Click Download Logs to download the zipped log files. You can review these files and troubleshoot.
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Using Usage Repository

Understanding Usage Repository

Usage Repository assists customers in fetching usage monitor data from different databases.

Customers can use this data to analyze and then add objects to the Change Package.

The usage repository can be used to:

• View usage monitor data.

• Run usage calculation.

Usage Monitor data fetched from different databases is stored in the PUM Usage Monitor table.

Handling Usage Monitor Data

From PeopleTools 8.60, Usage Monitor data is fetched from different databases and stored in the PUM
Usage Monitor table.

When users upload usage data to PUM source, relevant details are added to the PUM Usage Monitor
table.

Usage flags are introduced in this table to indicate the usage of Usage Monitor.

Flag Value Use

X Default value, and it indicates that the Usage Monitor is not in
use.

Y This value is used when user uploads usage data in PUM
source and Bug Calculation for Usage Monitor data is not
done.

N This value is used when user uploads usage data in PUM
source and Bug Calculation for Usage Monitor data is done.

Uploading Usage Data Using Integration Broker

The Usage Monitor data fetched from different databases are uploaded to the PUM Usage Monitor table
through the Integration Broker.
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To upload the data through Integration Broker, first the PUM source invokes the Usage Instance through
REST based APIs.

The APIs import the usage monitor information, which then gets populated into the PUM Usage Monitor
table.

You can define a database that can act as a Usage Instance. To define, set the orientation as Usage
Monitor in the Define Database page (Update Manager, Administer Metadata, Manage Database).

For details, refer to Defining and Managing Databases Using Update Manager.

Next, users can define an activity of type Sync Usage Monitor Data to fetch the information from this
Usage Instance database. You can define this activity on the Define Activity page (Update Manager,
Administer Metadata, Manage Activities).

For details, refer to Defining and Managing Database Activities.

Usage History Table

The usage history table maintains information of the database from which Usage Monitor data is
imported.

When Usage Monitor data is fetched from any database for the first time, the usage history table
populates the data against that database with last update time value as time of upload.

For the subsequent run, the system verifies if the data exists for that database in the usage history table.
If the data exists, then it imports the Usage Monitor data collected after the last update time of the history
table and this table will be updated with the latest last update time value. Basically, only the latest data is
fetched in subsequent runs.

Viewing Usage Monitor Data

The View Usage Data page displays usage data of each object.

Based on usage data of an object, you can decide to add an object in a Change Package.

This example illustrates the fields and controls on the View Usage Data page.
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This example illustrates the fields and controls on the View Usage Object References page.

The Is Used field on this page let's you know if the object is being used in a Change Package

Running Usage Calculation

The Run Usage Calculation page lets you to verify all the objects delivered in bugs applied in the PUM
source database against the objects uploaded in the Usage Repository and this result is stored in the PUM
source table.

A flag is introduced in the PUM source table is used to identify the bugs having objects that are also
uploaded in the Usage Repository.

If the value of the flag is Yes, then the bug has objects which are also uploaded in the Usage Repository.

If the value of the flag is No, then the bug does not have objects uploaded in the Usage Repository.

The flag value helps in setting usage values for a Change Package definition.

This example illustrates the fields and controls on the Run Usage Calculation page.

Click the Run Usage Calculation to update the usage calculation.
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Using PUM Automated Merge

Understanding PUM Automated Merge

Beginning with PeopleTools 8.59.02, Change Assistant supports object merge for PeopleCode, SQL and
XSLT objects in your Customization Repository.

When you enable object merge in Change Assistant and upload customizations to the PUM source, the
data for the PeopleCode, XSLT or SQL objects will be included in the merge repository.

If Object Merge is enabled and a change package is created that contains merge enabled objects, the
merge rules are used to automatically merge the code.

The merge session contains three sets of data:

• Parent (A) Data - This is the previous versions of data delivered in the PUM source database.

• Child 1 (Customization) Data - This is the data uploaded by user to the customization repository on
the PUM source database. 

See Uploading Customer Data to Image.

• Child 2 (Delivered) Data – This is the data delivered in the PUM source database.

Note that in the initial Change Package create process, Change Assistant exports Object Merge project
only with the metadata that is required for the Change Package create process. After running the object
merge, the entire project is exported.

Enabling PUM Automated Merge

To enable Object Merge in Change Assistant:

1. In Change Assistant, select Tools, Options.

2. Select the PUM Source tab.

3. Select Enabled for Object Merge.

4. (Optional) Use the Show button for a list of objects that can be merged.

5. Select Manage button for the Customization Repository to upload customization projects to the PUM
Source.

Note: Only Select Existing Database Object and Create New Database Project options are available
on Manage Customization Repository page if Object Merge is enabled.
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See Uploading Customer Data to Image

6. Select Edit button for the Default Merge Rules to review or change the default merge rules.

See Defining Default Merge Rules.

This example illustrates the fields and controls on the PUM Source Options. You can find definitions for
the fields and controls later on this page.

Select Enabled for the Object Merge to enable object merge.

Select the Manage button for Customization Repository to upload customizations. See Uploading
Customer Data to Image.

Defining Default Merge Rules
The default merge rules provide the basis for the automatic merge.

Select the Edit button for Default Merge Rules to review or modify the default merge rules.

When the merge analysis runs, if a difference is detected for a line of code, this table is used to determine
the action to be taken based on the status combination.
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This example illustrates the fields and controls on the Default Merge Rules page. You can find definitions
for the fields and controls later on this page.

Modify the default rules as necessary for your environment.

Child 1 is the data uploaded by user to the customization repository. Child 2 is PeopleSoft delivered data
in the PUM source.

If the Child 1 as Note or Child 2 as Note column is selected, the line of code will display greyed out in the
Merge Session. This helps to visualize and verify which line of code is getting merged or replaced by the
merge rules. These lines of code are not added to the merged output.

Select the Restore Defaults button to restore the default rules.

Versioning of Objects

Customization objects that are uploaded to merge repository are assigned a version number. Only those
objects that have version numbers are considered during the merge analysis step.

After running merge analysis, when the promote merge step is run, the merged output is written back to
the merge repository with a newly calculated version number.

The versioning format is nn.xx.yyy.

where,

nn- indicates the Image number.

xx- is reserved for future use.

yyy- indicates the upload iteration of the object. This increments when the same object is uploaded again.

Example on how versioning is calculated:
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Consider a development (target) database which has updates applied from Application Update Image 12.
An Object X (Peoplecode, XSLT, or SQL), has been customized by user in the development database.

Assume that the same object X was modified or delivered by multiple bugs (Bug 1, Bug 3, Bug 7, and
Bug 8) in the following Images, which were applied to the development database:

• Bug 1 delivered in Image 05.

• Bug 3 delivered in Image 07.

• Bug 7 delivered in Image 11.

• Bug 8 delivered in Image 13.

If bugs Bug 1, Bug 3 and Bug 7 were applied on the development (target) database, then the version of
Object X will be 11.00.001, where:

11- indicates the version of the highest Image in which Object X was modified or delivered.

00- reserved for future use.

001- indicates the upload iteration. In this case, the Object X was uploaded for the first time.

If the same object is uploaded again, then the version of Object X is 11.00.002.

If all the bugs Bug 1, Bug 3, Bug 7, and Bug 13 are applied on the development database, then the version
of Object X will be 13.00.001.

An Object Y, which is created by customer, and not delivered by PeopleSoft Images will not be
considered for merge. This object is assigned the version 99.00.001 to identify as a customer created
object.

Consider that Bug 9 delivers Object X in Image 14. If the merge process is run using Image 14 with
Object X, then the merged version of Object X is assigned 14.00.001 and written-back to the merge
repository.

On the Customization Repository pages in PIA, you can view the version numbers of the customization
objects.

This example illustrates the fields and controls on the Object Version History page.
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Retaining Object Merge Data and Session
Change Assistant writes back merged version of customized objects and merge session details in PUM
source as part of the promote merge step.

For subsequent PeopleSoft application maintenance updates, Change Assistant can use the previously
written-back merged objects as the latest customizations. This avoids re-upload of customizations.

Managing versions of customizations and details of merge sessions allows you to:

• Use previous merge session objects for the next merge session.

• Re-run merge sessions multiple times with same version of customization objects.

• Use the appropriate object version of customized objects in different merge use cases as explained
below.

• Delete merge sessions, including promoted written-back versions, to roll back to use user uploaded
version of customizations in the next run of merge process.

Few use cases on how to select the appropriate object versions of customized objects for merge analysis:

• When you run merge analysis for the first time, there is no record of merge sessions stored in the
PUM source. In this case, Change Assistant uses the latest uploaded customization objects for merge
analysis. When running merge promotion, the merged version of the object is retained in the PUM
source to be used in subsequent runs of merge process.

• You can run the merge analysis step again with modified merge rules until the merged version of the
object is satisfactory. If you want to only change the merge rules to tweak the merge output, but use
the same object versions that were used in the previous merge process run, then you can do so by re-
running the merge analysis step with same merge session name.

Using the same merge session name, lets you to pick the same set of customization objects that were
used in the previous run of that session.

• After running a merge session (SESSN1), an updated merged version of the customization (M1), is
written-back to the merge repository tables. On next merge session run (SESSN2), M1 will be used.
If you want to revert to using the previous user uploaded version (A) instead of M1, then the merge
session that wrote-back the merged version of the object must be deleted, which is SESSN1.

If you want to upload a new version of the customization object again (A2) and use SESSN2, then
all previous merge sessions, including SESSN1, must be deleted. This happens if A2 version is lower
than the written-back version of the object (M1) from any previous merge runs (SESSN1).

By deleting all the previous merge sessions (SESSN1), the merge output that was written-back gets
deleted (M1). At this point, Change Assistant picks the latest customization that was re-uploaded
(A2).

To delete, refer to Delete Merge Session.

Note: New version of customizations can be uploaded using either Change Assistant or Administer
Metadata in Update Manager.
For details on syncing merge repository through Administer Metadata, refer to Defining and
Managing Database Activities
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• When the merge analysis step runs on a subsequent change package apply job, the latest version of
customization objects are picked from the merge repository. The latest version could either be the
written-back version of the customization objects from the previous merge session or the version of
the object that was synced through the Administer Metadata; whichever is the highest version of that
object.

Delete Merge Session

You can delete existing merge sessions in Change Assistant. This deletes the merge session data and the
corresponding merged objects.

To delete existing merge session in Change Assistant:

1. Set the action type as View PUM Automated Merge Sessions.

2. Open the Tools menu.

3. Select Merge PeopleCode/SQLT/XSLT option.

4. Next, select Delete Merge Session.

In the Delete Merge Session window, you can select multiple merge sessions to delete using the Shift
and down arrow key.

You can also delete a merge session while applying a change package.

You can also delete merge sessions from command line.

For more details, refer to Constructing Command Line to View and Delete Merge Sessions

Merge Session History

Change Assistant maintains the merge session details in the merge session history tables.
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When customer runs the same merge session multiple times, then Change Assistant can lookup the merge
session history tables to use the same set of customized objects that were used for merge analysis. This
allows customer to run multiple sessions with changed merged rules.

When a merge session is re-run, Change Assistant deletes the previous merge session with the same
merge name and inserts the latest one as the active merge session.

You can migrate (import or export) merge history tables.

In Change Assistant, select Tools, Options, PUM Source tab, then click Manage for Migrate Customer
Data.
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This example illustrates the fields and controls on the PUM Data Migration page.

Select the appropriate Merge Repository option to import or export merge history tables.

Applying Change Package That Includes Merge-Enabled Objects

When merge-enabled objects are included in a change package, additional steps will be present in the
Change Assistant job template to perform the automatic merge.

The new steps will perform the following update actions:
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1. Running the Merge Analysis Process-IP

This step will run the merge analysis process in the initial pass for mergeable objects included in the
current change package. The merged code is stored in staging tables.

2. Backing Up Source Objects Prior to Merge Promotion

This step will run Copy to File for existing (delivered) objects from PUM source prior to merge
promotion. This file is used to restore the PUM Image to it’s original (pre-merge) state after the
merging process is complete.

3. Running the Merge Promotion Process-IP

This step will run in the initial pass to promote the staging tables to the PUM Source tables.

4. Exporting Change Package MO Project from Source

This step creates a project with the merged code that is exported back into the change package.

5. Restoring Source Objects After Completing Merge

This step runs the Copy from File to restore the PUM delivered objects from the backup created in the
step Backing Up Source Objects Prior to Promotion.

6. Running Compare of Vanilla Object Project

This step compares the PeopleSoft delivered version of the objects that were merged to the target
database. These secondary compare reports can be used for additional reference when reviewing the
primary compare results which compare the Merged versions of the mergeable objects to your target
database.

7. Updating the Project Actions for Merged Objects

After the Managed Object compare is run, you can review the compare reports which will show how the
code was merged.

Note: If the merge steps fail, you can view the Merge Session to resolve any issues. See Viewing PUM
Automated Merge Sessions.

Viewing PUM Automated Merge Sessions

The PUM Automated Merge Session displays how the code is automatically merged based on the merge
rules. This page can be used if the merge steps in the template fail or to review how the code was merged.

To access a merge session from a Change Assistant job, right-click on the step Running Object Merge and
select View Merge Session.

To access a Merge Session in Change Assistant:

1. From the menu, select Change Action.

2. If the Welcome page is displayed, click Next.

3. Select View PUM Automated Merge Sessions and click Next.
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4. Select Open Existing Merge Session and click Finish.

5. Select the PUM Source Database and click OK.

6. Select the Merge Session.

This example illustrates the fields and controls on the Merge Session page. You can find definitions for
the fields and controls later on this page.

The Merge page contains these panes:

• Object list

• Merge edit pane

• Merge output pane

• Parent (A) Data

• Child 1 (Customization) Data

• Child 2 (Delivered) Data

Merge Menu

Field or Control Description

Save Session Select to save session.

Set Merge Rules Select to change merge rules.

Exit Select to exit.
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Object List

Field or Control Description

Object Mergeable object name.

Type Object type:

• P (PeopleCode)

• S (SQL)

• X (XSLT

Status Object Status:

• In Progress (Default status. Will be considered for
promote merge)

• Completed (Optional - User can mark this as complete
after review. Objects with this status as well will be
considered for promote merge)

• No Action (User can select this if he/she does not want
the respective object to be merged in promote merge step)

• Applied (Only visible and selected when object is merged
in promote merge step)

Merge Edit Pane

Change Assistant displays the comparison in the merge edit pane. Lines from Child 1 and Child 2 are
listed in the merge pane and in the output pane according to the merge rules.

In the merge edit pane, the Child1 and Child 2 column shows the state of the line and the database to
which it belongs. The lines are also color coded to show the state of each line. The color codes are, by
default:

Action Color

COMMON Black

ADDED Green

CHANGED Blue

DELETED Red
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Action Color

COMMENT Gray

READ ONLY Black

Common lines are grouped in collapsed sections. Click the expand icon to expand each section.

Click in the text area of a line to edit the text.

To add lines to the merge edit pane from the individual data panes :

1. Highlight a line in the data pane.

2. Highlight a line in the merge edit pane.

The new line will be inserted below the highlighted line.

3. Click an action icon to either insert the line or insert it as a note.

To add a blank line or delete a line, select the line and click the Add line icon or the Delete line icon on
the Merge toolbar.

The Merge toolbar contains these options:

Field or Control Description

Add line.

Delete line.

Previous difference.

Next difference.

Insert Parent line.
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Field or Control Description

Insert Parent line as note.

Insert Child 1 line.

Insert Child 1 line as note.

Insert Child 2 line.

Insert Child 2 line as note.

Merge Output Pane

The output pane displays the current merge results. Initially, the output pane displays the results of the
comparison based on the merge rules. When you apply changes, the new merge appears in the pane.

Data Windows

When you select a program, Change Assistant displays the three versions of the program in the respective
Parent (A) Data, Child 1 (Customization) Data, and Child 2 (Delivered) Data windows.

Copyright © 1988, 2022, Oracle and/or its affiliates. 281



Using PUM Automated Merge Chapter 15

282  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 16

Managing Test Repository

Understanding Test Repository

The test repository provides awareness for mapping tests to bug fixes when selecting updates in the PUM
search. The test repository includes:

• Test repository in the PUM Source.

• Visualization of test impact in the PUM Search.

• Ability to take action based on identified test impacts.

• Test Repository persistence mechanism.

See Migrating PUM Data

Creating Test Repository

The test repository resides on the PUM Source. In order to create the repository, you must first identify
the components or tests that you want to track in the target databases in a project and then upload the
metadata to the PUM Source. The test projects apply across all your target databases.

Test information is uploaded to the PUM Source in Change Assistant. Depending on the type of test
project uploaded the following occurs:

• PTF Tests

Change Assistant will read the test metadata and determine all of the components associated with
the test. The test information metadata is uploaded to the test repository by test name. The test object
reference will display the all the tests associated with the component.

• Components

For customer who do not use PTF, you can create projects that contains components. The test
information (component names) is uploaded to the test repository using the project name. The test
name will be the same as the project name.

Note: It is not necessary to use PTF in order to use the test repository. Test impact is calculated based on
components.

1. Create a project on the customer database that includes your components or tests.

Note: You can create as many test projects as required.
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There are several methods available to create the test project:

• Create the test project in Application Designer by adding the tests or components to the project.

• Create the project in Change Assistant using the Create New Database Project option in Upload
Customer database to Image.

2. (Optional).Copy the test project to file.

3. Use Change Assistant to upload the customer data to PUM Source.

4. Review the upload on the PUM Source.

5. Run the Test Coverage Calculation on the PUM Source.

Uploading Tests to PUM Source
Navigation:

To upload tests to the PUM source:

1. In Change Assistant, select Tools, Options.

2. Select the PUM Source tab.

3. Select the Manage button for the Test Repository
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This example illustrates the fields and controls on the Manage Test Repository page. You can find
definitions for the fields and controls later on this page.

There are 3 options for uploading test data:

• Select Existing Project File(s)

• Select Existing Database Project(s)

• Create New Database Project

After selecting the projects, click the Load button to upload the tests to the PUM source Test Repository.

Copyright © 1988, 2022, Oracle and/or its affiliates. 285



Managing Test Repository Chapter 16

Select Existing Project File(s)

This example illustrates the fields and controls on the Select Existing Project File(s) page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Target Repository Test is selected and read only.

Project Type Tests are always managed object, the field will be grayed.

Folder Select the folder where the project file is stored.

Search Enter value to search for and press the Enter key.

All projects matching the entered value will be returned.

Project Grid Select the projects that you want to upload from the project
grid.

Add Selected Click the Add Select to return to the Upload Customer Data to
Image page.
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Select Existing Database Project(s)

This example illustrates the fields and controls on the Select Existing Database Project(s) page. You can
find definitions for the fields and controls later on this page.

Field or Control Description

Target Repository Test is selected and read only.

Project Type Tests are always managed object, the field will be grayed.

Database Select the target database where the project file is stored.

Search Enter value to search for and press the Enter key.

All projects matching the entered value will be returned.

Project Grid Select the projects that you want to upload from the project
grid.

Add Selected Click the Add Select to return to the Upload Customer Data to
Image page.

Copyright © 1988, 2022, Oracle and/or its affiliates. 287



Managing Test Repository Chapter 16

Create New Database Project

This example illustrates the fields and controls on the Create New Database Project page for the Test
Repository. You can find definitions for the fields and controls later on this page.

Field or Control Description

Database Select the database that contains the PTF tests.

Project Name Enter the Project Name.

All PeopleSoft Test Framework Tests This feature will insert all PTF tests in the database.

Using the Test Repository

Once test projects have been uploaded to the PUM Source, the Update Manager Dashboard provides the
following components to manage the test repository:

1. Manage Tests

2. Manage Test Objects

3. Run Test Coverage Calculation

Manage Tests
The Test Repository is used to identify the relationship between tests and components before the change
package is created. For PTF customers, this would be the same as the Test Coverage Report, however it is
available when selecting updates in the PUM Search. The Test Repository is delivered empty on the PUM
Source and must be populated using Change Assistant to upload the customer data.

To access the Manage Tests page, select PeopleTools >Lifecycle Tools >Update Manager
Dashboard >Test Repository >Manage Tests.
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This example illustrates the fields and controls on the Manage Tests page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Test Name For PTF tests, this is the name of the test. For component
projects, this is the name of the project.

You can have 0–n test defined. Each defined test must have a
unique test name.

Description Use this field to provide a more detailed description of the test.

Include in Package Specify whether bug fixes which impact the specified test
should be, by default, included or excluded from change
package creation.

• No – exclude from package creation

• Yes (default) – include in package creation

Note: This value can be overridden in the PUM Search.

Include Bugs that Reference Components Without Associated
Tests in Package

Select Yes to include the bugs in the change package even if
the component does not have an associated test.

Select No if you want 100% test coverage for the package.
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Adding Tests

To manually add tests, use the + action in the grid. When this method is used, a new row is added,
however no objects will be associated with the new row. Use the Define Test Object Reference page to
add the objects. See Managing Test Objects.

Rows can also be added by uploading customer data through Change Assistant. See Creating Test
Repository.

Deleting Tests

To delete a tests, use the – (delete row) action in the grid.

If a test is deleted, the test coverage calculation must be re-run to ensure that the correct metadata exists in
the database.

Managing Test Objects
The Manage Test Objects page contains a list of the test objects. The same object may exist in more than
one test.

Navigation:

To access the Manage Tests Objects page, select PeopleTools >Lifecycle Tools >Update Manager
Dashboard >Test Repository >Manage Test Objects.

This example illustrates the fields and controls on the Manage Test Objects page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Filter By Name Use the Filter By editbox to select a test name and display all
the components associated with that test.

Object Type The object type is Component.
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Field or Control Description

Object Value 1–4 These 4 columns are the same 4 key columns used to identify a
managed object in PUM and managed object projects.

Tests Displays the test count. Click the count link to open the Add/
Delete Test Coverage page, which displays the test names
associated with the component.

To delete a component, select the component on the grid and click Delete Selected.

Adding and Deleting Tests

To add or delete test coverage, click the count link. This will open the Add/Delete Test Coverage page.

This example illustrates the fields and controls on the Add/Delete Test Coverage References page. You
can find definitions for the fields and controls later on this page.

Use the + (add row) icon to add a test. The list of tests to add to a component is limited to the list of tests
defined in the Test Repository.

Use the – (delete row) icon to delete a test from the component.
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Running Test Coverage Report
In order to manage and display the test impact in the PUM Search UI, a test coverage calculation must be
generated for each bug fix in the Image. The Test Coverage Calculation page is used to run the calculation
for the components identified in the Test Repository.

Navigation:

To access the Run Test Coverage page, select PeopleTools >Lifecycle Tools >Update Manager
Dashboard >Test Repository >Run Test Coverage Calculation

This example illustrates the fields and controls on the Test Coverage Calculation page.
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Defining Change Packages

Understanding Change Packages

There a four types of Change Packages.

1. Update Package

Update change packages contain updates and enhancements selected by the customer, along with the
pre and post requisites. There are multiple ways for customers to select which updates to apply.

See Defining Update Change Packages

2. Upgrade Package

Upgrade packages are used when a customer upgrades to application 9.2. The Upgrade change
package will contain the Application Upgrade template from the current release to 9.2. Upgrades also
require a Required for Upgrade package which contains all of the bugs required for upgrade

See Defining an Upgrade Package

3. Tools Delta Package

Tools Delta change packages are used after a PeopleTools upgrade and contain attributes or objects
that were stripped away when the updates were applied in the old release.

See Creating and Applying Tools Delta Package

4. Translations Delta Package

Translation Delta packages contain languages and translation fixes.

See Defining Translations Delta Package

Defining Update Change Packages

The latest PeopleSoft Update Image downloaded from MOS includes the PeopleSoft working database,
PeopleTools, applications, managed objects, codeline, and the data and metadata required to use the
PeopleSoft Update Manager. The Update Manager PIA interface is used to identify required and desired
updates for the change package definition.

The Define Change Package wizard will guide you through the steps to create a change package
definition. There are 6 steps:

1. Select Target Database
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Note: The target database is selected from the Select Target Database folder on the Update Manager
Dashboard. This page is only displayed when no target databases have been up loaded.

2. Enter Change Package Name

3. Select Scope

4. Select the updates, objects or criteria

Based on the scope selected in step 3, appropriate page will open to select your updates. If you select
All Updates Not Applied in step 3, this step is skipped.

5. Review Bugs

6. Done Identifying Bugs

Dependency Calculator

When the user transitions from Step 4 to Step 5 the dependency calculator is automatically executed.

• The calculator is a PeopleCode Program.

• If you selected to select by Specific Updates, Updates by Criteria, or Updates by Object Name,
the dependency tree is calculated such that  bugs that are Already Applied, and the post-requisites
of those same bugs are excluded from the package during the calculation process. Unapplied pre-
requisites of applied bugs will, however, be included in the calculated result.

• If you selected All Updates Not Yet Installed, the calculator will insert all updates that have not been
applied in the selected target environment into the results table.

Note: All requisite updates are specific to and calculated based on the target database. If the change
package is reused for another database, Change Assistant will perform a check to ensure all requisites
exist. If requisites are missing, you will get an error message.

Define Update Package Wizard Step 1 of 6
Custom change packages are created on to your PUM Source Database.

Navigation:

On to your PUM Source Database, select PeopleTools >Lifecycle Tools >Update Manager >Update
Manager >Select Target Database

All environments that were selected as target databases in Change Assistant Wizard and uploaded to the
PUM Source will be displayed in the list. This list is also filtered by UserID.
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This example illustrates the fields and controls on the Select Target Database.

Note: The target database information is uploaded to the PUM source database when you select the
Upload Target Database Information to PUM Source. See Uploading Target Database Information

If you only have one database, it is selected by default.

Define Update Package Wizard Step 2 of 6
Navigation:

Open the Define Change Package folder and select Update Package.

The second step is to enter an update package name.

This example illustrates the fields and controls on the Update Package Step 2 of 6 page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Action Select the action. Create is the default.

Select Edit if you want to update an existing package
definition.

Package Name Enter a name for your custom change package. To edit an
existing change package, select the Lookup button. The list of
change packages that can be edited is restricted as follows:

• Packages created by the current user.

• Packages created for the currently selected target
database.

• Packages which have been defined but have not been
created.

Package Description Enter a description for the change package.

Click Next.

If you selected Create and the package name already exists, a message “Exiting package name not
permitted in Create action mode (269,259) Enter a new package name to continue.

If you selected Edit, the Change Package Options page id displayed.

Change Package Options

On the Change Package Options page, you can select whether to edit or replace the change package.

This example illustrates the fields and controls on the Change Package Options page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Edit Select this option to edit the existing change package. The
search results previously entered are retained.

Replace Select this option to replace the existing change package.

Cancel Select this option to cancel and select a new name for the
change package.

Define Update Package Wizard Step 3 of 6
The third step is to select the scope to use for searching for updates.

This example illustrates the fields and controls on the Update Package Step 3 of 6 page. You can find
definitions for the fields and controls later on this page.

Note: Regardless of the option you choose, all available and not yet applied requisite updates for the bugs
selected will be included in the change package.

Field or Control Description

Standard System Search Criteria Select this option to perform a simple standard search.

Previously Defined Search Criteria Select this option to use a saved search.

All Other Search Criteria Select this option to perform a selective search
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Selecting Standard System Search
Select the Standard System Search radio button and click Next.

This example illustrates the fields and controls on the Standard System Search Criteria. You can find
definitions for the fields and controls later on this page.

Field or Control Description

All Unapplied Updates for Installed Products Change package containing all updates for all installed
products not applied on target database.

All Critical Unapplied Updates for Installed Products Change package containing all severity 1 updates for all
installed products not applied on target database.

All Critical Updates Not Applied Change package containing all severity 1 updates not applied
on target database.

All Tax Updates Not Applied Change package containing all tax updates not applied on
target database.

All True Requisites Not Applied Change package containing all true requisites updates not
applied on target database.
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Field or Control Description

All Updates Not Applied Change package containing all updates not applied on target
database.

Selecting Previously Defined Search Criteria
Select the Previously Defined Search Criteria radio button and click Next.

This example illustrates the fields and controls on the Previously Defined Search Criteria. You can find
definitions for the fields and controls later on this page.

Customer saved searches will be displayed. Select the saved search to use for the new update package.

Selecting All Other Search Criteria
Select the All Other Search Criteria radio button and click Next.
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This example illustrates the fields and controls on the All Other Search Criteria. You can find definitions
for the fields and controls later on this page.

The search process is iterative. Once you have selected bugs into the search results gird, you can select
another search option and add additional bugs to the search result grid. Search and selection can be
performed in any order, the results are recalculated with each search.

Field or Control Description

True Post Requisites When you select this option, the Search by True Post
Requisites page is displayed. Users can use the Search button
to display the post requisite bugs. Users have the option to
select or deselect the bugs in the grid.

If there are no unapplied true requisites for the target database,
 this option will be grayed out and not selectable.

New Features Select this option to search for new features.

Note: This option is equivalent to using the Advanced Search
option in PeopleTools 8.54 and selecting the tracking group
Enhancement with the value Enhancement.

Translations Only When you select this option you see a field that allows you to
select a language.

If the target database is English Only, this link will be greyed
out and not selectable.
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Field or Control Description

Tax Updates Select this option to search for tax updates.

If there are no unapplied tax updates for the target database,
 this link will be greyed out and not selectable.

Specific Bugs Select this option to search for updates related to specific Bug
IDs.

Specific Objects Select this option to search for updates related to specific
PeopleSoft managed objects.

Prod/Severity/Image Select this option to search for updates by various criteria such
as Product, Severity, or Image.

Other Criteria Other criteria covers any tracking groups for the application
that are not covered in another search, such Legislative/
Regulatory, Multi-instance, or PeopleTools Compatibility.

Tracking groups will differ by product.

If there are no unapplied other criteria for the target database,
 this link will be greyed out and not selectable.

Advanced Options Select this link to set the dependency calculation.

See Using Advanced Options Page

Selecting Specific Bugs
Select the Specific Bugs link.

Note: Specific bugs can be combined with bugs using any of the other search criteria options.

This example illustrates the fields and controls on the Search by Bugs page. You can find definitions for
the fields and controls later on this page.
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Field or Control Description

Enter Multiple Bug Numbers Use this link to open a model window where you can enter the
specific bugs. Use a comma or space to separate Bug numbers.

Bug Number Use the lookup icon to select specific bugs. Add additional
rows as needed.

Product The product from the bug will be displayed as read only.

Subject The subject from the bug will be displayed as read only.

This example illustrates the fields and controls on the Find these specific Bugs page that opens when
Enter Multiple Bug Numbers is selected. You can find definitions for the fields and controls later on this
page.

Once you have selected the updates, click Next.

Selecting Updates by Prod/Severity/Image
Select the Prod/Severity/Image link.
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This example illustrates the fields and controls on the Search by Product/Severity/Image page. You can
find definitions for the fields and controls later on this page.

The Search by Product/Severity/Image page, enables you to search for updates by:

• Product Family

Allows you to select one or more values.

A Product Family is a grouping of products. This grouping is defined by PeopleSoft, and is intended
to align with the “Bundle” groupings in non-PUM enabled application updates.

Note: Product Family = PNA will select all fixes for Payroll North America (equivalent to a PNA Tax
Update in prior releases),
Product Family = Global Payroll will select all fixes for Global Payroll products (equivalent to a GP
Update Bundle in prior releases).

• Installed Products

You can select if you want to include related components and subcomponents and then select the
installed products to search. A related component or subcomponent is a defined relationship between
products. This relationship is defined by  PeopleSoft, and is intended to assist the search experience
by including the related products automatically when a given product is selected.

• Severity

Select the severity:

• 1 - Complete loss of service

• 2 - Severe loss of service

• 3 - Minimal loss of service

• Image Number
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When you select this option you see drop-down lists for From PI and To PI. Enter a range of image
numbers to include in the search.

The minimum allowed value is image 1.

This example illustrates the fields and controls on the Example Search by Severity. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Show Already Applied Updates Select this check box to include already applied updates in the
result set. If this check box is selected, a visual indicator will
appear in the Applied column.

Bug Number Lists the bug numbers returned by the search.

Subject Displays the subject for the bug.

Applied A visual indicator will be displayed, if the Show Already
Applied check box is selected and the bug has already be
applied to the target database.

This bug is not included in the change package definition.

True Post Req True post-requisite updates will be sorted to the top of the bug
list. A visual indicator is displayed to identify the bug as true
post requisite.

All bugs discovered based on the Post Requisites for (Select)
Previously Applied bugs will be listed as suggested.
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Field or Control Description

Custom Impact Indicates whether or not the bug has an impact on an object
stored in the Customization Repository.

If the Customization Calculation has not been run this column
will display Run Calc.

See Using Customization Repository

Test Exists A visual indicator will be displayed if the bug has an impact
on tests defining in the Test Repository.

See Using the Test Repository

Image Image number that contains the bug.

Details Click this icon to display the bug details.

Selecting Specific Objects
The Specific Objects link, enables you to search for updates related to specific traditional or ADS
managed objects. Select an object type and enter an object name. For example, you can search for the
PERSONNEL record and see all of that record’s related fixes.

To search for updates related to specific PeopleSoft objects:

1. Select an object type from the drop-down list.

2. Enter an object name.

For example, you can search for the records that start with JOB and see all of that records that start
with JOB.

3. Optionally, deselect the Hide Objects of Applied Bugs if you want to see objects matching your
criteria that have already been applied.

4. Click Find.

After clicking the Find button, the grid displays your query output; in this instance, the specific
PeopleSoft objects related to your search criteria.

5. Select the check box next to each object in the result grid that you want to search for.

6. Click the Search for Bugs button.

7. By default all bugs returned in the grid will be selected.

You can manually deselect a bug or use the Clear All button to clear all the selections and then
manually select the bugs to include.
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8. Optionally, select the Show Already Applied Updates check box to include bugs that have already
been applied to the target database or environment.

This example illustrates the fields and controls on the Search by Objects page. You can find definitions
for the fields and controls later on this page.

Selecting True Post Requisites
Select the True Post Requisites link.

True Post Requisites are those that are defined by PeopleSoft, as being critical to correct or complete a
previously posted fix.
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This example illustrates the fields and controls on the Search by True Post Requisites page.

Selecting Tax Updates
Select the Tax Updates link.

This example illustrates the fields and controls on the Tax Updates Search page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Tax or Regulatory Update When you select this option you see a drop-down list for Tax
or Regulatory updates available.
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Field or Control Description

Image Number When you select this option you see drop-down lists for From
PI and To PI. Enter a range of image numbers to include in the
search.

Selecting New Features
Select the New Features link.

This example illustrates the fields and controls on the New Features Search page. You can find definitions
for the fields and controls later on this page.

There are 2 filter options to assist in the search for new features, Installed products and Image Number.
These filters are optional and if you click Search for Bugs with no filters, all matching rows will be
returned.

Field or Control Description

Installed Products When you select this checkbox, the installed products are
displayed and available to select.

Image Number When you select this option you see drop-down lists for From
PI and To PI. Enter a range of image numbers to include in the
search.
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Selecting Other Criteria
Other Criteria allows you to search by tracking group and image. Tracking Groups are defined by
PeopleSoft on an as required basis in order to facilitate the search for fixes of a specific, often functional,
type. Tracking groups will differ by product.

Select the Other Criteria link.

This example illustrates the fields and controls on the Search by Criteria page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Tracking Group Select the Tracking Group name and value.

Image Number Select the Image Numbers to search.

Using Advanced Options Page
Use this page to set the dependency calculation. The package dependency calculation can optionally
include or exclude the post requisites of fixes that have previously been applied to your target database
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This example illustrates the fields and controls on the Advanced Options page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Yes Include Post Requisites of Already Applied Bug Fixes

The full Dependency Tree is calculated prior to checking
whether bug fixes included in the calculation have previously
been applied to your target. The resulting package will include
the Post Requisites of Already Applied bug fixes, but not the
Already Applied bug fixes or their pre-requisites. Selecting
this option will generally result in a larger change package
being created, but this may reduce the chances of missing a
fix.

No Exclude Post Requisites of Already Applied Bug Fixes 
(default)

The Dependency Tree is calculated such that bugs that are
Already Applied are removed during the calculation process,
 and as a result the resulting package will not include the
Post Requisites of the Already Applied bug fixes, nor the
Already Applied bug fixes or their prerequisites. Selecting
this option will generally result in a smaller change package
being created, but this may increase the chances of missing a
required fix.

Using the Selection Grid
Regardless of the search option selected, the search results will always be displayed in the selection grid
at the bottom of the search page.
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This example illustrates the fields and controls on the List of Updates grid. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Show Already Applied Updates Select this check box to include already applied updates in the
result set. If this check box is selected, a visual indicator will
appear in the Applied column.

Bug Number Lists the bug numbers returned by the search.

Subject Displays the subject for the bug.

Applied A visual indicator will be displayed, if the Show Already
Applied check box is selected and the bug has already be
applied to the target database.

This bug is not included in the change package definition.

True Post Req True post-requisite updates will be sorted to the top of the bug
list. A visual indicator is displayed to identify the bug as true
post requisite.

All bugs discovered based on the Post Requisites for (Select)
Previously Applied bugs will be listed as suggested.

Custom Impact Indicates whether or not the bug has an impact on an object
stored in the Customization Repository.

See Using Customization Repository

Test Exists A visual indicator will be displayed if there is a test name in
the Test Repository corresponding to an object in the bug.

See Using the Test Repository

Details Click this icon to display the bug details.
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Define Update Package Wizard Step 5 of 6
The fifth step is to review the results of the dependency calculation. This page will display all of
the updates selected, as well as all dependent updates. Any updates that include PeopleTools hard
dependencies will be excluded from the change package and listed in the Excluded Tools Dependent Bug
grid.

Note: This page is read-only. In order to modify the results, the user must click Previous to return to the
previous page in the Wizard.

This example illustrates the fields and controls on the Update Package Step 5 of 6 page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Bug Number All of the bug numbers that will be included in the change
package are listed.

Product The PeopleSoft product impacted.

Subject Displays the subject for the bug.

User Selected If the bug number was selected in Step 4, this column will
contain a check. Updates that do not have a check are required
for the selected updates.
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Field or Control Description

Applied If the bug has already been applied to your database, this
column be checked.

Note: Applied bugs are not included in the change package
definition.

True Post Req Icon is displayed to indicate the bug type.

Subject Bug subject is displayed

Image Number Image where the bug was fixed.

Custom Impact Indicates whether or not the bug has an impact on an object
stored in the Customization Repository.

See Using Customization Repository

Test Exists A visual indicator will be displayed if the bug has an impact
on a referenced component stored in the Test Repository.

See Using the Test Repository

Click the Bug Details icon to display the Bug information.

Excluded Bug Fixes Section Expand this section to view bugs that are excluded from the
package, excluded bug will include bugs that have already
been applied, bugs the user excluded, bugs that fail to meet the
minimum tools level, and bugs that are required for upgrade.

Overlapping Packages Section This section will appear if any of the bugs selected have
already been included in another change package definition
that has not been applied to the database.

Note: If overlapping packages are listed, you will be prompted
to either click OK to ignore the overlapping packages, or click
Cancel to return to the previous page and review the change
package.

Bug Details

When you click the bug details icon, a modal window is displayed:
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This example illustrates the fields and controls on the Example Bug Details (top of page). You can find
definitions for the fields and controls later on this page.

Field or Control Description

Summary of Metadata for this Package For each metadata type, if there is metadata, a link Available is
displayed. Use this link to go to that section of the bug detail.

If the metadata type is not contained in the package, the
metadata type will indicate Not Applicable.

Bugs delivered through a PRP will have no data on
components to test , therefore Components to Test will
indicate No Data.

Pre-requisite Bugs List of pre-requisite bugs, their subjects and image numbers.
 Click the Details icon to open a window with the bug details.

Tags Defined by Bug The tag name and value represent the tracking group and
value. A bug can have 0-n Tracking Groups defined.

Managed Objects Included in Update List of managed objects included in the change package. The
object columns list the records, fields and so on, that are part
of the fixes in the bug.

314  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 17 Defining Change Packages

Field or Control Description

ADS Managed Objects Included in Update List of ADS managed objects included in the change package.
 The columns list the Data Set name, customization count, data
set record, and object values that are part of the fixes in the
bug.

Post-requisite Bugs List of post-requisite bugs, their subjects and image numbers.
 Click the Details icon to open a window with the bug details.

Customizations Lists the names of the customizations that affect this bug.

Tests Lists the test names that provide coverage for this bug.

Components to Test Lists the components to test for this bug.

Define Update Package Wizard Step 6 of 6
When you transition to step 6, the Change Package Aggregator will execute. The Change Package
Aggregator is an engine that aggregates the steps from one or more BUG step apply structures into one
single list of steps. This list of steps is then passed to the Change Packager API so that a Change Assistant
template can be generated. The Change Package Aggregator will also remove any duplicate steps.

This example illustrates the fields and controls on the Define Update Package Step 6 of 6. You can find
definitions for the fields and controls later on this page.

A summary is displayed for the Change Package. A link is provided to Review Change Package.

See Reviewing Change Package

From 8.60, you can either create and apply change package from this step or return to Change Assistant to
begin packaging.
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You can also define and create Change Package from the Define Job page ( select Update Scheduler,
Define Job).

For Upgrade Package type, only Create Change Package option is available.

For all other package types, Create and Apply Change Package options are available.

Refer Scheduling Update Jobs
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Applying Custom Change Packages

Packaging Updates

After defining the Change Package, you must return to Change Assistant to create the package.

1. Select Tools, Create Change Package.

2. Select the new change package from the drop down list.

3. Optionally select the Apply Change Package check box.

If selected the Apply Change Package Wizard will launch when the package is created.

4. Click Finish.

The progress dialog box will open to indicate the change package is being created.

The change package is created as upd<change package definition name>.zip. For example
updPKG1.zip.

5. Click OK on the message Change Package <package name> has been successfully Created in the
Download Directory.

Change Packager is also aware of the target environment, including the platform and all installed
products. The Change Package will include platform and product filters.

This example illustrates the fields and controls on the Create a New Change Package. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Download Directory When the change package definition is defined on the PUM
Source, it will be downloaded to the directory indicated
here. By default the download directory defined for Change
Assistant is used.

Change Package Select the change package definition from the drop down list.

Create Selected Change Package Definition This check box is selected and read-only. After selecting the
change package definition when you click Finish, Change
Assistant will create the change package in the download
directory.

Proceed to Apply Change Package Wizard after Package
Creation

Select this option if you want to apply the change package as
soon as it’s created. If you leave this check box cleared, you
can review the Change Package before applying it.

Change Package Contents in the Download Directory

The download directory will contain the following:

• Zip file for the change package name upd<changepackage_name>.zip

• Project Directory named upd<changepackage_name>

Depending on the updates selected, the project directory contains the following folders:

Field or Control Description

changeassistanttemplate Contains the Change Assistant template for the update job

DATA Contains any data files required for the selected updates.

Documentation Contains the documentation for the Change Assistant job.

Projects Contains the Managed Objects project.

Scripts Contains any scripts files required for the selected updates

SQR Contains any SQRs included in the selected updates.
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Applying Change Package

The Apply Change Package wizard will guide you through the configuration based on the Apply Type
that is selected.

Understanding the Apply Update Process
When the custom change package containing your selected updates is created not all files are included in
the change package for 2 major reasons:

1. Reduces the time it takes to create the initial package.

2. Leverages Change Assistant job filtering to eliminate the creation of files not required by your target
environment.

The update job is filtered based on the target environment and only the files required for the target
environment are created from the PUM source. Depending on where the PeopleSoft Update Image (PUM
Source) is installed the process may be very time-consuming, to alleviate this issue customers have the
option to run the source and target steps in separate jobs.

The initial pass to apply updates has the following options:

• Source Steps Only

The Source Steps Only option provides the ability to run the initial pass to create all files that are
contained in the change package. This job can be run on the same machine where the PUM Source is
installed. Once the initial pass has completed, a modified change package is created that contains all
the files. The modified update change package can then be copied to the machine where you will run
the Apply Update on your target database.

• Target Steps Only

Using the new change package created from the Source Steps Only job, you can apply the change
package to your target database without requiring a connection to the source database. When the job is
created for the target environment, all unnecessary files are filtered out.

• All Steps

All steps requires a connection to both the target database and the PUM source. When this option is
selected, the source steps will create the necessary files needed for the target system.

Applying the Change Package
To apply the change package:

1. Start EMF if it is not already started and you selected Configure EMHub For File Deploy on the
EMHub Options page in Change Assistant.

Note: EMHub is only required for file deploy. If you plan to manually deploy file, skip this step.
If EMHub is not running, the Change Package template will include a step to manually copy the
files included in the Change Package to the various Application Server(s), Web Server(s) and File
Server(s) associated with the current Target Database.
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2. In Change Assistant, select Tools, Change Actions.

3. Select Update Manager and Click Next.

Note: If you are already in the Update Manager action, select Tools, Apply Change Package.

4. Select Apply Change Packages and click Finish.

5. Select the download directory where the change package was created.

6. Select the change package that was created for your custom change package definition.

7. Select Initial Pass.

By default All Steps is selected. Change this value if you choose to decouple the source and target
steps.

This example illustrates the fields and controls on the Change Package Settings page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Download Directory When the change package definition is defined on the PUM
Source, it will be downloaded to the directory indicated
here. By default the download directory defined for Change
Assistant is used.

Change Package The change package name will include the change package
definition. upd<your change package name>.zip.
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Field or Control Description

Apply Type • Initial Pass

You will first apply the update to your development
environment which is an Initial Pass.

In the Initial Pass you will perform compares to retrofit
your customizations and repackage the update to
include all your customizations.

Important! Development environment must have the
same maintenance level as any additional targets where
you intend to subsequently reuse this package (after
incorporating customizations) and apply them using the
Move to Production apply type.

In the initial pass, you can select which steps to
perform.

See Understanding the Apply Update Process

• Subsequent Pass

The final step in the initial pass creates a
modified change package which includes all your
customizations. This modified change package is then
used to apply the updates to additional target databases
the same maintenance level. If you select subsequent
pass, the modified change package will contain Less
manual stops than the initial pass, but will include a
manual stop to review the change package and a step
to update the change package. Typically you would run
an initial pass, then a subsequent pass and then the final
move to production.

Note: The subsequent pass template is similar to the
Move to Production pass templates delivered in Images
on PeopleTools releases prior to 8.57.

• Move to Production

Use the Move to production pass to apply your updates
to the Production database. This pass will execute
the SQL's used in the initial pass or subsequent pass
bypassing the build steps. There are less steps and
manual stops reducing apply time.

See PUM Best Practices and Maintenance Strategy
document post on the PUM Homepage.Update Manager
Home Page
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Field or Control Description

Synchronize Target Metadata (Requires Source) Select Yes to upload the target database information to the
PUM Source when the update is applied.

The default is Yes, however if you are applying the update to
a database that is not used for defining and creating change
packages in PUM, there is no need to upload the database
information to the PUM Source and you would select No.

Note: If the PUM source is not defined, this option will not
be enabled.

8. Click Next.

9. Select the target database.

Note: Use the Create button to create the target database if it has not been previously created. See
Defining Databases and Defining Target Database

10. If you are using EMHub, select the file server.

322  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 18 Applying Custom Change Packages

This example illustrates the fields and controls on the Select Target Database page. You can find
definitions for the fields and controls later on this page.

11. Click Next.

12. Change Assistant will perform primary checks, validate the target environment and validate the source
environment. The Validation page displays the status for the specific validations.
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This example illustrates the fields and controls on the Validation page.

13. Click Next.

14. The Apply Summary is displayed, click Finish.

Change Assistant will begin building the Change Assistant job.

15. The Update job will be created and open in Change Assistant.

Reviewing the Change Assistant Job

After you apply a change package, the Change Assistant job is created using the selected change package
and options.

Understanding Job Naming Conventions
The Update job name reflects the criteria selected for the job.

Softwareupdate.<PACKAGE NAME>.{<PUM SOURCE DATABASE>-<TARGET-DATABASE}<IP or MTP>
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For example:

Softwareupdate.SELECTIVE.{HR92U016-HC920001}IP

In this example, the package name is SELECTIVE, the PUM source database is HR92U016, the target
database is HC920001, and the apply type is Initial Pass.

Staging and Output Directories

When the Change Assistant job is created, a folder for the job is created in both the Staging and Output
directory. The folder will have the same name as the Change Assistant job. In the example above the
folder would be named softwareupdateSELECTIVE{HR92U016-HC920001}IP.

When Change Assistant is creating a new job, if an existing output and staging folder is found, Change
Assistant will add a number to the folder, for example, softwareupdateSELECTIVE{HR92U016-
HC920001}IP.1.

Understanding Job Filtering
Change Assistant will filter the job to only include the steps that apply to your environment. The job is
filtered by step attribute criteria, including:

• Platform

• Language

• Products

• PeopleTools Release

• Orientation

• EM Hub

If the EM Hub is defined and the target database is defined to the hub, the file deploy steps will be
included in the job, if it is not defined, the file deploy steps will be set to Filtered at the Job Level.

• Synchronize Target Metadata

If the Synchronize Target Metadata option is set to No , the step Re-Synching Target Details with PI
Image will be set to Filtered at the Job Level.

Creating Filtered Documentation

The Change Assistant template is delivered with embedded documentation to help guide you through
the change package jobs, especially the manual steps. You can create a single HTM file that is filtered
to contain only the documentation for the chapters, tasks, and steps relevant to your job. This section
assumes that you have created a Change Assistant job from a PUM change package. To create the filtered
documentation:

1. In Change Assistant, in Update Manager mode, highlight the root node of the template.

2. Right-click, and select Finalize Documentation.
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This produces a single consolidated HTM file named for the update job. The file is saved on your
client machine in the following location, where <staging_directory> is the directory you specified on
the General Settings page:

<staging_directory>\<change assistant job name>\Documentation\<package_name>.h⇒

tm

For example: D:\PUM\Staging\softwareupdateSELECTIVE{HR92U016-HC920001}IP
\Documentation\SELECTIVE.htm.

Running Change Assistant Job
Change Assistant will execute each step in the job until completion, unless a manual step or error is
encountered.

When you encounter manual steps you will need to take some action, such as review compare reports. If
you make any changes while the job is executing, you will want these same changes applied to additional
targets.

Running SQRReport Steps

For Change Assistant jobs created from PUM change packages only, you can edit the SQRReport step
type to add a user-defined Run Control ID, as follows:

1. Highlight the step and select Edit, Step Properties.

2. Select the Step Definition tab.

3. Click Additional Settings.

4. Add the Run Control ID, and specify any other settings needed.

If no value is entered for Run Control ID, the default value ADHOC is used.

5. Click OK twice and restart the Change Assistant job.

Updating Package for Subsequent Passes
The last steps in the initial pass and subsequent pass template are used to prepare your change package for
the Move to Production.

Step Type Description

Copying Customized Codeline Objects Manual Stop Manually copy your customized codeline
objects (located in PSHOME / PS_APP
_HOME / PS_CFG_HOME or such
similar locations to the staging directory.
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Step Type Description

Merging CP and CP Invalid View
Projects

Merge Project Merges the additional invalid views
project (if one was created during the
initial pass) into the existing project
resulting in a single project. The merged
project is used in all subsequent applies
using the updated change package.

Exporting Modified Package-MO Project CopyToFile Copies the managed object project to a
file.

Exporting Modified ADS-MO Project

Only if Required

AEWithRunControl Consolidates multiple ADS projects into
one project and copies it to a file.

Exporting Modified ADS Project -
[ADSProjectName]

Only if Required

AEWithRunControl Copies individual ADS project (by bug)
to a file.

Note: There will be a step created for
each ADS project included in the change
package.

Create Modified Change Package UpdateChangePackage The change package is zipped to the
staging directory and ready for the Move
to production.

Moving to Production

In the Initial Pass, you applied the custom change package to your development database. In the process
of applying the change package, you completed all compares and adjusted the change package to retrofit
any customizations to your system. Once you have tested the updates, you are ready to deploy the updates
to your other target environments using Subsequent Pass.

The Subsequent Pass uses the modified change package created in the initial pass to apply the updates
to additional databases. During the subsequent pass, you have the opportunity to further modify the
template for customizations if needed. At the end of the subsequent pass, a new modified change package
is created.

The Move to Production Pass uses the modified change package created in the initial or subsequent pass
to apply the updates to the production database.

To apply the updates to your target databases:

1. (Optional) Start EMF if it is not already started and you selected Configure EMHub For File Deploy
on the EMHub Options page in Change Assistant.

Note: EMHub is only required for file deploy. If you plan to manually deploy file, skip this step.
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2. In Change Assistant, select Tools, Change Actions.

3. Select Update Manager and Click Next.

Note: If you are already in the Update Manager action, select Tools, Apply Change Package.

4. Select Apply Change Packages and click Finish.

5. Select the download directory where the change package was created.

6. Select the change package that was created for your custom change package definition.

7. Select Move to Production.

8. Click Next.

9. Select the target database.

Note: Use the Create button to create the target database if it has not been previously created. See
Defining Databases

10. If you are using EMHub, select the file server.

11. Click Next.

12. Change Assistant will connect to the target database and check compatibility. The Compatibility
Check page will then be displayed.

13. Click Next.

14. The Apply Summary is displayed, click Finish.

Change Assistant will begin building the Change Assistant job.

15. The Update job will be created and run until it completes or encounters an error.

Note: There are no manual stops in the Move to Production.
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Applying PeopleSoft Release Patchset to
PeopleSoft Image

Applying Downloaded PeopleSoft Release Patchset to PeopleSoft
Image

The PeopleSoft Update Image will be available on a regular schedule and is the source of all updates to
your application, however there may be times when a critical fix is necessary and you can not wait for the
next PeopleSoft Image. When this circumstance occurs, it will be necessary to download the PeopleSoft
Release Patch from My Oracle Support (MOS).

You will apply the PRP to the current PeopleSoft Image so that you can continue to take advantage of the
powerful PeopleSoft Update Manager PIA application to generate a custom change package including
requisite updates that may have already been posted. The PRP change package includes the metadata
required to keep your current PeopleSoft Image up to date. Every PRP will be included in the next
scheduled release of the PeopleSoft Image which is cumulative of all updates.

Important! The pi_home directory requires read and write access to apply PeopleSoft Release Patchsets
(PRPs). To apply PeopleSoft Release Patchsets (PRPs), use the instructions in the PeopleSoft Deployment
Packages for Update Images Installation (PeopleSoft PeopleTools 8.5x), “Using and Maintaining the
PeopleSoft Environment”.

Warning! Because PRPs are created for specific PIs, the PRP can only be applied to the specific PI for
which it was created. Change Assistant will not allow you to apply a PRP directly to your PeopleSoft
environment.

To download and apply an individual fix:

1. Discover and download the PRP from MOS.

2. Use Change Assistant to apply the PRP to the PeopleSoft Image database.

3. Create a new custom change package definition using Define Change Package option in the Update
Manager Action.

See Defining Change Package

4. Apply the new custom change package the same as any other update from the PeopleSoft Image.

See Applying Change Package
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Discovering and Downloading the PRP
Before you download the change package for the PRP, make sure that you have set up a download
directory on your local machine.

To discover and download the PRP:

1. Create a download directory on your local machine.

2. Log onto My Oracle Support and Select the Patch and Updates tab.

3. Search for PeopleSoft Release Patchsets (PRP) by Bug Number, Product, or Product Family.

4. Search for PRPs.

Use the Patches and Updates tab in My Oracle Support to search for PRPs. PRPs have a classification
of Critical.

5. Open the fix details to review the fix.

6. From the Patch Details page, click Download.

7. Select the Include Prerequisites checkbox to list all the prerequisite change packages.

8. In the file download window, click on the change package name and select Save.

9. Select your download directory.

Applying the PRP to the PeopleSoft Image
To apply the PRP to the PeopleSoft Image:

1. In Change Assistant, select Tools >Change Actions.

Note: If you are already in the Update Manager Action, select Tools, Apply Downloaded PeopleSoft
Release Patchset to PeopleSoft Image then go to step 4.

2. Select Update Manager and click Next.

3. Select Apply Downloaded PeopleSoft Release Patchset to PeopleSoft Image and click Finish.

4. Select the download directory where you downloaded the PRP change package and click Next.

5. Select the PRP change package or packages from the list displayed and click Next.

6. Change Assistant will verify that the package is compatible with the PI version. If it is not compatible,
you will receive a message to Cancel.

7. The Change Assistant job will start running.

Note: Use the instructions in the PeopleSoft Deployment Packages for (PeopleSoft PeopleTools 8.55) ,
“Using and Maintaining the PeopleSoft Environment”, Changing the Access for PI_HOME to change the
access to read/write and disable guest login for the pi_home share.
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Applying the PRP to Target Database
After the PRP has been applied to the PeopleSoft Image database, it is now available for you to apply
to your target environments using the Update Manager action. Apply the PRP as you would any other
update.

See Defining Change Package
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Applying PeopleTools Patch

Using Change Assistant to Apply PeopleTools Patch

Understanding PeopleTools Patch
PeopleTools patches deliver fixes between PeopleTools minor releases. PeopleTools patches are posted to
My Oracle Support, as they become available. PeopleTools patches are cumulative. They include all fixes
from all previous patches for the specified release. For example, patch .03 contains all the fixes contained
in the .02 patch as well as all of those contained in the .01 patch.

The patch contains the PeopleSoft Installer which is used to update the binaries in your PS Home
directory.

The PeopleTools patch location is always the PTP directory in your target PS home.

Locating and Downloading PeopleTools Patch
To locate and download the DPKs:

1. Go to the PeopleSoft PeopleTools Patches Home Pages, My Oracle Support, Doc ID 2062712.2, to
find the information on locating and downloading the latest PeopleSoft PeopleTools patch.

The PeopleTools Patches Home Pages contain links to the patch, as well as the links to the installation
documentation.

2. Download the DPK zip files into a single directory, referred to in this documentation as
DPK_INSTALL.

Be sure that the DPK_INSTALL directory has adequate available space for all the zip files. When
you download, there will probably be multiple zip files. The multiple files are needed due to size
limitations.

The files names are comprised of the following parts:

• <Operating_System> is LNX for Oracle Linux, WIN for Microsoft Windows, AIX for IBM AIX,
or SOL for Oracle Solaris for SPARC.

• <Release> is the release and patch number for the product, such as 8.56.04.

• n represents the total number of zip files

The zip files have the following format:

PEOPLETOOLS-<Operating_System>-<Release>-#ofn.zip

For example for Linux the files would be:
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PEOPLETOOLS-LNX-8.56.02-1of4.zip

PEOPLETOOLS-LNX-8.56.02-2of4.zip

PEOPLETOOLS-LNX-8.56.02-3of4.zip

PEOPLETOOLS-LNX-8.56.02-4of4.zip

Installing the Patch
Refer to the installation documentation posted on the  PeopleSoft PeopleTools Patches Home Page
2062712.2 for instructions on installing the PeopleTools DPK.

Installing a New PeopleTools Patch Version of Change Assistant
When you install the new release PeopleTools Client from the PeopleTools DPK, you will be prompted if
you want to install Change Assistant, select Y.

See the PeopleSoft PeopleTools Deployment Packages installation guide on the PeopleSoft PeopleTools
Patches Home Page 2062712.2, Applying PeopleTools Patches Using DPKs.

Note: You need to install the latest version of Change Assistant in order to apply the PeopleTools patch to
your target database. When you install the PeopleTools Client from the DPK, it installs the latest Change
Assistant.

See Installing Change Assistant

Configuring Change Assistant for Applying a PeopleTools Patch
To apply a PeopleTools Patch, the following configurations is required:

• General Options

If the general options have not been previously defined, the Change Assistant Wizard will open this
page when you select an action. See Opening Change Assistant the First Time

Alternatively, you can populate the General options using the command line. See the section
Command Line for Setting Options in Update Manager Mode

• Database Definition

Each target database will need to be defined. You can define a database by selecting File, New
Database or clicking the Create button on the Select Target Database page. See Defining Databases

Alternatively, you can define the target database using the command line. See the section Command
Line for Creating Environments in Update Manager Mode

Applying the PeopleTools Patch Change Package
To apply the PeopleTools patch in Change Assistant:

1. In Change Assistant, select Tools, Change Actions.
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2. Select Update Manager and click Next.

3. Select Apply a Patch to your Current PeopleTools Release and click Finish.

4. Review the Change Package Settings page and click Next.

PeopleTools patches do not use the PUM Source, so it will indicate Not Set.

The download directory is always the PTP directory in your target home.

PeopleTools patches are always applied to the target database.

5. Select the target database, if the database has not been defined yet use the Create button to create the
database.

See Defining Databases

6. Click Next.

7. Select the Change Package.

This example illustrates the fields and controls on the Select PeopleTools Patch to Apply.

8. Click Next.

9. Change Assistant performs a PeopleTools patch version check. Review the messages and click Next.
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A warning is displayed if the selected patch is at the same or a lower level than the installed
PeopleTools patch. It is not recommended to re-apply or downgrade PeopleTools patches.

10. The Apply Summary page is displayed, review the summary and click Finish.

11. Change Assistant will load the change package and run the PeopleTools patch job.

12. All steps will run unattended and when the last step is complete you will receive a message that there
are no more steps to run.

PeopleTools Patch Level

In PeopleTools 8.54, a new field PTPATCHREL was added to the PSSTATUS table. When you apply a
PeopleTools patch, the PTPATCHREL field is updated with the new PeopleTools patch level.

Using Command line to Apply PeopleTools Patch

Alternatively, If you have configured a target database and general options in Change Assistant, you can
apply the PTP via the command line by using an updated version of the following syntax: For example:

Changeassistant.bat -MODE UM -ACTION PTPAPPLY -TGTENV <YOUR_TARGET_DB_ENV_NAME_LIKE⇒

_PT856TST> -UPD PATCH856

See the section Command Line for Applying PeopleTools Patch in Update Manager Mode
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Upgrading PeopleTools

Using Change Assistant to Upgrade PeopleTools

Understanding PeopleTools Upgrade
PeopleTools upgrades involve two major components:

• New PeopleTools release.

• Change Package containing databases changes for the new PeopleTools Release.

The PeopleTools 8.5x Upgrade Homepage on My Oracle Support provides links to the information and
resources for your PeopleTools upgrade.

Your documentation and template files are delivered differently depending on which of the following
installation methods you are using:

• PeopleTools DPK

The PeopleTools DPKs also contain the upgrade documentation, upgrade template, and files.

• Software downloaded from the Oracle Software Delivery Cloud (OSDC)

Download the Change Package from the upgrade home page to get your template and HTML
documentation.

Upgrading Oracle's PeopleSoft PeopleTools software requires planning, resources, testing, and training.
The PeopleSoft PeopleTools upgrade documentation provides information to help you get started
planning for your upgrade and installing the new release.

Important! The PeopleSoft PeopleTools upgrade documentation provides all of the steps necessary to
prepare for and upgrade PeopleTools.

The PeopleSoft PeopleTools Upgrade involves the following steps:

1. Installing the New Release

Refer to the documentation for installing either the PeopleTools DPK or the PeopleTools installation
guide for your database platform if you downloaded the software from OSDC.

2. Applying a PeopleTools Patch

If you installed the new release using OSDC, you will need to download the latest PeopleTools patch
from My Oracle Support.

See Using Change Assistant to Apply PeopleTools Patch
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3. Installing PeopleSoft Change Assistant

See Installing Change Assistant from PeopleTools Client DPK

Note: If Change Assistant was installed on a previous release, you will be prompted to remove the
existing Change Assistant. For some release/patch levels, the installation may perform an update and
all your configurations settings can be retained.

4. Applying the PeopleTools Upgrade Change Package

a. Downloading the PeopleTools Upgrade Change Package

Note: If you used DPK to deploy PeopleSoft PeopleTools, you do not need to perform this step.

b. Setting Up Change Assistant

See Configuring Change Assistant for PeopleTools Upgrade and Configuring Change Assistant
for Update Manager – Upgrade to a New Release of PeopleTools

c. Upgrading PeopleTools

See Upgrading to a New Release of PeopleTools

d. Reviewing Upgrade Step Properties

Configuring Change Assistant for PeopleTools Upgrade
When performing a PeopleTools Upgrade, you will always be using a newly installed version of Change
Assistant at the new PeopleTools release/patch level.

To configure Change Assistant for PeopleTools upgrade:

1. Launch Change Assistant.

2. At the Welcome menu, click Next.

De-select the Always show this page if you want to bypass the Welcome menu next time you launch
Change Assistant.

3. On the Select Action page, select Update Manager and click Next.

4. If this is the first time you are selecting Update Manager, the Wizard will guide you through the
Change Assistant setup.

See Configuring Change Assistant for Update Manager – Upgrade to a New Release of PeopleTools

5. On the Select Task page, select Upgrade to a New Release of PeopleTools and click Finish.

6. To apply the PeopleTools upgrade, the Wizard will guide you through the environment setup.

See Upgrading to a New Release of PeopleTools
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Configuring Change Assistant for Update Manager – Upgrade to a New
Release of PeopleTools

If this is the first time you are selecting Update Manager, the Wizard will guide you through the Change
Assistant setup. As you click Next you will complete the following pages:

1. General Options

2. PUM Source Options

Note: PUM Source is not used with PeopleTools upgrades. You will click Next to skip this page.

3. EM Hub Options

Note: EM Hub is not used with PeopleTools upgrades. You will click Next to skip this page.

4. Additional Options

5. Select Task

Note: Once the environment has been configured, you can use Tools >Options to make any changes to
the environment options.
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General Options

This example illustrates the fields and controls on the General Options page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Maximum Concurrent Processes Specifies the maximum number of processes that can be
executed concurrently on the local machine. The default is 1.

PS Home Server Starting Port Specify the port number for the first PS Home server.

Change Assistant uses this port number to communicate with
Change Assistant PS Home servers. The default starting port
number is 6151. If you enter a port number that is already
in use, you see an error message. You must change to a port
number that is not in use, and then restart Change Assistant for
the change to take effect.
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Field or Control Description

PS Home Server Maximum Instances Enter a number between 1 and 10 for the maximum number of
PS Home servers.

Use this value for environments with more than one PS_
HOME. For each server instance, Change Assistant increments
the PS Home Server Starting Port number by 1 up to the
maximum number of instances. For example, with a PS Home
Server Starting Port value of 6151 and a PS Home Server
Maximum Instances value of five, the port numbers would be
6151, 6152, 6153, 6154, and 6155. The default is 5.

If you change this value, you must restart Change Assistant for
the change to take effect.

PS Home Enter the full path to the new PeopleTools release PS_HOME.

Note: This is the same PS_HOME used to install Change
Assistant.

Staging Directory Enter the directory in which you would like to stage all the
Change Assistant upgrade files. This is the location that
Change Assistant will store files to be used during the upgrade
to new PeopleTools process.

Output Directory Enter the directory in which you want the log files generated
by the upgrade process to reside.

Download Directory Enter the full path of the location to which you want to
download your change packages.
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Field or Control Description

SQL Query Tool Select the correct executable for the database platform that
matches the PS_HOME defined for CA. This value is used as
the default when creating environments. Each environment
contains separate settings and therefore, you can change this
executable for a specific database.

Valid SQL query executables for each platform are:

• DB2: db2cmd.exe

• Microsoft SQL Server: sqlcmd.exe

• Oracle: sqlplus.exe

Note: Change Assistant uses the command line version of the .
exe, not the GUI version. For example, sqlplus.exe is used for
an Oracle database, rather than sqlplusw.exe.

Important! Oracle Database Customers: For systems running
on the Oracle database, by default, Change Assistant copies
the generated SQL script files to the location specified as the
TEMP User variable on the Environment Variables dialog box.
 So, on Oracle, the generated SQL script files will actually
exist in two locations: the specified Change Assistant output
directory, and the TEMP directory. This behavior is in place
because some versions of Oracle SQL Plus do not support
pathnames longer than 79 characters. It is recommended that
you ensure that the value specified for the TEMP User variable
is set to a path short enough so that the string comprising the
path and generated SQL file will not exceed 79 characters.
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Additional Options

This example illustrates the fields and controls on the Change Assistant - Additional Options page. You
can find definitions for the fields and controls later on this page.

Notification Settings Section

Field or Control Description

Send Email Notifications Select this check box to receive email notifications if there are
errors in the upgrade process. Change Assistant also sends you
a completion message when it encounters a Stop in the update
process.

SMTP Server Enter the SMTP mail server from which you receive the error
or completion messages.

Port Enter the port from which you want to access the email.
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Field or Control Description

Send To Enter the address to which you want the email sent.

Return Address Enter the email address of the sender. Use this to identify who
sent the notification.

Test Validates that email is sent to the designated recipients and is
working correctly.

Note: Ensure that your SMTP server is installed and
configured correctly.

Proxy Section

Field or Control Description

Host (Optional) Enter the name of the proxy server if you want to
run Change Assistant behind the firewall using a proxy server.

Port (Optional) Enter the port number for the proxy server.

Anonymous Proxy Indicates that you are using a proxy server that does not
require authenticated connections.

Microsoft Proxy Server Indicates that you are using a proxy server with Windows
authentication.

Windows Domain The network domain in which the system runs.

Other Proxy Servers Indicates you are using non-Microsoft proxy servers.

Select Task

Select Upgrade to a New Release of PeopleTools.
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This example illustrates the task Upgrade to a New PeopleTools Release selected.

Upgrading to a New Release of PeopleTools
To apply the PeopleTools upgrade, the Wizard will guide you through the environment setup. As you
click Next you will complete the following pages:

1. Change Package Settings

2. Select Target Database

3. Select PeopleTools Upgrade

4. Validation

5. Apply Summary
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Change Package Settings

This example illustrates the fields and controls on the Change Package Settings page for a PeopleTools
Upgrade. You can find definitions for the fields and controls later on this page.

For a PeopleTools upgrade, the apply type is Initial Pass and Target Steps Only.

Select Target Database

On the Select Target Database page, select your target database if the databases were imported to the new
instance of Change Assistant.

To create a new database or add the New Homes to an existing database:

1. Click the Create button, which will launch the Database Wizard.

2. On the Define Database page, enter the information for the database you are defining.

Note: For PeopleTools Upgrade, you must set the path information for the new PS home locations.
You must also ensure that the current PS_APP_HOME and the current PS_CUST_HOME are not set
to the current PS_HOME. See Defining Databases

3. Click Next.

Change Assistant will query the database and gather additional database.

Note: Change Assistant will verify the connection to the database, including User ID/password,
Access ID/password, and Connect ID/password. You will need to correct any errors before continuing
to define the database.

4. The information is then displayed on the Additional Database Details page.

5. Click Next and the Confirm Settings page is displayed.
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6. Click Finish.

Select PeopleTools Upgrade

The select PeopleTools Upgrade page will display the target database information, as well as the
change package to install and any PeopleTools patches that Required at Upgrade and downloaded to the
download directory.

This example illustrates the fields and controls on the Select PeopleTools Upgrade page.

Validation

Change Assistant will check the connectivity to the target database, validate the PTU, and validate the
target environment.
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This example illustrates the fields and controls on the Validation page.

PeopleTools Upgrade Job

When you click Finish on the Summary page, the PeopleTools upgrade job is created and opens. The first
step is usually a manual stop.

For more information on running Change Assistant Jobs, see Running the Upgrade Job

Creating and Applying Tools Delta Package

Since PUM supports multiple PeopleTools releases it is necessary for PUM to handle shape differences
that may exist between different PeopleTools releases. There are 2 types of Tools dependencies:

• Hard Dependencies - The object will not work on a lower release and is therefore stripped from the
change package definition.

• Soft Dependencies - Some of the attributes of the object are stripped in order to work on the lower
release.

When the customer does upgrade to the newer PeopleTools release, any previously applied updates that
contained soft dependencies need to be re-applied with the associated post-requisites to add back the
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attributes or objects that were stripped away when the updates were applied in the old release. The Tools
Delta Package option in the PeopleSoft PIA application is used to create this change package.

Prerequisites

You will use the Change Assistant Update Manager > Define or Create a New Change Package action to
create and apply the change package. Before you can select this action, the following prerequisites must
be configured and installed:

1. Download the latest PeopleSoft Update Image (PI) from My Oracle Support and install it locally.

See Installing PeopleSoft Update Image

2. Configure the Microsoft Windows client running Change Assistant.

See Configuring the Microsoft Windows Client Running Change Assistant

3. (Optional) Configure Environment Management Framework for your target environment, if you want
to use the file deploy feature.

See Configuring the Environment Management Hub

4. (Optional) Start EMF if you plan to use the file deploy feature.

See Running the Environment Management Hub

5. Define the PUM Source and EM Hub.

Note: For the PeopleTools Upgrade these options were skipped when the original configuration for
Change Assistant was completed. Depending on the PeopleSoft Image downloaded and installed, you
may need to remove Change Assistant and install the version delivered with the PeopleSoft Image.
After installing a new version of Change Assistant, you will need to set up Change Assistant.

Defining the PUM Source and EM Hub
If you are using the same version of Change Assistant that was used for the PeopleTools upgrade, follow
these instructions. If you installed a different version of Change Assistant, follow the instructions in
Configuring Change Assistant for Update Manager.

To configure Change Assistant options:

1. In Change Assistant, select Change Actions.

2. Select Update Manager and click Finish.

3. Select Tools, Options.

4. Verify that the information on the General page is correct.

Note: PS_HOME will be the new release of PeopleTools.

5. Select the PUM Source tab.

a. Select Define PUM Source.
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b. Click Create and define the PUM source database.

See Defining Databases

c. Select the drive that you mapped to the pi_home directory when you configured the Microsoft
Windows client.

d. Enter the PUM Source PIA URL.

6. (Optional) Select the EM Hub tab.

You must have EMF configured and running before defining the EM Hub.

a. Select Configure EMHub For File Deploy.

b. Enter the Server Host Name.

c. Enter the Server Host Port.

d. Enter the Chunk Size.

e. Enter the Ping Interval.

f. Enter the Drives to Crawl.

g. Click Ping.

A successful ping will return Packets: Sent = 3, Received = 3, Lost = 0.

h. Click the View button to display the Environment Management Hub Summary.

Select the Additional tab.

Verify that the information on the Additional page is correct.

7. Click OK.

Creating the Tools Delta Package
To create the tools delta package:

1. Select Tools, Define Change Package.

2. Click the button Click Here to Open a Browser and Connect to the PUM Source Database.

3. Sign on.

4. Select PeopleTools, Lifecycle Tools, Update Manager Dashboard, Select Target Database.

5. If you only have one target database defined, the target database is selected by default.

6. Select Define Change Package, Tools Delta Package.

7. On step 2, enter a Package name and description, then click Next.
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8. On step 3, enter the From Tools Release value in the format <release>.<patch> for example 8.53.12
(PeopleTools release 8.53 patch 12). The new PeopleTools release/patch number for the target
database is displayed in the To Tools Release field.

9. Click Next. For Tools Delta packages step 4 is skipped.

10. Step 5 in the Define Change Package wizard is displayed showing all the bugs that will be included in
the change package.

Note: This package may also contain additional bugs that you have not applied to the target database.

11. Click Next.

The change package definition is created and you can return to Change Assistant to apply the change
package.

12. Sign off and close the browser.

13. Return to Change Assistant and select Tools, Create Change Package. The package you just created
on the PUM source should be at the top of the list. Select the change package.

Note: If you closed Change Assistant, launch Change Assistant and select Tools, Create a Change
Package.

14. If you would like to apply the package when it is created, select the Proceed to Apply Change
Package Wizard after Package Creation checkbox.

15. Click Finish.

Applying Tools Delta Change Package
To apply the tools delta package:

1. In Change Assistant, select Tools, Apply Tools Delta Package.

2. Select the change package using the drop down. Only tools delta change packages are available.

3. Select Initial Pass.

By default All Steps is selected.

4. Click Next.

5. Select the target database.

Note: Use the Create button to create the target database if it has not been previously created. See
Defining Databases and Defining Target Database

6. Click Next.

7. Change Assistant will connect to the target database and validate the environment. The Validation
page will then be displayed.

8. Click Next.

Copyright © 1988, 2022, Oracle and/or its affiliates. 351



Upgrading PeopleTools Chapter 21

9. The Apply Summary is displayed, click Finish.

Change Assistant will begin building the Change Assistant job.

10. The Update job will be created and open in Change Assistant.
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Defining and Applying Translations Fixes

Understanding Translation Fix Packs

The Translations organization, from time to time, will review existing/ previously defined and delivered
translations, and determine that a revision to that translation is required. This is a standalone review
process that:

• is not directly linked to fixes or features being delivered by the applications.

• may include changes to objects that have not changed since Product GA.

• is language specific, in that each language is reviewed separately and the content of each language
deliverable can and is likely to be unique.

The result and content of this translations process is referred to as a Translations Fix Pack (TFP).

The Translations Delta Package component is used to select the Translations Fix Pack(s) to include in a
Translations Delta Package (TDP).

Defining Translations Delta Package

To define a translation delta package:

1. Select PeopleTools, Lifecycle Tools, Update Manager, Update Manager Dashboard.

2. Expand the Select Target Database folder and click on the database name.

3. Expand the Define Change Package folder and select Translations Delta Package.

4. This launches the Define Translations Delta Package Wizard starting at step 2. Enter a name and
description for the package.

Note: Step 1 is only displayed when no target databases have been uploaded. The database name you
selected in step 2 above is used.

5. Click Next.

6. On step 3, select the languages.

7. Click Next. Step 4 is skipped for translation delta packages.

8. Step 5 will display all bugs meeting the language criteria.

9. Click Next.
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10. When you transition into Step 6 the change package definition is complete.

11. Return to Change Assistant to create the package.

Define Translations Delta Package Wizard Step 2 of 6
Navigation:

After selecting the target database in the Update Manager Dashboard, expand the Define Change folder
and select Define Translation Delta Package.

The second step is to enter the package name and description.

This example illustrates the fields and controls on the Define Translations Delta Package Wizard step 2 of
6 page. You can find definitions for the fields and controls later on this page.

Field or Control Description

Package Name Enter a name for your translation delta change package. To
edit an existing change package, select the Lookup button.
 The list of change packages that can be edited is restricted as
follows:

• Packages created by the current user.

• Packages created for the currently selected target
database.

• Packages which have been defined but have not been
created.

Package Description Enter a description for the change package.
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Define Translations Delta Package Wizard Step 3 of 6
Use the Select Search Method page to select the language or languages to update.

Note: If the target database is English only, nothing is displayed since you do not need a translation fix
pack.

This example illustrates the fields and controls on the Define Translation Delta Package Wizard Step 3 of
6 page.

Define Translations Delta Package Step 5 of 6
Step 5 will display the bugs to be included in the translation delta package.

This example illustrates the fields and controls on the Define Translation Delta Package Step 5 of 6 page.
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For details on the grid columns see Define Update Package Wizard Step 5 of 6

Define Translations Delta Package Wizard Step 6 of 6
When you transition into Step 6 the change package definition is complete.

This example illustrates the fields and controls on the Define Translation Delta Package Wizard Step 6 of
6 page.

Each language is processed separately. A project definition is created for language, with suffix indication
the language. The projects will be combined into a single change package with separate steps by
language. The Change Package Type is TDP.

Creating Translations Delta Package
After defining the translations delta package, return to Change Assistant to create the package.

To create the Change Package in Change Assistant:

1. Select Tools > Create Change Package.

2. Select the package name from the drop-down list box.

3. Click Finish.
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This example illustrates the fields and controls on the Create a New Change Package page. You can find
definitions for the fields and controls later on this page.

If you select the Proceed to Apply Change Package Wizard after Package Creation, Change Assistant will
launch the wizard. See Applying Translations Delta Package

Applying Translations Delta Package

To apply the translation delta package:

1. In Change Assistant, select Tools, Change Actions.

2. Select Update Manager and Click Next.

Note: If you are already in the Update Manager action, select Tools, Apply Translation Delta
Package.

3. Select Apply Translation Delta Package and click Finish.

4. Select the download directory where the change package was created.
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This example illustrates the fields and controls on the Change Package Settings page.

5. Select the translation delta change package to apply. Only translation delta packages are available in
the drop down. The package name will end with TDP.

6. Select Initial Pass.

By default All Steps is selected. Change this value if you choose to decouple the source and target
steps.

Note: For information on Apply Type see Understanding the Apply Update Process

7. Click Next.

8. Select the target database.

Note: Use the Create button to create the target database if it has not been previously created. See
Defining Databases and Defining Target Database

9. Change Assistant will connect to the target database and validate the environment. The Validation
page will then be displayed.
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This example illustrates the fields and controls on the Validation page.

10. Click Next.

11. The Apply Summary is displayed, click Finish.
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This example illustrates the fields and controls on the Apply Summary page.

12. Change Assistant will begin building the Change Assistant job.

13. The Update job will be created and open in Change Assistant.
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This example illustrates a Translation Delta Project Job.
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Using Apply Update Action

Discovering Updates Using My Oracle Support

If the current application level of PeopleSoft product is not PUM-enabled, it is necessary to use My
Oracle Support to discover updates and then download them to your local system.

1. Log onto My Oracle Support (MOS).

2. Select Patch and Updates tab.

For detailed instructions on using MOS for patches and updates, refer to

My Oracle Support Patches and Updates for PeopleSoft Products [ID 1465172.1]

Downloading Updates From My Oracle Support

When you select an update to download, you will be downloading the change package. You will need
to set up a download directory on your local machine to store all of your downloaded change packages.
When you are ready to apply the change packages, you will reference this directory from Change
Assistant.

Downloading a Single Patch
To download a patch from the Patch Details page:

1. In the Patch Search Results table, click the patch name link to view the patch details page.

2. Click Download.

3. Select the Include Prerequisites check box to list all the prerequisite change packages.

4. In the File Download window, click the patch file name link and select Save.

The context bar for each patch provides a download option. Note that you can select multiple patches
from a list by using Ctrl or Shift.

Downloading Multiple Patches From My Oracle Support
To download more than one patch:

• From the patch search results, click anywhere in the row except a link to select that row. Use Ctrl or
Shift to select multiple rows.

• Choose the Download button from the context bar.
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• Click each file and save it.

Using WGET Options
WGET is a UNIX download utility. The WGET options enable you to create a WGET download script
that you can save as a file or copy to the clipboard.

Note: The WGET download script is intended for advanced users. In most cases, there are no messages to
indicate that an error has occurred. Before using the WGET script, you should be familiar with the WGET
command and WGET log files. You should also be familiar with UNIX file management, know how to
edit, delete, and copy UNIX files, create and edit shell scripts, change execute privileges in UNIX, and
understand HTTP error codes. Alternatively, use a download manager to download multiple patches. If
you do this, you must maintain an active My Oracle Support session while you download the patches.

For details on using the WGET options refer to

Patches and Updates

Reviewing the Updates Change Log

Using the Environment Management hub, Change Assistant evaluates the change log status of the
available environments to identify if prerequisites have already been applied before allowing you to apply
a new change package.

To review the change log for an environment, or to confirm whether particular update has been applied,
you use the following PeopleTools utilities:

Utility Navigation

Updates - View All PeopleTools > Utilities > Administration > View All
Updates

Updates by Release Label PeopleTools > Utilities > Administration > View Updates
by Release Label

Updates by Update ID PeopleTools > Utilities > Administration > View Updates
by Update ID

Only those application releases in which all of their application updates were delivered in change
packages are considered to have reliable change log data. Application updates that you applied that were
not delivered as change packages are probably not included in your change log. Therefore it's possible
that your change log does not match your actual maintenance history. In these cases, you should apply
change packages individually—select only one change package in the Update Wizard. Then, you can
verify whether the list of missing prerequisites reported by Change Assistant accurately reflects your
maintenance history.

If your target environment is at an application release level that is not considered to have reliable change
log data, Change Assistant may falsely report that a prerequisite is missing from this environment. If this
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is the case, do not add the supposed missing update to your current apply list, as this would reinstall the
update (not recommended).

Therefore, if your target environment may have unreliable change log data, review the list of missing
prerequisites found by Change Assistant and if any of these updates are known to have been previously
applied to your target environment, manually enter these updates to your change log first so that Change
Assistant can accurately determine that these prerequisites have been satisfied. If you need to add entries
to your change log, you will have to restart the apply change packages process.

Configuring Change Assistant for Apply Updates Action

Before you can apply an update, you need the following:

1. Change package in your download directory.

For non-PUM enabled applications, this is the change package downloaded from MOS. See
Downloading Updates From My Oracle Support

For change packages created for your own customizations, place the change package in the download
directory. See Creating a Change Project

2. Environment Management Framework must be configured and running.

See Configuring the Environment Management Hub

Selecting Apply Updates Action
To start Change Assistant: and apply updates:

1. Select Start, Programs, PeopleSoft Change Assistant 8.5x.xx, wherex.xx refers to the release/patch
number.

2. Depending on your preferences, you may or may not see a Welcome dialog box. If the Welcome
dialog box is displayed, click Next.

The Select Action page is displayed.

3. Select Apply Updates and click Next.
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This example illustrates the fields and controls on the Select Task page for Apply Updates. You can
find definitions for the fields and controls later on this page.

4. The options required for Apply Updates are shown on the left side of the page. If the options have not
been defined, Change Assistant will guide you through the set up pages. Click each option to ensure it
is properly configured for this action.

General Options

This example illustrates the fields and controls on the General Options page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Maximum Concurrent Processes Specifies the maximum number of processes that can be
executed concurrently on the local machine. The default is 1.
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Field or Control Description

PS Home Server Starting Port Specify the port number for the first PS Home server.

Change Assistant uses this port number to communicate with
Change Assistant PS Home servers. The default starting port
number is 6151. If you enter a port number that is already
in use, you see an error message. You must change to a port
number that is not in use, and then restart Change Assistant for
the change to take effect.

PS Home Server Maximum Instances Enter a number between 1 and 10 for the maximum number of
PS Home servers.

Use this value for environments with more than one PS_
HOME. For each server instance, Change Assistant increments
the PS Home Server Starting Port number by 1 up to the
maximum number of instances. For example, with a PS Home
Server Starting Port value of 6151 and a PS Home Server
Maximum Instances value of five, the port numbers would be
6151, 6152, 6153, 6154, and 6155. The default is 5.

If you change this value, you must restart Change Assistant for
the change to take effect.

PS Home, PS App Home, and PS Cust Home Enter the full path for your PS home directories.

Note: Specify the PS_HOME location you used to install
Change Assistant.

Staging Directory Enter the directory in which you would like to stage all the
Change Assistant update files. This is the location that Change
Assistant will store files to be used during the apply update
process.

Output Directory Enter the directory in which you want the log files generated
by the update process to reside.

Download Directory Enter the full path of the location to where you downloaded
the update change packages.
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EM Hub Options

This example illustrates the fields and controls on the EM Hub Options page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Configure EMHub For Deploy File Select this checkbox if you want to use EMHub for file deploy.

Note: In order to apply traditional updates (non-PUM enabled)
EMF must be configured and running.

Server Host Name The hostname of the server in which the Environment
Management HUB resides.

Server Host Port Indicates the port in which to connect to the Environment
Management hub.

Chunk Size Used for deploying files during a software update. Default is
1024 * 1024 bytes. Typically this does not need to be changed
unless there are a significant number of files greater that
1024KB in a software update.

Ping Interval Ping interval is in milliseconds for Change Assistant to contact
the hub for new messages.

Ping Click to verify a valid server URL. If you see Service is off to
the right of this button, then you must correct the server URL
and ping again until you see Service is on.

368  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 23 Using Apply Update Action

Field or Control Description

View Click to display the list of all PeopleSoft components
discovered and registered in the Environment Management
hub.

Note: This button is visible only if your display is set to
Windows Classic style.

Additional Options

This example illustrates the fields and controls on the Additional Options page. You can find definitions
for the fields and controls later on this page.

Notification Settings Section
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Field or Control Description

Send Email Notifications Select this check box to receive email notifications if there are
errors in the update process. Change Assistant also sends you
a completion message when it encounters a Stop in the update
process.

SMTP Server Enter the SMTP mail server from which you receive the error
or completion messages.

Port Enter the port from which you want to access the email.

Send To Enter the address to which you want the email sent.

Return Address Enter the email address of the sender. Use this to identify who
sent the notification.

Test Validates that email is sent to the designated recipients and is
working correctly.

Note: Ensure that your SMTP server is installed and
configured correctly.

Proxy Section

Field or Control Description

Host (Optional) Enter the name of the proxy server if you want to
run Change Assistant behind the firewall using a proxy server.

Port (Optional) Enter the port number for the proxy server.

Anonymous Proxy Indicates that you are using a proxy server that does not
require authenticated connections.

Microsoft Proxy Server Indicates that you are using a proxy server with Windows
authentication.

Windows Domain The network domain in which the system runs.

Other Proxy Servers Indicates you are using non-Microsoft proxy servers.
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Validating Change Assistant Settings

Before applying non-PUM updates, you should validate your settings.

Change Assistant validates settings by:

• Locating valid SQL query tools required to run SQL scripts.

• Testing the Environment Management hub and ensuring that Change Assistant can communicate with
it.

You can also print a summary of your environment, which can facilitates the diagnosis of problems by
Oracle Global Customer Support.

To validate your environment:

1. From the Select Task page, select Change Assistant Validate EMF Setting and click Finish or from the
menu bar, select Tools, Validate.

2. Click Start Validation.

3. When the validation process has completed, a completion message appears.

4. If any of the steps were unable to complete successfully, open the log file to determine the cause.

Click View Log in the lower part of the screen to see more details regarding individual steps of the
validation.

You can also select the Validate Change Assistant EMF Settings radio button from the Change Assistant
Wizard when the action Apply Updates is selected.

This example illustrates validation results.

Note: If you use proxy servers, the system will ping those and prompt for proxy server user ID and
password.
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Working with Templates

When applying a change package, Change Assistant uses the update template embedded in the
PeopleSoft-provided change package. You can use the update template to automate the majority of the job
steps. The primary difference between a template and a job is that a template is a composite of the update
process, whereas a job is a set of filtered steps for a given target environment within a template.

When you apply updates by using the Apply Update action with the Apply Change Packages option,
Change Assistant automatically loads the template into the Change Assistant internal storage system. You
can add additional chapters, tasks, and steps to the template.

Note: Any changes that you make to the imported template won't affect the original template that you
downloaded with the change package. If you want to overwrite the original template with your changes,
save the template and select File, Export to export it to the directory from which you downloaded it. You
can also use the export function to make this modified template available to others.

In order for others to use the template that you create or modify, you need to export it from Change
Assistant.

To export a template:

1. Select File > Open Template.

2. Select  File > Export Template.

The Export Template dialog box appears.

3. Navigate to the folder in which you want to save the template.

4. Enter the name of the template.

Note: If you want to overwrite the original template that you downloaded, enter the original name of
the template.

5. Click Save.

Note: To ensure consistency with shared templates, the system includes all template and step
properties in the exported XML file, regardless of whether the property value differs from the default
value.

Setting the Documentation Directory

To view the documentation associated with a template, you need to set the documentation directory first,
so that Change Assistant can locate the files. Once set, you select a chapter, task, or step in the template or
job tree, and Change Assistant displays the corresponding upgrade documentation in the documentation
pane.

To set the documentation directory:

1. Select Edit, Set Documentation Directory.
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2. Enter or browse to the folder where you placed your upgrade documentation HTML files.

3. Click OK.

4. Save the template.

Note: The saved template will include the documentation path information.

See Working with Embedded Documentation.

Applying Updates To A Target Environment

The apply process enables you to apply one or more change packages to the target environment. A typical
change package apply process, would be as follows:

1. Apply the change package without compare to your demonstration environment.

Since the demonstration environment does not contain any customizations, there is no need to
compare. This brings the demonstration environment current on the specific maintenance, overwriting
the new maintenance into the demonstration environment.

2. Apply the change package to the first customized environment by using the 'Apply with Database
Compare/Copy' option.

This uses your demonstration database as the source and this customized environment as the target.
This process augments the normal Change Assistant template/job in order to compare the change
project from the demonstration database to the target database.

3. Use the PeopleTools database compare and copy utilities to reconcile the new changes from
PeopleSoft with your customizations, just as you do during an upgrade.

4. Once the reconciled or modified change package is created, it can then be applied without compare
into all other customized environments, assuming these customized environments are the same.

To apply change packages to the target environment:

1. The Environment Management Hub must be up and running.

2. In Change Assistant, select Tools, Change Actions.

3. Select Apply Updates.

4. Select Apply Change Packages and click Finish.

5. Apply Change Packages Wizard starts.

You use the Apply Change Packages wizard to select the appropriate settings for a change package.
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This example illustrates the fields and controls on the Apply Updates to Target Environment page. You
can find definitions for the fields and controls later on this page.

Field or Control Description

Apply Automatically Without Compare Applies the change package to the target environment and
copies the project without initiating any compare reports or
analysis.

Select this option if you are:

• Applying a PeopleSoft-delivered change package to a
PeopleSoft demo environment.

Because you have not made any customizations to a
demonstration environment, there is no need to compare
objects.

• Applying a modified change package to your own
environments, as in development, test, or production
environments.

The "modified change package" refers to a new change
package created using the Apply with Database Compare/
Copy option. This modified change package is the
result of the Change Management process where
you have reconciled changes made in the PeopleSoft
maintenance with your customizations. Once the
modified change package has been created for the first
customized environment, there is no need to compare
additional environments. This assumes that the additional
environments contain the same metadata. Once you
have created this modified change package, it can be
applied without compare to the remaining customized
environments.

See Apply Without Compare
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Field or Control Description

Apply With Database Compare/Copy Select this if you are beginning the process of migrating a
PeopleSoft-delivered change package to your customized
environments. In this case, you are applying to a customized
environment, and this will require the use of PeopleTools'
change management tools, such as compare and copy.

See Apply With Compare or Copy

Note: When applying multiple updates, a job set may not move on to the next update if there are steps in
the current update with a status of Warning rather than Success. In this situation, review the logs for the
steps with warnings and take any corrective measures, as needed. Then change the status of these steps
from Warning to Complete to proceed to the next change package in the job set.

Apply Without Compare
This section describes the apply process after you have selected the Apply Automatically without
Compare option.

To apply a change package without compare:

1. On the Apply Updates Using the Change Impact Analyzer screen indicate whether you want to
include Change Impact Analyzer analysis.

Typically, system administrators use Change Impact Analyzer to help devise a test plan based on the
impact of changes.

2. On the Select a product line release screen indicate product line associated with the target
environment.

3. On the Select Target Environment screen, select the database name associated with the target
environment.

All PeopleSoft web servers, application servers, Process Scheduler servers, and so on, are associated
with one, and only one, environment, which is determined by the database. Change Assistant will re-
validate the environment.

4. On the Environment Preparation screen acknowledge that you have performed the recommended pre-
update procedures.

5. On the Select File Servers screen, select the file servers that are used in conjunction with the target
environment.
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Note: The system uses this file server selection only as a destination to deploy files during the apply
process. The file server specified is not used for execution purposes. The executables used to run
steps during the apply process are those specified in the PS_HOME edit box on the Change Assistant
Options page.
File server installations are not necessarily tied to any one environment, unlike application servers,
web servers, Process Scheduler servers and database servers, which are associated with one, and
only one, database environment. On the other hand, a single file server could be used for multiple
databases, and likewise, there could be multiple file servers in your PeopleSoft implementation all
supporting different application versions. So, it is necessary to prompt you to select the appropriate
file server installation.

6. On the Enter user name and password screen, enter the user credentials required for Change
Assistant to be authenticated.

Note: For the Apply without compare, only the target database is required. For the Apply with
compare, credentials for both the target and source are required.

7. On the Select Download Directory screen, confirm the location of the change packages you intend to
apply.

8. On the Select Change Packages screen, select change packages to install.

You can use Select All to select all the available change packages listed on the screen.

9. Click Next after you've selected your change packages.

At this time, Change Assistant examines all the selected change packages to determine if any of them
have previously been applied.

Note: If an Unable to read change package error appears because of an unsupported change package
version number, then you must install the latest release of Change Assistant.

10. If the change package has already been installed, you will be prompted to select one of the following
options:

• Do not reapply the change package.

• Review each change package individually, with option to apply.

If you choose to review each change package individually, you will be prompted either not to
reapply the change package or to reapply the change package (not recommended).

11. Select the options, then click Next.

If none of the translated languages included in a change package applies to the languages installed in
the target environment, you will be prompted to select one of the following options:

• Remove these change packages from my installation list.

• Review each of these change packages individually, with option to apply.
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If you elect to review each change package individually, you will be prompted either not to apply
the change package or to apply the change package (not recommended).

12. After you've made your selection, Change Assistant searches for post-requisites. If there are post-
requisites that are not listed in the apply list, you will be prompted to select one of the following
options:

• Apply these additional change packages.

The additional change packages are added to the list of selected change packages.

Note: This option is enabled only if the additional change packages are already present in your
apply directory.

• Remove the change packages that require post-requisites from my installation list.

13. Click Next.

Change Assistant searches for any missing prerequisites required by the selected change packages,
and you will be prompted to make the same selections as in the previous step.

Note: If your target environment is at an application release level that is not considered to have
reliable change log data, Change Assistant may falsely report that a prerequisite is missing from this
environment. If this is the case, it is very important that you not elect to add the supposed missing
update to your current apply list, because this would reinstall the update, which is not recommended.
Therefore, if your target environment is considered to have unreliable change log data, it is very
important that you review the list of missing prerequisites found by Change Assistant. If any of
these updates are known to have been previously applied to your target environment, you must first
manually enter these updates to your change log so that Change Assistant can accurately determine
that these prerequisites have been satisfied. If you need to add entries to your change log, you will
have to restart the Apply Change Packages process.

14. After you have selected your option, click Next.

If one or more of the change packages you are applying includes the Build and Alter template steps,
you will be prompted to select one of the following methods to apply the database changes.

• Automatically: Enables build scripts to be run as an automated template step.

• Manually: Enables the build script to be run as a manual template step.

15. If one of your selected changes packages will be executing a script that includes embedded question
syntax that is supported by Change Assistant, you will be prompted to enter a runtime value for the
script variables.

16. Click Next to display a screen where you confirm your selections–target environment and change
packages to apply and number of manual steps, if any, for each change package.

17. On the Apply Now screen, consider the options presented before applying the change project.
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Field or Control Description

Validate Now Note: Before you initiate the apply update process, you
can validate your environment connections to ensure all
components are active.

Review and Apply Enables you to review the entire job to make sure it is
correct before running it against an environment.

Note: If there are steps you don't want run or have already
completed manually, you could set them to Complete
while reviewing the job. For example, if you have already
deployed some files manually to a certain PS_HOME,
 you could set that step to Complete to save time and avoid
overwriting any custom settings.

Begin Apply Starts the update job.

Apply With Compare or Copy
The interface of the Apply Change Packages wizard is similar to what you see with the Apply Without
Compare option, however, the following steps are included.

• Compare project from the demo database to the development or copy of production database.

Change Assistant will compare this project between the source database and the currently selected
environment (target database).

• Examine the compare report step (a manual step).

You must examine the compare reports generated to determine the appropriate action (for example,
whether or not to copy the object from the source database to the target database).

• Copy project from the source database.

Change Assistant copies the objects from the source database to the target database, based on the
actions chosen.

• Extract the files from the delivered change package.

Change Assistant will extract the current change package to a temporary location (<<staging
directory>>/~ExtractedCP).

• Re-apply customizations.

This is a manual step.

• Compare and merge files.

This is a manual step.

• Export the project from the target database.
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Change Assistant will export (from the target database) the project containing customize objects to a
temporary location (<<staging directory>>/~ExportedProject).

• Change Assistant creates a new change package in the download directory. The original change
package is renamed to xxxxx.zip_datetimestamp.

Automatically Deploying Files to Different Servers
Change Assistant can automatically deploy files in a change package to different servers within an
environment. If the job that is running while applying the change package includes a Deploy Files chapter
and contains tasks and steps, that indicates to Change Assistant to deploy the files to the agents that are
running in the environment.

While Change Assistant runs deploy file steps within the job, it will query the hub for the location to
deploy the files. The query is based on the server, operating system, and database platform. If the query
returned from the hub matches what was defined for the file reference in the change package, Change
Assistant attempts to deploy the files to the agent running on the host machine.

Change packages provided by PeopleSoft applications, are configured to deploy multiple files of the
same type within one step. This can improve performance, especially when a change package contains
hundreds of updated files.

When files are deployed, the step's log file lists the host name and the type of server that match the file
reference and the target path on the remote host.

If the Environment Management agent is not running at the time when Change Assistant is trying to
deploy files, a warning message appears stating the inability to deploy the files. Other types of problems
that may occur, such as lack of disk storage space, will result in step failure.

Resuming Running Jobs
If there is a current apply job set, the Resume Running Jobs dialog box appears automatically when you
start Change Assistant, run a job, or apply change packages (start a new apply).

Select Cancel to:

• Remove all jobs associated with the current apply job set that have not been run.

• If a job definition is open in Change Assistant and it does not belong in the current apply job set, the
job definition remains open.

• If a template definition is open in the Change Assistant, regardless of whether or not it's used in the
current job set, it will remain open.

Select No to keep the current apply job set and its associated jobs as they are, so that you can resume this
apply job set later.

Select Delete Job Set to delete the current apply job set.
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Working with Change Packages (Traditional
Update Only)

Understanding Change Packages

Once you have your change project completed, you create a change package in Application Designer.
Change packages are used to enable:

• PeopleSoft developers to package software updates and any prerequisites associated with PeopleSoft
application updates.

• You to package your own system customizations into a change project, which is then used by the
Change Packager and Change Assistant when migrating from one release or one environment to the
next.

The process of using a change package is to:

1. Create a new project adding all new items for the application changes to the database for the update,
identifying the project as a change project and setting the appropriate update IDs and prerequisites, if
applicable.

2. Define the file reference definition(s), if necessary, for the individual files that need to be packaged
with the project and the file type code.

Note: Only projects that contain physical files (such as SQR or Excel files) need to include a file
reference definition.

3. Generate the change package, which copies the project to a file, generates a Change Assistant
template and documentation, creates the Data Mover scripts for non-managed objects, and packages
the referenced files.

4. Manually update the Change Assistant template, if necessary, that is generated by the Change
Packager.

5. Finalize the change package using the Finalize Change Package option, which performs validations
on the package and produces the zip file.

The zipped archive files contain the change project and all its associated files.

6. Test the newly created change package.
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Creating a Change Project

In addition to identifying the project as a change project, if necessary, you will need to add a file reference
definition to the project, which requires a file type code definition. A file reference is only necessary if
there is a physical file that you want to execute or deploy or both when the change package is applied by
Change Assistant.

This section discusses how to:

• Set project properties for a change package.

• Define the file type code.

• Create a file reference definition.

• Modify the upgrade definition type.

Setting Project Properties for a Change Package
Before beginning to work with the Change Packager, you must identify the project you want to use as a
change project. You do this in the Project Properties dialog box.

To create a change project and set project properties:

1. Create a new project.

2. Open the Project Properties dialog box.

3. Enter a Project Description and any pertinent comments for your internal tracking system on the
General tab.

The system populates the information you enter here into the change log and the manifest.

4. Select Change Project on the General tab.

This enables the Update IDs and the Pre-Requisites tabs. Here you identify the lead incidents from
your incident tracking system, if applicable, that identify the updates to the database.

5. Select the Update IDs tab.

6. Enter the primary incident tracking ID associated with the update you want to implement in the
Update ID field.

This field is numeric. The system considers the first value in the list to be the primary ID for the
project. When entering your own incidents:

a. Enter the names of the fixes or the update IDs fixed in this project. The system logs them to the
manifest and includes them when Change Packager copies the project.

b. Click Add to add it to the list.

Note: In order for Change Packager to create the change package successfully, you must enter a
value in the Update ID field.
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7. Select the Pre-Requisites tab.

List any prerequisites that this project might have. Change Assistant checks those incidents that you
enter here against those listed in the target environment's change log to verify whether the fix has been
applied.

Defining the File Type Code
Each file reference definition that you create for the project must be associated with a file type code.
The file type code stores generic information that is applicable to a group of files within the same target
directory.

Access the file type code definition from Tools > Miscellaneous Definitions > File Type Codes.

To define the file type code for the file reference definition:

1. Click New to access the New File Type Code dialog box.

2. Enter a file type code and click OK.

The file type code can be up to 30 characters in length. This action opens the File Type Code dialog
box.

3. Enter the Path.

This notifies Change Assistant where the file belonging to this type code should be deployed. The
only supported environment variable for use is %ps_home%.

4. Enter a description for the file type code.

This field is required in order to save the definition.

Creating a File Reference Definition
If you have individual files that need to be packaged with the project, you can create file reference
definitions to identify them. Create one file reference definition for each file. You create a file reference
definition in the same manner as all other PeopleTools definitions in Application Designer, by selecting
File > New from the menu.

Field or Control Description

File Name and Path Enter the path and file name for the file you want to reference.
 Use the browse button to search the proper path. This is the
source location and file from which Change Packager selects
the definition for packaging. This field supports the use of
environment variables.

If you want to create a file reference with a variable path,
 prepend %FILEREFPATH% to the filename.

Change Assistant Template Text Enter the text you want to display in the Change Assistant
template for this change package. This field has a 20 character
limit.
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Field or Control Description

Binary Check if the file is a binary file. This information is necessary
to properly transfer the file to the target platform.

Database Platform Select the database platform for the target database.

Operating System Select the operating system for the target database.

PeopleSoft Server Select the applicable server for your system.

Unix Target Directory Security Specify the file permissions the file should have once it is
copied if operating on a UNIX system.

For each of the drop-down list boxes in this dialog box, you may select multiple entries by using the
Shift/Ctrl keystroke combinations.

The file reference properties contain only the General tab where you can enter any comments about the
file reference as well as select the Owner ID. This tab also tells you when the definition was last updated
and by whom.

When you save the file reference definition, the definition name defaults to the file name you entered in
the File Name and Path field. The Save As dialog box prompts you for the File Type Code, which is a
requirement for every file reference definition.

Variable File Reference Path

You can use a variable path as a file reference. To do this, in addition to the steps for creating an absolute
path:

• In the File Name and Path edit box, enter the name of the file and prepend the filename with
%FILEREFPATH%.

For example: %FILEREFPATH%\ExcelToCI.xls

• Add this file reference to a change project.
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This example illustrates the fields and controls on the Example of Variable Path File Reference. You can
find definitions for the fields and controls later on this page.

Using variables in the file reference definition eases the repackaging of a change package. When you
create a change package with a variable file reference, the File Reference Path edit box in Create Change
Package dialog expands the %FILEREFPATH% variable in the file reference definition. However, the file
reference definition itself is not updated in the process.

This enables you to repackage change packages without having to modify the file reference definitions.
The value in the File Reference Path field is stored in the registry and displays the last value.

When the change package is recreated, the update ID automatically expands the file reference paths
according to the following construct:

file reference path + upd + update ID + \ +upd + update ID +_batch\filereferences\ + file type code +
filename

For example:

c:\temp\upd999999\ upd999999_batch\filereferences\XLS\ExcelToCI.xls

c:\temp\upd999999\ upd999999_batch\filereferences\SQR\xrfwin.sqr

If the file does not exist in the directory, the system searches for the file reference path. If the file isn’t
found in this directory, then an error will be displayed and the Change Packager fails to create a change
package.

See Creating a Change Package.

Modifying the Upgrade Definition Type
After creating the file reference definitions and inserting them into the change project, the next step is to
modify the upgrade definition type to instruct whether Change Assistant should deploy or execute the file
reference. Deploying the file copies it to the location specified in the File Type Code defined in the target
environment. Executing the referenced file means it will be run on the Change Assistant machine.
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Note: File references and application engine programs are the only definition types that can be executed.

To modify the upgrade definition type:

1. Open the change project.

2. Select the Upgrade tab in the project workspace.

3. Double-click the File References folder.

This action opens the upgrade definition type listing all file reference definitions for that project.

4. Choose the appropriate upgrade attributes for each of the file references listed.

Refer to this table to ensure the desired results:

Desired Result Execute Check Box Upgrade Check Box Action Option

Deploy and Execute Selected Selected Copy

Deploy only Cleared Selected Copy

Execute only Selected Cleared Copy

No Step* Cleared Cleared Copy

No Action** Either Either Delete

* No step indicates that the generated Change Assistant template will not have a step corresponding to
that file reference definition.

** No action means that the file is neither deployed or executed in the target machine.

The default settings for the upgrade definition type are set for deploy only.

5. Save the project.

Creating Change Packages

This section discusses how to:

• Create a change package.

• Modify the Change Assistant template.

• Finalize the change package.

386  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 24 Working with Change Packages (Traditional Update Only)

Creating a Change Package
Once you have created your change project you can build the change package using the Change Packager
feature in Application Designer.

To create a change package, select Tools, Create Change Package, which invokes the Create Change
Package dialog box.

This example illustrates the fields and controls on the Create Change Package dialog box. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Export Directory The Change Packager feature copies the project into the
directory you identify. Use the browse button to search for the
desired directory. If you already created a change package for
this project in the same directory, the system prompts you to
delete the existing file.

File Reference Settings These settings apply only if your change package contains file
references, otherwise these settings are disabled.

• File Reference Path: Enter the path for the file reference.

• Update ID: Enter the associated update ID.

See Creating a File Reference Definition.

Generate New Template Select this option if you intend to generate a new Change
Assistant template with your change package that does not
incorporate any manual changes made to an existing template.
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Field or Control Description

Merge Existing Template Select this option if you intend to incorporate any manual
changes you have made to an existing Change Assistant
template. Enter the file path or navigate to the location of the
existing Change Assistant template you want to merge with the
updated template.

Backport IB to pre-8.48 PeopleTools Select if your changes affect Integration Broker (IB)
definitions and need to be applied to versions of PeopleTools
before PeopleTools 8.48. In PeopleTools 8.48, the metadata
surrounding Integration Broker changed significantly.

Overwrite if already backported Only appears if Backport IB to pre-8.48 PeopleTools is
selected. Select this option to overwrite any Integration Broker
changes that have already been backported.

The progress dialog boxes indicate the definitions that the system is copying into the change package.
The system then confirms that the change package was created successfully. The Results tab of the
output window displays a list of the definitions in the project by definition type, as well as any errors
encountered.

Open the staging directory to confirm the change package was created successfully. The destination
directory now includes a new folder named after the project and appended with the word Package.

Change Packager Output

The Change Packager feature generates several folders and a manifest, placing them in the output
directory you specified previously. The manifest from the change package is an XML document
containing data that may need to be accessed quickly by Change Assistant. This manifest information
includes:

• Update ID(s) from the project properties.

• Prerequisite ID(s) from the project properties.

• Update summary text from the project properties.

• The user who created the update.

This is the user ID for the individual that last updated the project based on the By User field in the
Project Properties dialog box.

• Post date.

This date is generated from last updated Date/Time field from the Project Properties dialog box.
Change Assistant uses this date to determine the order in which to apply a selection of change
packages.

• The number of manual steps included in the Change Assistant template.

• A count of the definition types included in the project.

In addition to the manifest are six folders that include:
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• The Change Assistant template

The template contents for the update are tailored to the specific contents of the change project,
including all relevant file deployment steps for each file reference definition given the file type code
and the file reference attributes.

• Documentation

The change package documentation is an HTML file. This document contains general information on
the installation as well as instructions that are customized to your specific customizations. When you
open the change package in Change Assistant, it displays the proper documentation for the current
step in which you are currently working.

• File references

The File References folder contains folders for each file type code associated with each file reference
definition in the project. Each file type code folder contains a copy of the actual file referenced by the
project's file reference definitions associated with this file type code.

• Project folder

This folder contains an XML file of all project information.

• Pre 8.44 project folder

This folder is applicable only to customers operating on a pre-8.44 PeopleTools release and are
therefore not using Change Assistant to deploy change packages.

Modifying the Change Assistant Template
In most cases, the Change Assistant template generated by the Change Packager is exactly what you need
to begin working with Change Assistant. However, in rare instances it may be necessary to manually add
or update the steps in the Change Assistant template. The template is located in the Change Assistant
package directory as an XML file.

Finalizing a Change Package
Once you create the change package and are satisfied with the Change Assistant template, finalize the
change package. The finalization process validates the files to confirm that all of the necessary pieces to
produce the change package are present and generates a zip file for the entire change package. The zip file
enables you to easily migrate your change sets to multiple environments.

To finalize a change project:

1. Open the change project to finalize.

2. Select Tools > Finalize Change Package from the menu.

3. Enter the location of the staging directory that you would like zipped up for the change package and
click OK.

Use the browse button to search for the proper directory.
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Change Packager places the zip file in the "<project name>Package" file, using the project name for
the file name.

Working With Change Package Automation

This section provides an overview, and discusses:

• Working with ReleaseAdaptor.

• Working with ProjectFilter.

• Working with ProjectInspector.

Understanding Change Package Automation
PeopleTools provides a set of standalone utilities that automate the manipulation of change packages,
ensuring that only the appropriate changes get included in change packages and applied to your system.
For the most part, these utilities improve the process of creating change packages within Oracle for
distribution to customer sites. However, they can also be useful at customer sites, where development
teams create custom change packages to apply to their implementations.

These utilities address situations in previous releases, where during upgrades, manual steps were required
and multiple change packages need to be applied, such as in the cases where Integration Broker metadata
needed to be applied to pre-PeopleTools 8.48 releases. In most cases, these utilities run in the background
when you create change packages or perform an upgrade while using Change Assistant. To run these
utilities manually, they can be invoked from the command line, or added to automation shell scripts, for
example.

When these utilities are used within an upgrade process, the documentation in your Change Assistant job
and your upgrade documentation will provide the necessary details.

See Your PeopleSoft application upgrade documentation

Working with ReleaseAdaptor
ReleaseAdaptor is invoked by Change Assistant to remove:

• contents from the project that are not consumable by the target PeopleTools release.

• unneeded steps from the change package template.

ReleaseAdaptor appears as a Change Packager step, and automatically examines the project to determine
if it is applicable to the current PeopleTools release. For example, it determines whether a project contains
Integration Broker content, and, if the PeopleSoft application release is pre-PeopleSoft 9.0. If the project
meets these criteria it generates and includes the additional pre-PeopleTools 8.48 Integration Broker
elements without any manual intervention. The resulting change package will contain all elements
required for consumption by all applicable releases of PeopleTools.
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A set of command-line transformation programs enables this processing. Which programs need
to be run for a specific release is determined by the TRANSFORM_PROGRAMS.XML file.
TRANSFORM_PROGRAMS.XML has two sections:

• a list of <release> tags that map various pillar and release identifiers into <InitialToolsRelease>
elements

• and a list of <transform> tags that specify which transforms to apply for each <InitialToolsRelease>
element

The TRANSFORM_PROGRAMS.XML file is located in PS_HOME\BIN\CLIENT\WINX86.

The final, consolidated project will contain all required elements for all release targets.

Working With ProjectFilter
ProjectFilter enables you to remove the specified project contents from the specified project.

Use the following syntax:

ProjectFilter >]
[-N <instance name[;instance name*]>]] | [-TL]] [-LOG <log filepath>] [-?]

Parameter Description

-PRJ Specify the project file to be scanned. No default value
assumed.

-TY | -TX -TY specifies one or more object type names to be removed,
 delimited by a semicolon character (;).

-TX specifies one or more type names to be retained, delimited
by a semicolon character (;).

-TY and -TX are mutually exclusive. If neither TY nor TX are
specified, all types are removed.

-N A list of names of instances to be removed or retained in the
form type:name0.name1.name2.name3 where each name is
delimited by a semicolon (;) character. If not specified, all
instances are removed or retained consistent with any -TY or -
TX specification.

-TL Lists the valid type identifiers, names, and descriptions.

-LOG Absolute path to log file.

-? Shows usage details.
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Example: ProjectFilter

Entering the following removes record and field type objects from the project C:\PRJ151141.xml, and
writes a log file to C:\ProjectFilter151141.log.

ProjectFilter -PRJ C:\PRJ151141.xml -TY Record;Field
-LOG C:\ProjectFilter151141.log

Entering the following lists valid object types, and writes a log file to C:\ProjectFilterObjTypes.log

ProjectFilter -TL -LOG C:\ProjectFilterObjTypes.log

Working With ProjectInspector
ProjectInspector enables you to query the contents of projects. It does not require signon and it does not
make a database connection. ProjectInspector is designed to be incorporated in automation shell scripts
and for ad hoc queries. If can be run against projects created using previous releases of PeopleTools.

Use the following syntax: This has the command line:

ProjectInspector -PRJ <project file> [-TY <type name [‘;’ type name]* >]
[-N <instance name [‘;’ instance name]* >][-L N | C | T][-TL] [?]

Parameter Description

-PRJ Path name of the project file to be scanned. There is no
default. If just a name is specified, the program checks in the
current directory.

-TY One or more object type names to be listed, delimited by a
semicolon character (;).

If not specified, all types are removed.

-N A list of names of instances to be removed or retained in the
form type:name0.name1.name2.name3 where each name is
delimited by a semicolon (;) character. If not specified, all
instances are removed or retained consistent with any -TY
value.

-L Specifies the listing format and can be either N, T or C.

• N means list the types and names of all objects with one
object per line.

• T means list the types and counts of all objects with one
type per line.

• (Default) C means list just the number of objects as a
single integer.

The –N and –T arguments can be used in the same command
provided the types do not overlap. Specifying the same types
in an –N name argument as in a –T argument causes an error.
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Parameter Description

-TL Lists the valid type names, numeric identifiers, and
descriptions.

-? Shows usage details.

Example: ProjectInspector

Entering the following lists the number of subscription PeopleCode and message channel definitions in
the project, or a null string if there were none.

ProjectInspector -PRG PRJ8979874.XML -TY SubscriptionPPC ; MessageChannel -T T
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Getting Started with Software Upgrades

Understanding Change Assistant For Upgrades

Application upgrade only applies to upgrading an older application release to application release 9.2.
Once your application is on 9.2, PUM is used to apply maintenance and new features. You use Change
Assistant to help automate and customize the PeopleSoft upgrade process. A PeopleSoft upgrade typically
includes a PeopleTools and a PeopleSoft application upgrade.

Depending on your upgrade path, the application upgrade may be combined with the tools upgrade. If
they are not combined, you will need to perform the tools upgrade before the application upgrade.

The following list describes the major steps within an upgrade when using Change Assistant.

• Deploy the Certified Upgrade Source Image as your New Release Demo database. The Upgrade
Source Image is available for download from My Oracle Support. Starting with the release of
PeopleSoft PeopleTools 8.56, deployment packages (DPKs) are being used for the Upgrade Source
Images. Each PeopleSoft application upgrade home page in My Oracle Support includes a tab for the
Upgrade Source Images for that application.

See  PeopleSoft Upgrade Source Image Home Page (ID: 1552580.1). and Upgrading PeopleSoft?
Start Here. [ID 1587686.2]

• Deploy the PeopleSoft Update Image.

See Installing PeopleSoft Update Image

• Configure Change Assistant for Upgrade.

See Configuring Change Assistant for Upgrade Application

• Define Upgrade Package.

See Defining an Upgrade Package

• Use the Upgrade Application action to create an upgrade job tailored to your specific environment,
defining all the steps required to perform the upgrade.

See Upgrading Application

• Use Change Assistant to guide you step-by-step through the upgrade processes. Change Assistant
shows you documentation for each step, automates many of the steps, and keeps track of the upgrade
progress.

Databases Used for Application Upgrade
The following Databases are used in an Application Upgrade:
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• Production

• Copy of Production

• New Release Demo (certified Upgrade Source database)

• Update Image

As you progress through the application upgrade process, the source and target databases

This diagram illustrates the source and target databases used during the upgrade process.

Getting Started
Download documentation for the specific upgrade process that you will be performing from the Upgrade
home page in My Oracle Support. You must read the documentation Getting Started on Your PeopleSoft
Upgrade before you continue with your upgrade. This getting started guide explains the upgrade process,
terminology, and setup tasks that must be performed prior to starting your upgrade.

Before continuing with the upgrade, you must complete all of the tasks in Getting Started on Your
PeopleSoft Upgrade, "Starting Your Upgrade."
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Configuring Change Assistant for Upgrades

Defining an Upgrade Package

The Define Upgrade Package component in the PUM PIA application will create 2 change package
definitions:

• Upgrade package (UPG)

This package contains the Application Upgrade template from your current release to 9.2.

• Required for Upgrade package (RFU)

This package contains all of the bugs required for upgrade.

To define an Upgrade Package:

1. In Change Assistant configure the General Options and PUM Source.

See Configuring Change Assistant for Upgrade Application

2. Upload the Upgrade Source Database to the PUM Source database.

See Uploading Target Database Information

3. Select Tools, Define Change Package.

4. Click the Click Here to Open Browser and Connect to the PUM Source Database.

5. Sign on to the PUM Source Database.

6. Select PeopleTools, Lifecycle Tools, Update Manager, Update Manager Dashboard.

7. Expand the folder Select Target Database.

8. Click on the Upgrade Source database name.

9. Expand the Define Change Package folder and select Define Upgrade Package.

10. The Define Upgrade Package wizard will guide you through the steps to create a change package
definition.

• Step 2 of 6 - Enter Change Package Name

See Define Upgrade Package Step 2 of 6

• Step 3 of 6 – Select Scope

• Step 4 of 6 – this step does not apply to upgrade packages and therefore is skipped.

Copyright © 1988, 2022, Oracle and/or its affiliates. 397



Configuring Change Assistant for Upgrades Chapter 26

• Step 5 of 6 - Review Bugs

• Step 6 of 6 - Done Identifying Bugs

11. Return to Change Assistant and create the Upgrade Change package.

Selecting the Target Database
The target database for an Upgrade package is the Upgrade Source database (New Release Demo).

Define Upgrade Package Step 2 of 6
Enter a name and description for the Upgrade Package.

This example illustrates the fields and controls on the Upgrade Package Step 2 of 6 page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Package Name Enter a name for your upgrade package. To edit an existing
change package, select the Lookup button. The list of change
packages that can be edited is restricted as follows:

• Packages created by the current user.

• Packages created for the currently selected target
database.

• Packages which have been defined but have not been
created.

If the package name already exists, the Change Package
Options page will be displayed. See Define Update Package
Wizard Step 2 of 6

Package Description Enter a description for the upgrade package.

Define Upgrade Package Step 3 of 6
Select which App Upgrade Option to use. By default Application Upgrades to 9.2 is selected.

This example illustrates the fields and controls on the Upgrade Package Step 3 of 6 page. You can find
definitions for the fields and controls later on this page.

App Upgrade Options
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Field or Control Description

Application Upgrades to 9.2 Select this radio button to create an application upgrade
package (UPG).

Select the From release from the drop down list.

Select the Select the To path which will align with the Upgrade
Certified Image, for example 9.2 Image 10 from the drop
down list.

By default Required for Upgrade Fixes will be included in the
package.

Note: When you select this option 2 change package
definitions are created UPG and RFU.

Required for Upgrade Fixes Select this radio button to create a Required for Upgrade 
(RFU) package.

Note: When you select this option only 1 change package is
created RFU.

Define Upgrade Package Step 5 of 6
When you transition to step 5, the upgrade path is displayed.

This example illustrates the fields and controls on the Upgrade Package Step 5 of 6 page. You can find
definitions for the fields and controls later on this page.

Define Upgrade Package Step 6 of 6
When you transition to Step 6 the project definitions for the upgrade (UPG) and the required for upgrade
(RFU) are created, as well as the Change Assistant template.

400  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 26 Configuring Change Assistant for Upgrades

You will return to Change Assistant to create the Change Packages.

This example illustrates the fields and controls on the Upgrade Package Step 6 of 6 page. You can find
definitions for the fields and controls later on this page.

Creating Upgrade Package
To create the upgrade package in Change Assistant:

1. Navigate to the Create Change Package if you are not already on that page.

Select Tools, Create Change Package

2. Select the upgrade change package for the drop down. There will be 2 packages for upgrade (UPG
and RFU). Select one of these.
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This example illustrates the fields and controls on the Create a New Change Package. You can find
definitions for the fields and controls later on this page.

3. Click Next. You will receive a message Do you need to create the corresponding UPG CP? or

Do you need to create the corresponding RFU CP?, depending on your selection. Click OK.

4. The change packages will be created.

Configuring Change Assistant for Upgrade Application

Before you begin performing an application upgrade using Change Assistant, you configure Change
Assistant settings.

• General Options

• PUM Source is not used with Upgrade Application

• EM Hub is not used with Upgrade Application

• Additional Options is optional.

Depending on the upgrade pass, the source and target databases will change.

Pass Source Target

Initial New Release Demo database

Note: This is either the certified Upgrade
Source Image or Demo database for the
Upgrade Certified new release installed
from the media pack or CD.

Copy of Production
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Pass Source Target

Test Move to Production Upgraded Copy of Production New Copy of Production

Move to Production Upgraded Copy of Production Production

Setting Change Assistant Options
To set Change Assistant Options:

1. In Change Assistant, select Tools, Options.

2. Select Application Upgrade and click Next.

3. On the General Options page, specify the high-level settings for your current environment and click
Next.

4. On the Additional Options page, enter your optional email notifications settings.

5. Click Finish.

General Options

The values entered on the General Options page are used as the default values for all of the various
databases in the upgrade process.
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This example illustrates the fields and controls on the General Options page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Maximum Concurrent Processes Specifies the maximum number of processes that can be
executed concurrently on the local machine. The default is 1.

PS Home Starting Port Specify the port number for the first PS Home server.

Change Assistant uses this port number to communicate with
Change Assistant PS Home servers. The default starting port
number is 6151. If you enter a port number that is already
in use, you see an error message. You must change to a port
number that is not in use, and then restart Change Assistant for
the change to take effect.
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Field or Control Description

PS Home Server Maximum Instances Enter a number between 1 and 10 for the maximum number of
PS Home servers.

Use this value for environments with more than one PS_
HOME. For each server instance, Change Assistant increments
the PS Home Server Starting Port number by 1 up to the
maximum number of instances. For example, with a PS Home
Server Starting Port value of 6151 and a PS Home Server
Maximum Instances value of five, the port numbers would be
6151, 6152,6153, 6154, and 6155. The default is 5.

If you change this value, you must restart Change Assistant for
the change to take effect.

PS Home Enter the full path in which you installed PeopleTools client on
the Windows Client machine.

Note: Specify the PS_HOME location you used to install
Change Assistant.

Staging Directory Enter the directory in which you would like to stage all the
Change Assistant upgrade files. This is the location that
Change Assistant will store files to be used during the upgrade
job.

Output Directory Enter the directory in which you want the log files generated
by the upgrade job.

Download Directory Enter the download directory where you created the Upgrade
Change Package.
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Additional Options

This example illustrates the fields and controls on the Additional Options page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Send Email Notifications Select this check box to receive email notifications if there are
errors in the update process. Change Assistant also sends you
a completion message when it encounters a Stop in the update
process.

SMTP Server Enter the SMTP mail server from which you receive the error
or completion messages.

Port Enter the port from which you want to access the email.

Send To Enter the address to which you want the email sent.

Return Address Enter the email address of the sender. Use this to identify who
sent the notification.

Test Validates that email is sent to the designated recipients and is
working correctly.

Note: Ensure that your SMTP server is installed and
configured correctly.

Upgrading Application

Before using the Upgrade Application task, the following must have been completed:
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• Define Upgrade Package

• Configure Change Assistant Settings.

To use the Upgrade Application

1. In Change Assistant, select Tools, Upgrade Application.

Note: You must be in the Update Manager action.

2. The Change Package Wizard will guide you through the creating the upgrade job.

3. On the Change Package Settings page, select the download directory and apply type and click Next.

4. On the Select Upgrade Target Database page , select the target database and click Next.

5. On the Select Upgrade Source Database page, select the source database and click Next.

6. On the Application Upgrade page, select the packages to apply and click Next.

7. Change Assistant will check the compatibility and display the status. Review the checks and click
Next.

8. The Apply Summary page is displayed. Click Finish.

9. Change Assistant will create the Application Upgrade job and open it.
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This example illustrates the fields and controls on the Application Upgrade Job.

Change Package Settings
On the Change Package setting page, you will select the download directory and apply type.

408  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 26 Configuring Change Assistant for Upgrades

This example illustrates the fields and controls on the Upgrade Application - Change Package Settings.
You can find definitions for the fields and controls later on this page.

Field or Control Description

Download Directory Select the directory where you created the Upgrade Package.

See Creating Upgrade Package

Apply Type Select the Apply Type. By default Initial Pass is selected.

• Initial Pass (default)

Initial upgrade pass on your Copy of Production database.

• Move to Production

Upgrade between your Copy of Production database and
your test or production system.

Select Upgrade Target Database
On the Select Target Database page, select the target database to upgrade. If the target database does not
exist, click the Create button to launch the Database Wizard. See Defining Databases

Note: For upgrades, you need to set the new home information on bottom of the Select Upgrade Target
Database page. To set the new homes see Configuring New Homes for Upgrade.
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This example illustrates the fields and controls on the Select Upgrade Target Database page.

Select Upgrade Source Database
For the initial pass, the upgrade source database is the Release 9.2 Demo database certified for this
upgrade.
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This example illustrates the fields and controls on the Select Upgrade Source Database.

Select Application Upgrade
On the Select Application Upgrade Page, the Upgrade source and target are displayed with the
PeopleTools release for the database, the current PS_HOME and the new PS_HOME.
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This example illustrates the fields and controls on the Select Application Upgrade page. You can find
definitions for the fields and controls later on this page.

Select the Packages to Apply:

• Application Upgrade

• Required for Upgrade Package

• PeopleTools Upgrade

• PeopleTools Patch

Validation Page
The Validation page will perform checks and validations on both the source and target environments.
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Running Upgrade Jobs with Change
Assistant

Running the Upgrade Job

When you create a new upgrade job, you will see a job view similar to the following example:

This example illustrates the fields and controls on the Upgrade Job. You can find definitions for the fields
and controls later on this page.

In the job area on the left-hand side of the screen, you'll see one of the following icons next to the steps.

Field or Control Description

Indicates each step that must be performed manually. The
status of manual steps can be set only to Stop or Complete.
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Field or Control Description

Indicates that Change Assistant can automatically run this step.
 You can set the status to Stop, Run, Restart, or Complete.

If you set the status to Stop, this indicates that you want to
stop the upgrade job at that step or that a milestone has been
reached. The status can be reset to Run when desired.

Indicates a restart process. If a step failed and you corrected
the problem, you can set the step to restart from the point of
failure.

Indicates that the process is running.

Indicates a failure has occurred that needs immediate attention.
 This appears if a Data Mover script, SQL script , or project
copy step fails. Resolve the error before continuing with
processing.

Indicates a warning for this step which does not need
immediate attention. The job continues processing with no
adverse affects. After the job completes, review the steps in a
warning state and evaluate for further action.

Indicates that the step was completed by the system.

Indicates this step was completed manually.

Indicates this step is filtered at the job level.

Steps filtered at the job level will not execute and are
equivalent to Complete. To hide these steps, select View, and
deselect Steps Filtered at the Job Level.

Indicates this step is filtered by a filter query.

Steps filtered by filter query will not execute and are
equivalent to Complete. To hide these steps, select View, and
deselect Steps Filtered by Filter Query.

When you are ready to run your upgrade job, select Run from the Change Assistant toolbar. Monitor
the status of the automated upgrade steps in the Step Details box. After a automated step is completed
running in Change Assistant, you can view logs, scripts and update job properties for individual steps.

Note: Change Assistant uses Application Designer and Data Mover in the background to perform many
of the tasks. When using Change Assistant, make sure that any current Application Designer and Data
Mover sessions running on the same workstation as Change Assistant are closed before running Change
Assistant.
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Viewing Upgrade Logs

You can view all the logs generated by the automated processes. After the process runs, you can select a
step to view.

To view a log:

1. Highlight or select the step.

2. Select Edit > View Log.

3. Click OK

Note: If a step encounters an error, Change Assistant will automatically display the View Log.

Note: On the left side of the file list, Change Assistant displays both error and success symbols. These
indicate which step logs contain errors to help you troubleshoot.

Viewing Scripts

You can view SQL and Data Mover scripts that are used to automate processes. Before the step that
contains the script runs, you can view or modify the original script. After the process runs, you can view
or modify the updated script and then restart the step.

To view a script:

1. Highlight or select the step.

2. Select Edit, View Script.

3. On the View Script dialog box, select the script you wish to view and click OK.

Modifying Job Properties

You may want to maintain a record of how long your upgrade takes. In that case, you can view and
change the dates and durations for steps in the View/Edit Job Properties dialog box.

Change Assistant allows you to set the status for these sub-steps: DBTSFIX, UpgradePeopleTools and
LoadBaseData.

To modify job properties:

1. Highlight or select the step.

2. Select Edit, Job Properties.

3. Enter changes to a specific job property, or add comments, and click OK.
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Running Process Scheduler Steps

This section discusses how to:

• determine when to run Process Scheduler steps.

• prepare to run Process Scheduler steps.

• work with Process Scheduler steps.

• ensure Process Scheduler security authentication.

Determining When to Run Process Scheduler Steps
Running the ProcessScheduler step type is designed to improve performance and quicken completion
times of long-running, data-intensive steps, that can be run in parallel in an application upgrade. In most
cases, the steps that would require Process Scheduler processing are delivered in your upgrade template
configured to run on a Process Scheduler server. However, if you are creating a custom template, decide
that improved performance can be gained by running a step through Process Scheduler, as opposed to
running through a remote agent, you can configure a process to be run by a ProcessScheduler step.

Before setting up an upgrade process to be run through Process Scheduler:

• always consult your specific upgrade documentation for any recommendations, considerations, or
restrictions.

• make sure Process Scheduler is configured and defined within your upgrade environment.

Note: Refer to the PeopleSoft upgrade documentation for your upgrade path for additional information.

Preparing to Run Process Scheduler Steps
Before running an upgrade process though Process Scheduler, the following items need to addressed:

Task Documentation Reference

Set up Process Scheduler. See  Process Scheduler

Define Process Scheduler servers in your upgrade database. See Specifying Database Process Scheduler Settings.

Include a ProcessScheduler step type in your upgrade
template.

See Step Parameters.

Working With Process Scheduler Steps
This section discusses how to:

• View Process Scheduler logs.
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• Restart Process Scheduler steps.

• Cancel Process Scheduler steps.

Viewing Process Scheduler Logs

If in your upgrade environment you have configured Change Assistant to be able to access Process
Scheduler logging information, you can view the Process Scheduler processing information from within
Change Assistant just as you would for any other step (click on the step and select Edit, View Log).

The status returned by Change Assistant for the step matches the status returned by Process Scheduler
itself. The log files generated by Process Scheduler are not parsed for warnings or errors. Therefore, even
though Change Assistant may show a status of Complete for a Process Scheduler step type, you should
review the generated log files for more details.

Restarting Process Scheduler Steps

If a Process Scheduler step has failed or has been stopped, you can restart the process by setting the step
to Restart. This is most useful for restart-aware process definitions using Application Engine. When a step
has been set to Restart, Change Assistant resubmits the process requests to Process Scheduler.

Canceling Process Scheduler Steps

While Change Assistant is executing the ProcessScheduler step, you can kill the step, by clicking on
the step and selecting Run, Kill. This is equivalent to stopping or cancelling scheduled processes on the
Process Scheduler. When you 'kill' the step, Change Assistant connects to the Process Scheduler, which
issues "cancel" commands to the appropriate processes.

Ensuring Process Scheduler Security Authentication
PeopleSoft Change Assistant uses the PROCESSREQUEST component interface object to submit jobs
to run on the PeopleSoft Process Scheduler server. You must ensure the user submitting the process has
the appropriate authentication set for the PROCESSREQUEST object in the database the process runs
against. You must edit security permissions to run the PROCESSREQUEST object.

To set up PROCESSREQUEST component interface security:

1. Log in to PeopleSoft through the browser.

2. Select PeopleTools, Security, Permissions and Roles, Permission Lists.

3. Select the permission list for which you want to set security. The Permission List component appears.

4. Access the component interfaces page and select the PROCESSREQUEST component interface.

5. Click Edit.

The Component Interface Permissions page appears, showing all of the methods (both standard and
user-defined) in the component interface and their method access.

6. Set the access permission for each method.

Select Full Access or No Access. You must grant full access to at least one method to make the
component interface available for testing and other online use.
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7. Click OK, and then Save.
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Understanding Data Conversion Utilities

The Upgrade Data Conversion Application Engine Programs are organized into a series of Drivers or
Groups that guide the flow and order of execution at runtime for a particular upgrade path.

This topic contains information regarding People Tools Impact Analysis (PTIA) and the
PS_PTIA_DCAEPGMS table. The PTIA process consists of two Application Engine programs and is
intended to optimize the data conversion process by analyzing Source and Target tables and state records
to determine actual dependencies between Application Engine sections. This allows you to run your data
conversion process during your PeopleSoft application upgrade with optimal performance.

Using the PTIA Data Conversion Process
This section discusses:

• Understanding the PTIA Data Conversion Process

• Reviewing PTIA Initial Analysis

• Reviewing Dependency Analysis

• Reviewing Runtime for PTIADATACONV

• Reviewing PTIA Reporting

Understanding the PTIA Data Conversion Process
The PeopleTools Impact Analysis (PTIA) process uses many pieces of the previous style data conversion
delivered in PeopleSoft 9.1 applications and lower. For example, PTIA uses the Application Engine
section grouping and sequencing in the PS_PTIA_DCAEPGMS table for its dependency modeling. The
PTIA process also uses the terminology – root or top section. A root or top section is an Application
Engine section defined in PS_PTIA_DCAEPGMS. We use root or top section to distinguish between
sections being called from the data conversion program as opposed to sections being called from an
Application Engine call section step.

The PTIA process includes analyzing the insert, update, and delete SQL steps in your data conversion to
determine the Source and Target tables and state records that are used. This includes analyzing dynamic
SQL, App Classes, SQLExec’s, and platform-specific code.

The Application Engine program gathers a list of Application Engine sections required for data
conversion from a given upgrade path. These sections are analyzed and SQL statements are extracted and
stored in the Application Engine Analyzer repository. Each SQL statement is analyzed to derive a list of
tables that are manipulated or queried during the execution of that SQL. Once all the SQL is analyzed,
the information is used to derive section dependency information, which is then saved in the Application
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Engine Analyzer repository. PTIA allows the Application Engine data conversion to run out of the box on
a number of threads.

There are two types of analysis for PTIA: initial and dependency. This section will describe both analysis
types in detail.

Reviewing PTIA Initial Analysis
This section discusses:

• Understanding Initial Analysis

• Reviewing Data Conversion Query Parsing

• Reviewing Custom Data Conversion Code

• Reviewing Table Usage Information

• Reviewing Non Parsable SQL

• Reviewing the Data Conversion Repositories

Understanding Initial Analysis

The first part of the PTIA process is the PTIAANALYSIS Application Engine, also known as the
Application Engine Analyzer. PTIAANALYSIS accepts one parameter for the upgrade path, and then
queries PS_PTIA_DCAEPGMS to retrieve all the groups and sections for that upgrade path, ordering
by group and sequence. Starting with the first group and first sequence, PTIAANALYSIS parses each
Application Engine section definition following the flow from step to step and through any nested call
sections. As it follows the flow, it inserts rows into the PS_PTIA_ANALYSIS table for each Application
Engine Section, Step, and Action it comes across. PTIAANALYSIS maintains a counter as it goes and
increments the counter as it writes each Action to the PS_PTIA_ANALYSIS table. By the end of this
first task, the PS_PTIA_ANALYSIS table will describe the entire upgrade from top to bottom, from the
first Application Engine section in the first Upgrade Group to the last section in the last Upgrade Group.
By querying the PS_PTIA_ANALYSIS table and ordering by PTIA_AESTMTSEQ, the whole will be
described, including any nested call sections.

It is important to note that the PS_PTIA_ANALYSIS table contains every actual Step in the chosen
upgrade path. During the data conversion runtime phase, it is likely that not all these steps will be
executed because specific data composition and various application options will prevent some sections or
steps from running. With the PTIA process, data composition can affect the data conversion runtime flow,
which makes it impossible to predetermine the exact runtime flow the conversion will follow.

The PTIAANALYSIS Application Engine reads the data conversion code for your defined upgrade
path (where the path is defined in the PS_PTIA_DCAEPGMS table with PTIA_UPG_CONV_TYPE=
“MAIN”).

The Application Engine Analyzer program leverages two PeopleCode functions included with PeopleSoft
PeopleTools 8.50 or higher. The two PeopleCode functions are:

• GetProgText: A function that retrieves a PeopleCode program as text.

• ResolveMetaSQL: A function that returns a string of SQL text that has had its metasql resolved.
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Reviewing Data Conversion Query Parsing

After PTIAANALYSIS determines the upgrade path flow, it traverses the flow again looking at all the
different Step Actions to determine which SQL is being executed by that Step. Most action types are
straightforward; SQL, Do Select. PeopleCode is the most complicated action type. A Java program parses
the PeopleCode and pulls all the SQL executed in the PeopleCode. The results of the action type analysis
end up in a table called PS_PTIA_DTLIDSQLS, which stores a reference to PS_PTIA_ANALYSIS,
along with the SQL statements associated with each Step Action. In the case of PeopleCode, there may be
many rows in the PS_PTIA_DTLIDSQLS table for each PeopleCode reference in PS_PTIA_ANALYSIS.
In addition, a second shadow table, called PS_PTIA_DTLIDSQLSR, is also populated during action type
analysis. The only difference between PS_PTIA_DTLIDSQLS and PS_PTIA_DTLIDSQLSR is that
PS_PTIA_DTLIDSQLSR contains the fully resolved SQL statements. For example, if the original SQL in
a Step was:

UPDATE PS_BEN_DEFN_COST SET RATE_TBL_ID = %Substring(%Sql(UPG_HC_221,RATE_TBL_ID),1⇒

,4) %Concat ’-2’ WHERE RATE_TYPE=’2’ AND RATE_TBL_ID IN ( SELECT RATE_TBL_ID FROM P⇒

S_UPG_BN_RATES WHERE RATE_TYPE=’2’)

Then this would be resolved to platform-specific SQL. In the case of SQL server it would be:

UPDATE PS_BEN_DEFN_COST SET RATE_TBL_ID = SUBSTRING(RTRIM(RATE_TBL_ID),1,4) + ’-2’ ⇒

WHERE RATE_TYPE=’2’ AND RATE_TBL_ID IN (SELECT RATE_TBL_ID FROM PS_UPG_BN_RATES WHE⇒

RE RATE_TYPE=’2’)

Each of these SQL statements is further parsed to determine the tables that participate in the query. The
results are stored in the PS_PTIA_DTLIDTBLS table. A query can have zero or one target tables. If
the query is an INSERT, UPDATE, DELETE, etc, then there will be one target. If the query is a select
statement, then there will be no target table. For the previously stated query, you would expect to see 2
rows in the PS_PTIA_DTLIDTBLS table. The first row would be for the PS_BEN_DEFN_COST table
with an PTIA_TABLEUSAGE value of T because it is the target table of the query. The second row
would be for the PS_UPG_BN_RATES table with an PTIA_TABLEUSAGE value of S because it is a
source table in the query.

At this point we have gathered all the information we need about the specific upgrade path to build a
dependency model. The dependency model is solely based on which tables are affected by which steps
and follows some very simple rules. Most of these rules are inherent in the Upgrade Group model.

Reviewing Custom Data Conversion Code

You can include custom data conversion code in the Initial Analysis and subsequent steps in the PTIA
process by adding a row (or rows) to the PS_PTIA_DCAEPGMS table for each custom Application
Engine section that is to be executed, where a row is defined as PTIA_UPG_PATH, PTIA_UPG_GROUP,
SEQ_NUM, AE_APPLID, AE_SECTION, ACTIVE_FLAG, PTIA_UPG_CONV_TYPE,
PTIA_UPG_GROUP_LVL.

Reviewing Table Usage Information

The data conversion analysis process attempts not only to identify the tables that are used in a given
Application Engine step, but also how the tables are being used in the context of each step.

This information is stored in the analysis tables and documented in the Table Usage and Action columns
of delivered PTIA reports, such as PTIA0001.SQR.
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Valid values for the Table Usage column are:

• S for Data Source

• T for Data Target

• X for Unknown

Note: An X value in the Table Usage column for the PS_PTIA_DUAL, PS_PTIA_COMMON_AET,
PS_PTIA_NORECNAME, or PS_PTIA_STATE_AE tables is expected and does not impact the
subsequent Dependency Analysis Process.

See Reviewing Dependency Analysis

Valid values for the Action column are:

• CREATE

• DELETE

• DROP

• INSERT

• SELECT

• TRUNCATE

• UPDATE

• UPDSTATS

• UNKNOWN

• OTHER

A valid value for the action “Unknown” is only applicable to PeopleCode steps and only occurs in
instances when the parser encounters syntax such as GETRECORD, GETROWSET, CREATERECORD, or
CREATEROWSET, and cannot determine which actions were being done against the variable.

A valid value for the action “Other” occurs in instances when the parser encounters syntax such as the
“Invalid SQL Override” or other non-SQL statements such as application function calls.

Reviewing Non Parsable SQL

The data conversion analysis process may mark certain SQL statements as non parsable. This designation
refers to SQL statements that the Application Engine Analysis process could not correctly process. When
a SQL statement is marked non parsable, there are three options that you can use:

• Modify the SQL so that the Application Engine Analyzer can process the statement. The following
table compares sample non parsable and parsable SQL statements:
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NON PARSABLE SQL PARSABLE SQL

UPDATE %Table(%BIND(RECNAME)) SET
RELATIONSHIP = ’C’ WHERE RELATIONSHIP IN (’S’,
 ’D’)

• UPDATE %TABLE(BN_834_MEMBER) SET
RELATIONSHIP = ’C’ WHERE RELATIONSHIP IN 
(’S’, ’D’)

• UPDATE %TABLE(DEP_BEN_EFF) SET
RELATIONSHIP = ’C’ WHERE RELATIONSHIP IN 
(’S’, ’D’)

• UPDATE %Table(EMERGENCY_CNTCT) SET
RELATIONSHIP = ’C’ WHERE RELATIONSHIP IN 
(’S’, ’D’)

• For non parsable SQL statements in PeopleCode, add an override line directly above the non parsable
SQL to manually document the Source and Target tables that are in use.

Note: There is no override option for Application Engine SQL steps that are marked as non parsable.

Note: Entering inaccurate or incomplete information in the override statement may result in
data conversion sections being run in the incorrect dependent order, which can produce incorrect
conversion results, such as data errors.

Note: Tables defined in the override statement require the PS_ prefix.

Correct = PS_JOB

Incorrect = JOB

The following table gives sample override lines for various situations:

Syntax Sample Override Lines

When Source and Target tables are explicitly known and
static

For example:

• REMSQLANALYSIS:T:<Tgt Table>,<Tgt
Table>:S:<SRC Table>,<SRC Table>;

• REMSQLANALYSIS:T::S:<SRC Table>,<SRC
Table>;

• REMSQLANALYSIS:T:<Tgt Table>,<Tgt Table>:S:;
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Syntax Sample Override Lines

When Source and/or Target Tables are determined based on
a query

For example:

• REM SQLANALYSIS:T:%SQL(SQLid [,
 paramlist]):S:[table name];

• REM SQLANALYSIS:T:<Tgt Table>,<Tgt Table>:S:
%SQL(SQLid [, paramlist]);

• REM SQLANALYSIS:T:%SQL(SQLid [,
 paramlist]):S: %SQL(SQLid [, paramlist]);

• REM SQLANALYSIS:T::S:%SQL(SQLid [,
 paramlist]);

• REM SQLANALYSIS:T:%SQL(SQLid [,
 paramlist]):S:;

Where:

SQLid: Specify the name of an existing SQL definition.

paramlist: Specify a list of arguments for dynamic
substitutions at runtime. The first argument replaces all
occurrences of %P(1) in the referenced SQL definition, the
second argument replaces %P(2), and so forth.

Note: The paramlist arguments must be static values.
 Variable values in the parmlist are not permitted.

Note: The Query is resolved at the time the Data
Conversion Analysis is executed. It is NOT resolved during
the Data Conversion Runtime.

Note: The Query must return one or more valid RECNAME
values. No other return results are permitted.

Where there is no Source or Target table to be defined an/or
the non parsable SQL is to be excluded from the table and
dependency analysis.

REMSQLANALYSIS:T::S:PS_PTIA_NORECNAME;

Note: The “REMSQLANALYSIS:T::S:;” syntax is not
a valid override and will be marked as “Invalid” by the
PTIAANALYSIS Program.

• Leave the SQL as it is. This results in the non parsable SQL being marked as “dependent” on all steps
that exist prior to it, and all steps subsequent to the non parsable SQL become dependent on it.

Note: This will likely result in slowing the runtime of data conversion and is not recommended.
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Reviewing the Data Conversion Repositories

The tables in the Data Conversion Analysis repository hold the following data:

• Step actions stored in execution order.

• SQL clauses extracted from step actions.

• Tables featured in SQL clause.

• Bind variables used in SQL.

Analysis information is stored in the following tables:

• PS_PTIA_DCAEPGMS

• PS_PTIA_ANALYSIS

• PS_PTIA_ANALYSISTX

• PS_PTIA_DATACONV

• PS_PTIA_DTLIDSQLS

• PS_PTIA_DTLIDSQLSR

• PS_PTIA_DTLIDTBLS

• PS_PTIA_RUNDEPEND

• PS_PTIA_SECDEPEND

• PS_PTIA_SECLISTTMP

• PS_PTIA_STEPDEPEND

The following Analysis tables make up the PTIA process:

PS_PTIA_DATACONV

The PS_PTIA_DATACONV table is based on the table definition for PS_PTIA_DCAEPGMS. It stores
the upgrade Application Engine sections for the chosen upgrade path.

COLUMN DESCRIPTION

PTIA_UPG_PATH Upgrade Path copied from PS_PTIA_DCAEPGMS

PTIA_DBTYPE Stores the text equivalent of the standard DBTYPE codes

PTIA_UPG_GROUP Upgrade Group

PTIA_UPG_GROUP_LVL Upgrade Group Level
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COLUMN DESCRIPTION

PTIA_UPG_CONV_TYPE Conversion type: MAIN or DDL

SEQ_NUM Upgrade Sequence Copied from PS_PTIA_DCAEPGMS

AE_APPLID Upgrade Application Engine Copied from PS_PTIA_
DCAEPGMS

AE_SECTION Upgrade Application Engine Section Copied from PS_PTIA_
DCAEPGMS

ACTIVE_FLAG Active Flag Copied from PS_PTIA_DCAEPGMS

PTIA_RUNDURATION Elapsed time for this section to run during data conversion

PTIA_RUNSTATUSFLAG Run Status Flag (Y-complete, N-not run yet, R-Running, F-
Failed)

PTIA_GUID GUID generated by the Data Conversion runtime engine

PS_PTIA_ANALYSIS

This is the main analysis table. The Application Engine Analyzer (PTIAANALYSIS) writes a row to this
table for every Action in each Root Section of the specified upgrade path.

COLUMN DESCRIPTION

PTIA_UPG_PATH Upgrade Path copied from PS_PTIA_DCAEPGMS

PTIA_DBTYPE Stores the text equivalent of the standard DBTYPE codes

PTIA_UPG_GROUP Upgrade Group

PTIA_UPG_GROUP_LVL Upgrade Group Level

PTIA_UPG_CONV_TYPE Conversion type: MAIN or DDL

SEQ_NUM Upgrade Sequence copied from PS_PTIA_DCAEPGMS
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COLUMN DESCRIPTION

PTIA_TOPAEAPPLID Upgrade Application Engine copied from PS_PTIA_
DCAEPGMS

PTIA_TOPAESECTN Upgrade Application Engine Section copied from PS_PTIA_
DCAEPGMS

PTIA_TOPAESTEP Upgrade Section Step

PTIA_TOPAESEQNUM Upgrade Section Sequence Number

PTIA_AELEVEL Nesting level for Call Section

AE_APPLID Actual Application Engine Program (same as PTIA_
TOPAEAPPLID if PTIA_AELEVEL is 1)

AE_SECTION Actual Section (same as PTIA_TOPAESECTN if PTIA_
AELEVEL is 1)

AE_STEP Actual Step (same as PTIA_TOPAESTEP if PTIA_AELEVEL
is 1)

AE_SEQ_NUM Actual Seq Num (same as PTIA_TOPAESEQNUM if PTIA_
AELEVEL is 1)

MARKET Market

DBTYPE DBTYPE

AE_DO_SECTION If Step Action is Call Section, then this is the section to be
called

AE_DO_APPL_ID If Step Action is Call Section, then this is the program to be
called

AE_DYNAMIC_DO Indicates the Call Section is a dynamic call section

STEP_DESCR Step Description
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COLUMN DESCRIPTION

AE_STMT_TYPE Action Type e.g. S-SQL, P-PeopleCode, D-DoSelect, H-
DoWhen etc

PTIA_STMTTYPENUM Numeric identified for AE_STMT_TYPE (used for ordering
step actions)

PTIA_AESTMTSEQ Sequence used to order the steps actions for the whole upgrade

AE_REUSE_STMT Standard Application Engine Reuse Statement flag

AE_DO_SELECT_TYPE Standard Application Engine Do Select Type

DETAIL_ID Section.Step.Action identifier used as a key to most PTIA
tables

PTIA_INFO1 Extra Information mostly related to FUNCLIB calls

PTIA_INFO2 Extra Information mostly related to FUNCLIB calls

PTIA_INFO3 Extra Information mostly related to FUNCLIB calls

PTIA_INFO4 Extra Information mostly related to FUNCLIB calls

PTIA_INFO5 Extra Information mostly related to FUNCLIB calls

SQLID For SQL step, the SQLID of the SQL this step action executes

PTIA_STMTDESCR Description copied from Application Engine Step Description

PTIA_HASPARENTS This Step has dependencies on other one or more other Steps

PTIA_HASCHILDREN One or more other Steps have a dependency on this step

PTIA_HASWHERE The SQL has a where clause – Mostly used by PeopleSoft
Development

PS_PTIA_DTLIDSQLS

This table holds a reference to every SQL in the conversion code for the specified upgrade path.

428  Copyright © 1988, 2022, Oracle and/or its affiliates.



Chapter 28 Using Data Conversion Utilities

COLUMN DESCRIPTION

PTIA_GUID GUID generated by the Data Conversion runtime engine

DETAIL_ID Section.Step.Action identifier used as a key to most PTIA
tables

AE_APPLID Actual Application Engine Program

DBTYPE DBTYPE

PTIA_UPG_PATH Upgrade Path copied from PS_PTIA_DCAEPGMS

PTIA_DBTYPE Text equivalent of the standard DBTYPE codes

PTIA_UPG_CONV_TYPE Conversion type: MAIN or DDL

PTIA_SQLNUM SQL Number, for PeopleCode there may be many SQL
statements

PTIA_AESTMTLEN Length of the text of the SQL statement

PTIA_OBJ_TYPE S-SQL or P-PeopleCode

TABLE_NAME Main Table in the SQL Statement, Blank if SQL is SELECT
with many tables

PTIA_DMLACTION INSERT, UPDATE, DELETE, SELECT etc

PTIA_LINENUM Refers to the PeopleCode line number where the SQL is
defined

PTIA_SQLPASSDPARSE Indicates whether SQL parser was able to successfully parse
the SQL statement

DESCR254 Description column

PTIA_PARAMCLAUSE Bind variable used in the SQL

PTIA_INFO1 Extra Information mostly related to FUNCLIB calls
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COLUMN DESCRIPTION

PTIA_INFO2 Extra Information mostly related to FUNCLIB calls

PTIA_INFO3 Extra Information mostly related to FUNCLIB calls

PTIA_INFO4 Extra Information mostly related to FUNCLIB calls

PTIA_INFO5 Extra Information mostly related to FUNCLIB calls

PTIA_CHUNKSEQ Statement Chunk Sequence

PTIA_TEXTCHUNK Statement executed by this Step

PS_PTIA_DTLIDSQLSR

This table differs slightly from the PS_PTIA_DTLIDSQLS table in that the SQL statement has been fully
resolved into platform-specific SQL. This makes it much easier to see what is happening in the SQL.

COLUMN DESCRIPTION

PTIA_GUID GUID generated by the Data Conversion runtime engine

DETAIL_ID Section.Step.Action identifier used as a key to most PTIA
tables

AE_APPLID Actual Application Engine Program

DBTYPE DBTYPE

PTIA_UPG_PATH Upgrade Path copied from PS_PTIA_DCAEPGMS

PTIA_DBTYPE Text equivalent of the standard DBTYPE codes

PTIA_UPG_CONV_TYPE Conversion type: MAIN or DDL

PTIA_SQLNUM SQL Number, for PeopleCode there may be many SQL
statements

PTIA_CHUNKSEQ Statement Chunk Sequence
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COLUMN DESCRIPTION

PTIA_TEXTCHUNK Statement executed by this Step

PS_PTIA_DTLIDTBLS

This table holds a reference to every SQL in the conversion code for the specified upgrade path and which
Tables or Records are in use for each piece of SQL.

COLUMN DESCRIPTION

PTIA_GUID GUID generated by the Data Conversion runtime engine

DETAIL_ID Section.Step.Action identifier used as a key to most PTIA
tables

AE_APPLID Actual Application Engine Program

PTIA_UPG_PATH Upgrade Path copied from PS_PTIA_DCAEPGMS

PTIA_DBTYPE Text equivalent of the standard DBTYPE codes

PTIA_UPG_CONV_TYPE Conversion type: MAIN or DDL

PTIA_SQLNUM SQL Number, for peoplecode there may be many SQL
statements

RECNAME Record Name

TABLE_NAME Associated Table Name

PTIA_TABLEUSAGE T-Target, S-Source

PTIA_TABLETYPE R-Record, S-State Record, U-Upgrade Table, V-View, T-
TempTable

PTIA_INFO1 Extra Information mostly related to FUNCLIB calls

PTIA_INFO2 Extra Information mostly related to FUNCLIB calls

PTIA_INFO3 Extra Information mostly related to FUNCLIB calls
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COLUMN DESCRIPTION

PTIA_INFO4 Extra Information mostly related to FUNCLIB calls

PTIA_INFO5 Extra Information mostly related to FUNCLIB calls

PS_PTIA_STEPDEPEND

By querying PS_PYIA_DTLIDTBLS and PS_PTIA_ANALYSIS, it is possible to determine which steps
have dependencies and what those dependencies are.

COLUMN DESCRIPTION

PTIA_UPG_PATH Upgrade Path copied from PS_PTIA_DCAEPGMS

PTIA_DBTYPE Text equivalent of the standard DBTYPE codes

PTIA_UPG_CONV_TYPE Conversion type: MAIN or DDL

PTIA_P_UPG_GROUP Parent Data Conversion Group

PTIA_P_UPGGRPLVL Parent Data Conversion Group Level

PTIA_P_SEQNUM Parent Application Engine Section Sequence Number

PTIA_P_TOPAEAPPLID Parent Data Conversion Application Engine Program

PTIA_P_TOPAESECTN Parent Data Conversion Application Engine Section

PTIA_P_TOPAESTEP Parent Data Conversion Application Engine Step

PTIA_P_TOPAESEQNUM Parent Data Conversion Application Engine Step Sequence

PTIA_P_AEAPPLID Parent Application Engine Program

PTIA_P_AESECTION Parent Application Engine Section

PTIA_P_AESTEP Parent Application Engine Step

PTIA_P_AESEQNUM Parent Application Engine Step Sequence within the Section
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COLUMN DESCRIPTION

PTIA_P_AESTMTSEQ Parent Application Engine Step Sequence across whole
upgrade

PTIA_P_DETAILID Parent Application Engine Step Detail ID

PTIA_P_SQLNUM Parent Application Engine Detail ID SQL Sequence

PTIA_C_UPG_GROUP Child Data Conversion Group

PTIA_C_UPGGRPLVL Child Data Conversion Group Level

PTIA_C_SEQNUM Child Application Engine Section Sequence Number

PTIA_C_TOPAEAPPLID Child Data Conversion Application Engine Program

PTIA_C_TOPAESECTN Child Data Conversion Application Engine Section

PTIA_C_TOPAESTEP Child Data Conversion Application Engine Step

PTIA_C_TOPAESEQNUM Child Data Conversion Application Engine Step Sequence

PTIA_C_AEAPPLID Child Application Engine Program

PTIA_C_AESECTION Child Application Engine Section

PTIA_C_AESTEP Child Application Engine Step

PTIA_C_AESEQNUM Child Application Engine Step Sequence within the Section

PTIA_C_AESTMTSEQ Child Application Engine Step Sequence across whole
upgrade

PTIA_C_DETAILID Child Application Engine Step Detail ID

PTIA_C_SQLNUM Child Application Engine Detail ID SQL Sequence

PTIA_TABLENAME Common table referenced by the parent and child step
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COLUMN DESCRIPTION

PTIA_P_TABLEUSAGE Parent table usage T-Target, S-Source

PTIA_C_TABLEUSAGE Child table usage T-Target, S-Source

PS_PTIA_ SECDEPEND

This table is an aggregation of PS_PTIA_STEPDEPEND to the Section level.

COLUMN DESCRIPTION

PTIA_UPG_PATH Upgrade Path copied from PS_PTIA_DCAEPGMS

PTIA_DBTYPE Text equivalent of the standard DBTYPE codes

PTIA_UPG_CONV_TYPE Conversion type: MAIN or DDL

PTIA_P_UPG_GROUP Parent Data Conversion Group

PTIA_P_UPGGRPLVL Parent Data Conversion Group Level

PTIA_P_TOPSEQNUM Parent Application Engine Section Sequence Number

PTIA_P_TOPAEAPPLID Parent Data Conversion Application Engine Program

PTIA_P_TOPAESECTN Parent Data Conversion Application Engine Section

PTIA_P_AESTMTSEQ Parent Application Engine Step Sequence across whole
upgrade

PTIA_C_UPG_GROUP Child Data Conversion Group

PTIA_C_UPGGRPLVL Child Data Conversion Group Level

PTIA_C_TOPSEQNUM Child Application Engine Section Sequence Number

PTIA_C_TOPAEAPPLID Child Data Conversion Application Engine Program

PTIA_C_TOPAESECTN Child Data Conversion Application Engine Section
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COLUMN DESCRIPTION

PTIA_C_AESTMTSEQ Child Application Engine Step Sequence across whole
upgrade

PTIA_DEPENDSOURCE Dependency Rule

PTIA_DEPENDRULE DEPENDENT or INDEPENDENT

PTIA_EXCLUDEFLAG Indicates whether this dependency should be excluded from
the runtime dependency calculation

PS_PTIA_RUNDEPEND

This table represents the section dependency model. You can query this table for any given data
conversion Application Engine Section to determine what it depends on and what depends on it. The
runtime data conversion Application Engine (PTIADATACONV) uses this table to determine which
sections are eligible to run.

COLUMN DESCRIPTION

PTIA_UPG_PATH Upgrade Path copied from PS_PTIA_DCAEPGMS

PTIA_DBTYPE Text equivalent of the standard DBTYPE codes

PTIA_P_UPG_GROUP Parent Data Conversion Group

PTIA_P_TOPSEQNUM Parent AE Section Sequence Number

PTIA_P_TOPAEAPPLID Parent Data Conversion AE Program

PTIA_P_TOPAESECTN Parent Data Conversion AE Section

PTIA_C_UPG_GROUP Child Data Conversion Group

PTIA_C_TOPSEQNUM Child AE Section Sequence Number

PTIA_C_TOPAEAPPLID Child Data Conversion AE Program

PTIA_C_TOPAESECTN Child Data Conversion AE Section
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COLUMN DESCRIPTION

PTIA_DEPTH Dependency Nesting

Reviewing Dependency Analysis
This section discusses:

• Understanding Dependency Analysis

• Reviewing Data Conversion Runtime Rules

Understanding Dependency Analysis

The table usage information identified in the Initial Analysis is subsequently used to determine
the dependencies between AE Steps. The Step Dependency Information is then aggregated to the
“Root Section” level where a Root Section is defined as a row in the PS_PTIA_DCAEPGMS table
(PTIA_UPG_PATH, PTIA_UPG_GROUP, SEQ_NUM, AE_APPLID, AE_SECTION, ACTIVE_FLAG,
PTIA_CONV_TYPE, PTIA_UPG_GROUP_LVL).

Reviewing Data Conversion Runtime Rules

The following rules are the data conversion runtime rules:

• Dependencies are derived from tables referenced in SQL or PeopleCode actions in Upgrade Sections.

• Dependencies follow the Upgrade Group sequencing. If Section ABC in Upgrade Group 1 updates a
given table, then any Section assigned a higher sequence than ABC that updates or queries that same
table cannot run until Section ABC is complete.

• Upgrade groups are further grouped into levels. For example, objects defined in Level 2 are dependent
on objects defined in Level 1. Additionally, objects defined in Level 3 are dependent on objects
defined in Level 1 and Level 2.

• Upgrade groups within the same level do not depend on each other. If Section QWE in Upgrade
Group 2 updates table FFF and Section ASD in Upgrade Group 3 also updates table FFF and Upgrade
Groups 2 and 3 are at the same level, there is no dependency created.

• Upgrade groups create dependencies on sections within their own upgrade group and upgrade groups
of lower levels. If Section ABC in Upgrade Group 1 updates table FFF and Section QWE in Upgrade
Group 2 also updates table FFF, and Upgrade Group 1 is in a lower level than Upgrade Group 2, then
Section QWE becomes dependent on Section ABC.

• Tables as sources do not create dependencies. If Section ZXC in Upgrade Group 1 selects from
table FFF, and then Section BNM in Upgrade Group 1 also selects from table FFF, no dependency is
created.

• If a Section has a SQL statement that PTIAANALYSIS cannot understand, the SQL is flagged as non
parsable from the parser point of view (the Data Conversion will still run fine) and a hard dependency
is created. This means for every Section with a query that cannot be parsed, it becomes dependent on
every Section sequentially above it in its Upgrade Group, and on every Section in Upgrade Group 1.
Furthermore, every Section sequentially afterward becomes dependent on it.
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• Usage of the PS_PTIA_DUAL, PS_PTIA_COMMON_AET, or PS_PTIA_NORECNAME tables
never results in a dependency.

Example of Dependency Rules Calculation

In the following example, the highlighted row (with values in italics) would be dependent on
itself and all items in Level’s MAIN-1 and MAIN-2, but not the other items in Level MAIN-3 nor
items in Level DDL-1.

PATH GROUP SEQ_NUM AE_APPLID AE_
SECTION

PTIA_CONV
_TYPE

GROUP_
LEVEL

HC89 1 260 UPG_HR89 HCHRS01 MAIN 1

HC89 1 265 UPG_FG89 FGHCS01 MAIN 1

HC89 3 230 UPG_BN89 HCBNS06 MAIN 2

HC89 4 165 UPG_GPBR90 HCBRP040 MAIN 2

HC89 7 40 UPG_EP89 HCEPS25 MAIN 2

HC89 7 50 UPG_EP89 HCEPS30 MAIN 2

HC89 10 20 UPG_TL89 HCTLK01 MAIN 2

HC89 80 140 UPG_TL90 HCTLP04 MAIN 3

HC89 80 160 UPG_TL90 HCTLP06 MAIN 3

HC89 85 170 UPG_PY90 HCPYM01 MAIN 3

HC89 85 180 UPG_PY90 HCPYP01 MAIN 3

HC89 10 200 UPG_PY90 HCPYP09 DDL 1

HC89 10 210 UPG_PY90 HCPYP10 DDL 1

Reviewing Runtime for PTIADATACONV
This section discusses:

• Understanding Runtime for PTIADATACONV
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• Querying the PTIA Tables

Understanding Runtime for PTIADATACONV

All runtime information for PTIADATACONV is stored in the following tables:

• PS_PTIA_DATACONV

• PS_PTIA_RUNSTATUS

• PS_PTIA_RUNDETAIL

• PS_PTIA_RUNCOUNT

The PTIADATACONV Application Engine leverages the Dependency Analysis to optimize the runtime
of the data conversion. The runtime of the data conversion is improved in the new PeopleSoft release by
running multiple instances of PTIADATACONV in parallel, executing against a single set of dependency
information. The optimal number of instances to be initiated will vary.

PTIADATACONV determines which “Root Sections” are able to run and executes them. A Root Section
is able to run when all Root Sections that are dependent on it have completed successfully.

In the event that multiple root sections are able to run at the same time, steps that have the largest number
of dependent Root Sections and/or Root Sections that have the longest runtime (in a previous run), are
given priority.

In the event of failure, the instance of PTIADATACONV that encountered the error will mark the step as
“Failed” and stop. All other instances of PTIADATACONV will continue to run. Steps that are dependent
on a “Failed” step will be marked as “Blocked” and will not be executed as part of the current run. Upon
restarting the process, the “Failed” section and any “Blocked” sections will be executed.

The following list describes the PTIADATACONV program flow:

• The run is initialized.

This initial phase determines if this is a brand new run or if it is a restart of a previously failed run. If
it is a new run, then PTIADATACONV sets up a thread in PS_PTIA_RUNSTATUS.

• PTIADATACONV performs a simple test to verify that there is work to do.

If there is work to do, then PTIADATACONV runs Data Conversion Application Engine Sections that
have not already run. This is a fairly simple Do While loop that counts eligible sections left to run. If
there are no more sections left to run, processing stops. The work inside the loop consists of executing
a process to check the status of any other thread that is running. If a thread dies, it cannot clean itself
up, so one of the other threads has to perform the cleanup. The cleanup mostly consists of setting the
status flag in PS_PTIA_DATACONV to “F” for the AE Section that failed.

• SQLs run to look for work to do.

The SQL object PTIA_FINDSECTIONTORUN finds the next eligible section to run. If the query
returns nothing, we execute another SQL object called PTIA_COUNTSECTIONSNOTDONE to
count how many Sections are left to run. If PTIA_FINDSECTIONTORUN returns no work to do
and PTIA_COUNTSECTIONSNOTDONE returns Sections still need to be run, then there must be a
Section already running that must complete before anything else can run. If there is no work to do, the
loop issues a pause before the loop completes and executes the next loop.
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• PTIADATACONV performs more housekeeping to reset statuses on successful completion of all Data
Conversion Application Engine Sections.

• A completion message is written to the log file.

Reviewing PTIA Reporting
This section discusses:

• Understanding PTIA Reporting

• Reviewing the Tables Referenced Report

• Reviewing the Customization Impacts Report

• Reviewing Execution Report by Section – Duration

• Reviewing Execution Report by Section – Start Time

• Reviewing the Execution Report by Step

• Reviewing the Execution by Thread Report

• Reviewing the Thread Duration Report

• Reviewing the Execution Comparison Report

• Reviewing the Table Analysis Report

• Reviewing the Data Conversion Report

Understanding PTIA Reporting

You can query all tables populated and leveraged by PTIA (as identified previously) through the various
platform specific query tools or psquery. You can gather information in the PTIA tables to identify the
following:

• Tables referenced in the data conversion code.

• Steps impacted by customizations (prior to the initial data conversion run).

• Performance issues (after the initial data conversion run).

• Impact of changes (run to run timing comparisons).

Oracle has delivered a series of standard reports to address the most commonly accessed information in
the PTIA repository.

Reviewing the Tables Referenced Report

PTIA0001.SQR lists all tables referenced within the Application Engine data conversion programs. For
each table listed, the report displays the section and step in which it is used, whether it is a data source
or data target table, and the type of SQL statement in which it is referenced. This report is sorted by
table name. Data for this report comes from the PS_PTIA_ANALYSIS, PS_PTIA_DTLIDSQLS, and
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PS_PTIA_DTLIDTBLS tables. This report can be run anytime after the PTIAANALYSIS Application
Engine program has run and populated the PTIA tables used by this SQR.

Reviewing the Customization Impacts Report

PTIA0002.SQR shows the section/steps within the Application Engine data conversion programs that
referenced tables with custom added fields. This report is sourced from the PS_PTIA_ANALYSIS table
and the PSPROJECTITEM table. This report must be run after the customizations project has been
compared against the New Release Demo database.

Reviewing Execution Report by Section – Duration

PTIA0003.SQR shows the duration or execution time for each Application Engine section. Since this
report is at a section level, the information is sourced from the PS_PTIA_RUNDETAIL table. The report
is ordered by execution time with the poorest performing steps at the top. This report can be run anytime
after the PS_PTIA_RUNDETAIL table has been populated for the data conversion run on which you want
to report.

Reviewing Execution Report by Section – Start Time

PTIA0004.SQR shows the duration or execution time for each section. Since this report is at a section
level, the information will be sourced from the PS_PTIA_RUNDETAIL table. The report would be
ordered by start time so that you can see the order in which the sections were executed. This report can
be run anytime after the PS_PTIA_RUNDETAIL table has been populated for the data conversion run on
which you want to report.

Reviewing the Execution Report by Step

PTIA0005.SQR shows the execution time for each section and the associated steps that were run.

This report requires a trace of 16,384 or higher.

Since this report is at a step level, it assumes that a trace of 16,384 or higher has been run so that the step
information could be obtained from the PS_PTIA_TIMINGS_DT table. If the appropriate trace has not
been run, then a report is not created and output files will be produced. The report will be ordered by
execution time with the poorest performing steps at the top.

Reviewing the Execution by Thread Report

PTIA0006.SQR shows the execution timing of each Application Engine section run as part of the data
conversion process. This report is sorted so that you can see which sections were executed by each thread.
This report is sourced from the PS_PTIA_RUNDETAIL table.

Reviewing the Thread Duration Report

PTIA0007.SQR shows the total duration time for each thread used during the data conversion
process. This report is sourced from the PS_PTIA_RUNDETAIL table. It can be run anytime after the
PS_PTIA_RUNDETAIL table has been populated from the data conversion run on which you want to
report.
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Reviewing the Execution Comparison Report

PTIA0008.SQR shows the execution duration from the current run of data conversion as compared
to the execution duration from the previous run of data conversion. This report is sourced from the
PS_PTIA_RUNDETAIL table. This report can be run anytime after the PS_PTIA_RUNDETAIL table has
been populated for the data conversion runs on which you want to report.

Note: Run this SQR after data conversion is finished. This report will help fine-tune the data for a
subsequent upgrade pass.

Reviewing the Table Analysis Report

PTIA0009.SQR indicates how a particular application table is impacted by the create/alter scripts
as well as the data conversion process during the PeopleSoft upgrade. This report is sourced
from the PS_PTUALTRECDATA, PS_PTUALTRECFLDDAT, PS_PTIA_ALTRECDATA,
PS_PTIA_ANALYSIS, and PS_PTIA_DTLIDTBLS tables. This report can be run after the Alter
Analyzer and the AE Analyzer processes have successfully completed. This report is designed to be run
against the initial pass database as the data stored in the tables during the Move to Production will differ.

Reviewing the Data Conversion Report

Each of the upgrade data conversion sections contains comments that describe the processing performed
by the section. Oracle delivered an SQR (PTIA0010.sqr) to list all of these comments by the group and
sequence numbers that determine how they run. The name of this report is PTIA0010.

To run PTIA0010:

1. Using SQRW, run SQR PTIA0010 on your copy of Production database.

2. When prompted for upgrade path, enter (for example):

HC90

CR90

CR91

To run the report from PIA:

1. Select PeopleTools >Lifecycle Tools >Upgrades >Run Data Conversion Report

2. Enter the Upgrade Path and Group Number.

3. Click Run.
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This example illustrates the fields and controls on the Run Data Conversion Report.

Using the Upgrade Driver Program

The sequence of Application Engine sections that are run by an upgrade driver is maintained in the
PS_PTIA_DCAEPGMS table. The Application Engine sections defined in the PS_PTIA_DCAEPGMS
table are referred to as root sections.

There are two categories of Upgrade Groups:

• MAIN – Core Data Conversion

• DDL – Data Conversion sections that contain Drop Table Statements (only)

Upgrade groups contain one or more Application Engine sections that are ordered within the group by
sequence number. The Application Engine program PTIADATACONV is used to execute the MAIN and
the DDL data conversion groups.

When data conversion is executed using the PTIADATACONV Application Program, the sequence
number is used to determine the “Relative Run Order” of Application Engine sections that reference the
same table or tables, but not the “Absolute Run Order” of the upgrade group(s).

This section discusses:

• Defining an Upgrade Path

• Accessing the Define Data Conversion Page

Defining an Upgrade Path
Before you can define data conversion sections, you must define an upgrade path.

To define an upgrade path:

1. From your browser, sign in to the Demo database.

2. Select PeopleTools >Lifecycle Tools >Upgrades >Define Upgrade Paths.
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3. The Define Upgrade Path page appears.

4. Click the Add a New Value tab.

5. Enter a value for Upgrade Path.

6. Click Add.

7. Select a value for Active Flag.

8. Enter description for the new upgrade path.

9. Click Save.

This example illustrates the fields and controls on the Define Upgrade Path page.

After you have defined an upgrade path, you can add sections for the upgrade path on the Define Data
Conversion page.

Accessing the Define Data Conversion Page
Before you run data conversion, you may need to change what the Upgrade Driver program runs. You can
add, remove, or deactivate Application Engine sections through the Define Data Conversion page.

To access the Define Data Conversion page:

1. From your browser, sign in to the Demo database.

2. Select PeopleTools, Lifecycle Tools, Upgrades, Define Data Conversion.

3. The Define Data Conversion page appears.

4. Enter your upgrade path.

For example:

HC91

CR91

5. Click Search.

The Define Data Conversion page displays information for the selected upgrade path, as shown in the
example below. Following the example of the Define Data Conversion page are descriptions for each
section of the page.
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This example illustrates the fields and controls on the Define Data Conversion page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Upgrade Path This field contains the upgrade path on which the section
will be run.

Program Name This is the Application Engine program that contains the
section.

Group Number This is the group number. All sections with the same group
number will be run during the same run of the PTIA_
DATACONV Application Engine program.

Group Level This is the group level.

Conv Type This is the conversion type. PTIA supports two categories:
MAIN and DDL.

Section This is the section that will be called from the PTIA_
DATACONV Application Engine program.

Sequence This is the order in which the sections will be called during
the run of PTIA_DATACONV for the group number.

Active Flag This field determines whether the section will be run. If the
value of this field is Active, the section will be run. If the
value is Inactive, it will not be run. If you need to remove a
section, change the value in this field to Inactive.

Short Description This field contains the Section description.
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Field or Control Description

Long Descr This field is optional.

This section also discusses:

• Adding a new Section on the Define Data Conversion Page.

• Inactivating a Section on the Define Data Conversion Page.

Adding a new Section on the Define Data Conversion Page

Follow the instructions below to add a new section to the Define Data Conversion page.

Note: To add a new section, the Application Engine program and section must exist on the Demo
database.

To add a new section to the Define Data Conversion page:

1. From your browser, sign in to the Demo database.

2. Select PeopleTools >Lifecycle Tools >Upgrades >Define Data Conversion.

3. The Define Data Conversion page appears.

4. Enter your upgrade path.

For example:

HC90

CR90

5. Click Search.

The Define Data Conversion page displays information for the selected upgrade path.

6. Add a new row.

7. Select a value for Program Name.

8. Enter a value for Group Number.

Note: Each group number corresponds to a data conversion step in the PeopleSoft Change Assistant
template. If you select a group number that already exists in the PS_PTIA_DCAEPGMS table,
your section will be executed when PeopleSoft Change Assistant runs the data conversion step that
corresponds to the group number you selected. Alternatively, if you assign a group number to your
new section that does not already exist in PS_PTIA_DCAEPGMS, you must add a new step to your
PeopleSoft Change Assistant template. The new template step will have the same properties as the
other data conversion steps, except for the group number specified in the step properties Parameters
box.

9. Enter values for Group Level  and Conv Type.

Copyright © 1988, 2022, Oracle and/or its affiliates. 445



Using Data Conversion Utilities Chapter 28

10. Select a value for Sectionand enter value for Sequence.

11. Select a value for Active Flag.

12. The Short Descriptionfield is populated from the Section description. The Long Descrfield is
optional.

13. Click Save.

Inactivating a Section on the Define Data Conversion Page

Follow the instructions below to deactivate a section on the Define Data Conversion page. If a section is
deactivated, the section will not run as part of data conversion.

To inactivate a section on the Define Data Conversion page:

1. From your browser, sign in to the Demo database.

2. Select PeopleTools >Lifecycle Tools >Upgrades >Define Data Conversion.

3. The Define Data Conversion page appears.

4. Enter your upgrade path.

For example:

HC90

CR90

5. Click Search.

6. Find the row with the Program Name and Section you want to remove and change the value of the
Active Flag field to Inactive.

7. Click Save.
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Working With Scripts

Understanding Process, Scripts, and Syntax

Before Change Assistant runs SQL and Data Mover scripts, it determines whether the scripts need
updating. This ensures that logs are sent to directories that are known to Change Assistant and that the
scripts run properly.

The following table shows the processes, what scripts are updated, and the updated syntax.

Process Script Files Updated Syntax

DataMoverBootstrap

DataMoverUser

LoadBaseData

<process name>.dms SET LOG statements

Db2 for z/OS SQL Commands

SQL Scripts

UpdatePeopleTools

<process name>.sql CONNECT TO …

SET CURRENT SQLID =

Oracle SQL Commands

SQL Scripts

UpdatePeopleTools

<process name>.sql WHENEVER SQLERROR EXIT

SET ECHO ON

SET TIME ON

SPOOL…

SPOOL OFF

EXIT

Running Scripts Outside of Change Assistant

If you are running a script outside of Change Assistant, keep in mind that the default behavior of Change
Assistant is to stop when any errors are encountered. To replicate that behavior outside of Change
Assistant, you will need to run the script using the correct options. The following table displays the
command line options required per database platform to either stop at errors or continue when errors are
encountered.
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Database Stop/Continue at Errors

Oracle Exit on error:

<sqltool> <accessID>/
<password>@<dbname>@<scriptname>

Prepend script with: WHENEVER SQLERROR EXIT

Continue on error:

<sqltool> <accessID>/
<password>@<dbname>@<scriptname>

Prepend script with: WHENEVER SQLERROR CONTINUE

Db2 for z/OS Exit on error:

<sqltool> /c /w /i DB2 -tvf <script name> -z <log name> -s

Continue on error:

<sqltool> /c /w /i DB2 -tvf <script name> -z <log name>

Microsoft SQL Server Exit on error:

<sqltool> -U <accessID> -P <password> -s <server name> -D
<database name> -i <script name> -o <log name> -e -n -I -b

Continue on error:

<sqltool> -U <accessID> -P <password> -s <server name> -D
<database name> -i <script name> -o <log name> -e -n -I
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Modifying Step Properties and Parameters

Step Types

When creating custom steps, select one of these step types.

Note: When creating step types that Application Designer executes, such as Build Project or Compare
and Report, if there are specific settings that need to be set for Application Designer, make sure to specify
those using the Build, Upgrade, or Object Types buttons that appear to the right of the Step Type drop-
down list box. Use these buttons to save any necessary settings to the Change Assistant template. At run
time, any Application Designer settings saved in the template override the current settings for Application
Designer on the machine where an Application Designer process runs.

Step Type Definition

Application Engine Runs the Application Engine process indicated by the Script/
Procedure value under Step Properties.
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Step Type Definition

ApplicationEngineWithRunControl Runs an Application Engine process with run controls. Use the
Options button to select the application engine program and
enter the run control parameters.

ADS application engine process PTADSAEPRCS is used to
copy an ADS project a a file, copy an ADS project from a file,
 validate an ADS project from file, or compare an ADS project
from a file.

For an example of ADS Compare/Copy see Setting AE With
Run Control Options for ADS Compare/Copy

Global Payroll (GP) application engine programs are used
to move GP rules and data between databases. There are 7
application engine programs available. The same parameters
are used for all the GP application engine programs. Run
Control ID needs to be the same name as the Package ID.
 Package ID is the Package ID of the rule package. Version
indicates if this package is to be versioned, the default is Y.

For an example of GP-Import Rule see Setting Global Payroll
Options

Search Framework - Schedule Index runs the application
engine program PTSF_SCH_INDEX to build a Search
Framework search index. The run control options are the same
as the Build Search Index page.

For an example of Schedule Search Index see Setting
Search Framework Options for AE With Run Control For
more information on search indexes see "Building Search
Indexes" (Search Technology).

The Logging Suffix option can be used to create a unique log
file for the step.

Build Project Builds the project specified in the step properties parameter as
#Project= (for example, #Project=ALLTABS). The project is
built through the PeopleTools command line.

Use the Build button to select options based on the instructions
in the update documentation for your product and path.

Note: The Build dialog box that appears displays identical
options to Application Designer.

See "Selecting Build Options and Running the Build
Process" (Application Designer Developer’s Guide).
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Step Type Definition

Compare And Report Runs the project compare (which produces compare reports)
process using the project specified in the step properties
parameter as #Project= (for example, #Project=ALLTABS).
 The compare is performed through the PeopleTools command
line.

For the Compare and Report and all Copy ... step types, use
the Upgrade button to select the appropriate options, which are
identical to those provided for Upgrade Options in Application
Designer.

See "Setting Upgrade Options" (Lifecycle Management
Guide).

Compare from file Runs the project compare (which produces compare reports)
process using the project specified in the step properties
parameter as #Project= (for example, #Project=PROJECT1).
 The compare is performed through the PeopleTools command
line.

Use the Upgrade button to select the definition types to
compare and enter the Import/Export Directory that contains
the file.

Use the Options button on the Compare from File dialog box
to select the appropriate options, which are identical to those
provided for Upgrade Options in Application Designer.

See "Setting Upgrade Options" (Lifecycle Management
Guide).

Compile PeopleCode Compiles PeopleCode based on database or project.

Use the Options button to select the PeopleCode to compile.
 For the database, you can select either all PeopleCode or just
directive PeopleCode. For a project select Project and enter the
project name.

Copy Database Copies a project from the source database to the target
database as specified under the Step Properties. The project
used is the one specified in the step properties parameter as
#Project= (for example, #Project=ALLTABS). The copy is
performed through the PeopleTools command line.

Copy from file Copies a project from a file. This is used in conjunction
with the Copy To File. It uses the project specified in
the Step Properties parameter as #Project= (for example
#Project=ALLTABS).

Use the Upgrade button to select the definition types to copy
and enter the Import/Export Directory that contains the file.
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Step Type Definition

Copy to file Copies a project to a file. This is used in conjunction with
the Copy From File option. It uses the project specified in
the Step Properties parameter as #Project= (for example
#Project=ALLTABS).

Use the Upgrade button to select the definition types to copy
and enter the Import/Export Directory for the file.

Create Customization Project Creates a customization project within Change Assistant. Use
the Options button to launch the Create Project dialog box
where you can select any combination of definition types to
include in the project, such as pages, records, fields and so
on, as well as the user IDs. You can enter multiple user IDs
separated by commas.

The customization project will include all managed objects
for the object types selected that have any of the user IDs
selected as the last user ID for the object. If user ID all is
selected, the project will contain all managed objects for the
object types selected where the last user ID for the object is
not “PPLSOFT’.

Create project Creates a project within Change Assistant. Use the Object
Type button to launch the Create Project dialog box where you
can select any combination of definition types to include in the
project, such as pages, records, fields and so on.

Note: If you select Pages, the system inserts all the page types
into the project, including pages, subpage and secondary
pages.

Merge project Merges two project definitions.

For example, this is used in upgrades during the "Merge IB
Project" step, which merges pre and post-PeopleTools 8.48
Integration Broker metadata.

Data Mover-Bootstrap Runs Data Mover scripts as the access ID specified in the
credentials panel in the Apply Wizard (bootstrap mode).

Data Mover-User Runs Data Mover scripts as the user ID specified in the
credentials panel in the Apply Wizard (non-bootstrap mode).

DBTSFIX e(Applies to Db2 for z/OS and Oracle). Change Assistant
determines the source and target releases of the databases
defined under Step Properties as Source and Target. Once
this is completed, Change Assistant determines which release
scripts need to be generated by the DBTSFIX sqr to produce
release scripts for your environment.
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Step Type Definition

Deploy file Deploys files in change packages to different servers.

Note: COBOL files are deployed to src/cbl for non-Windows
platform.

When you select the DeployFile type, an Additional Settings
button is available to set:

• File Reference ID

• File Type Code

FileCopy Enables you to copy files or directories.

File Copy properties include:

• Source Path

• Destination Path

• Overwrite Existing Files check box.

The Source and Target Paths can be defined as:

• actual paths for example: C:\temp

• variables for example: %STAGINGDIRECTORY%

• combination of variables and fixed paths for example:
%STAGINGDIRECTORY%\IMAGE\

ExecuteProcess Enables you to include custom processes, such as bat files, that
you can run as part of a Change Assistant job.

Enter the file path to the file in the Parameters edit box. For
example, if you want to run backup.bat, enter the following in
the Parameters edit box:

c:\bat\backup.bat

Note: Your custom file needs to be able to close without
needing human interaction. Change Assistant does not
officially recognize the step as being successfully completed
until the processes ran by the bat file have been closed.

ExportTemplate This step exports the current template.

Typically this step would be included in a Update change
package.
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Step Type Definition

Load Base Data Change Assistant determines the source and target releases
when running either the DBTSFIX or UpgradePeopleTools
steps (depending on your database type). Once these are
determined, Change Assistant will dynamically define which
Load Base Data scripts need to be run for the original target
release and the languages that you have installed.

Manual Stop Defined as a step you must run manually. Change Assistant
automatically sets the run status to Stop. After you have
manually completed the step, you must change the Job Status
to Complete.

ProcessScheduler Runs the specified upgrade process through Process Scheduler.
 To further define the step, you use these required parameters:

#USE_PRCS_SERVER=

#PROCESS_TYPE=

#PROCESS_NAME=

#RUNCONTROLID=

#NUM_INSTANCES=

Note: If you don't specify the value to each parameter
correctly, the step will fail.

Example: To run one instance of an Application Engine
program on SERVER1, specify parameters as:

#USE_PRCS_SERVER=SERVER1
#PROCESS_TYPE=Application Engine
#PROCESS_NAME=MYAE
#RUNCONTROLID=TEST
#NUM_INSTANCES=1

Example: To run three instances of an SQR report (XRFWIN)
on SERVER2, specify parameters as:

#USE_PRCS_SERVER=SERVER2
#PROCESS_TYPE=SQR Report
#PROCESS_NAME=XRFWIN
#RUNCONTROLID=MYID
#NUM_INSTANCES=3

See Step Parameters.

PTFTest This step is used to run a PTF test. Use the following
parameters:

• #TST - test name

• #TC - test case

• #PFX - test case prefix
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Step Type Definition

SQL Command Runs the SQL command defined in the Parameters value under
the Step Properties. Change Assistant runs the command using
the SQL Query tool specified in the Database Configuration
dialog box.

For most SQL Query Tools, Change Assistant stops on an
error.

SQL Script Runs the SQL script defined in the Script/Procedure value
under the Step Properties. Change Assistant runs the script
using the SQL Query tools specified on the Database
Configuration.

For most SQL Query Tools, Change Assistant stops on an
error.

SQL Script DBO Runs the SQL Script defined in the Script/Procedure value
under the Step Properties, using the DB Owner ID.

The DB Owner and password is set for the database when
the Set DB Owner Credentials is selected on the database
definition.

SQR Report Runs SQRs using the pssqr command line. If parameters
are included in the Parameters section of the step properties,
 Change Assistant will obtain the SQR settings from the
database definition.

See Setting SQR Report Output Options

SyncDatabaseInfoToCA This step updates all of the target information to Change
Assistant.

This step will run as part of the Cleanup and Administrative
tasks in the Change Assistant Job.

SyncDatabaseInfoToPUMSource This step is only used for PUM updates. If the user selects
Yes on the Synchronize Target Metadata (Requires Source)
radio button on the Change Package Settings page, this step
is executed in the job to update all of the target database
information to the PI.

UpdateChangePackage UpdateChangePackage is a specialized function within the
Change Packager relating to the updating of change packages
created using Update Manager.
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Step Type Definition

UpdateCurrentHomes This step updates the database Current Homes PS_HOME
information by setting the Current PS_HOME to the value
of the New PS_HOME for Database definition associated to
the DB Orientation (Source or Target) of the step. It does not
update the PS_APP_HOME or PS_CUST_HOME.

Typically this step would be included in a PeopleTools
Upgrade.

UpgradePeopleTools Change Assistant determines the source and target releases
of the databases defined under Step Properties as Source
and Target. Once this is completed, Change Assistant then
determines which Release scripts to run in order to upgrade
your PeopleTools release from the original source release to
the new target release.

Note: There is no limitation to the number of steps you can add to a template.

Setting AE With Run Control Options for ADS Compare/Copy
The application engine process PTADSAEPRCS is used to copy an ADS project a a file, copy an ADS
project from a file, validate an ADS project from file, or compare an ADS project from a file.

To set the AE run control options:

1. Insert a new step in the template and select Type ApplicationEngineWithRunControl or open an
existing step with the type ApplicationEngineWithRunControl.

2. Make sure the orientation is set correctly.

• Source is used for Copy to File.

• Target is used for Compare From File and Copy From File.

3. Click the Options button.
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This example illustrates the fields and controls on the AE With Run Control Options page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Process Select the AE process, For ADS, the options are:

• Compare From File

• Copy to File

• Copy From File

• Validate From File

Project Name/Run Control Enter the ADS Project Name. The project name is also used
as the run control and is automatically populated in the Run
Control ID.
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Field or Control Description

Area Name Enter the name of the area (folder) for the file. When you
select Copy to File, the file will be written to the Staging
directory defined for the job in a folder PTADSAEPRCS\<area
name>. For example:

D:\Staging\PTADSAEPRCS\TOOLS

Languages Select the languages

Include Language Neutral Objects Select to include language neutral objects (COMMON).

Object Types ALL will include all data sets in the project. To select only
specific data sets, enter the data set name or names separated
by comma.

Merge Select Yes to merge target configurations on the Copy From
File.

Overwrite Existing Select Yes if you want to overwrite an existing file.

Ignore Shape Difference This functionality is disabled. If there is a shape change in
Application owned datasets between the source and target
environments the copy/compare/validate process will fail.

If the process fails, select the View Log option for the step,
 which will list the App owned dataset that needs to be
synchronized.

Validate Before Apply Select Yes to validate the data set before it is compared or
copied from file.

Validate After Apply Select Yes if you want to check integrity after the copy.

Logging Suffix Options Select whether to use the default log name or enter a custom
suffix value for the log file name.

The suffix is used to create a unique output log file name for
the step.

Note: Depending on the action selected, the available options are enabled.

Setting Global Payroll Options
Global Payroll (GP) application engine processes include:

• GP-Import Rule

• GP-Compare Rule
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• GP-Compare Rule AE Report

• GP-Upgrade Rule

• GP-Import Non Rule

• GP-Compare Non Rule

• GP-Upgrade Non Rule

To set the AE run control options:

1. Insert a new step in the template and select Type ApplicationEngineWithRunControl or open an
existing step with the type ApplicationEngineWithRunControl.

2. Make sure the orientation is set correctly.

• Source is used for Copy to File.

• Target is used for Compare From File and Copy From File.

3. Click the Options button.
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This example illustrates the fields and controls on the AE With Run Control Options page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Run Control ID Run Control ID needs to be the same name as the Package ID.

Package ID Package ID is the Package ID of the rule package.

Version Indicates if this package is to be versioned, the default is Y.

Logging Suffix Options Select whether to use the default log name or enter a custom
suffix value for the log file name.

The suffix is used to create a unique output log file name for
the step.
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Setting Search Framework Options for AE With Run Control
Search Framework- Schedule Index is used to schedule a build for the search index.

This example illustrates the fields and controls on the AE With Run Control Options page with Search
Framework-Schedule Index selected. You can find definitions for the fields and controls later on this
page.

Field or Control Description

Run Control ID Enter the run control id.

Search Definition Enter the Search definition.

Execution Option Select whether to Wait for Completion or Continue without
waiting.
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Field or Control Description

Schedule Language Select the schedule language.

Logging Suffix Options Select whether to use the default log name or enter a custom
suffix value for the log file name.

The suffix is used to create a unique output log file name for
the step.

Setting SQR Report Output Options
To set SQR output options:

1. Insert a new step in the template and select Type SQRReport or open an existing step with the type
SQRReport.

2. Enter the report name in the Script/Procedure field.

3. Click the Output Settings button.

This example illustrates the fields and controls on the SQR Output Settings dialog box. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Unicode Only Select this checkbox for Unicode Only.

Output Type Currently File is the only supported value and is read-only.

Output Format Select the output format. The allowable output values are
PDF, HTML, and SPF.

The default is SPF
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Field or Control Description

Output File Suffix Enter an output file suffix if applicable.

The suffix is used to create a unique output log file name for
the step. A change package may run the same SQR multiple
times, the suffix will ensure unique output log files.

Run Control ID Enter the run control ID. The default is AD HOC.

4. Click OK.

5. Click OK on the step

Step Parameters

Depending on the step type, you may need to include additional parameters in the Parameter edit box of
the Step Properties dialog box.

Parameter Description

#Project= Used primarily for functions that require a project name, like
Build Project, Create Project, and Merge Project.

For the Merge Project step type, you can specify two projects
separated by a comma. For example:

#PROJECT=PRJ656265,PRJ656265_IB_PRE848

#Directory= Used when you need to run a script that is not located in the
one of standard home directories defined for the environment.
 For example:

#Directory=#OutputDirectory

#RunLocation=

#FileLocation=

By default the scripts and processes are run on one of the
current home directories defined for the environment.
 However if the script or process needs to run on the new
release, you need to specify the new release home directories
using the variable #ALL_NEW_PATHS_TGT. Example:

#RunLocation=#ALL_NEW_PATHS_TGT
#FileLocation=#ALL_NEW_PATHS_TGT

#P1 through #P5= Used to pass parameters to SQR reports, for example, TEST.
sqr. In this case, you would pass the necessary value, such as:

#P1=#OutputDirectory
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Parameter Description

#OutputDirectory= Used to specify the Output Directory variable that is defined in
the Options, Change Assistant, Directories screen.

#Type= Enables you to specify the type of record to insert into the
project. Choose from the following record types:

All Records, Table, View/Query, View/Derived, SubRecord,
 Stored Procedure, Temporary Table, Dynamic View.

#RCID= Enables the user to override the run control ID used for
Application Engine processes.

#CI = Connect ID (Used for Data Mover – Tools).

#CW = Connect password (Used for Data Mover – Tools).

#EXTRACT_DMS= Extracts DMS export script from file (Used for Data Mover –
Tools).

#DBSETUP= Extracts dbsetup DMS import script from file and database
connectivity parameters (Used for Data Mover – Tools).

#DATLOCATION= Specifies the location of the .dat file (Used for Data Mover –
Tools).

#UNICODE= Generates DMS script for UNICODE database (default is
NON-UNICODE) (Used for Data Mover – Tools).

#TABLESPACE= Default tablespace (PTMINITS) (Used for Data Mover –
Tools, DB2 LUW, Oracle and Informix only).

#DBSPACE= Physical dbname.tablespace (PTMINIDB.TABLESPACE) ) 
(Used for Data Mover – Tools, DB2 z/OS only).

#STOGROUP_TS= Storage group for tablespace (Used for Data Mover – Tools,
 DB2 z/OS only).

#STOGROUP_IDX= Storage group for index (Used for Data Mover – Tools, DB2 z/
OS only).

#TABLEOWNER= Database owner ID (same as sqlid and tableowner) (Used for
Data Mover – Tools, DB2 z/OS only).

#INDEXSPC= Default tablespace (PTMINITS) (Used for Data Mover –
Tools, Informix only).
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Parameter Description

#USE_PRCS_SERVER= (Used only for ProcessScheduler step types).

Enter the name of the Process Scheduler server to run the step.
 Valid values are SERVER1 or SERVER2, which correlate to
the Process Scheduler server definitions you have defined in
your upgrade environment.

#PROCESS_TYPE= (Used only for ProcessScheduler step types).

Enter the process type, as defined in Process Scheduler. For
example, Application Engine, SQR Report, Data Mover, and
so on.

Note: This parameter is case sensitive. That is, the value
must appear in the exact case as the process type in
Process Scheduler. For example, for an Application Engine
program, the process type parameter should appear as
PROCESS_TYPE=Application Engine, not PROCESS_
TYPE=APPLICATION ENGINE.

#PROCESS_NAME= (Used only for ProcessScheduler step types).

Enter the process name, such as DDDAUDIT.

#RUNCONTROLID= (Used only for ProcessScheduler step types).

Enter the appropriate run control ID.

Note: If NUM_INSTANCES is greater than one, Change
Assistant will append unique sequence numbers to the end
of the Run Control ID before requests are submitted to the
Process Scheduler. This is required for submitting multiple
instances of the same process. If NUM_INSTANCES is equal
to one, Change Assistant will NOT append unique sequence
numbers to the end of the Run Control ID.

#NUM_INSTANCES= (Used only for ProcessScheduler step types).

Used by Change Assistant to schedule multiple processes
through Process Scheduler as individual process requests.
 However, the actual number of instances simultaneously
executed on the Process Server is controlled by the Max
Concurrent setting for the process type in the Process
Scheduler server definition.

#TST Used with the PTFTest step to identify the test

#TC Used with the PTFTest step to identify the test case.

#PFX Used with the PTFTest step to identify the test prefix.
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Variables for All Step Types that Use Path
The order by which the PeopleTools runtime will pick up objects from the file system is as follows:

1. Staging directory

2. PS_CUST_HOME

3. PS_APP_HOME

4. PS_HOME

Change Assistant will loop through the paths in order of precedence until it finds the first instance of the
file object at which time it will execute the step.

The following variables can be used for parameters requiring a path.

Variable Description

#ALL_PATHS_TGT Uses the path values defined for the target database current
environment.

#ALL_PATHS_SRC Uses the path values defined for the source database current
environment.

#ALL_PATHS_ODMO Uses the path values defined for the copy of demo database
current environment.

#ALL_PATHS_PROD Uses the path values defined for the production database
current environment.

#ALL_OLD_PATHS_TGT Uses the path values defined for the target database old
environment.

#ALL_PATHS_TGT_CBL The location of COBOL files differs depending on whether
you are using Windows or Linux. COBOL files are stored in:

• PS_HOME/src/cbl/base for Windows

• PS_HOME/src/cbl for Linux

This parameter is used to find the path for COBOL files.

Note: This parameter is only available for #FILELOCATION.

Platform Used in Command Line
Steps where the command line includes the platform are:

• ApplicationEngine

• ApplicationEngineWithRunControl
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• BuildProject

• CompareAndReport

• CopyDatabase

• CopyfromFile

• CopyToFile

• CreateProject

• MergeProject

• DataMoverBootstrap

• DataMoverUser

• SQLCommand

• SQLScript

• SQRReport

Consolidating Data Mover Scripts

When Change Assistant encounters a Data Mover step, it collects similar Data Mover steps below this
step and generates a consolidate Data Mover script. The newly generated Data Mover script is then
executed through a single data mover session.

In order to consolidate the Data Mover steps the following criteria must be met:

• On 8.56 or higher Tools version

• Identical Data Mover step type (DataMoverUser or DataMoverBootStrap)

• Identical Orientation in Step Properties (Source or Target)

• Identical Parameters value in Step Properties

• Allow for Errors = N in Step Properties

• Run Concurrently = N in Step Properties

• Step status = Run/Restart

• Step is not filtered out from job

• Continuous Data Mover steps
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Clearing Environment Management
Framework Cache

Clearing Environment Management Framework Cache Overview

To ensure consistent behavior across all the elements of the Environment Management Framework, at
times, it is necessary to clear the cache stored within each element. Clearing the cache just on the web
server for the Hub, for example, is not sufficient. To re-initialize the entire framework, you need to
perform this cleanup on:

• All agents

• Change Assistant

• Viewer

• Hub

When to Clear Environment Management Framework Cache

After analyzing customer environments and consulting PeopleSoft support, the following list reflects the
most common situations in which it is recommended that you clear cache files:

• After applying a maintenance pack. Maintenance packs deliver a large number of files. Clearing the
cache after applying a maintenance pack may increase performance for applying future updates.

• After applying a PeopleTools patch. Information related to previous PeopleTools releases stored in the
cached directories can cause a variety of issues for Change Assistant.

• After receiving a warning during file deploys or during the validate process (Tools, Validate). This is
typically related to cached references to peer IDs that are no longer used. Clearing the cache removes
references to unused peer IDs.

• After Change Assistant hangs during re-validation. This is often a sign of cache issues.

• After receiving notifications that you need to apply prerequisites that have already been applied.

Note: The above list reflects the most common situations when cache should be cleared, not every
possible situation. If you are encountering unexpected behavior, one element of your troubleshooting
should be clearing the cache.
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Clearing EMF Cache

To clear EMF cache:

1. Close the Change Assistant, stop all agents, and stop PSEMHUB.

2. Delete cache files from Change Assistant, agents, and Viewer.

a. Navigate to the following EMF locations:

EMF Element Location

Change Assistant Change Assistant installation location. For example,

c:\Program Files\PeopleSoft\Change Assistant
\envmetadata

Agents PS_AGENT_HOME\PSEMAgent\envmetadata

Note: If PS_AGENT_HOME is not defined, the data is
stored in PS_HOME.

Viewer PS_HOME\PSEMViewer\envmetadata

b. Delete the following directories:

\PersistentStorage

\ScratchPad

\transactions (if it exists)

\data\ids

c. For Change Assistant and agents only, delete the following file:

\data\search-results.xml

3. Delete cached files on PSEMHUB.

a. On the web server, navigate to PIA_HOME\webserv\peoplesoft\applications\domain\PSEMHUB
\envmetadata.

b. Delete the files stored in these directories:

\scratchpad

\PersistentStorage

\transactions (if it exists)

c. Delete all objects in \data (files and subdirectories, but not the \data directory).
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For example,

\data\*.*

4. Restart PSEMHUB.

5. Restart all agents.

6. Restart Change Assistant and Environment Management Viewer as needed.
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Troubleshooting Change Assistant and EMF

Peer Cannot Connect to the Hub

When an Environment Management peer (typically an agent or the viewer) can't communicate with the
hub, the following error messages appear in the logs and stdout:

Broken connection - attempting to reconnect
RemoteException while connecting to server - retrying attempt 1
RemoteException while connecting to server - retrying attempt 2
RemoteException while connecting to server - retrying attempt 3

The peer periodically attempts to reconnect to the hub (by default every ten seconds) with the parameters
that are specified in the configuration.properties file.

Determining the Error Condition

The peer may not be able to communicate with the hub for one of the following reasons:

• The peer is started but the hub is not started.

The peer reconnects once the hub is started.

• The peer is started but the web server is configured to run on a different machine.

Edit the configuration.properties file and change the hubURL parameter.

• The peer is started but the web server is configured to listen on a different port.

Users continue to see the error messages described previously. Edit the configuration.properties file
and change the port number for the hubURL parameter. Shut down and restart the peer.

• The peer is running and communicating with the hub, and the PIA web server is shut down.

Users see the broken connection error message. Once the PIA web server is started, the connection is
restored.

When the peer has a pinginterval configuration parameter set to a high value (60 seconds or more), the
following exception might appear in the log:

INFO Thread-48 org.apache.commons.httpclient.HttpMethodBase - Recoverable
 exception caught when processing request WARN Thread-48
org.apache.commons.httpclient.HttpMethodBase
- Recoverable exception caught but MethodRetryHandler.retryMethod() returned
false, rethrowing exception Broken connection - attempting to reconnect
Sending pulse from 'com.peoplesoft.emf.peer:id=5'

This is due to an HTTP client connection timeout which does not affect functionality.
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Ensuring the Correct Configuration

To ensure that you've configured the peer (agent or viewer) to properly connect with the hub, try each of
the following actions in turn:

• Ping the hub host machine.

At a command prompt, enter ping machinename, using the machine name configured in the
hubURL setting. You should see messages indicating a reply from the machine.

• Ping the hub host domain.

At a command prompt, enter ping hostdomain, using the fully qualified domain name as it's
configured in the hubURL setting; for example, mymachine.example.com. You should see messages
indicating a reply from the machine.

• Use an IP address in the hubURL.

In configuration.properties, replace the domain name in the hubURL setting with the machine's IP
address, then restart the peer.

• Ensure that you specify the right port number in the hubURL.

In configuration.properties, the port number in the hubURL setting must be <PIA port> if you set up
PIA for a single server. In single server configurations, the hub uses the same port to which PIA is
configured.

In multi-server configurations, the hub uses the application default port, which is 8001. If you need to
change this setting, it must be done in the web server configuration files.

Agent-Specific Resolutions

If an agent is still experiencing connection difficulties, delete the following agent directories if they exist:

• PS_HOME\PSEMAgent\envmetadata\data\ids

• PS_HOME\PSEMAgent\envmetadata\PersistentStorage

• PS_HOME\PSEMAgent\envmetadata\transactions

Note: You must also delete these directories after you install an additional hub on the same machine
which doesn't replace the existing hub, then shut down the old hub and start the new hub using the same
settings.

Viewer-Specific Resolutions

If the viewer Java application can't connect to the hub, first ensure that you specify the right port number
when launching the viewer program.

If you set up PIA for a single server, 80 is the default port number, if you set up PIA for multiple servers,
8081 is the default listening port number for PSEMHUB.

If the viewer is still experiencing connection difficulties, delete the following viewer directories if they
exist:
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• PS_HOME\PSEMViewer\envmetadata\data\ids

• PS_HOME\PSEMViewer\envmetadata\PersistentStorage

• PS_HOME\PSEMViewer\envmetadata\transactions

Note: You must also delete these directories after you install an additional hub on the same machine
which doesn't replace the existing hub, then shut down the old hub and start the new hub using the same
settings.

Error Initializing Agent

When starting agents, if you receive the following error message, determine whether an agent is already
running:

Error initializing agent. Verify if another agent is not
running on this machine or if you have the required permission to run the
agent.

If the console for the agent is not visible, check the task manager for the list of Java processes that are
currently running. Stop a running agent by invoking the scripts to stop the agents and then restart the
desired agent.

Determine whether the agent port is available. If not, choose a different port to start the agent.

Distributed Object Manager Errors

When running process, such as Application Engine, through the Process Scheduler (by way of
Change Assistant) the following error can occur if you do not have security set appropriately for the
PROCESSREQUEST.

Connecting to App Server: 192.0.2.1:9000
Error, exception caught: Distributed Object Manager: Page=Create Language=%2 (1,4)

See Ensuring Process Scheduler Security Authentication.

Cloned Databases Not Being Unique

When copying databases, it is extremely important to delete the GUID value in the new (copied)
database. If not deleted, the hub will assume that the two environments are the same, leading to confusing
environment records.

To resolve this, set the value of the GUID field in the PSOPTIONS table to <space> in the new database.
You can insert the blank value in the PSOPTIONS table using the SQL tool at your site. The next time an
application server connects to the database, the system generates a new, unique GUID.
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Large SQL Scripts Fail on Microsoft SQL Server

In some situations, depending on various factors, such as memory available on the Change Assistant
workstation, large SQL scripts can fail when run against Microsoft SQL Server. For example, this can
occur when running the Microsoft conversion script during an upgrade.

To resolve this issue:

• Set the step executing the SQL script to run manually.

• Split the script into at least three separate scripts and run them individually.

Process Scheduler Logs Retrieved Using FTP Losing Formatting

When reviewing Process Scheduler files retrieved by way of FTP, in some cases formatting is lost.

This is typically an issue with the ANSI setting on the FTP server. For example, on a vsftpd server, in the
vsftpd.conf file, make sure ascii_download_enable is set to YES. If not, stop the FTP daemon,
modify the setting, and restart the FTP daemon. (Adjust this information as needed for your FTP server).

Viewing Change Assistant Log Files

Change Assistant provides the following log files:

• Job log file

• Step execution logs

• Create change package log

Job Log File

The job.log file is a consolidated file that includes all of the information entered in the Apply Wizard, as
well as execution status of all the tasks and steps in the change package. There are five Apply Wizards in
Update Manager action.

• Apply Change Package

• Apply PeopleSoft Release Patch

• Apply PeopleTools Patch

• Upgrade Tools

• Upgrade Application

The log file will contain the information on Check Compatibility, Apply Summary pages, as well as
information about the Target and PUM Source environments. Once the job starts to execute, the execution
status of each step will be logged. This consolidated job log can be used to check the environment
settings, track the status of job, or review the job.
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The job log is located in the folder generated for the change package job in the output
directory defined on the Change Assistant General Settings page, for example C:\CA\output
\updPACKAGE1_1476310350534\job.log.

You can also access the job log from Change Assistant by right-clicking on the job name and selecting
View Log.

This example illustrates accessing job log from Change Assistant. Right-click on the job name and select
View Log.

The job log includes:

• Check Compatibility Page

• Apply Summary Page

• PI Environment

• Step/job execution status during job execution

Step Execution Logs

As a job executes, the logs are placed in the output directory specified in Change Assistant in a folder
with the job name. For each step there several logs created:
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Log File Description Example

*_Search.log Indicates whether or not the file for the step was
found.

CP_BUILD_search.log

Searching for file of bin\client\winx86\pside.exe in
D:\PT8.54.21_Client_ORA\ – File Found.

*_CA.log Displays the command line used. CP_BUILD_CA.log

Command Line: D:\PT8.54.21_Client_ORA
\bin\client\winx86\pside.exe -CT ORACLE
-CS -CD HC920001 -CO PS -CP * -PJB
PACKAGE1 -HIDE -QUIET -SS NO -
SN NO -MN -LF D:\Labs\PUM\Output
\softwareupdatePACKAGE1{HR92U016-
HC920001}IP\CP_BUILD_cmdline.log -CI
people -CW *

*.log Output of command line execution, created by the
command itself.

CP_BUILD.log

SQL Build process began on 10/13/2016 at
12:00:20 AM for database HC920001.

SQL Build process ended on 10/13/2016 at
12:00:25 AM. 78 records processed, 0 errors, 0
warnings.

SQL Build script for Create Tables
written to file D:/Labs/PUM/Staging/
softwareupdatePACKAGE1{HR92U016-
HC920001}IP/Scripts/CP_crttbl.sql.

...

*_cmdline Lists command line parameters used. CP_BUILD_cmdline.log

PeopleSoft Project Command Line Build Project
Project Name: PACKAGE1 Tools Release: 8.54.
21 2016-10-13 : 00.00.20

-CT Source Database Type = ORACLE

-CS Source Database Server =

-CD Source Database Name = HC920001

-CO Source Database Operator = PS

Command line process successfully completed.
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Log File Description Example

*_out.log For SQR, Application Engine, Data Mover, and
Filter steps this log lists parameters used and
results, as well as path to output files if applicable.

RESETVERSIONS_OUT.log

PeopleTools 8.54.21 - Application Engine
Copyright (c) 1988-2016 Oracle and/or its
affiliates. All Rights Reserved Application Engine
program VERSION ended normally

Create Change Package Log

Change Assistant will save information about progress and status shown on Change Assistant UI to a log
file. The log file also contains basic information such as PUM Source Database, tools version, operation
system type, source/target database information, download directory, tools location, and so forth.

The log for creating a change package is cpcreate log for the package. The log is placed in <output
directory>\logs\createcp\<packagename>.log. For example C:\PUM\Output\logs\createcp\PK1.log.

The log shows the shows progress and status for creating the Change Package. This is an example of a
cpcreate log:

Change Assistant version: 8.57.00
Operating System: Windows Server 2012 R2
2018-04-30 13:56:25.122 - PUM Source Database : H92CDPUM
2018-04-30 13:56:25.126 - Download Directory : C:\PUM\Downloads\
2018-04-30 13:56:25.128 - Connecting to Source Database...
2018-04-30 13:56:26.347 - Retrieving Database Information from Source Database...
2018-04-30 13:56:37.931 - Synchronizing Source Database Information to Database Def⇒

inition in Change Assistant...
2018-04-30 13:56:39.068 - Source Tools Bin Location : C:\PT8.57-120W\bin\client\win⇒

x86
2018-04-30 13:56:39.133 - Source Tools Release : 8.57.00
2018-04-30 13:56:39.135 - Change Package GUID : 0409985a-4cb0-11e8-b113-b11fa0e5185⇒

f
2018-04-30 13:56:39.136 - Creating Change Package 1 of 1: PK1
2018-04-30 13:56:39.138 - Loading Project PK1
2018-04-30 13:56:39.445 - Validating File Reference ...
2018-04-30 13:56:39.447 - Copying Project to File ...
2018-04-30 13:56:47.224 - Copying Files Needed for Doc Generation...
2018-04-30 13:56:47.263 - Querying Source Envrioment Information...
2018-04-30 13:56:47.283 -   Base Language :ENG
2018-04-30 13:56:47.292 -   Installed Language :[ENG]
2018-04-30 13:56:47.301 -   Application Release Label :HRMS 9.20.00.550
2018-04-30 13:56:47.302 - Creating Change Package content ...
2018-04-30 13:56:47.780 - Creating Template ...
2018-04-30 13:56:48.629 - Finalizing Change Package the first time ...
2018-04-30 13:56:48.879 - Generating Non-Manage Object Scripts : PK1
2018-04-30 13:56:48.889 - Generating Security Scripts : PK1
2018-04-30 13:56:48.922 - Updating Change Package Manifest ...
2018-04-30 13:56:53.978 -   Image Type : PUM
2018-04-30 13:56:53.985 -   Image Version : 25
2018-04-30 13:56:54.028 -   Target Environment Tools version : 8.56.07
2018-04-30 13:56:54.043 -   Target Environment Languages : [ENG]
2018-04-30 13:56:54.055 - Generating Documentation ...
2018-04-30 13:56:54.609 - Finalizing Change Package ...
2018-04-30 13:56:55.906 - Updating package status ...
2018-04-30 13:56:55.926 - Completed Successfully
2018-04-30 14:39:52.383 - Connecting to Source Database...
2018-04-30 14:39:53.725 - Retrieving Database Information from Source Database...
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2018-04-30 14:40:04.876 - Synchronizing Source Database Information to Database Def⇒

inition in Change Assistant...

If the create change package fails, the log will indicate Completed with Error. This is an example of a
failed change package.

Change Assistant version: 8.57.00
Operating System: Windows Server 2012 R2
2018-04-30 13:12:17.121 - PUM Source Database : H92CDPUM
2018-04-30 13:12:17.126 - Download Directory : C:\PUM\Downloads\
2018-04-30 13:12:17.147 - Connecting to Source Database...
2018-04-30 13:12:18.299 - Retrieving Database Information from Source Database...
2018-04-30 13:12:33.353 - Synchronizing Source Database Information to Database Def⇒

inition in Change Assistant...
2018-04-30 13:12:34.633 - Source Tools Bin Location : C:\PT8.57-120W\bin\client\win⇒

x86
2018-04-30 13:12:34.700 - Source Tools Release : 8.57.00
2018-04-30 13:12:34.702 - Change Package GUID : fb7b99f8-4ca1-11e8-b113-b11fa0e5185⇒

f
2018-04-30 13:12:34.704 - Creating Change Package 1 of 1: UDPKG1
2018-04-30 13:12:34.710 - Loading Project UDPKG1
2018-04-30 13:12:34.950 - Validating File Reference ...
2018-04-30 13:12:38.378 - Change Package was not created, see invalid File Referenc⇒

es

Invalid File Reference(ID-UPD26637235_01_EXP_DMS,Type Code-MAINT):File path CCL dat⇒

a cannot be found in source database.
Invalid File Reference(ID-UPD26637235_02_IMP_DMS,Type Code-MAINT):File path CCL dat⇒

a cannot be found in source database.
Invalid File Reference(ID-UPD26637235_03_SETUP_DOC,Type Code-MAINT):File path CCL d⇒

ata cannot be found in source database.
Invalid File Reference(ID-UPD26650168_PRP_SPL_DMS,Type Code-MAINT):File path CCL da⇒

ta cannot be found in source database.
Invalid File Reference(ID-UPD26650179_PRP_SPL_DMS,Type Code-MAINT):File path CCL da⇒

ta cannot be found in source database.
Invalid File Reference(ID-UPD26731230_PRP_SPL_DMS,Type Code-MAINT):File path CCL da⇒

ta cannot be found in source database.

Total number:6
2018-04-30 13:17:40.526 - Completed with Error

If the change package is defined using the command line, a special date time stamp is appended to each
line in the log.

Microsoft Windows [Version 6.3.9600]
(c) 2013 Microsoft Corporation. All rights reserved.

C:\Users\User1>CD C:\CA

C:\CA>changeassistant.bat -MODE UM -ACTION CPCREATE -UPD CP3
PUM Source Database : H92CDPUM
Download Directory : C:\PUM\Downloads\
Retrieving Database Information from Source Database...
Synchronizing Source Database Information to Database Definition in Change Assis
tant...
Source Tools Bin Location : C:\PT8.57\bin\client\winx86    at Mon Apr 30 17
:31:25 MDT 2018
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Source Tools Release : 8.57.00    at Mon Apr 30 17:31:25 MDT 2018
Change Package GUID : 4b63e1d8-4cce-11e8-90a8-c99c39c8fa80    at Mon Apr 30 17:3
1:25 MDT 2018
Creating Change Package 1 of 1: CP3    at Mon Apr 30 17:31:25 MDT 2018
Loading Project CP3    at Mon Apr 30 17:31:25 MDT 2018
Validating File Reference ...     at Mon Apr 30 17:31:25 MDT 2018
Copying Project to File ...    at Mon Apr 30 17:31:25 MDT 2018
Copying Files Needed for Doc Generation...    at Mon Apr 30 17:31:26 MDT 2018
Querying Source Envrioment Information...    at Mon Apr 30 17:31:26 MDT 2018
  Base Language :ENG    at Mon Apr 30 17:31:26 MDT 2018
  Installed Language :[ENG]    at Mon Apr 30 17:31:26 MDT 2018
  Application Release Label :HRMS 9.20.00.550    at Mon Apr 30 17:31:26 MDT 2018

Creating Change Package content ...     at Mon Apr 30 17:31:26 MDT 2018
Creating Template ...    at Mon Apr 30 17:31:26 MDT 2018
Finalizing Change Package the first time ...    at Mon Apr 30 17:31:27 MDT 2018
Generating Non-Manage Object Scripts : CP3    at Mon Apr 30 17:31:27 MDT 2018
Generating Security Scripts : CP3    at Mon Apr 30 17:31:27 MDT 2018
Updating Change Package Manifest ...    at Mon Apr 30 17:31:27 MDT 2018
  Image Type : PUM    at Mon Apr 30 17:31:29 MDT 2018
  Image Version : 25    at Mon Apr 30 17:31:29 MDT 2018
  Target Environment Tools version : 8.56.07    at Mon Apr 30 17:31:29 MDT 2018
  Target Environment Languages : [ENG]    at Mon Apr 30 17:31:29 MDT 2018
Generating Documentation ...    at Mon Apr 30 17:31:29 MDT 2018
Finalizing Change Package ...    at Mon Apr 30 17:31:30 MDT 2018
Updating package status ...    at Mon Apr 30 17:31:30 MDT 2018
Completed Successfully

C:\CA>

Errors Found in Log Files

Change Assistant scans log files that are generated when various processes run, such as SQL, Data
Mover, SQR, CopyDatabase and so on. The following table describes what logs are produced and what
Change Assistant determines to be an error:

The log files generated by Process Scheduler are not parsed for warnings or errors. Therefore, even
though Change Assistant may show a status of Complete for a Process Scheduler step type, you should
review the generated log files for more details.

Processes Log File Error Warning Status

Application Engine <process name>_out.log Restart Failed.

Invalid, Error.

Abended.

Abort.

Not Defined.

Warning.
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Processes Log File Error Warning Status

Build Project

CompareAndReport

CopyDatabase

CopyFromFile

CopyToFile

CreateProject

<process name>.log Error.

Invalid PeopleCode.

Copy process cancelled.

Project <xxx> does not exist.

Warning.

DataMoverBootstrap

DataMoverTools

DataMoverUser

LoadBaseData

<process name>_out.log

Note: Any logs generated
by the Data Mover SET
LOG statement will also be
available.

Unsuccessful.

PSDMTX Error.

Warning.

DBTSFIX SQRReport <process name>_0.out

<process name>_out.log

TNS Error.

Program Aborting.

Not Defined Error.

NA

Deploy File <process name>_out.log Failure.

• Unable to connect.

• Environment
Management
Components are
Unavailable.

Warning status.

NA

DSAutoGeneration

DSCompile

DSCustomReport

DSPatchCorrection

DSPatchImport

<process name>_out.log

<process name>.log

Failed.

Warning status.

NA

DSGetLogs

DSInitialImport

DSRunJob

<process name>_out.log

<process name>_detailed.log

<process name>.log

Failed.

Warning status.

NA
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Processes Log File Error Warning Status

ProcessScheduler The log files generated by
Process Scheduler are not
parsed for warnings or errors.
 Therefore, even though
Change Assistant may show
a status of Complete for
a Process Scheduler step
type, you should review the
generated log files for more
details

SQLCommand

SQLScript

UpdatePeopleTools

<process name>.log DB2 z/OS and DB2 UDB:

• SQLSTATE=value (value
cannot be 02000).

• SQLxxxxxN.

• DB2xxxxxE.

Oracle: ORA.

Microsoft SQL Server:

• Msg[Microsoft].

• Cannot open database,
 access denied.

• Specified SQL Server not
found.

Transaction rolled back.

• ConnectionOpen 
(Connect()).

• Login failed.

Warning.
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